This manual contains all you need to know about installing your program and maintaining a network version.

It includes an overview of the programs and working exercises for the Pallet Group, Arrange Group, Design Group, Casefill Group, Display Pallet, Folding Carton (FCA) and KDF Group programs.

Further chapters are provided on the Editors, Databases, Importing & Exporting, and Compression Strength Analysis.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copyright Notice</td>
<td>iii</td>
</tr>
<tr>
<td>Installing CAPE PACK</td>
<td>14</td>
</tr>
<tr>
<td>System Requirements</td>
<td>14</td>
</tr>
<tr>
<td>Installation Options</td>
<td>14</td>
</tr>
<tr>
<td>Installing the Program</td>
<td>14</td>
</tr>
<tr>
<td>New Installation</td>
<td>16</td>
</tr>
<tr>
<td>Network Server Installations</td>
<td>19</td>
</tr>
<tr>
<td>Program File Structure</td>
<td>19</td>
</tr>
<tr>
<td>The CAPE213 Folder</td>
<td>19</td>
</tr>
<tr>
<td>Technical Support</td>
<td>20</td>
</tr>
<tr>
<td>Network Administration</td>
<td>22</td>
</tr>
<tr>
<td>Introduction</td>
<td>22</td>
</tr>
<tr>
<td>Network Privileges/Rights</td>
<td>22</td>
</tr>
<tr>
<td>Client Server Installations</td>
<td>22</td>
</tr>
<tr>
<td>Mapped Network Drive Instructions</td>
<td>23</td>
</tr>
<tr>
<td>Opening the Network Administrator</td>
<td>23</td>
</tr>
<tr>
<td>Accessing CAPEAD through the Front Menu</td>
<td>23</td>
</tr>
<tr>
<td>Accessing CAPEAD through the Windows Explorer</td>
<td>25</td>
</tr>
<tr>
<td>Selecting your Log-in Mode</td>
<td>25</td>
</tr>
<tr>
<td>Managing CAPE PACK Network users</td>
<td>25</td>
</tr>
<tr>
<td>Adding a User</td>
<td>25</td>
</tr>
<tr>
<td>Deleting a User</td>
<td>27</td>
</tr>
<tr>
<td>Editing a User's Setup Information</td>
<td>28</td>
</tr>
<tr>
<td>Sorting the User List</td>
<td>29</td>
</tr>
<tr>
<td>Printing the User List</td>
<td>30</td>
</tr>
<tr>
<td>Program Parameters</td>
<td>30</td>
</tr>
<tr>
<td>Changing the Password</td>
<td>31</td>
</tr>
<tr>
<td>Changing the Images path</td>
<td>32</td>
</tr>
<tr>
<td>Checking Active Connections</td>
<td>32</td>
</tr>
<tr>
<td>Unlocking Web Page Publisher Catalogs</td>
<td>33</td>
</tr>
<tr>
<td>Printing a Network Administrator report</td>
<td>33</td>
</tr>
<tr>
<td>Exiting CAPEAD</td>
<td>33</td>
</tr>
<tr>
<td>Exploring CAPE PACK</td>
<td>34</td>
</tr>
<tr>
<td>Introduction</td>
<td>34</td>
</tr>
<tr>
<td>Getting Started</td>
<td>34</td>
</tr>
<tr>
<td>Start the program</td>
<td>36</td>
</tr>
<tr>
<td>Analysis types</td>
<td>38</td>
</tr>
<tr>
<td>Default Settings</td>
<td>38</td>
</tr>
<tr>
<td>CAPE PACK Suite of Programs</td>
<td>39</td>
</tr>
<tr>
<td>Analytical Programs</td>
<td>39</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Accessories Programs</td>
<td>40</td>
</tr>
<tr>
<td>Which Program to Use</td>
<td>41</td>
</tr>
<tr>
<td>New Features of CAPE PACK 2.13</td>
<td>41</td>
</tr>
<tr>
<td>Front Menu Features</td>
<td>41</td>
</tr>
<tr>
<td>Display Pallet Features</td>
<td>43</td>
</tr>
<tr>
<td>Optimization Type</td>
<td>44</td>
</tr>
<tr>
<td>Algorithm Type/Parameters</td>
<td>45</td>
</tr>
<tr>
<td>Packaging Loading Rules</td>
<td>46</td>
</tr>
<tr>
<td>Pallet Group Features</td>
<td>47</td>
</tr>
<tr>
<td>Designing Pallet Displays</td>
<td>47</td>
</tr>
<tr>
<td>Multi-Dimensional Analysis</td>
<td>49</td>
</tr>
<tr>
<td>Rotate Layers</td>
<td>49</td>
</tr>
<tr>
<td>Arrange Group Features</td>
<td>49</td>
</tr>
<tr>
<td>Quick Report for Multiple Pallets Enhanced</td>
<td>49</td>
</tr>
<tr>
<td>Sort Common Secondary Pack Sizes by Primary Packs per Load</td>
<td>49</td>
</tr>
<tr>
<td>Lift Covers off Trays for Retail Ready Packaging</td>
<td>51</td>
</tr>
<tr>
<td>Blister Pack Enhancements</td>
<td>52</td>
</tr>
<tr>
<td>Folding Carton Arrange</td>
<td>52</td>
</tr>
<tr>
<td>Case Cube Utilization</td>
<td>52</td>
</tr>
<tr>
<td>Design Group Features</td>
<td>53</td>
</tr>
<tr>
<td>Calculate Solutions with Fixed Primary Pack Volume</td>
<td>53</td>
</tr>
<tr>
<td>Multi-Viewer Graphics Features</td>
<td>55</td>
</tr>
<tr>
<td>New Report Style</td>
<td>55</td>
</tr>
<tr>
<td>Compression Strength Program Enhancements</td>
<td>57</td>
</tr>
<tr>
<td>Preset Custom Reports</td>
<td>58</td>
</tr>
<tr>
<td>Export Options Expanded</td>
<td>59</td>
</tr>
<tr>
<td>Exploring the Front Menu</td>
<td>62</td>
</tr>
<tr>
<td>Introduction</td>
<td>62</td>
</tr>
<tr>
<td>Screen Resolution or Scaling</td>
<td>62</td>
</tr>
<tr>
<td>Choosing which program to run</td>
<td>62</td>
</tr>
<tr>
<td>File Menu</td>
<td>65</td>
</tr>
<tr>
<td>Open Input Data</td>
<td>65</td>
</tr>
<tr>
<td>Open CIF</td>
<td>66</td>
</tr>
<tr>
<td>Open Viewer/Open Saved Solutions</td>
<td>67</td>
</tr>
<tr>
<td>Settings</td>
<td>69</td>
</tr>
<tr>
<td>Open Network Administrator</td>
<td>71</td>
</tr>
<tr>
<td>Change Private Path</td>
<td>71</td>
</tr>
<tr>
<td>Exit</td>
<td>71</td>
</tr>
<tr>
<td>Programs Menu</td>
<td>71</td>
</tr>
<tr>
<td>Make a New Shape Menu</td>
<td>72</td>
</tr>
<tr>
<td>Databases Menu</td>
<td>72</td>
</tr>
<tr>
<td>Resolutions Menu</td>
<td>73</td>
</tr>
<tr>
<td>Internet Menu</td>
<td>73</td>
</tr>
<tr>
<td>Publisher Menu</td>
<td>73</td>
</tr>
<tr>
<td>Help Menu</td>
<td>73</td>
</tr>
<tr>
<td>Contents</td>
<td>74</td>
</tr>
<tr>
<td>Search for Help on</td>
<td>74</td>
</tr>
<tr>
<td>Glossary</td>
<td>74</td>
</tr>
<tr>
<td>New Features in v2.13</td>
<td>74</td>
</tr>
<tr>
<td>About cape pack v2.13</td>
<td>74</td>
</tr>
<tr>
<td>Display CAPE License</td>
<td>74</td>
</tr>
<tr>
<td>Pallet Group - Building Pallet Loads</td>
<td>76</td>
</tr>
<tr>
<td>Introduction</td>
<td>76</td>
</tr>
<tr>
<td>My Default Settings</td>
<td>76</td>
</tr>
<tr>
<td>The Basics</td>
<td>76</td>
</tr>
<tr>
<td>Start the Program</td>
<td>77</td>
</tr>
<tr>
<td>Create Data</td>
<td>78</td>
</tr>
<tr>
<td>Input Settings</td>
<td>78</td>
</tr>
<tr>
<td>Product Name/Product Code</td>
<td>79</td>
</tr>
</tbody>
</table>
Secondary Package or Case Data
Pallet Data
Truck Data
Save Data
Selecting the Preferred Load
Formatting the Screen
Formatting the Load
Filling the Truck
Formatting the Panel
Formatting Objects
Save Data
Share Data
Printing
Emailing
Exporting
Web Page Publisher
Packaging Solutions
Pallet Group Data Input Features
Right Clicking Options in Data Entry
Using Multiple Pallet Types
Floor Loading into Containers
Changing Package Color
Custom Colors for Package
Adding Graphics to Packages
Primary Packages in your Shipper
Ounce to Pound Conversion Feature
Zero Package Weights
Using Trays as Secondary Packages
Special Secondary Pack Types
Palletizing Cylinders or Drums
Recessed Objects
Interlocking Pallet Layers
Secondary Package Database
Converting Product Volume to Net Weight
Printing Input Data
Overhang and Underhang
Calculating the Maximum Load Height
Using Master Pallets
Customizing your Pallet Style List
Setting a Default Pallet
Customizing Your Truck Style List
Setting a Default Truck
Pallet Group Multi-Viewer Graphics Features
Exporting to the Packaging Information Database (PID)
Packaging Report
Reviewing Objects in the Load
Multi-Dimensional Loading
Pallet Maximizer
Changing the Product Name and Product Code in graphics
Changing the Number of Decimal Places in Graphics
Changing Content of Dimension Labels
Dimension Labels and Outside or Inside Dimensions
Review Product Quantity
Dimension Labels
Rotate Layers 90 degrees
Editing your Layer Pattern
Rotating Objects
Displaying the Case Front around the Pallet
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Design Features in this Version</td>
<td>202</td>
</tr>
<tr>
<td>Calculate Solutions with Fixed Primary Pack Volume</td>
<td>202</td>
</tr>
<tr>
<td>Folding Carton Arrange (FCA) Programs</td>
<td>204</td>
</tr>
<tr>
<td>Introduction</td>
<td>204</td>
</tr>
<tr>
<td>New Case Sizes</td>
<td>204</td>
</tr>
<tr>
<td>Fixed Case Sizes</td>
<td>211</td>
</tr>
<tr>
<td>New Features in Folding Carton Arrange</td>
<td>216</td>
</tr>
<tr>
<td>Case Cube Utilization</td>
<td>216</td>
</tr>
<tr>
<td>KDF Group – Knocked Down Flat Cartons</td>
<td>218</td>
</tr>
<tr>
<td>Introduction</td>
<td>218</td>
</tr>
<tr>
<td>Starting the KDF Programs</td>
<td>218</td>
</tr>
<tr>
<td>Modifying Formulas</td>
<td>220</td>
</tr>
<tr>
<td>Editing Formulas</td>
<td>221</td>
</tr>
<tr>
<td>Adding Formulas</td>
<td>221</td>
</tr>
<tr>
<td>Running a Flatblank Analysis</td>
<td>221</td>
</tr>
<tr>
<td>Adding Straps to the Bundle</td>
<td>224</td>
</tr>
<tr>
<td>Pallet Information for Flatblanks</td>
<td>225</td>
</tr>
<tr>
<td>Truck Information for Flatblanks</td>
<td>226</td>
</tr>
<tr>
<td>Saving Flatblank Data</td>
<td>227</td>
</tr>
<tr>
<td>Reviewing Solution Statistics</td>
<td>228</td>
</tr>
<tr>
<td>Formatting the Load</td>
<td>229</td>
</tr>
<tr>
<td>Loading the Truck</td>
<td>229</td>
</tr>
<tr>
<td>Printing Reports</td>
<td>230</td>
</tr>
<tr>
<td>Running a Made-up Case Analysis</td>
<td>232</td>
</tr>
<tr>
<td>Pallet Information for Made-Up Cases</td>
<td>234</td>
</tr>
<tr>
<td>Truck Information for Made-Up Cases</td>
<td>234</td>
</tr>
<tr>
<td>Saving Made-Up Case Data</td>
<td>234</td>
</tr>
<tr>
<td>Running a Bale Analysis</td>
<td>235</td>
</tr>
<tr>
<td>Bale Information</td>
<td>237</td>
</tr>
<tr>
<td>Truck Information for Bales</td>
<td>237</td>
</tr>
<tr>
<td>Saving Bale Data</td>
<td>238</td>
</tr>
<tr>
<td>Display Pallet</td>
<td>240</td>
</tr>
<tr>
<td>Introduction</td>
<td>240</td>
</tr>
<tr>
<td>The Problem</td>
<td>241</td>
</tr>
<tr>
<td>Considerations</td>
<td>241</td>
</tr>
<tr>
<td>Data Input</td>
<td>243</td>
</tr>
<tr>
<td>Optimization Type</td>
<td>244</td>
</tr>
<tr>
<td>Algorithm Type/Parameters</td>
<td>245</td>
</tr>
<tr>
<td>Packaging Loading Rules</td>
<td>246</td>
</tr>
<tr>
<td>Packages Tab</td>
<td>247</td>
</tr>
<tr>
<td>Package 1 – Bagged Chips in a Case</td>
<td>248</td>
</tr>
<tr>
<td>Package 2 – Boxed Crackers in a Case</td>
<td>251</td>
</tr>
<tr>
<td>Package 3 – Candy Pouches in a Case</td>
<td>253</td>
</tr>
<tr>
<td>Package 4 – Bottles of Lemonade</td>
<td>255</td>
</tr>
<tr>
<td>Package 5 – Cans of Coffee</td>
<td>256</td>
</tr>
<tr>
<td>Pallet Information</td>
<td>258</td>
</tr>
<tr>
<td>Truck Information</td>
<td>260</td>
</tr>
<tr>
<td>Saving Data</td>
<td>261</td>
</tr>
<tr>
<td>Evaluating Results</td>
<td>262</td>
</tr>
<tr>
<td>Comparing Statistics</td>
<td>262</td>
</tr>
<tr>
<td>Reviewing Graphics for Other Solutions</td>
<td>262</td>
</tr>
<tr>
<td>The Best Solution</td>
<td>263</td>
</tr>
<tr>
<td>Formatting the Pallet Load</td>
<td>263</td>
</tr>
<tr>
<td>Adding a Top Cap</td>
<td>263</td>
</tr>
<tr>
<td>Adding Corner Posts</td>
<td>264</td>
</tr>
<tr>
<td>Loading the Truck</td>
<td>264</td>
</tr>
<tr>
<td>Sharing Data</td>
<td>266</td>
</tr>
<tr>
<td>Setting up the Screen</td>
<td>266</td>
</tr>
</tbody>
</table>

Version 2.13

CAPE PACK • 5
Installing CAPE PACK

System Requirements
CAPE PACK runs on Microsoft Windows 98/ME/2000/2003/XP/XP Pro, NT, Vista and Windows 7. To install this program in any NT-based system, you must have ADMINISTRATIVE PRIVILEGES/RIGHTS.

To run the program, you will need the following:

<table>
<thead>
<tr>
<th>Computer set up</th>
<th>Windows operating systems</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD ROM Drive</td>
<td>CAPE PACK is normally supplied on a CD</td>
</tr>
<tr>
<td>Processor</td>
<td>A Pentium processor.</td>
</tr>
<tr>
<td>Windows Client</td>
<td>When running CAPE PACK on a single PC you must run with Microsoft Windows 7 (32/64 bit) or Windows 8 (32/64 bit), Windows XP SP3 (all editions except Starter Pack) or Vista (32/64 bit).</td>
</tr>
<tr>
<td>Windows Server</td>
<td>When running CAPE PACK on a server you must run with Windows 2008 (32 bit), Windows 2008 R2 (64 bit) or Windows 2003 (32/64 bit). CAPE PACK is Citrix compatible. CAPE PACK also runs on other Terminal Servers.</td>
</tr>
<tr>
<td>Colour Graphics</td>
<td>Your computer must have colour graphics capability. CAPE PACK requires a minimum screen resolution of 800 x 600 to take full advantage of the powerful colour graphics.</td>
</tr>
<tr>
<td>Printers</td>
<td>CAPE PACK will, through Windows, support most graphics capable printers.</td>
</tr>
<tr>
<td>RAM</td>
<td>CAPE PACK requires that your computer have at least 64 Mbytes of RAM.</td>
</tr>
<tr>
<td>Hard Disk</td>
<td>CAPE PACK will occupy approximately 120 Mbytes of space on your hard disk for program storage. Additional space will be needed as you add data files and save Solution/Graphics files.</td>
</tr>
</tbody>
</table>

Installation Options
You can install your software in one of two ways.

- **Central Location Setup**: Installs all of the CAPE PACK files to one location on either the hard drive of your computer or on a specified network drive.

- **Client/Server Setup**: Installs the main program files on your local hard disk. The remaining common program files and software licensing are located on a specified network server. This option is provided to optimize loading and response times on network servers. Because the main programs are being run directly from the hard drive, the program responds much faster over a network.

Note: The Client/Server option is provided to deal with the issue of programs operating slowly on network servers due to the amount of traffic on the network at any one time. Using this installation option locates the main programs to your local hard disk and therefore allows the CAPE PACK programs to work much faster.

UNLESS YOU ARE USING UNC’S FOR YOUR INSTALLATION PATH, IT IS HIGHLY RECOMMENDED THAT YOU INSTALL THE PROGRAM USING A CLIENT PC RATHER THAN A NETWORK TO PERFORM NETWORK INSTALLATIONS. PATHING FILES ARE ESTABLISHED DURING THE INSTALLATION PROCESS AND DRIVE LETTERS WILL NOT BE CORRECT UNLESS A CLIENT PC IS USED.

Installing the Program

Insert the CAPE PACK CD into your CD tray and close it. The CD Browser will start.
Select **Install Software**.

You have two options for installing CAPE PACK 2.13

If you choose the **Install US Version**, you will have a choice between US England or Spanish with inches/pounds measurements as default, and with the North American Compression Strength program. If you choose this option, you can switch to one of the other program languages after installation. You can also setup your program groups to work in metric as default.

If you choose the **Install Metric Version** option, you can choose which language to install with (Euro English, Spanish, French, German or Swedish), but the program will install using Metric units of measure and the European Compression Strength Program.

If you wish to install the Metric version, please find the Installation and Network Administration.pdf file on your Application CD in the Documentation\English (European) folder for further installation instructions. The instructions in this manual are for the US Version.

Click on **Install US Version**. The CAPE PACK installation program will automatically appear.

![Install US Version](image)

Click on **Next**. and you will see the **cape pack v2.13 Setup** screen. Here you have three options:
• I am installing CAPE PACK on this computer for the first time. (New Installation)

• I am upgrading an older version of CAPE PACK on my computer. (Upgrade)

• I am reinstalling CAPE PACK on my computer. (Reinstall)

**New Installation**

• Select **I am installing CAPE PACK on this computer for the first time. (New Installation)**

Accept the default folder, and then click on **Next**. You will see the following screen.

This screen allows you to choose your Setup Type, the Pallet Styles you want to install and the Program Language you prefer.
Select **Central Location Setup** for a full network installation or a PC installation. **Select Client/Server Setup** to install licensing and common files to the network and the main program files to your hard drive. Make your choice and click on **OK**.

Choose either **European Pallet Base Styles**, **American Pallet Base Styles** or both.

Select either **American English** or **Spanish** Program Language.

Click on **Next** and you will see the following screen.

![Image](image1)

Click on **Install** to begin the installation. The installation process will begin. This could take several minutes and you will see progress screens during the process.

![Image](image2)

Once the Windows files have been registered you will be asked to enter your License Code that was supplied with your program. **The License Code is Case-Sensitive.** Enter your supplied code and hit **OK**.
Next you will be prompted to enter details about your company’s name and address. You must complete these details. Then click on **Register**.

When all the files have been installed you will see this screen.

Click on **Finish**.

The installation will create a shortcut on your desktop for CAPE PACK and add it to your Start menu.

To close your CD Browser program, click on the **Back** button. Then click on **Exit** and the browser will close.

**Note:** Remove the CD from your PC and keep in a safe place.
Network Server Installations

UNLESS YOU ARE USING UNC’S FOR YOUR INSTALLATION PATH, IT IS HIGHLY RECOMMENDED THAT YOU INSTALL THE PROGRAM USING A CLIENT PC RATHER THAN A NETWORK TO PERFORM NETWORK INSTALLATIONS. PATHING FILES ARE ESTABLISHED DURING INSTALLATION PROCESS AND DRIVE LETTERS WILL NOT BE CORRECT UNLESS A CLIENT PC IS USED.

Once you have installed the program to the server you will need to register a range of system files in the Windows Registry for each workstation that is going to run CAPE PACK.

On each workstation, open your Windows Explorer and go to the CAPE213 folder.

Locate the file called Client.Exe. Double-click on this file and it will automatically install and register these files in the Windows Registry. It will also add the CAPE PACK program shortcut to your Desktop.

You are now ready to run CAPE PACK on the workstation.

If you are installing your program to a network server, please refer to the chapter entitled Network Administration.

Program File Structure

During installation the programs are loaded onto your hard disk in your chosen folder, normally called CAPE213. Here is what the CAPE213 folder looks like in Windows Explorer.

The CAPE213 Folder

This folder holds a wide range of program files.

DO NOT ATTEMPT TO MOVE ANY OF THE FILES IN THE CAPE213 DIRECTORY.

Databases

This folder contains all the databases for the program. You can move these if you wish without harming the program, however the program will not be able to locate them by default if they are moved.
Examples

The Examples folder contains samples of Excel and Access files that can be used to run the CAPE PACK program modules, and also samples that can be used to create databases for your program modules. These files can be moved if you wish. You can also modify and share these files with others.

Images

This directory holds all of the files created by the 3D Imaging Program. These files have the extension .3DI.

Private

This is your own “private” directory for storing the CAPE program files. These files have the extension CLF or CL2.

Shared

This can be used as another, more “public” location for the CLF files if you are using a network.

Tutor

This is where CAPE PACK stores a wide range of program utilities and database files used within the programs.

DO NOT ATTEMPT TO MOVE ANY OF THE FILES IN THE TUTOR DIRECTORY.

Cylinder, Bag, GableEnd, RectBottle, Display Case, VariableTray and Ovals.

These are folders that hold the special files for different package shapes (.CSF).

You must save the shapes to default directory for that shape. Do not move these files to any other directory, otherwise they will not appear in the proper lists.

Technical Support

Technical Support for your program is available by telephone, email and fax.

Our Help Desk can be reached Monday through Friday between 8:00 a.m. and 5:00 p.m. Eastern Time by telephone at 888-387-0485 or Central Time at 800-229-3434, or by Fax at 989-681-6260 or 972-359-1106. International customers can reach us by phone at 989-681-3540 or 972-359-1100.

Or you can email the Help Desk at help@capesystems.com.
Network Administration

Introduction

The CAPE PACK Network Administrator program is available to help you maintain the network parameters. Its main function is to provide administrators with an easy way to set up CAPE PACK for network users.

Network Privileges/Rights

The CAPE PACK folder (CAPE213) must have Security permission of the Modify level for “users” profile or any other user profile group that will want to run CAPE PACK.

Note: It is important that you have these rights or your CAPE PACK program will not function correctly.

Client Server Installations

Once you have installed the program to the server you will need to register a range of OCX and DLL files in the Windows Registry for each workstation that is going to run CAPE PACK.

On each workstation where you intend to run the program, open Explorer and go to the CAPE213 folder on your server.

Locate a file called Client.Exe. Double click on this file and it will automatically download and register these files in the Windows Registry. It will also add the CAPE PACK program shortcut to your Desktop.

You are now ready to run CAPE PACK on your workstation.
Mapped Network Drive Instructions

Please follow the instructions below, when CAPE PACK is installed onto a mapped network drive and the installer does not pick up the UNC.

Obtain the UNC (or universal name) of the server for the network mapped drive. This is usually the server name preceded by a double backslash. (Example `\\MADH133_SERVER`). For our example, let’s assume that CAPE PACK has been installed onto the "E" drive.

Open `cpsetup.ini` which is located in the application path, usually `"...\CAPE213"`. The content of the file will appear as follows:

```
[paths]
Program=E:\PROGRA~2\CAPE213\ 
Tutor=E:\PROGRA~2\CAPE213\TUTOR\ 
Shared=E:\PROGRA~2\CAPE213\SHARED\ 
Images=E:\PROGRA~2\CAPE213\IMAGES\ 

[Dictionary]
Dictpath=E:\PROGRA~2\CAPE213\TUTOR\ 
```

You now have to replace the drive letter and colon (E:) with "\MADH133_SERVER". Please keep in mind that you have to use your UNC instead of our example "MADH133_SERVER".

The above entries will now look like this:

```
[paths]
Program=\\MADH133_SERVER\PROGRA~2\CAPE213\ 
Tutor=\\MADH133_SERVER\PROGRA~2\CAPE213\TUTOR\ 
Shared=\\MADH133_SERVER\PROGRA~2\CAPE213\SHARED\ 
Images=\\MADH133_SERVER\PROGRA~2\CAPE213\IMAGES\ 

[Dictionary]
Dictpath=\\MADH133_SERVER\PROGRA~2\CAPE213\TUTOR\ 
```

Save and exit the `cpsetup.ini`.

Opening the Network Administrator

CAPEAD can be accessed either through the Front Menu of the CAPE PACK program or through the Windows Explorer.

Accessing CAPEAD through the Front Menu

Start CAPE PACK as usual by double-clicking on its shortcut. From the File menu, choose Open Network Administrator.
You will then see a screen like this and you will be prompted to enter a password.

If you have not entered CAPEAD before, the password will be CAPE (all capital letters). If you have entered CAPEAD previously and changed the password, enter that password.

The program will only allow **three** incorrect tries at the password before exiting the program. Please contact CAPE Systems if you have forgotten your password.

Type your password and press the **Enter** key. A window like this appears.
Accessing CAPEAD through the Windows Explorer

Start Explorer. Find and change to the drive and directory where CAPE PACK resides.

In the main CAPE PACK directory, typically CAPE213, find a file called `capead32.exe` and double click on it. You will be prompted for a password.

![Password dialog]

Type in your password and hit the Enter key. If you have not entered CAPEAD before the password will be CAPE (all capital letters). If you have entered CAPEAD previously and changed the password, enter that password.

Selecting your Log-in Mode

You can select either the User-id or Global User-id login mode from the Tools menu.

![Network Administrator]

Your chosen mode will have a check mark next to it. When you switch modes, all users will need to use the same type of login: 3-character or 7-character.

Managing CAPE PACK Network users

If CAPE PACK is installed on a network for several users, the administrator will have to create a unique login ID for each user. A login ID provides the user with access to the program. A user will not be able to access the program without a unique ID. With the new version of Network Administrator, the program manager will have the ability to allow the user to log in to CAPE PACK in one of two ways.

- With the standard User ID (three character) This is the default method.
- With the new Global User ID (7 character). If the Global User ID is chosen, the program will create a unique User ID for each Global User ID.

Adding a User

You can specify up to 99 unique login ID’s. However, the number of simultaneous log-ins is only equal to the number of Network User Licenses you have purchased. For example, if you bought a 3-user network license and there are 7 people who want to access CAPE PACK, you can create 7 unique log-in ID’s, but only 3 of those ID’s will be able to run the program simultaneously. If a fourth person tries to log in, they will receive a message denying them access.
From the CAPEAD Front Menu, click on the **Create/Edit List of Valid Users** button. A window showing a list of current users will appear.

Click on the button labeled **Add New User**. A dialog box will appear.

Select whether you wish to add a **User-id** (3 character) or **Global User-id** (7 character). If **User-id** is selected, the **Global** and **Location** fields will be grayed out. If **Global User-id** is selected, the **User ID** field will be grayed out. Fill in the fields that are available according to the following.

- **User I.D.** – 3 alphanumeric characters. Certain three letter combinations cannot be used. They are EXE, BAT, COM or DLL.

- **Global User ID** – up to 7 alphanumeric characters

- **User Name** – the proper name of the user for which the ID was created
• **Users Private Path** – default folder where all CAPE PACK CLF files are stored. This is the default or saving and opening files.

• **Location Field** – 25 character free-flow field for location information for the user.

![User Input Window](image)

If a user’s private path is on the local hard drive, that user’s ID will not function on another workstation. This is because the private path will not exist.

You can deactivate user’s ability to save Default User Text. If you choose to do this, click on the appropriate field.

When all the information has been entered, click on the **OK** button to accept it, or **Cancel** to return to the User List without adding the user.

To ensure any changes are retained, click on **OK** from the User List Window. If you do not want to save your changes, click on **Cancel**.

**Deleting a User**

If a user no longer needs to be part of the User List you can delete that user from the list.

From the CAPEAD Front Menu, click on the **Create/Edit List of Valid Users** button. A window showing a list of current users will appear.
Find the user in the list and click on the row to highlight it.

Click on the **Delete User** button. You will be prompted to confirm the deletion.

You cannot delete the last remaining record.

When you are deleting a user, the removal is final if you answer **OK** to the confirmation prompt. In order to get a user back once they have been deleted; you must add them as a new user.

**Do not delete the default user, CAP. If this user is deleted, the program will need to be reinstalled to function properly.**

To make the deletion final, click on **OK** at the confirmation prompt. The user is gone and you are returned to the User List window.

At the User List Window, it is important to remember that if you were to click on the **Cancel** button, the deleted user does not return.

**Editing a User’s Setup Information**

If a user requires a name change or path change, you can edit the user’s information.

From the CAPEAD Front Menu, click on the **Create/Edit List of Valid Users** button. A window showing a list of current users will appear.
Find the user in the list and click on the row to highlight it.

Click on the button labeled **Edit User**.

Make any changes to any of the fields, then click on **OK** to accept changes, or **Cancel** to cancel changes.

**Sorting the User List**

You can sort your user list by one of four fields: User-id, Name, Global User-id and Location Field. Select the method you choose from the drop down box in the upper left corner of the screen and the list will be resorted and displayed.
Printing the User List

Click on the Create/Edit List of Valid Users button. A window showing a list of current users will appear.

Click on Print User List. This will automatically send a copy of the user list to the default printer.

Program Parameters

Within CAPEAD there are some features that allow you to check and change the status of the program. Fortunately, this does not have to be done often, if at all.

Click on Maintain System Parameters. A window will appear.
### Field Name | Description
--- | ---
**Number of Users** | This is the number of simultaneous users for which the software has been licensed. Contact CAPE Systems for a program update if you need to increase the number of licensed users.

**Pallet Group** | This indicates you are licensed for the Pallet Group of programs.

**Arrange Group** | This indicates you are licensed for the Arrange Group of programs.

**Design Group** | This indicates you are licensed for the Design Group of programs.

**CAPE Folder** | This folder, created during the installation process, specifies the location of the CAPE PACK programs and selected files. Normally CAPE213.

**WPP Shared Folder** | Set the path for the location of the Shared folder for CAPE’s Web Page Publisher. Refer to the Web Page Publisher PDF file on your Application CD in the Documentation folder for more information.

**Tutor Folder** | The location of the Tutor Directory was set during installation and contains certain configuration files required to run CAPE PACK. This cannot be moved.

**Image Folder** | The Image folder is for storage of your 3D files.

**Display Pallet Database Shared Directory** | This folder is for shared database files that are used in the Display Pallet program.

**Master Database Directory** | This folder is for shared database files that are used in the single product parts of the program. The databases can be moved to a central location and this field updated.

**Password** | Displays the current password. The password is case-sensitive.

### Changing the Password

To change the password for CAPEAD:

Click on **Maintain System Parameters**.

In the Password field, type a new password. The password you type can be a combination of letters and numbers. Remember that the password is case sensitive.

Click on OK, to accept the change. Click on Cancel if you do not want to accept the change.

If you forget your password, you will need to contact CAPE Systems for assistance.
Changing the Images path

The installation procedure creates a folder called Images under the main CAPE directory. You can change this default after installation. Users should have all appropriate rights to this directory.

Click on **Maintain System Parameters**. A window like this will appear.

![Maintain System Parameters](image)

Type in a new drive and directory location in the *Images* directory field.

Click on **OK**, to accept the changes. Click on **Cancel** if you do not wish to accept the changes.

You can only change the Tutor Folder when CAPEAD is launched from outside the CAPE PACK program. If CAPEAD is launched from within the program, the Tutor Folder will be disabled.

Checking Active Connections

CAPE PACK maintains a list of active connections to ensure compliance with the license agreement. If an excessive amount of users try to log into the program, CAPEAD will not allow it. This list also ensures that two users do not log in with the same ID simultaneously.

For example, if a user attempts to log into CAPE PACK they will receive a message informing them the ID is already logged in or that the maximum amount of users have logged in. You can check to see who is logged in or if the user might already be logged in from a previous session.

If the program terminates abnormally, it may be unable to close the connection for that User ID. When the user attempts to log back into the program it will not allow it. This is because it assumes the user is still logged in.

Click on **Edit List of Active Connections**.

Scan the list for the number of users logged in. Ensure this number does not equal the maximum number of users. If it does, the user will not be able to log in until someone else logs out.

Also look for that person’s ID in the list.

If you find the ID for the person who wants to log in, you can highlight the ID and click on the **Delete** button. This will clear the connection for that ID and allow the person to log in.

You have a similar feature for managing your list of active Web Page Publisher Connections.
Unlocking Web Page Publisher Catalogs

If you get an error message when you are trying to change a Web Page Publisher catalog, you can use this feature to unlock or release the hold on that catalog.

Click on the **Unlock Catalog** button.

Select the type of catalog you want to unlock and click on **OK**.

A screen will open for you to select your catalog and you unlock it by deleting the connection.

**Printing a Network Administrator report**

If you want to keep a copy of the configuration, you can print a copy of all the settings. Click on **Print Network Administrator Report**. The report will be printed to the default printer.

**Exiting CAPEAD**

After you have completed all your checks and modifications you can exit the CAPEAD program.

Click on the button labeled **Exit from CAPEAD**. You will be returned to the Front Menu providing that is where you initiated CAPEAD. Otherwise you will be returned to the Windows Explorer.
Exploring CAPE PACK

Introduction

CAPE PACK is a 32-bit, standard Windows convention program that has been designed to operate in a similar style to other programs, such as Microsoft Word. The program is easy to use, with pull-down menus, toolbars, right-click menus and tabbed data input screens.

Like Word, CAPE PACK is a comprehensive system, catering to a wide range of needs. We understand that not everyone will want to use all of its features at first. However, a lot of people will grow to use many parts of the program over a period of time.

So, don't be overwhelmed by every feature or option that is available in the program. Just concentrate on the features you want to use for your own circumstances. Like any large system, the finer points can be learned as and when you need them or when you have the time to experiment.

CAPE PACK is a group of programs designed to help you solve most of your packaging problems.

- What is the best way to load this product onto a pallet?
- How do I design the best size primary pack (product), case (shipper) size and pallet load?
- How many boxes can I fit on a pallet?
- How will the pallet load fit in a truck?
- How can I draw all the packaging components and load diagrams?
- Which load is more economical?
- How do I create realistic packaging components for my specifications?
- How can I put surface graphics on my packaging components?
- How can I communicate the results to my colleagues/customers?

By running one or more of the program groups you have the ability to evaluate many different packaging alternatives quickly. You no longer have to sit for hours with paper, pencil and calculator trying to decide how best to load a case, pallet or a truck.

Getting Started

Simply select the package type you need from the drop down lists on the Pallet, Arrange, Design, KDF or Casefill groups on the Front Menu. Then click on Go to launch that program.
Or if you have already run one program, you can select another program from the **Programs** menu on any of the input screens.

Or you can customize your Front Menu using the Rearrange Program Groups option on the **Programs** menu.

Using any of these methods, the program will load with your Default Settings. You then just enter the data you need to change, choose a save option and then the program calculates and displays a range of solutions. You then evaluate the different solutions using the on-screen graphics and a number of text reports.
The on-screen graphics allow you manipulate the diagrams to suit your own requirements so that you can save those results, print them, or export them for use in another program application (i.e., packaging specifications, databases or Word documents).

**Start the program**

Start CAPE PACK from your desktop by double-clicking on the icon.

Choose the appropriate program and package type and click on the **Go** button. You move forward to the data entry area with the **Default Settings** already filled out. The following is an example of the Pallet Group.

**Create Data**

Modify your Default Settings with your specific package and loading requirements.
Save Data

Save the data and calculate the results.

Your Default Settings will be maintained, but your data will be saved to a filename of your choice. You will then be presented with a range of solutions, in the graphics portion of the program.

View the results in Multi-Viewer Graphics.

Evaluate the different solutions, select a solution, and customize your results with screen, layer or object formatting. Then save the graphics for later use.

Share Data

Print or share your results with colleagues/export to other applications/communicate to customers.
From here you can customize the on-screen graphics, print your reports, export solution information to other programs, create web pages OR you can move back to the data entry area and modify/refine the input data to re-run the analysis.

Analysis types

There are three types of analysis you can use in the program groups:

- Use My Default Settings which load automatically whenever you start a program group.
- Start from a completely New data file. Once the program group has loaded, you can select New from the File menu to “clear” the data input screen of all previous information. If you have identified a default pallet or truck style, this will appear with each new analysis.
- Open a saved data input file and modify the data entries in that file. You can then either save over the existing file to update it, or save the file as a new name, preserving the existing file.

Using your own Default Settings is by far the easiest way to create a new data file as the data fields are already filled out. All you have to do is modify them. Starting a New data file means you have to enter all the data.

Whether you launch the program from the pictorial sections on the Front Menu or from the Programs menus, the appropriate program will begin with Default Settings already loaded.

Default Settings

Default Settings are simply your chosen default parameters for the module. Your program is supplied with preset Default Settings. These should be modified to suit your needs and then saved by clicking on File, Save My Default Settings. These settings are a template or master set of information for the program. Because the program loads these Default Settings automatically, all you need to do is make necessary changes for the particular analysis, enter your product name and product code, and calculate your answers.

For example, if you loaded the Pallet Group for cases, all you might need to do is enter a new case size and weight and then calculate your answers. The pallet information and/or truck information would mostly likely remain the same.

Default Settings are also an easy way for you to see the type of information required by any of the CAPE PACK program modules. They offer an ideal way for you to work with the different program groups and familiarize yourself with the software and how it works. You can open the Default Settings, change the data and run an analysis. You can resave them, but you cannot create any additional templates.

There is only one template for each program module as follows.

<table>
<thead>
<tr>
<th>Pallet Group</th>
<th>Rectangle/Oval, Cylinder/Bottle, Trapezoid, Bags</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange Group</td>
<td>Box/Bag/Bottle, Cylinder/Bottle, Trapezoid</td>
</tr>
<tr>
<td>Design Group</td>
<td>Box/Bag/Bottle, Cylinder/Bottle, Trapezoid</td>
</tr>
<tr>
<td>Case Fill Group</td>
<td>Box/Bag/Bottle – Fixed, Box/Bag/Bottle- Variable, Cylinder/Bottle - Fixed</td>
</tr>
<tr>
<td>KDF Group</td>
<td>Flatblank, Made-up Case</td>
</tr>
<tr>
<td>FCA Group</td>
<td>New-Nested Cartons in Bundles, New-Nested Bundles in Cases, Fixed-Nested Cartons in Bundles (all Patterns), Fixed-Nested Cartons in Bundles (Row/Column), Fixed-Nested Bundles in Cases (Row/Column)</td>
</tr>
</tbody>
</table>
CAFE PACK Suite of Programs

CAFE PACK contains two types of programs: the Analytical programs and the Accessories programs.

Analytical Programs

Use these programs to solve a specific type of packaging design or pallet loading problem.

Pallet Group

If you have a fixed sized object, which you want to load onto a pallet or into a truck, you should run this program to see how that object can be loaded, based on the restrictions you apply. The object can be a rectangle, oval, bag, cylinder or trapezoid, or an object you create within the Make a new Shape feature. You can load the object onto a variety of pallet styles or into a variety of truck styles. Use this program to compare the different alternatives for loading an object onto a maximum of three different pallet sizes.

Display Pallet

If you have different sizes of boxes to load on the same pallet, you would use this program. Once designed, you can then place your loads into a truck. Display Pallet allows you to combine up to 40 different box sizes, with a maximum load of up to 500 boxes. There is also a powerful load editor for fine-tuning your load.

Arrange Group

If you have a fixed-sized product or primary package you need to arrange in a case and then palletize for shipping, you should run this program. You specify the shape and size of the primary package, how many you want in a case and (if required) how it should be bundled in groups. The program will calculate a case size, which it will then palletize. The object of this program is to fit the highest number of primary packages on the pallet, based on the loading restrictions you specified.

Design Group

If you have a new product to design or primary package you need to resize and pack in a case, and then palletize, you should run this program. You specify the shape and size of the primary package, how much the size can vary, how many you want in a case and (if needed) how it should be packed in bundles. The program will then calculate new primary package sizes, a variety of package arrangements and new case sizes, which will then be palletized. The object of this program is to calculate the best primary package size in order to fit the maximum number of primary packages onto the pallet.

KDF Group

These programs are specifically for use by corrugated companies where the user wants to start with either a flat blank of a case or a made-up case (an erected corrugated case). They select a formula and the program automatically converts the flat blank or made-up case dimensions to a KDF (knocked down flat/flat-glued case). They enter a minimum and maximum number of KDFs per bundle and the program creates the bundle size. Finally, they choose a pallet and truck type and the program does the rest.

Folding Carton Arrange (FCA)

The Folding Carton Arrange programs are for building bundles of flat folded cartons, and then arranging these bundles into cases, and then putting these cases onto pallets. There are two modules for new case sizes and 3 modules for existing case sizes. The New Case size options will design you new cases based on your bundle counts and case parameters. The Fixed Case Size options will evaluate your cartons in bundles compared to a database of existing cases.
Casefill Group

If you need to fill an existing case size with a product or primary package, use this program. First, set up a database of case or tray sizes that exist within your operation. Then specify the size and shape of the primary package as well as the cases/trays you want to consider loading. The program searches for the case that yields the best fit. In addition, Variable Casefill will allow for changes in the primary pack size to fit more efficiently in an existing case. This program does not palletize the case because it assumes that the palletization for this case is acceptable to you. Use this program to help in consolidating the number of existing case sizes your company uses. The rule that 20% of the product supports 80% of the business might apply to this analysis.

Accessories Programs

Use these optional programs to enhance or customize your results from the main analytical programs and then communicate them to others.

Pallet Audit

Introducing Pallet Audit. Pallet Audit has been designed to allow the user to enter very simple input information so the program can create a database of all possible 2 dimensional case footprint sizes, for all CAPE’s pallet patterns, on up to four different pallet sizes. The completed Audit Database contains a wealth of information at a glance.

Web Page Publisher

Use this program to create web pages and catalogs that can be uploaded to a web address to provide a single source for your palletizing specifications. You can then allow access to these pages via the Internet anytime day or night by anyone in the world, based on your security settings.

Make a New Shape programs

These programs allow you to create rectangular, cylindrical, trapezoidal, ovals and gable-end shaped packages. Bottles, cans, milk cartons, various bag shapes and sloping sided shapes can also be created.

You can also color either the entire package in one color or different colors for different parts of the package for greater realism. So, a green wine bottle with a red top seal is very easy to create.

You can also create display cases and trays, pallet base styles, pallet crates, pallet blocks, container sizes and pallet bins for use in the analytical programs.

Packaging Information Database

CAPE PACK has a powerful database feature called the Packaging Information Database. This special database allows you to save the information from any solution you create in Pallet, Arrange, Design, KDF or Casefill and then sort, review or group that information. You can even recall your saved graphics from within the database.

Strength

This program calculates the compression strength of a case based on case size, board grades, and environmental factors. The results are calculated using the McKee formula, which is based on strict laboratory conditions. Use Strength to work out how your particular case performs under different conditions.

Add-on Graphics (3D Imaging)

This program allows you to transfer scanned images or artwork files onto the surfaces of the packaging components (primary, tray, secondary package) available in the analytical programs or onto those packages created using the Make a
new Shape feature. Full documentation for this program is available on your Application CD in the Documentation folder.

### Which Program to Use

To determine which program you need, all you have to do is to ask the question "What am I trying to do?" Here are some guidelines.

- **Building pallet patterns**: If you want to put a case onto a pallet, choose the **Pallet Group** and the appropriate shape you want to use (i.e., a case, a cylinder).

- **Creating a new case size**: If you have a fixed size primary package and you want to arrange it in different case counts to create a new case size, then choose the **Arrange Group** and the appropriate shape of primary package.

- **Designing a new size primary package**: If you have already run the Arrange Group for a fixed primary package size and then want to change the dimensions to design a new primary package, choose the **Design Group** and the appropriate shape of primary package.

- **Case consolidation**: If you have a primary package and a number of existing, fixed, case sizes and you want to see how many primary packages you can fill into each one of those different case sizes, you will be "filling cases". Therefore, choose the **Casefill Group** and an appropriate primary package shape.

- If you have cases that you want to ship in a knocked-down form, bundled onto pallets, use the **KDF Group**. This group can take either a flat case and fold it up to achieve the KDF size, or it can take the erected case size and convert it to a KDF.

- **Folding Carton Arrange**: If you are trying to determine a case size for flat folded cartons, you would use the Arrange Group for either Fixed or New case sizes.

- If you have more than one size of case that needs to be placed onto the same pallet at the same time, you should use the **Display Pallet** program. This program can consolidate up to 40 different sizes of packages onto the same pallet, and then display the finished pallets loaded into a truck or container.

The program names correspond to the type of analysis you need to run. So just think about what you are trying to do and the name of the appropriate program group will become obvious.

### New Features of CAPE PACK 2.13

**Front Menu Features**

We introduced a way for you to customize the Front menu of your screen to allow any three program groups to appear.

Click on the **Programs** menu and **ReArrange Program Groups**.
The following screen will appear.

Select the groups you want to appear by clicking on the appropriate check mark in the **Show Group** column, then setup the order you prefer in the order column. Here is an example.

And the results would look like this.
Pallet Group has been replaced with Display Pallet, Arrange and Design Group has been replaced with FCA Group and Casefill has been replaced with the KDF Group. The program will remember these options as your default until you change them.

### Display Pallet Features

Display Pallet is designed to help you determine the best way to load multiple cases or trays onto a pallet. You can use standard cases, or any case or tray that you have designed in the Make a new Shape feature. You can also fill these packages with inner packs that can be bottles, bags or boxes.

You have two different loading patterns that you can use: Columns or Layers. Columns are useful when you need a load of different items that is shoppable. The layer method is useful when you need to send mixed loads, but you need to be able to stack them for shipping.
In addition, you have two different methods of loading.

- **Single Palletization** is for building a single pallet display with as many of the packages in the load as possible.

- **Order Fulfillment** is for building loads to ship all the products requested in the load, regardless of how many pallets are required for the shipment.

In some situations, you might want to edit or modify a particular load, change the position of some of the cases or even add or delete certain items. For these situations, we have provided a series of load editors. There may be times when you might want to build a load with special requirements that fall outside the normal “column” or “layer” calculations. When optimization is less of a priority than specific requirements, you also have the option to build a load manually from scratch. To do this you can use one of the Display Pallet load editors.

### Optimization Type

This is where you decide on the type, or purpose, of your load. You have 2 options, both of which can be in either a layer or column configuration.
Single Pallet Optimization

Single Pallet Optimization will provide you with a variety of loads that will include some (or maybe all) of the products on the pallet. These loads are often used for Club Store Displays.

Order Fulfillment

This type of optimization is designed to transport products from point A to point B. The program will load all the items in your load list and use as many pallets as are required.

Algorithm Type/Parameters

These options let you decide more specifically what type of load you want and which algorithm or editor to use.

Column Algorithm

CAPE PACK will build loads with only columns of boxes. The program will not allow mixed columns of product unless Allow Mixed Columns is marked.

Layer Algorithm

CAPE PACK will build loads with layers of boxes, with the largest layer on the bottom of the load. When you select the Layer Algorithm, you will have access to 4 additional Layer Algorithm Restrictions at the bottom of the screen.

• Do Not Allow Mixed Top. This option will not allow the program to mix products on the top layer. When this is marked, the program will allow all layers to be mixed except the top layer.

• Do Not Allow Mixed Layers. This option will not allow any mixed layers in the load.

• Spread to Biggest Layer. This option will spread the upper level layers to the full footprint of the lowest layer on the load.

• Maximum Spread. This option will spread the bottom layer to the full size of the load including any overhang allowed.
Editors

There are three editors available to you for building your own loads from scratch. You can find more information about the editors in the Exploring the Pattern Editors chapter.

- Column Editor. Allows you to build loads with columns of boxes.
- Layer Editor. Allows you to build loads with layers of boxes.
- Mixed Load Editor. Allows you to build loads with some layers and some columns. This is hybrid type editor.

Packaging Loading Rules

These rules are established so that you can further enhance and define your loads based on specific restrictions.

No Loading Restrictions

CAPE PACK will build the loads the best way it can with the algorithm selected.

Limit Column Height

This option enables you to limit the number of packages in a column. Use the Max in Column field on the Edit Package Screen to define the maximum height of the column for each box type. This option is not available for the Layer Algorithm.
Load Priority

This option prevents heavy objects from being placed on lighter objects. Specify your loading priority in **Load Priority** field on the Edit Package screen. The lower the number, the lower in the load the box will be placed. The higher the number, the higher the box can be placed in the load.

Pallet Group Features

Designing Pallet Displays

Pallet Displays are a regular pallet base style that has a display case or tray secured to the top. This allows stores and discount clubs to use their pallet loads for customer shopping convenience, without having to unload the product from the pallet or case.

To create a Pallet Display:

Go to the **Make a new Shape** menu on the Pallet, Arrange, Design or KDF input screens and select **Make a new Pallet Display**.

The following screen will appear:
Enter **Pallet Display** as the description.

Select **48x40.pa4** from the pallet base style drop down list.

Select **TRAY2.CSF** as your Display Case.

For the Crate length, enter **48**.

For the Crate Width, enter **40**.

For the Crate Height, enter **50**.

For the Crate weight, enter **53**.

Now click on the **Save** button.
Enter a file name for the Display. These file names cannot exceed 8 characters.

Your pallet display has now been saved to the chosen file name. It is available to use from the Pallet Base Style list on the Pallet tab.

Multi-Dimensional Analysis
We have added the second page to Multi-Dimensional Analysis export results.

Rotate Layers
We have enhanced the rotate layers top to include the top view with dimensional labels.

Arrange Group Features

Quick Report for Multiple Pallets Enhanced
The quick report shows basic information about the loads you have calculated to help you select the best option. When using multiple pallets for your analysis, we have changed the product count from secondary packs to primary packs. This will allow you to quickly see which secondary package the program calculates for you and will give you the best pallet load yield.

Sort Common Secondary Pack Sizes by Primary Packs per Load
When using more than one pallet type, you can now sort your results by the number of primary packs per load. This gives you advantage of reviewing the best case sizes for moving your product through the supply chain.
The following screen opens.

![Screen shot of Common Secondary Pack Sizes]

And in the lower left corner, a sort feature has been added.

Which gives you these sorted results.
Lift Covers off Trays for Retail Ready Packaging

You can choose to treat your case like a tray and lift the full cover off in MultiViewer Graphics to display the contents inside. This is a Retail Ready Packaging option instead of Open Flaps. Access the feature from the pop up menu for the case.

Your results will look like this.
Blister Pack Enhancements

Formerly, blister packages had 2 limitations. First, they were only allowed to be packed height dimension vertical in the case. And second, if there was room to nest them they were always nested. Both of these limitations have been removed. Here are some examples.

Folding Carton Arrange

Case Cube Utilization

One of the new features added to this program is the ability to see the cube utilization of the case on your quick report as shown below.
Because this program uses a database of existing case sizes and styles, it is important to know how efficiently those cases are being used. In this case the first solution is 63.1% cube efficient. Here is the second solution.

Compare the two results. The first solution is 63.1% cube efficient. The second solution has increased the carton bundle by 5 units, however, the cube efficiency has decreased to 58.1%.

**Design Group Features**

**Calculate Solutions with Fixed Primary Pack Volume**

CAPE PACK has always given you the ability to modify your primary pack volume based on a percentage of change, or to keep that amount constant. We now offer you a third option to fix a specific volume.

To change your volume, click on the **Input** menu and **Vary Volume/Weight**.
The following screen will open.

Your three choices are:

Keep volume as it is now by setting your Vary Volume By setting at 0% as shown above.

Change your volume variance by entering a percentage of change.

Set your volume to a specific measurement as shown below.
Multi-Viewer Graphics Features

New Report Style

With this version of CAPE PACK, we are introducing a new standard report style called New Report Style. You will still have access to the Classic Report Style, but the default will be the new style. To change between the report styles, select the View menu in Multi-Viewer Graphics, Report Type and then your choice of style.

Here is the Page Setup screen for the New Report style. You will notice that there are several grayed out options. These do not apply to the New style. Explanations of the other options can be found in the next section, Classic report Style.
Here is an example of the **New Report Style**.

There are a number of standard windows formatting options available with this new report style. These can be found in the tool bar across the top.

**Print:** Allows you to print the report from Print Preview.

**Copy:** Allows you copy parts of the report that can be highlighted, or to copy the entire report.

**Search:** Allows you find text within the report.

**View Multiple Pages:** Lets you setup your report to view more than one page on the screen at a time.
Zoom: Standard Windows Zoom feature.

Paging: Standard Windows page advancing feature.

Compression Strength Program Enhancements

In this new version of CAPE PACK, you can now save your Compression Strength results to be printed along with your Graphical Solution report.

Run your compression strength program as normal.

When you click on Close, the program will prompt you about saving your data for your graphical solution report.

If you want to save the data for inclusion in your normal CAPE PACK report from the MultiViewer Graphics screen, mark that option. Then you can select if you want to print all boards or only the ones you selected. If you simply chose to print successful materials, that will be considered “selected” boards by the program.

If you choose to Print Selected boards, the following screen will appear when you click on Close.

Your CAPE PACK graphical solution report will include the Strength data on additional pages.
Preset Custom Reports

Your program will be installed with 7 custom reports ready to use. To see these reports, click on the File menu in Multi-Viewer graphics called Print Custom Report (Word).

To add additional report styles, select Add Template from the menu. The following window will open.
Click on the **Add** button to add templates, or highlight a template and click on the **Delete** button to remove it from the list.

You can also add your own custom report styles if you wish. When you add a template, a screen will appear to allow you to set your diagram export size, template type and diagram type. The diagram type must be consistent with the macro you are using, but it will normally be a JPEG file.

To print a template, click on the **File** menu, select **Print Custom Report (Word)** and then click on the template you want to print.

This action will cause the CAPE PACK to open Microsoft Word and your template file. It will then populate the data fields and graphics fields with information from your load file and print the document.

**Export Options Expanded**

We have added margin settings to enhance our export settings feature.
Exploring the Front Menu

Introduction

The Front Menu is the entry point of the program. It lets you choose where you want to go in the program.

It is also designed to provide easy access to certain functions that will affect the overall program (i.e. screen resolution settings) and let you connect to our web site, access the Packaging Information Database, convert old CAPE data files and help you navigate around CAPE PACK.

Screen Resolution or Scaling

Select the Resolutions menu option.

![Resolution Options](image)

You will see a list of resolutions that are available on your PC. Select one of these settings and your CAPE PACK program will change to that resolution. This means you have the choice to set either a full or partial screen setting for your PC.

Once you select one of the resolution settings the program will then set itself by resizing this Front Menu screen. Setting the resolution here means that all of your CAPE PACK screens will appear at that resolution. You can reset the screen resolution at any time, but only from the Front Menu.

Choosing which program to run

The Front Menu is where you can choose the group you need for your particular analysis.

You select your package type from the Type of Package list, then click on the Go button to launch that program.
If your program is not showing on the Front Menu, you can either launch it directly from the programs menu as shown below:

Or you can use the new Front Menu setup feature to rearrange how your program groups appear on your screen. Click on the Programs menu and Rearrange Program Groups.

The following screen will appear.
Select the groups you want to appear by clicking on the appropriate check mark in the Show Group column, then setup the order you prefer in the order column. Here is an example.

And the results would look like this.
Pallet Group has been replaced with Display Pallet, Arrange and Design Group has been replaced with FCA and Casefill has been replaced with the KDF Group. The program will remember these options as your default until you change them.

Design Group

If the Arrange/Design Group is active on your Front menu, you it by clicking on the Vary field under Arrange/Design Group, then select your package type and click on the Go button.

File Menu

Here is the File menu.

Open Input Data

This is a standard Windows Open function to open a selected input data file.

Click on Open Input Data and the following dialog box will appear.
Select the filename and click on **Open**. This will launch the program module that was used to create this file. The input screens will then appear with all of the appropriate data fields filled in.

In the event that your input data also contains saved solutions/graphics, you will be prompted with the following message.

If you click on **Yes** you will retrieve your saved graphics. If you click on **No** your input data will open.

**Open CIF**

This new feature of CAPE PACK allows you to open specially formatted text files called CAPE Interface Files (CIF). The open feature will work in the same manner as Open Input Data. The correct program group will open along with the input data. However, with CIF files, the calculation process can be made automatic. So when you open the file, the program will automatically calculate answers for your data.
You will see a file open box.

You select the file you wish to use and open it, the program will then load the program group, data and the next thing you will see is the Multi-Viewer Graphics screen with your solution.

Open Viewer/Open Saved Solutions

When you run a CAPE analysis, you have the option to save the on-screen graphics and to view them at a later date. This special option has been located at the Front Menu to make it easy for you to open the saved files.

Click on **Open Viewer/Open Saved Graphics**, select either cape pack or Display Pallet (Club-store), and then select **Solution Dialog**.
You will then see a Saved Solution Open Dialog box.

Only those files with Saved Solutions will appear in the list and their details are provided to help you locate the file you want.

Highlight the file containing your saved graphics and click on Select. Your graphics will then appear.

Alternatively, you can click on Open Viewer/Open Saved Graphics and select Standard Dialog.
The following dialog box appears, which lists all of your CLF files, not just those with saved solutions.

Settings

Select **Settings** from the **File** menu and you will have three choices.

- **Program Language**: You can choose between English, French, German, Spanish, Swedish or Italian as the language to run your program with.

Selecting any of these will change the language on the menus, buttons and reports. Here is an example of Spanish.

The addition of print languages previously available from the Front Menu is not available on the **File** menu of the Multi-Viewer Graphics screen.
More Settings selected from the Settings menu will display the following screen.

Choose any of these options if you wish to use them.

- **Enable Specifi Export**: if you have the Specifi program and would like an automatic interface to it.
- **Export Solution Information** adds the ability to export an ASCII file with information about a particular solution to the Export option in Print Preview.
- **Activate CIF** turns on or off the export to CIF file format.
- **Activate Flatblank** is designed to allow "flatblank" to appear in the Pack Type list in the Arrange Box/Bag/Bottle option. This feature allows a flat-blank case to be converted to folded case and then packed in bundles on the pallet.
- **Activate Accelerate Interface** turns on the menu option for exporting to Accelerate for Folding Cartons.
- **Desktop Refresh** works in conjunction with the new option for creating shortcuts to establish shortcuts on your desktop.
- **Transfer Help Files to my Local Drive** will make a copy of your program help files on your hard drive so the program can access them.
Open Network Administrator

A special program for managing and maintaining network installations.

Change Private Path

The CAPE PACK program sets a default path called Private for you to save the data and results of your analyses. This path defaults to a folder within the overall CAPE PACK directory. If you wish to change the location of your Private path, simply select this option and you will see the following screen:

Now click on the browse button (…) and select a new path. The CAPE PACK programs will recognize this new path and display it in any File Save or File Open dialog box.

Exit

Selecting this option will completely exit CAPE PACK and return you to Windows or to another program application you have open.

Programs Menu

The Programs menu is an alternative way to launch the program modules (Pallet, Arrange, Design, Casefill and KDF), or you can use it to select some of the other programs available in CAPE PACK (Strength, Display Pallet, etc.).

The Programs menu is also available, on the input screens, in the major program modules to allow you to switch from one program to another. This approach means that you do not have to return to the Front Menu each time you want to switch programs.
The **Wizard** option on this menu allows you to activate the automatic calculation (**Auto Calc**) feature of the program. If activated, when you click on any **Go** button, the program will load whatever default settings are current for the program and then automatically calculate solutions, taking you straight to Multi-Viewer Graphics. Your options are:

- **Use My Default Settings** which will load the data input screens as normal.
- **Auto Calc** which will take you straight to Multi-Viewer Graphics.

**Make a New Shape Menu**

The Make a New Shape menu is a group of programs that lets you create a specific shape of primary, secondary packages and pallet/container styles to be used in the Pallet, Arrange, Design, Casefill and Display Pallet modules. You can choose between Cases, Trays, Cylinders, Bags, Oval shapes, Rectangular or Square bottles and Gable-end cartons; or you can make pallet base styles, pallet crates, pallet blocks, pallet bins or containers/truck styles.

The Make a New Shape menu is also available on the input screens in the Pallet, Arrange, Design, Display Pallet, KDF and Casefill program modules.

**Databases Menu**

CAPE PACK has a powerful database feature called the Packaging Information Database. This special database allows you to save the information from any solution you create in the analysis modules.

By selecting the **Databases** menu and then **Packaging Information Database**, you will see the following screen.
From here you select the information you wish to review.

Resolutions Menu
The Resolutions menu is for switching between full-screen or partial screen versions of CAPE PACK.

Internet Menu
With the increasing use of the Internet and the need for people to keep up to date with program versions, news and “what’s new” with CAPE, we have added this new menu item. It provides you with easy access to our website and the many options. Just remember you will need to be on-line or be able to get on-line to use these features.

Here are the Internet menu options.

You can now email the Help Desk for technical support or help with your analysis.

Publisher Menu
This menu is for using the Web Page Publisher feature.

Help Menu
We provide extensive on-line Help with the CAPE PACK programs. Wherever you are in the programs the Help files are applicable only to that specific area. For example, when you are working on the input screens, the Help files relate to the input information only. When you get to the Multi-Viewer Graphics section of the program, the Help files relate to graphics, printing, exporting, etc.

Here are the options on the Help menu.
Contents

Allows you to see the contents of the Help file associated with the part of the program you are currently operating.

Search for Help on ....

Provides a detailed listing for you to select a subject:

Glossary

Generates a Help file with a listing and explanation of all the names and terms used in the CAPE PACK programs.

New Features in v2.13

Creates a standard Windows About screen.

About cape pack v2.13

Creates a standard Windows About screen.

Display CAPE License

Click on this option to display the CAPE PACK License screen. This way you can check the serial number of your program and make sure it is a legal version licensed to your company and your current location.
Pallet Group - Building Pallet Loads

Introduction

There are two types of analysis you can use in the program groups:

1. **Use My Default Settings** which load automatically whenever you start a program group or module.

2. **Start from a completely New data file.** Once the program group has loaded, you can select New from the File menu to “clear” the data input screen of all previous information. If you have identified a default pallet or truck style, this will appear with each new analysis.

Using your own Default Settings is by far the easiest way to create a new data file as the data fields are already filled out. All you have to do is modify them. Starting a New data file means you have to enter all the data.

Whether you launch the program from the pictorial sections on the Front Menu or from the **Programs** menus, the appropriate module will begin with Default Settings already loaded.

My Default Settings

This is simply your chosen default parameters for the module. Your program is supplied with preset Default Settings. These should be modified to suit your needs and then saved by click on **File, Save My Default Settings**. These settings are more or less a template or master set of information for the program. Because the program loads these Default Settings automatically, all you need to do is make necessary changes for the particular analysis, enter your product name and product code, and calculate your answers.

For example, if you loaded the Pallet Group for cases, all you might need to do is enter a new case size and weight and then calculate your answers. The pallet information and/or truck information would mostly likely remain the same.

Default Settings are also an easy way for you to see the type of information required by any of the CAPE PACK program modules. They offer an ideal way for you to work with the different program groups and familiarize yourself with the software and how it works. You can open the Default Settings, change the data and run an analysis. You can resave them, but you cannot create any additional templates.

The Basics

There are four basic steps to completing a CAPE PACK analysis.

- Start the program
- Create data
- Save data
- Share data

This section of the manual is designed to give you these basics of the program including data entry, calculating answers, customizing your graphics, and sharing information with others. This chapter will walk you through a sample analysis so you can become familiar with these steps. We will use the Pallet group and place cases on the pallet and into the truck. At the back of this chapter you will find a guide to getting results from the software depending on your needs, along with the documentation sources that can help you.
Start the Program

Launch CAPE PACK from your Windows desktop by double-clicking on the icon, or from the Windows Start, Programs menu.

Then, simply select the package type you need from the drop down lists on the Pallet, Arrange, Design or Casefill groups on the Front Menu. Then click on Go to launch that module.

Or if you have already run one program, you can select another program module from the Programs menu on any of the input screens.

Using either of these methods, the program will load with your Default Settings. You then just enter the data you need to change, choose a save option and then the program calculates and displays a range of solutions. You then evaluate the different solutions using the on-screen graphics and a number of text reports.

The on-screen graphics allow you manipulate the diagrams to suit your own requirements so that you can save those results, print them, or export them for use in another program application (i.e., packaging specifications, databases or Word documents).
Create Data

In this example, we will start with the Default Settings, but modify them slightly to help you get the feel of navigating through the program. Through the data entry process, you can move to the next data field by using the Tab key, or by clicking in the field with your mouse.

Input Settings

The first step in creating data is to outline the problem – to tell the program what type of analysis you want to run and what options you want to use. We do this with the Input Settings button. You will find this button on each of the input screens.

Click on the Input Settings button and you will see the following screen.

![Input Settings Screen](image)

This screen gives you all the options available for the Pallet Group programs. Some of them are grayed out (i.e., Recessed Objects Allowed) as they are not applicable to this type of analysis (i.e., cases). Mark the following items:

- **Enter OD's** – we will use the outside dimensions of our case for this sample.
- **Show Flap Indicator** – will automatically apply the longest dimension indicator to each case.
- **Alternate Layers** – will automatically alternate the layers of the load if possible.
- **1 x Pallet** – we can use up to 3 different pallet sizes, however for this example we will only use one.
- **Objects Onto Pallets Into Trucks** – we want to be able to load the pallets into the trucks after we have selected and formatted the pallet load.
- **in/lb** – we will not be using metric for this example.

Your screen should look like the following. Click on OK.
Some of this information can be changed “on the fly” with right-click mouse options. Experiment with the right-clicks in different parts of the program.

**Product Name/Product Code**

This button is for “labeling” your analysis. The Product Name and Product Code are the first lines of the report and should be descriptive in nature.

Click on **Product Name/Product Code**.
Enter in **Widget** for the **Product Name** and **062469** for the **Product Code**. Click on **OK**.

If you forget this step, the program will remind you when you calculate and give you the opportunity to enter the data at that time.

### Secondary Package or Case Data

Make sure you are on the tab labeled **Case**.

Choose **1: RSC (2,2,4)** from the **Pack Type** field. This is the type of shipping case you are using. It stands for Regular Slotted Container and the 2,2,4 represents the number of layers of corrugated material in each dimensions of the box – 2 in the length dimensions, 2 in the width and 4 in the height.

Choose **Case** from the **Pack Name** field. This is just a descriptive name for the secondary package. You can type in anything you wish in this space. Alternatively, you can build your own list of names by selecting **Pack Names** from the **Tools** menu.

For the outside dimensions, enter **15.25**, **13.25**, and **8.625** in the **Length**, **Width**, and **Height** fields respectively.

In the **Dimension Vertical on Pallet** field make sure only **Height** is marked. This indicates which direction the case is turned on the pallet.

Enter **13** in the **Gross Weight** field. This is the weight of the shipping case plus the widgets inside it. It is used in determining any weight restrictions of the load.

Enter **12** in the **Net Weight** field. This is the weight of the widgets only. You can access an ounce to decimal conversion feature by right clicking on the weight fields.

Your screen should now look like this.
Pallet Data

Click on the tab labeled **48x40**. This is where we will enter the pallet information. The default pallet style is the 48x40 GMA 4-way pallet, which is the pallet we want to use. However, the maximum load height and weight need to be adjusted. If your default pallet is not the **48x40**, please select this one from the drop down list.

Click on the **Max Height** field and enter **48**.

Hit the **Tab** key and enter **1500** for the **Max. Weight**.

You can also select the pallet patterns type you want to consider by clicking on the **Select Pallet Pattern Styles Screen** button.

We will use all of the pallet patterns, so click **OK**.

The **Partial Top Layer Permitted** option will continue to fill your pallet load space with cartons until the maximum load weight has been achieved.
Your screen will now look like this.

You have several other options on this screen. The **Additional Palletizing Input** button allows you to access filters that you can use to limit the results shown on your solution report.

- **No Pattern Gaps** option will eliminate unnecessary gaps from your pallet pattern.
- **Minimum Load Dimensions** will restrict your results to only the loads that are larger than the dimensions listed.
- **Min Area Efficiency** will restrict your results to only the loads that meet the minimum area percentage.
- **Load Target** allows you to filter your results to a specific load quantity.
- **Clampable Information** are the settings required when using clamp-type fork trucks.

**Truck Data**

Click on the tab labeled **53footer**. This is our default truck style and the type of truck we want to use to ship our pallet loads. The dimensions will be filled in for you. If you do not have a truck already selected, select the **40hicube** from the drop down list.

We need to fill in the maximum weight for the load. Enter in **45000** for the **Max. Weight**.

And last, we need to make sure that both **Simple** and **Complex** patterns are selected.
Partial top layers allows you to place additional pallet loads into your container to take advantage of any remaining weight allowance. You can choose to allow partial layers in the truck if you wish, but that will not be necessary for this load as the product is not that heavy.

Your screen should now look like the following.

Save Data

Now that you have entered all your data, we need to save the data and calculate the load. Your Default Settings will be maintained, but your data will be saved to filename of your choice. You will then be presented with a range of solutions, in the graphics portion of the program.

Click on the Save/Calc. button.

Enter in a file name and click on OK. Your results will appear in Multi-Viewer Graphics.
In this portion of the program, you can evaluate the different solutions, select a solution, and customize your results with screen, layer or object formatting. Then save the graphics for later use. You may also return to the data input area of the program to make changes to your input if your results are not what you need. For example, maybe the pallet pattern you see is not efficient. You might want to add a little overhang to see if you can improve the results.

Selecting the Preferred Load

The solution that the program designates as number 1 (the best) is the solution with the most cases per load, with the simplest pallet pattern. You may have 6 different solutions with 9 cases per layer, but the simplest pattern will appear first in the list. In this case, the first solution is a column pattern. Let’s review the other solutions. There are 2 ways to look at different solutions.

You can click on the Solution Report button on the right side of the screen.

This list gives you a plan (top) view of the pattern footprint.

If you would rather see a more traditional listing, click on the Solution Report button on this screen. The following list will appear.

This gives you a break down of key information on the different pallet patterns the program found. Double-clicking on any one of these lines will bring that solution data forward to the Multi-Viewer Graphics.

The other way is to use the arrows at the top of the screen in the tool bar. The arrow that points to the right will scroll up one solution and the arrow pointing to the left will scroll down.

Move up a solution or two and then back down to solution number 2. Although this is not the best solution, it does have the alternated layers that we requested during data input.
Formatting the Screen

CAPE PACK gives you the ability to customize the graphics on the screen to meet your needs. The first thing we can change is the number of pictures that appear on the screen and will print with your report. You can have up to 4 different pictures.

Click on the **Set-up Buttons** button to activate your formatting controls.

Click on the **Format Screen** button and the following screen appears.
We want to see a picture of the pallet load, a picture of the truck and a picture of the box itself. So click on the button labeled 3. The screen returns with 3 panels available.

Formatting the Load

The next thing we want to do is format the pallet load itself.

Click on the picture of the pallet load to make sure that the fine black border is around that picture.

Then click on the **Format Load** button. The following screen appears.
In this screen you can alternate layers, add horizontal corner posts (H.C.), top caps, layer pads, layer trays, corner posts, straps, or a top board, or spread the boxes on the load. For this analysis, we will add horizontal corner posts, a top board and straps.

Layer one is the bottom layer, the layer sitting on the pallet.

Horizontal Corner Posts

Select **Add/Remove Horizontal Corner Posts** from the drop down list and new controls appear.

Select **Yes** for both the *Show Top HCP* and *Show Bottom HCP* selectors.

For the *Weight, Thickness* and *Width*, select **200 B Flute**. You can also type in whatever values you wish in these three fields.

For the *Length (%)* field, change the value to **80**.

Click on **Add HCP**.
Top Board

Select **Add/Remove Top Board** from the drop down list and new controls appear.

Select **200 B Flute** from the list for the Weight.

Click on the **Change Color** button and select a shade for your top board.

Click on **Accept Values** to add the top board.
Straps

You can add straps to the length and width of the load, either including the pallet or not.

Select **Add/Remove Vertical Straps** from the drop down list and new controls appear.

From the drop down lists, select 3 straps **Across Length** and 2 straps **Across Width**.

For the **Width of Straps (%)**, enter 5 and check the **Excludes Pallet Base** field.

Select **Change Color** and pick a color for your straps.

Click on **Add Straps** and your screen will look like this.
You can add up to 4 straps in both the length and width dimension, and you can also add horizontal straps using the same method.

Click **OK** to exit back to the Multi-Viewer with your changes.
Filling the Truck

Next we want to fill the truck with the pallet load you have chosen. It is important to do your Load formatting first because the dimensional data can change when you format your load, and you want these changes to be reflected in your truck.

In order to create a truck diagram, you need to start with a pallet diagram. Click on the picture of the top view of the pallet (panel 2).

Next click on the Truck menu and Show My Truck. You can also access this feature under the Tools menu, Truck Analysis.

The Truck Analysis Solution Report will appear.
This solution report will show up to 40 different truck loads. You can select any load you wish, or you can change your truck restrictions by clicking on File, Change Truck Restrictions.

The following screen will appear.

For this sample, we will just use solution number 1.
Click on the **File** menu and then **Save Current Load and Exit**. This will take the truck load back to the Multi-Viewer.

### Formatting the Panel

The next step is to place the right pictures in the right panels. Use the Format Panel controls to select the diagrams and their views for each panel.

To demonstrate, click on the picture of the pallet plus 1 layer of product.

Click on the drop down list under **Diagram Type** to select **Case (#1)**. The case will appear in the panel.

Use the drop down list under **Diagram View** and select **Default View**.

You can also use right-click options to select the view you prefer. To use these options, activate the diagram you want to change and then right-click on that diagram.
Formatting Objects

The last thing we need to do to set up our diagrams is to format the objects of the load. For this example, we are going to open the flaps of the case.

Click on the picture of the case in panel 3.

Click on the **Format Object** button.

Click on **Open Flaps**.
Save Data

Once your diagrams have been set up the way you want them, remember to save your solutions. This way you can recall them later from the Front Menu without having to recalculate them. Just click on File, Save Solution.

Share Data

CAPE PACK gives you more ways than ever before to share your data with colleagues, vendors, customers, and prospects. It is equipped with a full range of printing, exporting, web page, and email capabilities to meet your needs. Following is a brief overview of these options.

Printing

You have the ability to print standard CAPE PACK reports in addition to specially designed Custom Reports. We provide a variety of different template styles for your use, or you can contact us for assistance if you need a special template or specification design. This feature uses Microsoft Word and a Visual Basic macro to transport the data and diagrams from CAPE into an industry-standard word processing program. What this feature provides is an easy way to customize your CAPE PACK reports to suit your individual needs.

You can also print to both color or black and white printers, or to the Adobe PDF format if that feature is installed on your computer.

Emailing

CAPE PACK gives you the ability to email your results directly from the program to anyone you choose. The program will automatically attach a JPG or PDF file with your CAPE standard report. You simply add your recipient’s address, subject line and any other information you need to include. CAPE PACK does the rest.
Exporting

CAPE PACK gives you the option to export diagrams in a variety of graphics formats, as well as ASCII text to be used in Specs programs, documentation management systems or to integrate with other systems. We even include a Robotics interface for use in programming palletizing robots.

Web Page Publisher

This CAPE PACK feature quickly and easily creates catalogs of your palletizing specs that can be deployed to any Internet or intranet location you choose. The catalogs are backed up by XML statistical data that can be integrated with other web-based cataloging systems.

Packaging Solutions

Now you know the very basics of the software. What next? The following list should help you determine where you need to go within the software to solve your specific packaging challenges. For more information, please refer to the documentation folder included on your Application CD, the Help menu in the program, or contact your nearest CAPE office for assistance.

<table>
<thead>
<tr>
<th>If you want to….</th>
<th>Then use the following Group</th>
<th>Documentation Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place cylinders or drums on a pallet</td>
<td>Pallet Group – Cylinder/Bottles</td>
<td>Pallet Group, Other Pallet Group</td>
</tr>
<tr>
<td>Features</td>
<td>Place Bags on slip sheets into trucks</td>
<td>Place Cases into Pallet Bins</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td>Pallet Group – Bags</td>
<td>Pallet Group – Cases/Trays/Ovals</td>
</tr>
<tr>
<td></td>
<td>Pallet Group, Other Pallet Group Features</td>
<td>Pallet Group, Other Pallet Group Features</td>
</tr>
</tbody>
</table>

You will find sample analyses for the Arrange, Design, Casefill, Display Pallet and KDF Groups following this tutorial.

**Pallet Group Data Input Features**

**Right Clicking Options in Data Entry**

Right-clicking with your mouse on any of the data entry screens will bring up the following pop menu.
You can change any of these options by clicking on the new choice.

**Using Multiple Pallet Types**

Select **Input Settings** from the **Input** menu, or use the **Input Settings** button, or the right-clicking option.

Click on the **2 x Pallet** option. You screen should now look like this.

Click on **OK**.
Notice how the tab marked **Pallet 2** has become active.

Click on the **Pallet 2** tab.

Select the **Euro1.pa4 1200 x 800** pallet style from the drop down list. Enter the **Max Height** as 50 inches and the **Max Weight** as 2000 lb. Your screen should now look like this.

Now select **Save Input Data and Calculate** from the **File** menu or use the Save icon, or the **Save/Calc.** button. The Multi-Viewer Graphics screen will appear.
On the left side of the screen (larger picture) is Pallet load #1 and on the other side (smaller picture) is Pallet Load #2. Basic information for both loads is shown in the Quick Report area.

You can also click on the Summary Report button to see a combined report, or you can click on either Pallet Load and then click on the Solution Report button.

Here is the Summary Report.

Here is the Solution Report for Pallet Load #1.
Activate Panel 2 in the Multi-Viewer and click on the **Solution Report** button to see the report for Pallet Load #2.

<table>
<thead>
<tr>
<th>Sol. No.</th>
<th>Type</th>
<th># Per Layer</th>
<th>$#$ of Layers</th>
<th>D</th>
<th>V</th>
<th>Cube</th>
<th>Area</th>
<th>Length Under</th>
<th>Length Over</th>
<th>Width Under</th>
<th>Width Over</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I</td>
<td>4</td>
<td>4</td>
<td>H</td>
<td>89.9</td>
<td>100.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>2.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>T</td>
<td>38</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>2.00</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>4.00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>2.00</td>
<td>0.00</td>
<td>2.00</td>
<td>4.00</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>2.00</td>
<td>0.00</td>
<td>4.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>2.00</td>
<td>0.00</td>
<td>0.00</td>
<td>4.00</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>S</td>
<td>36</td>
<td>9</td>
<td>H</td>
<td>80.9</td>
<td>90.0</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

When you click on **Set-up Buttons**, the **Diagram Type** options under Format Panel show the number for each individual Pallet Load.
You must click on the pallet load you want to work before you can use the normal program features. Once you have selected a pallet load, everything will operate for that load in the normal way. Just remember that each pallet load will be numbered appropriately (Pallet Load #1, Pallet Load #2, etc.).

You can work with a maximum of three different pallet sizes at one time.

**Floor Loading into Containers**

You can use the multiple pallet feature to consider a pallet load compared to floor (or bed) loading.

To activate this feature, click on **Input, Input Settings**, and then click on the field labeled **Enable Floor Loading** in the **Analysis Type** section.

Click on **OK**, and you will see that the pallet tabs have changed.
On each of the pallet tabs, you will have an additional list to choose from. You may select either a Pallet Base Style or a Truck Base Style on each of the tabs. Here is an example of a case run both as a pallet load and floor loaded into a truck.

Here is a comparison of the pallet loads loaded into a truck, with the same case floor loaded.
Changing Package Color

Click on the panel with a case or primary pack. Now select the Colors menu and then choose Change Package Color. You will be presented with the Windows color palette.

Now select the color you want and click on OK. The package will change to your chosen color.

You can return to the original red, white and blue color by selecting Change to Original Colors from the Colors menu.

Custom Colors for Package

Select the Colors menu and choose Set Custom Colors.
Each panel has a letter (A-F). Select a panel letter and click on **OK**. The Windows Color Palette appears.

Select a color and click on **OK**.

Change as many panel colors as you wish, then click on **OK**. Your package will appear with all the selected colors displayed.
You can return to the original red, white and blue color by selecting **Change to Original Colors** from the **Colors** menu.

### Adding Graphics to Packages

Yes, CAPE PACK has the unique ability to add surface graphics to your packaging components (primary and secondary packs). Normally you would need to create the special 3D Image files to use this feature. However, your program is supplied with three 3DI files for you to experiment with.

Click on the panel with the case in it. Select the **Add Graphics** menu and then select **Add 3D Graphics**. The following screen will appear.

Click on **Case.3DI**. The case will then appear with graphics images on all six of its sides.
Now click on **OK** and the case with the images will appear in the picture window on the Multi-Viewer Graphics screen.

If you do not want to use these images, you can select **Remove Graphics** from the **Add Graphics** menu.

**Primary Packages in your Shipper**

You can show contents of your cases or trays by using the **Fill Wizard** option on the first input screen in Pallet Group – Cases/Trays/Ovals. This powerful feature unique to CAPE PACK allows you to put the actual contents (products) inside the fixed size case/tray you specify. Great for communicating results with colleagues and customers!

Select the **Fill Wizard** menu and choose **Define/Review Arrangement**.
Or you can use the right-click option.

You will see the following screen.

Select a pack type from the Pack Type list box. (i.e., select Cylinder, or a shape you created in the Make a new Shape feature.)
Now enter the arrangement of the cylinders as they might be in the “real world.” We will use an arrangement of $4 \times 4 \times 2$.

Dividers can be added if necessary.
You can also change pack colors and add 3D Images via the **Add Graphics** menu.

Select **Close**. You will then be returned to the normal input screen and your case will reappear. The contents are inside the case, but will not be displayed.

You will not see the jars again until you reach the Multi-Viewer Graphics after the program has calculated the results.

This report shows the pallet load, the top view of the pallet, the case and our jars. You can then use the **Format Object** feature to display the contents of the case.
Ounce to Pound Conversion Feature

Right-clicking on the weight fields in data entry brings up the following conversion chart.

Make your selection from the list and the weight field is updated automatically.

Zero Package Weights

CAPE PACK allows you to enter a zero (0) for package weights. Entering a zero will affect the overall load information.

Using Trays as Secondary Packages

As an alternative to using a case or a normal, straight-sided tray, the program is also supplied with a range of Variable Trays Styles. Here is an example where TRAY6 has been selected.
Notice how a "spin wheel" appears below the Secondary Pack Type list box. Click on this spin wheel or enter the height of the tray you require. The height of the tray can be less than or equal to the height you specify for the secondary pack dimensions.

Here is an example of a tray using the Fill Wizard option.
Special Secondary Pack Types

No Package

This package type allows you to palletize your product/primary pack without any outer packaging. Here is an example of the same bottle analysis but with the No Package type.

None

This package type provides a similar opportunity. However, it puts a “skin” on the items on a pallet. This is because, under some circumstances, selecting No Package might not let you clearly differentiate the individual items on the pallet load. Here is the same example, but using the package type None.
If you choose **None** or **No Package** you will not be able edit your pallet pattern with the Layer Editor.

**Shrink Wrap**

Select **Shrink Wrap** from the *Pack Type* list box. Here are wine bottles just shrink-wrapped on the pallet.
HSC (Half Slotted Container)

Select **HSC (2,2,2)** from the *Pack Type* list box. Here are wine bottles just shrink-wrapped on the pallet.

Palletizing Cylinders or Drums

When dealing with cylinders on pallets there is an extra feature that allows you to vary the diameter, height, volume and weight. This is called **Vary Cylinder Size** and is found under the *Input Settings* screen on the *Input* menu.

To vary the dimensions and weight you need to select the *Input* menu and then choose *Input Settings*. 
Click on OK and the input screen will then appear with these extra fields. If you do choose to vary the dimensions, volume or weight you will not be able to use the Recessed Objects Allowed feature. The program, in this mode, only works with solid objects.

**Recessed Objects**

When you recess cylindrical or trapezoidal objects, the Recess Factor is the amount one object sits inside another.

Select Input Settings and highlight Recessed Objects Allowed.
Click on OK and the cylinder input screen appears with one extra field. In the Recess Factor field, you enter the amount of recess of the top cylinder into the next one down in the stack.

In order to recess cylinders, the top and bottom must have different diameters.

**Interlocking Pallet Layers**

Select the **Alternate Layers** on the **Input Settings** screen. When the program calculates, it will display the layers already alternated/interlocked.
Secondary Package Database

This feature is accessed under the Databases menu.

See the CAPE PACK Databases chapter for more information.

Converting Product Volume to Net Weight

There is a special Volume-to-Net-Weight Conversion... feature on the Tools menu at input.

When selected, the following screen appears.

Enter a Volume (in cubic feet or liters) and a Bulk Density and click on the Calculate button. The net weight will be displayed.
Click on **OK** and the net weight will be automatically entered into the *Net Weight* field.

**Printing Input Data**

Use the **Print** or **Print Preview** options under the **File** menu at any input screen.

**Overhang and Underhang**

For overhang use an ordinary number such as .5” or 1”. For underhang put a minus sign in front of the number. Here is an example with 1” of overhang entered.

Please be aware that if you enter 1 inch overhang for the length or width, then the program will add up to 1 inch to each side of the length or width (i.e., a total of up to 2 inches).

**Calculating the Maximum Load Height**

First, make sure you filled out the Secondary Pack tab and that you have selected your Pallet Base Style.
Then select the **Pre-Calculate Max. Load Height** feature from the **Tools** menu when any of the pallet tabs are active.

![Tools menu](image)

The following screen appears.

![Max Height Calculation](image)

Simply enter the number of layers you want on the pallet and the program will calculate the load height including the pallet base height, and then automatically enter it into the **Maximum Load Height** field for you.

**Using Master Pallets**

Enter the secondary pack input and pallet restrictions as normal, **but choose the half pallet on the Pallet 1 tab.**
Now go the **Input** menu and choose the **Select Master Pallet Base** option.

The following window will appear.

Drop down the list box and select the pallet base style you want to use as a master pallet.

Enter in any overhang or underhang you need to consider, along with a maximum Master Pallet Load weight.
Click on OK.

Now select the **File** menu and the **Save Input Data and Calculate** option. Next you will see the Multi-Viewer Graphics screen displaying the cases on the quarter pallet.

Now select the **Tools** menu and the **Fill Master Pallet Base** option. You will see the following screen.
Select the **File** menu and **Save Current Load and Exit**.

You will see the two half pallets loaded onto the 48x40 US GMA pallet.

**Customizing your Pallet Style List**

This feature allows you to choose which pallet styles you want to appear on your list. You can also sort the list in alphanumeric order.
To access this feature, click on the Pallet Base Style Directory button or on the Tools menu and then Pallet Base Style Directory...

The following screen appears.

To activate a pallet style, click on the Include in List field for that pallet. A red arrow will appear.

To deactivate a pallet style, click on the red arrow in the Include in List field.

To sort the pallets, click on the drop down list for Sort Pallets by. Select one of the 4 methods to sort by: name, description, size or weight. When you make your selection, the pallets will resort.

To search for a pallet, click on the Find Pallet button.
Select the criteria you want to use to sort by, then enter the information required and click on Go.

To view a top down view of the pallet configuration, click on the Show Thumbnails button. You can scroll through the pallets in the same sort order, but with a picture of each pallet.

Click on OK to exit the Pallet Base Style Directory utility.

**Setting a Default Pallet**

This feature allows you to select a default pallet base style for all new analyses. This is the pallet that will automatically appear as your base style selection when you start a new problem. You can overwrite this default simply by selecting another pallet from the list.

To select your default pallet, click on the Tools menu, Set Default Pallet Base Styles and then choose Pallet 1, 2 or 3. The following screen will appear.
Click on the pallet in the list that you wish to use as your default, and then click on the Set Default button.

Customizing Your Truck Style List

This feature allows you to choose which truck styles you want to appear on your list. You can also sort the list in alphanumeric order.

To access this feature, click on Truck Style Directory button or the Tools menu and then Setup Truck Base Style Directory...

To activate a truck style, click on the Include in List field for that pallet. A red arrow will appear.

To deactivate a truck style, click on the red arrow in the Include in List field.

To sort the trucks, click on the drop down list for Sort Pallets by. Select one of the 4 methods to sort by: name, description, size or weight. When you make your selection, the trucks will resort.
To search for a truck, click on the **Find Trucks** button.

![Find Trucks](image)

Select the criteria you want to use to sort by, then enter the information required and click on **Go**.

To view a top down view of the truck configuration, click on the **Show Thumbnails** button. You can scroll through the trucks in the same sort order, but with a picture of each truck.

Click on **OK** to exit the Truck Base Style Directory utility.

### Setting a Default Truck

This feature allows you to select a default truck style for all new analyses. This is the truck that will automatically appear as your base style selection when you start a new problem. You can overwrite this default simply by selecting another truck from the list.

To select your default truck, click on the **Tools** menu, **Set Default Truck base Style**. The following screen will appear.

![Set Default Truck Styles](image)

Click on the truck in the list that you wish to use as your default, and then click on the **Set Default** button.

---

### Pallet Group Multi-Viewer Graphics Features

### Exporting to the Packaging Information Database (PID)

Select the **Databases** menu item and click on the **Packaging Information Database (PID), Export Current Solution to PID** option. This will save your solution information to PID.

Please refer to the CAPE PACK Databases chapter for more information on this feature.
Packaging Report

Click on the **Pack Report** button to generate the Packaging Report. The Packaging Report is a comprehensive, detailed report that lists all of the dimensions and statistics for your solution. It also includes information such as nesting angles (for cylinders), flat blank area (for cases) and the cubic feet measurements for your case and load.

![Packaging Report image]

Reviewing Objects in the Load

There is a special feature in Multi-Viewer Graphics that allows you to scroll through all of the levels, from individual primary pack right through to the truck.

Click on the **View** menu and select **Review Function**.

![Review Function image]

The following screen will appear.
Use the black **Up** and **Down** arrow heads to cycle through all the packs and methods of packing.

You can also print and export individual packaging components using this feature by selecting the appropriate buttons or menu options.

**Multi-Dimensional Loading**

You can use the **Multi-Dimensional Analysis** (MDA) feature located under the **Tools** menu to build loads of product with different dimensions vertical to the pallet base.
To run **MDA**, you must allow more than one case dimension vertical to the pallet during input. Let's take our Widget example where all 3 case dimensions have been allowed vertical to the pallet.

Choose **Save Input Data and Calculate**. The next thing you will see is the normal Multi-Viewer Graphics screen.

From the **Tools** menu, select **Multi-Dimensional Analysis**.

Having selected the **MDA** option the program will calculate any loads with layers with different dimensions vertical mixed together.
Notice how the load has 54 cases instead of 50 when just the height dimension could be vertical.

You can set where each layer should be and even change the mixture of layers. Here is the load with some other patterns selected.

To use this feature, select the patterns from one of the three tables and click on **Default Calc**.

You can also reset the layers in any order you choose.
Multi-Dimensional Analysis can only be used when you are working with a single pallet size. It is not available if you choose two or three pallet sizes.

Pallet Maximizer

Maximizer is a type of palletizing program that offers an alternative way to load pallets, cases or trucks with a single size product. It offers a very powerful way to optimize any loading space. The normal Pallet Group of programs builds efficient layers and then calculates how many layers high can be built on the pallet using one dimension vertical.

Maximizer looks and works just as the normal pallet programs. The only difference is that it creates more complex loads and often achieves the “soldiering” effect. So, entering your data, choosing a save option and getting to the graphics is a simple task. Pallet Maximizer takes a very different approach and builds loads with any dimension vertical even on the same layer.

Once the load has been calculated, select the **Tools** menu and **Maximizer**. Your options will be calculated.

You can scroll through the solution report to find the best option for you.

Here’s another example.
Simply select the load you want to use and then click on **File** and **Save Current Load and Exit**. Your solution will appear in the Multi-Viewer Graphics screen, along with any other pallet load solutions you have.

The program has calculated a variety of solutions. It is now displaying the graphics for the solution with the simplest pattern and the maximum amount of secondary packages per load.
All of the menus and functions in the Multi-Viewer Graphics except for layer formatting operate in the same way as they do in the normal Pallet Group programs. The Layer Editor is not available in Maximizer, and the Format Load option is grayed out.

Changing the Product Name and Product Code in graphics

This option is for those users who may have several products using the same case size. Thus, they do not have to run several Pallet Loading analyses just to change the Product Name and Product Code.

Use this feature to change the Product Name and Product Code information. You can then save the load along with all the associated graphics and reports to another file name. The feature is also available under Opening Saved Graphics Files (File menu at the Front Menu).

Select Review Product Name/Code from the View menu.

You will be presented with a window showing any existing Product Name and Product Code information.

Change this information as appropriate and click on OK.
Changing the Number of Decimal Places in Graphics

You can change them during data input for the Primary Pack Input screen, the Bundle Wizard and for the graphics, in the Multi-Viewer. You cannot change the decimal places for the fields on the input screens. These changes only affect the graphics screens and printing. They do not affect any information you want to export.

To change the number of decimal places in graphics around each object you can use the **Set Decimal Places (Dim Labels)** option under the **View** menu.

The following input screen appears.

```
Enter number of decimal places you require (say 2) and click on **OK**.
```

Changing Content of Dimension Labels

You can choose what information you want to have shown as your dimension labels around your diagrams in Multi-Viewer Graphics. Your choices are:
**Load:** Includes the largest dimension of the pallet or truck load.

**Product:** Includes the dimensions of the product on the pallet, not including the pallet itself.

**Product Load Height:** Includes the footprint (length and width) of the product on the pallet, but the load height including the pallet.

**Dimension Labels and Outside or Inside Dimensions**

You can choose whether to show your case dimension labels on your screen as either inside or outside dimensions. From the **View** menu, select **Set Secondary Pack Dimension Labels to**, and then choose either **OD** or **ID**.
Review Product Quantity

You can choose to add an inner package (primary package) count to your analysis whether or not you have used the Fill Wizard. From the View menu select **Review Product Quantity**.

The following screen will appear. Enter your inner package name and the quantity per case or shipper.
Click **OK** and then click on **File, Print Preview** to see the results.

**Dimension Labels**

You can choose not to show dimension labels on your printed reports and exported diagrams and reports. Click on the **View** menu, and **Show Dimension Labels** and then choose the option you prefer.
Rotate Layers 90 degrees

When using a square pallet, you can use this option to rotate the entire load 90 degrees on the pallet.

Editing your Layer Pattern

Use the Layer Editor option under the Edit menu in Multi-Viewer Graphics.
Please see the Exploring the CAPE PACK Editors for detailed instructions on how to use the Layer Editor.

Rotating Objects

You can click on the Rotation button and choose an angle at which you want the object to be drawn. For example, in order to rotate the pallet load make sure the panel with the pallet load is active and click on Rotation. Then select 0, 90, 180 or 270 degrees. We have selected 180 degrees.
Notice how the pallet has now changed to show the 180-degree view.

When you have finished setting the rotation, click on either one of the two **Format Panel** buttons.

**Displaying the Case Front around the Pallet**

Use the **Show Panel B around the Pallet** option under the **View** menu.

Panel B (relating to the Adding Graphics/3D Imaging) is defined as the “front panel” on any case or tray.
Show Contents

This removes three sides of the secondary pack to show the contents inside.

Click on the **Format Object** button and then **Show Content**.

![Show Contents](image)

Open Flaps

This options opens the top flaps of case to show the contents inside.

Click on the **Format Object** button and then **Open Flaps**.

![Open Flaps](image)
Exporting from Print Preview

Using the **Export** button you can export a variety of graphics file formats to a directory/destination of your choice.
Right Clicking Options in Multi-Viewer Graphics

Right-clicking with your mouse in the Multi-Viewer Graphics screens brings up different options depending on what objects are active. Here is the menu for pallet loads.

Here is the menu for secondary packages.

Here is the menu for truck loads.
Arrange Group – Creating New Case Sizes

Introduction

The programs in the Arrange Group are designed to help maximize the number of fixed size primary packages loaded on a pallet. The program will arrange a number of primary packages together and then calculate a new case, which is, in turn, palletized.

The primary package cannot vary in size, but it can be a box, bag, bottle, cylinder, oval, blister pack or trapezoid.

You need to specify the shape and size of the primary package, whether you want the product inside the primary package, how many you want in an arrangement, and if necessary, how the primary package should be bundled in groups within the arrangement. You will need to provide some details about the type of secondary package you want to use, and you will have to specify the pallet and/or truck information.

Running an analysis for each type of object is basically the same, but the data for the primary package will be different. This tutorial will take you through an analysis for a carton.

The Problem

The following example deals with a widget in a carton and there are currently 24 cartons per case. This existing case size does not palletize as well as you would like.

You already know that for this particular case size you cannot produce a more efficient load without changing the loading restrictions. As this is not possible, you realize that your only option is to change the size of the case. Before you can even think of changing the case size you need to gather some information. You go to the marketing, production, warehouse and logistics departments and ask some more questions.

• stores prefer a case count of 24, although they will accept 20 per case.
• the stores to which you ship the cartons give you space for up to four facings on the shelf.
• the maximum case size that can fit through the automatic case loaders is 36 x 36 x 36 inches.
• the minimum case size that can slide over the rollers without getting stuck is 8 x 8 x 3 inches.
• you know the size and weight of each individual carton.

You know from previous experience that:

• your company wants to use the 48x40 US GMA standard pallet size.
• fork trucks can lift a maximum of 2000 pounds.
• the maximum stack height is 50 inches.
• the type of board and the material thickness being used for the shipping case is already established.
• the type of shipping case is already established.
• the product can only be loaded with the height dimension vertical to the pallet.
• trucks cannot exceed the 80,000 pound weight limit.
• your company uses a standard 40 foot truck for shipping.

You want CAPE PACK to calculate a new case size based on 24 or 20 cartons per case. Therefore you decide to run the **Arrange Group** using the **Cartons/Bags/Ovals** program.

Make sure that the **Fixed** option is marked. This will load the Arrange program instead of Design.

From the first drop down **Type of Package** list in the Arrange Group section, choose **Carton**. This is the type of primary package (inner package) we will be using.

From the second drop down **Type of Package** list choose **Case**. This is the type of secondary package (shipper) we will be using.

Select **Yes** under both the Pallet and Truck sections.

Then click on the **Go** button.

Or, click on the **Programs** menu, and then select the **Arrange Group**. Now click on **Cartons/Bags/Ovals**. The first Arrange Group input screen appears with your Default Settings already filled out.
Notice how the tabs are similar to the Pallet Group. The difference is that you know the carton size and pallet restrictions, but a new case size has to be created.

Data Input
The first thing that we need to do is establish the parameters for the program. We do that with Input Settings.

Input Settings
Click on the Input Settings button, or you can use the Input menu, choose Input Settings, or the right-click options to activate this option.

The following screen appears.
Make sure the following items have a check mark next to them.

- **Enter OD’s** as we will be using outside dimensions of the carton (primary package) for this analysis.
- **Glue Flap Allowed** so we can enter information about the glue flap of the secondary package.
- **Alternate Layers** so that the software will automatically alternate layers of the pallet load.
- **8 x Single Count** rather than **Min/Max Count** because we want to define the number of packages allowed in the case.
- **1 x Pallet**
- **Objects onto Pallet into Truck**
- **in/lb**
- **Column** patterns. Setting the Arrangement Pattern for an Interlock arrangement is explained in the chapter *Arrange Group Features*.

Your Input Settings screen should now look like this.
You can change these options any time you wish by repeating the last two steps. Click on OK to return to data input.

### Product Name and Product Code

Click on the **Product Name/Product Code** button. The following screen appears.

Enter **Widget 1** in the **Product Name** field.

Enter **062469a** in the **Product Code** field.

Click on **OK**.

### Carton Information

You know the size and weight of the carton. You are looking for 20 or 24 cartons per case.

Make sure you are on the tab marked **Carton**.

Choose **REV Tuck (3,2,4)** from the **Primary Pack Type** field. This is the type of box (reverse tuck carton) in which the widget is placed.

Choose **Carton** from the **Primary Pack Name** field. This is just a descriptive label for the primary package. You could type in **Widget** or whatever name you want.
Enter 4, 2.5 and 5.75 in the Length, Width, and Height fields respectively for the Outside Dimensions field. Length must always be greater than width.

Choose Height in the dimensions allowed vertical in secondary pack.

Enter 0.5 in the Gross Weight field. This is the weight of the widget and the carton in which it is placed. If you wanted to enter ounces here instead of pounds, you could right click on the weight fields and bring up a selection menu.

Enter 0.4 in the Net Weight field. This is the weight of the powder itself. Your screen should now look like this.

Case Information

Click on the tab labeled Case.
The information on this tab is used to outline the type of case that the program will design for you. You enter in the package type and board that you want to use, the counts of primary packages that you can accept, and if necessary, the minimum and maximum case dimensions. From this information, the program will arrange your packages into new case sizes and display your options.

Using the information we had gathered earlier, we will fill in this tab.

Choose **RSC (2,2,4)** from the *Secondary Pack Type* field. This is the regular slotted container you are using. The 2, 2, 4, represents the number of material thicknesses in the length, width and height of the case. This case type is the most widely used of the standard case types in CAPE PACK.

Choose **Case** from the *Secondary Pack Name* field. This is a descriptive name for the shipping case or secondary pack.

Choose **125 C-flute .153** from the *Thickness* field. This is the thickness of the secondary package material. The lb/msf field should fill in automatically. If it doesn’t, enter **80** in this field.

Details of the size of the glue flap are an optional item that we selected on the Input Options screen. *Glue Flap* refers to the length of the glue flap for your shipping case. Enter **1.25** inches for the Glue Flap.

We will not use a partition type so leave that field as it appears.

In the *Carton per Case* field enter **20** in the first box and **24** in the second. These are the total numbers of primary packages you want within the shipping case. It is not the number of bundles.

Enter **50** in the *Maximum Weight* field. The new case cannot weigh more than this amount. Your screen should now look like this.
CAPE PACK also allows you to set up defaults for case restrictions. These are handled using the **Case Settings** button.

Click on the **Case Settings** button and the following screen appears.

Enter the following information concerning the new case the program will calculate for you.

- **Minimum Dimensions** are an optional input. The program does not require this information to calculate the results. However, it does provide an extra filter to remove any potential case sizes that would be smaller than the specified minimum. In our example, you should enter **8, 8 and 3** in the **Length**, **Width**, and **Height** fields respectively. The new case size cannot be smaller than these dimensions.

- For **Maximum Dimensions**, **36, 36** and **15** in the **Length**, **Width**, and **Height** fields respectively. The new case size will not be larger than these dimensions.

- **Bulge** is an optional input that will not be used for this analysis. Leave these fields set at **0**.

- **Slack in I.D.** is another optional input. Slack is the amount added to each overall dimension of the case to allow extra room within the case for hands or machinery packing the contents into the case. Enter **.125** in each of the slack fields.
• Make sure the **Height** box is marked in the *Dim. Vert. to Pallet* field. The case can only be loaded in an upright fashion.

• *Fit Case to Max size* is a new option in CAPE PACK. If selected you can enter the dimensions of an existing case in the *Maximum Dimensions* fields, and the program will force the OD to that size. We will not be using this feature for this analysis because we do not know the size of our case. We want CAPE PACK to calculate that information for us. If you choose this option, you can also choose to center your primary packs in the case by checking that box.

![Case Settings](image)

### Pallet Information

This procedure is exactly the same as for the Pallet Group Tutorial.

• You know from the warehouse manager that you need to use a 48x40 US GMA standard pallet and that a fork truck cannot lift more than 2000 pounds.

• The current method of shipping the cartons results in little or no damage to the product.

• You also know that the cases do not hang over the edge of the pallet. You decide you will **not** allow any overhang.

Click on the tab labeled **48x40**. This is our default pallet base style, and it is the pallet we will use for this analysis.

Because we are using the default pallet, you do not need to select a pallet from the drop down list. You could also select your pallet from the Pallet Thumbnails list of you choose.
Skip the *Maximum Overhang* field. This is any amount that a secondary package can extend over the edge of the pallet surface.

Enter **50** in the *Maximum Height* field. This is the height of the overall load including the height of the pallet base.

Enter **2000** in the *Maximum Weight* field. This is the weight of the overall load including the weight of the pallet base.

Click on the **Select Pallet Pattern Styles Screen** button and make sure all pattern types are marked, and click **OK**.

If required, you can choose options from the Additional Palletizing Input screen described in the *Pallet Group* chapter.
Your pallet tab screen should now look like this.

Now you have to define how the pallet gets arranged in the truck.

**Truck Information**

You know that a truck you want to use is a 40 foot truck and it cannot weigh more than 45,000 pounds.

Click on the tab labeled with a truck style.

For the **Truck Style**, choose **40' High Cube** from the drop down list. Notice how many parts of the **Truck Dimension** field are automatically filled in with the values for that item.

In the **Max. Weight** field, enter **45000** pounds.

In the Loading Patterns fields select **Simple** and **Complex**. Your screen should now look like this.
Saving Data

You want to save this data so that you can show your colleague how you reached your conclusion.

Choose **Save Input Data and Calculate** from the **File** menu, or click on the **Save/Calc.** button on any of the input screens.

You will be prompted to enter a filename and location for this problem. If you did not want to save the data, you would use the **Calculate Only** option.

Type **Widget1** in the **File name** box.

Click on **Save**. The program automatically begins calculating solutions for the problem you have defined. When the calculations have finished, you will see the Multi-Viewer Graphics screen.
The program has calculated ten solutions for you. The solutions in Arrange Group are new cases sizes. It is displaying the case size with the simplest pattern and the most primary packages per load. Notice how the layers of the load are alternated as requested during input.

Evaluating your Results

You can see diagrams of the primary package (bottom right), the secondary pack (bottom middle), the pallet layer (bottom left) and the corner view of the pallet load (top left).

Now click on the **Solution Report** button.

The default Thumbnail Solution Report opens showing you solution number 1 and the 6 pallet patterns determined for that box size.

Click on the **Solution Report** button to see the standard solutions report.

This report tells us that Solution #1 has 960 cartons per load and that they are packed 20 to a case.

Highlight Solution #1 and double click on it.
You review the numbers in the upper right corner. You see that the area efficiency is 90.9% which is greater than the existing pallet load efficiency. You see that there are 8 secondary packages per layer and that there are 6 layers. You decide that this is the solution you will use. However, at this stage, you cannot see how the pallets will be loaded in the truck.

Comparing Statistics

You are pleased with the results of Solution #1, but you would like to review some of the other solutions (if any are available). This can be achieved by looking at the statistics in the Solution Report and/or by viewing the solutions in a graphical mode.

To view statistics for solutions, click on the Solution Report button.

The solutions are listed in descending order of number of primary packages per load.

The on-screen Solution Report has two columns which show the number of cases per layer and number of layers on the pallet. Due to space constraints these two columns are not shown in the printed Solution Report.

Printing the Solution Report

From the File menu of the Solution Report window, choose Print Solution Report. The report will be sent to the default printer. You have a choice between Portrait or Landscape printing.
Closing the Solution Report

From the File menu of the Solution Report window, choose Close. You will be returned to the Multi-Viewer Graphics.

Reviewing Graphics

Click on the right arrow button (→) on the icon bar. This brings up the next solution in the list.

Click on the left arrow button (←). This brings up the previous solution in the list.

Click on the Jump to a Solution arrow button. Enter a particular solution number, and click on OK. That solution number appears.

If a particular arrow button is gray, you are either at the first or last solution in the list.

Reviewing Different Pallet Patterns

In the Arrange Group, each new case size can be palletized using different patterns, providing you selected more than one pallet pattern type on the Pallet tab.

Click on the up arrow button (↑). This brings up the next pattern in the list. Click on the down arrow button (↓). This brings up the previous pattern in the list.

To see how the same case might be palletized differently select the RePalletize option on the Tools menu. RePalletizing is easy with CAPE PACK since you do not have to remember all the dimensions and specifications. This option will recalculate all the patterns available for the specific pattern type shown on the report. For example, our pattern is an Interlock. Selecting RePalletize will calculate all the possible Interlock patterns for this case size.

Sharing Data

Solution #1 with the Interlock pattern is better than the method you are currently using. You want to present this solution graphically to your colleague along with the statistics you printed previously. However, you want to depict how the product is packaged, how the layers will be alternated on the pallet and how the load is going to be shipped.

If the graphics for your chosen solution does not need to be modified in any way, you can print the default views from the Print option on the File menu.

Setting up your Graphics

Click on Set-up Buttons. The statistics in the top right Quick Report will disappear and a new set of controls will take its place.
Setting up the Screen

First, you must decide on the presentation of your report, including the type and quantity of diagrams you wish to show. Since you have repackaged the primary packages you need to show the contents of the secondary package, the case and how it is palletized. You also want to show the truck filled with your pallets. The report needs to be set up to show four diagrams.

Click on the button labeled **Format Screen**. A window like this appears.

Click on the button labeled **1, 2a, 2b, 3** or **4** as required. However, we are leaving the screen set up as 4 panels, so click on the **Close** button.

Formatting the Load

Make whatever load formatting changes you want. This load is shown with horizontal corner posts, a top board and strapping.
Setting Up the Diagrams for the Report

Click on the pallet load to highlight panel #1.

Make sure the Diagram Type field is set to Pallet Load.

Make sure the Diagram View field is set to Corner View. To change the Diagram View, you can either use the Diagram View drop down list, or you can use the right-click options for the diagram.

Now activate panel #2 (bottom left).

Change this panel to a Pallet Load as well.

Click on the Truck menu and Show my Truck.

Highlight Solution number 1 on the list.

Click on the File menu and Save Current Load and Exit. This will place the truck in panel 2 in the Multi-Viewer.

Activate panel 3. Set it to show the Case (#1).

Finally activate panel 4. From Diagram Type, select Carton (#1). Your screen should now look like this.
Formatting Objects - Cases

Click on the secondary package picture and then the **Format Object** button.

Click on **Open Flaps**. Your final diagram setup should look like this.

You can also activate these features using right mouse click pop menus.
Formatting Objects – Pallets

Click on the pallet load diagram and then click on the Format Object button.

Now click on the Show Wrap box, and then right click on that same option. The following window opens:

Enter in a shrink wrap weight for the load, select a color for the wrap and choose whether or not you wish to include the pallet base.

Click OK and your pallet load will appear with your wrap options.
Notice how the pallet load and all the pallet loads in the truck have been shrink-wrapped. Now that you have the Multi-Viewer Graphics configured with the layout and types of diagrams you want you are ready to finalize the details for your report.

You can also activate this feature from the right-click pop menu.

**Printing Graphical Reports**

Now that you have formatted the pallet load you can print a report. However, you would first like to add a few comments.

Right click on the pallet load picture and select **Edit User Text**.
Choose the **User Text** tab.

![User Text tab](image)

Click on the **Clear** button. If there was any text in the box, it is now gone. Make sure your cursor is blinking on the first line. If it is not, click the mouse there.

Type **This report shows how the carton can be packed 20 into a case, palletized and then loaded into a truck. To see how our current method compares to this, see Solution 2 of the Pallet Group analysis.** When you are typing you must hit **Tab** at the end of every line.

When you are finished, click on **OK**. You are returned to the Multi-Viewer.

From the **File** menu, choose **Print Preview** to review your report before printing.

Use the scroll bars to scroll around the page, or use the **Zoom** controls. If everything looks okay, click on the **Print** button.

**Printing Custom Reports**

We have included several custom reports for use with your software. CAPE Custom Reports are individually designed printouts using a Microsoft Word Template. To fill out the information boxes/spaces you will need to create a Microsoft Word Macro. This will populate the text, number and diagram fields of the report. You can either edit the templates, or you can create new templates and custom reports for yourself.

There is a special option on the **File** menu in Multi-Viewer Graphics called **Print Custom Report (Word)**.
See the Printing chapter for more information on this feature.

**Saving your Graphics**

Click on **File, Save Solution** to save your graphics in your load file. These graphics can be recalled later from the Front Menu using **File, Open Viewer/Open Saved Graphics**.

**New Arrange Group Features**

The following section explains the new features of the Arrange Group added for CAPE PACK 2.13. Please refer to the chapter entitled **Arrange Group Features** on the Application CD in the Documentation folder for an explanation of the additional features in this program.

**Sort Common Secondary Pack Sizes by Primary Packs per Load**

When using more than one pallet type, you can now sort your results by the number of primary packs per load. This gives you advantage of reviewing the best case sizes for moving your product through the supply chain.

The following screen opens.
And in the lower left corner, a sort feature has been added.

Which gives you these sorted results.
Lift Covers off Trays for Retail Ready Packaging

You can choose to treat your case like a tray and lift the full cover off in MultiViewer Graphics to display the contents inside. This is a Retail Ready Packaging option instead of Open Flaps. Access the feature from the pop up menu for the case.

Your results will look like this.
Blister Pack Enhancements

Formerly, blister packages had 2 limitations. First, they were only allowed to be packed height dimension vertical in the case. And second, if there was room to nest them they were always nested. Both of these limitations have been removed. Here are some examples.

Arrange Group Data Input Options

Interlocking Patterns Inside the Case

CAPE PACK offers a unique way to quickly find out if an interlocking pattern will achieve more items per case and/or more items per pallet.
Sometimes a specific carton size and case count using the standard row/column packing method will not generate a suitable case size and efficient pallet load. If alternative case counts will not improve the situation, then try the “interlocking” method of packing. Here is an example with the normal row/column packing method with a case count range of 5 to 30. Our row column load achieves 450 cartons per load.

Now let’s run this example using the Interlock Arrangement Pattern option.

Click on Input Settings.
You will notice, in the bottom right-hand corner that the Arrangement Pattern is currently set for Column patterns. Click on Interlock and to choose a Minimum Fit Percentage. That is the only change we need to make.

This fill efficiency percentage is required because some interlocking patterns may have small gaps in between the items. So if the fill efficiency was set at 100%, only patterns without any gaps could be found. We recommend that you set this figure to approximately 80%.

All we need to do now is select Save Input Data & Calculate from the File menu. Here are the results.
Inverted Cylinders and Trapezoids

You can now calculate inverted tapered cylinders and trapezoids inside cartons in the arrange group. Simply select Inverted as your Arrangement Pattern under Input Settings.

Then enter your dimensions for your default trapezoid or cylinder.
Then calculate as normal. Here is your result.

Here is an example of trapezoids.
Blister Packs

You have the ability to design, show and calculate blister type packages within the Arrange Group in CAPE PACK.

Select the blister type you want to use from the Select Pack Type list and enter your dimensions.

Then calculate as normal. The following is an example of nested blisters. This will be the default if there is room to flip or alternate the packages so they nest together.
And here is an example of straight blisters. If you don’t want your blisters to automatically alternate, check the Do Not Nest field on the data input screen.

This will be the default if there is not room enough on the blister pack to alternate the packages.
Blister Pack Wizard

We have added a new **Make a New Shape** feature for Blister Packs as well.

Enter your starting dimensions.

Click **OK** to see the default shape on the screen.
Then adjust the placement of the card back and also the blister (or bubble) part of the package.

If offset will not be possible, you will see the following prompt when you save.

Save your shape and it will appear in your list of options.

**Minimum/Maximum Case Count**

Arrange has **two** modes for entering case counts.

- **Eight** individual case counts, and
• **Min/Max SP Count** which is available on the **Input Settings** screen from the **Input** menu

Choosing a wide range between the min/max case counts means the program will look at all those numbers, including some “odd” numbers/arrangements, and may increase the calculation time.

**Round to nearest 1/16<sup>th</sup> inch (IDs)**

Select this field if you wish to have the program round the inside dimensions of your case up to the nearest 1/16<sup>th</sup> of an inch. This option is not available for metric.

**Showing Product Inside the Primary Pack**

Often users want to show their product inside the primary package (i.e., a light bulb in a chipboard carton). They then want to package the carton into a case (or into bundles and then into a case), and then palletize the cases. There is a special **Product Allowed** feature on the **Input Settings** screen to allow this.
Two new fields open up Product Type and Product Name.

In the Product Type field, you can select a CAPE default shape or any product you have designed in the Make a new Shape feature.

Here is the Multi-Viewer Graphics screen after the analysis has been calculated.
You can also use the **Show Content** option to display the product inside the carton.

**Fixed Case size in Arrange and Design Group**

We have added an option for you to fix your case size (outside dimensions) to the maximum allowed case size in Arrange and Design Group. Click on the **Case Settings** button to select this feature.
If you select this option, you can also select the option to center your primary packages inside the case.

Analyses with No Outer Packaging

The program is provided with a special package types called **No Package** and **None**. Examples of these package types can be seen in the *Pallet Group Features* chapter.

Bundling Your Primary Packs

CAPE PACK has a unique Bundle Wizard for this purpose.

At the Primary Pack input screen select the **Bundle** menu, choose **Define/Review Bundle Input**.

Or you can use the right click option. You will see the following screen.
This screen allows you to see the bundle arrangements as you create them. You can create up to eight different Bundle Arrangements.

Enter \(8 \times 1 \times 1\) in the Bundle Arrangement fields.

Turn Switch Direction on to change the orientation in the bundle.
To package these cartons into a tray, choose Tray from the Bundle Package list.

You can adjust the height of the tray by using the spin-wheel at the top of the screen. You can also add dividers and change the material thicknesses for both the package and the dividers.

You can change the tray color and add a 3D Image from the appropriate menus. You can even shrink-wrap the tray.

Select the Format menu and click on Show Wrap.
Each Bundle Arrangement can be different. The Bundle Package type can be the same or different for each arrangement and the Material Thicknesses for the package and dividers can also be different. Therefore, you can consider different arrangements of the same primary package in one form of Bundle Pack, or you can look at those arrangements in different types of Bundle Pack, or you can even consider different arrangements, different Bundle Package types and Material Thicknesses, all at the same time.

Reviewing Bundle Dimensions

On the Secondary Pack tab, click on the Bundle menu and select Show Primary Pack/Bundle Details.

You will see the following screen.

This screen provides details of the Bundle Arrangements you specified in the Bundle Wizard. Having this information can help you to determine the Min/Max case sizes needed as input at the bottom of the Secondary Pack screen.
Changing Package Color

Select the **Colors** menu and then **Change Package Color**. A color palette will appear.

Select the color you require and click on **OK**. The package will then change to your selected color.

If you wish to return to the original colors select **Change to Original Colors**, from the **Colors** menu.

Alternatively, you can use the **Set Custom Colors** option to change the color of each individual panel.

Adding Graphic Images to Packages

Click on the **Add Graphics** menu and choose **Add 3D Graphics**.

The following screen appears.

Select **CARTON.3DI** from the list.
Click on **OK**.

**Changing Divider Color**

On the case screen, simply select the **Colors** menu and chose **Change Divider Color**:
We will pick red.

Click on **OK** and the dividers will change to your chosen color:

![Software interface showing carton configuration settings](image)

**Zero Package Weight**

You can use a zero weight for the primary and secondary package weights.

**Adding Extra Weight for items in the Carton**

An extra weight field can be used from a setting in **Input Settings**:
This brings the extra field onto the **Input** screen:
RePalletizing a Case

This option gives you the ability to review all options for a specific pallet pattern type (i.e. Interlock, Column, Spiral, etc.)

Make sure the solution for the case size you wish to evaluate is showing in the Multi-Viewer Graphics.

From the **Tools** menu choose **RePalletize**.

The **RePalletize** option calculates all the patterns available within the specified pattern group of your current solution. For example, if you are on an interlock pattern, selecting **RePalletize** will show you all the other possible interlock patterns for that case.

All the regular solution report options are available to you. These include copying, switching to the alternate report and printing. You also have the option to choose a solution in the list and bring that back to the original Arrange Group solution report.

To bring another pattern back into Multi-Viewer Graphics, select the solution you want to use. We are picking Solution #2.
Choose **File, Close** to take this new solution back to Multi-Viewer Graphics. Click **Yes** at the prompt.

When you choose to update the pattern, the pattern is temporary. If you switch to another solution and then come back to the updated solution, the pattern will revert to the original pattern that the Arrange Group calculated.
Common Secondary Pack Sizing

We have added a search feature to allow you to compare like secondary package sizes when you are using more than one pallet for your analysis. Here is an example. First you set up your data to evaluate on 3 separate pallets.

After calculate you are presented with 3 separate pallets with potentially 3 separate case sizes. Calculate and you will see the following screen.

You select **Search for Common Secondary Pack Size** from the **Tools** menu.
And the following list appears.

Select any option and click on **Open** and that case size will appear on each of your three pallets in whatever configuration is most efficient.
Design Group – Designing New Package Sizes

Introduction

The programs in the Design Group can help you determine how to maximize the number of primary packages on the pallet, while looking at new sizes for those primary packages.

First, the program will calculate a new size for the primary packages and then arrange them. It will then calculate a case size based on that arrangement. Subsequently, the new case is palletized for shipping.

You specify the shape of the primary package, how much it can vary in size, as well as how many you want in an arrangement and, if necessary, how the primary package should be bundled in groups within the arrangement. The primary package can be a box, bag, bottle, cylinder, oval or trapezoid or any shape created in the Make a New Shape Feature. Running an analysis for each type of object is the same, but the type of data you input will be different. This tutorial will take you through an analysis for a carton.

The Problem

After such a positive reaction from your colleagues regarding the results of the Arrange Group tutorial, you begin to think of other possibilities. What happens if you change the carton size? Would the new size mean you could distribute more of the product within the same space?

Considerations

You know from the results of the Arrange Group tutorial that for this particular carton size you cannot produce a more efficient load without changing loading restrictions. And you know you have set the loading restrictions appropriately.

But before you can start thinking about changing the carton size you need to gather some more information. You discuss with marketing and production the degree by which you can allow the primary pack to vary. You find that:

- you can use a slightly different size carton. However, no more than a fraction of an inch can change in either the length, width or height.

- all the other parameters must stay exactly the same as in the Arrange Group analysis.

You want CAPE PACK to calculate a new carton size for you. After reading the Welcome chapter you realize you need to run the Design Group – Cartons/Bags/Ovals program.

You know the product shape and how much the product can vary in size. You want to look at the same arrangements as in the Arrange analysis and then generate a new case size that will be palletized more efficiently.

In the Arrange/Design Group section on the Front Menu make the following changes.

Click on Vary.

Choose Carton from the first Type of Pack drop down list.

Choose Case from the second Type of Pack drop down list.
Mark **Yes** for **Pallet** and **Yes** for **Truck**

![Image of CAPE PACK interface]

Click on **Go**. The first input screen appears with your Default Settings already loaded.

![Image of CAPE PACK input screen]

The difference between the Arrange Group and Design Group is that the primary package can vary in size. To account for this difference a few fields have been added to the Primary Pack input tab. Everything else remains the same as before. You know that secondary package and loading restrictions are not going to change. So we will open the Arrange file we already completed so that we do not have to re-enter all the same data.

From the **File** menu, choose **Open**.

Find **Widget1.clf** in the list of filenames and click to highlight it.

Click on the **OK** button to open this file. This will open our Arrange example file.
Now select the Programs menu and click on Design Group, Cartons/Bags/Ovals. The screen will change to show the Arrange screen with nine extra fields.

The next step is to add the information about changing the size of the carton.

### Evaluating Different Primary Package Sizes

You have learned from marketing and production that the carton size can change slightly, but that the weight needs to stay the same. You can now define the carton and the variances you will allow.

For Dimensional Variance (+), enter .25, .25, and .5 in the Length, Width, and Height fields respectively. This is the additional amount up to which a particular dimension can be in size. So our carton will not be larger than 4.25 x 2.75 x 6.25 inches.

For Dimensional Variance (-), enter .25, .25, and .5 in the Length, Width, and Height fields respectively. This is the decreased amount to which a particular dimension can be in size. So our carton will not be smaller than 3.75 x 2.25 x 5.25 inches.
For *Dimensional Increment*, enter **.0625**, **.0625** and **0** in the *Length*, *Width*, and *Height* fields respectively. This is the quantity in which the program will add or subtract from the values in the range, in order to create a new size for the primary pack. Remember, the values in the range have been determined by the variance. Because we have not entered an increment in the *Height* field, the height will remain constant.

If you want to vary the volume of your product as the size varies, you can select this option from the *Input* menu. Do not vary the volume or the weight with the volume. For this tutorial we are working with a fixed volume analysis.

The program is restricted to forty increments. Therefore, you cannot specify a 2.5 inch plus and 2.5 inch minus variance with a .0625 inch increment. This would create a total of at least 80 increments (+40 and -40).

Your screen should now look like this.

The rest of your input screens remain unchanged and should look like this.
Saving Data

You have now entered all the information CAPE PACK needs to calculate solutions. Every other piece of information stays the same as in the Arrange analysis. All we are doing is varying the size of the carton within all of our specified parameters.

Choose **Save Input Data and Calculate** from the **File** menu, or click on the **Save/Calc.** button on any of the input screens.

The program automatically begins calculating solutions. When it is finished, you will see the Multi-Viewer Graphics screen.

Evaluating Results

The program has calculated a variety of solutions. It is displaying the solution with the simplest pattern and the most primary packages per load.
You see diagrams of the primary package (bottom right), the secondary pack (bottom middle), the layer on a pallet (bottom left) and a corner view of the pallet load. You need to view your solution information so you can decide on the best pallet load.

Click on the Solution Report button which will display the Thumbnail report. This report shows you the different pallet patterns for the first solution in the list.

Then the Solution Report button on the Thumbnail report.
If you check the Solution Report you will find that this solution achieves 1176 cartons per load, compared to the 960 cartons per load found in the Arrange Tutorial.

The new carton size has changed marginally, from 4.00 x 2.5 x 5.75 inches to 4.25 x 2.4375 x 5.5505 inches. A very small size change to achieve an extra 216 cartons (or +22.5%) per pallet.

### Reviewing Graphics

You are very pleased with the outcome shown in solution #1 but you might want to look at other solutions and patterns.

Click on the right arrow button (→) on the icon bar. This brings up the next solution in the list.

Click on the left arrow button (←). This brings up the previous solution in the list.

Click on the **Jump to a Solution** arrow button. Enter a particular solution number, and click on **OK**. That solution number appears. If a particular arrow button is grayed out, you are at the first or last solution in the list. Click on the opposite button or the **Jump to a Solution** button to switch solutions.

### Viewing other Pallet Patterns

In the Design Group program, each new case size can be palletized using different patterns, providing you selected more than one pallet pattern type on the first pallet tab.

Click on the up arrow button (↑). This brings up the next pattern in the list. Click on the down arrow button (↓). This brings up the previous pattern in the list.

You can run the case size through the **RePalletize** feature under the **Tools** menu. This is easy with CAPE PACK because you do not have to remember all the dimensions and specifications. For more information, see the **Other Arrange Group Features** file in the Documentation folder on your Application CD.

### Comparing Statistics

After reviewing some of the graphics solutions, you decide you want to compare the actual statistics. You find it is hard to remember all the data when switching between solutions.

Click on the **Solution Report** button.

The solutions are listed in descending order of number of primary packages per load. You see in the list that the top solution contains 1176 cartons per load. You could scroll through the list evaluating the different primary package configurations within the secondary package, as well as the size of the secondary package. However, you are only really interested in Solution #1 with its extra 216 cartons per load.
The on-screen Solution Report has two columns which show the number of items per layer and number of layers on the pallet. Due to space constraints, these two columns are not shown in the printed Solution Report.

After evaluating the statistical data you see that solution #1 shows the least amount of size change for the primary package. The following table outlines the differences.

<table>
<thead>
<tr>
<th></th>
<th>Before</th>
<th>After</th>
<th>Difference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary (L)</td>
<td>4.00</td>
<td>4.25</td>
<td>+.25</td>
</tr>
<tr>
<td>Primary (W)</td>
<td>2.5</td>
<td>2.4375</td>
<td>-.0625</td>
</tr>
<tr>
<td>Primary (H)</td>
<td>5.75</td>
<td>5.5505</td>
<td>-.1995</td>
</tr>
</tbody>
</table>

After outlining the differences and seeing that the pattern is an interlocking style, which is what you have been using, you decide to draw up a preliminary proposal. You want to print the statistics and a graphical representation of the primary package and the pallet load.

**Printing the Solution Report**

From the **File** menu of the Solution Report window, choose **Print Solution Report**. The report is sent to the default printer.

**Closing the Solution Report**

When you have finished analyzing the statistics you can close the Solution Report.

From the **File** menu of the Solution Report window, choose **Close**. You will be returned to the Multi-Viewer Graphics.

**Sharing Data**

Now that you have returned to the Multi-Viewer Graphics, you do not feel that it is necessary to manipulate graphics at this early stage. You do, however, want to draw attention to the significant impact of such a small change. You want to make a note on the printout.

Make sure solution #1 with the Interlock pattern is showing on the screen.
From the **File** menu, choose **Page Setup**.

Now choose the **User Text** tab.

Click on the **Clear** button. If there was any text in the box, it is now gone. Make sure your cursor is blinking on the first line. If it is not, click the mouse there.

Type **This report shows how the carton, when slightly changed in size, is more efficiently loaded in the same pallet loading area. This alone could save us a large amount of money.** You must hit the **Tab** key at the end of every line.

Click on **OK**. You are returned to Multi-Viewer Graphics.

From the **File** menu, choose **Print Preview**. A window comes up showing you how the printout will look.

Use the scroll bars to scroll around the page, or use the **Zoom** controls.

You can, if you wish, add extra notes using the **Annotation** feature.

If everything looks okay, click on the **Print** button.

---

### New Design Features in this Version

### Calculate Solutions with Fixed Primary Pack Volume

CAPE PACK has always given you the ability to modify your primary pack volume based on a percentage of change, or to keep that amount constant. We now offer you a third option to fix a specific volume.

To change your volume, click on the **Input** menu and **Vary Volume/Weight**.

The following screen will open.
Your three choices are:

Keep volume as it is now by setting your Vary Volume By setting at 0% as shown above.

Change your volume variance by entering a percentage of change.

Set your volume to a specific measurement as shown below.
Folding Carton Arrange (FCA) Programs

Introduction

We have added two new Folded Carton Arrangement programs to the Arrange Group of programs. Each of these programs is designed to alternate either individual collapsed cartons or bundles of collapsed cartons, then place them into the case, then onto a pallet and into a truck. The philosophy behind this program is that often our folded cartons do not lay flat, but will have one end thicker than the other. For example, a standard carrier may have 2 thicknesses of paperboard on the handle end and 6 or more thicknesses on the bottom end of the carrier. So to maximize the space in the carton, the program alternates, or flips them in the case, just as the manufacturer would in real life. The diagram on the input screen shows a standard tuck-top box, but any folded carton style could be entered. However, the picture on the screen will be rectangular when calculated.

There are two modules for new case sizes and three modules for existing case sizes. These are the options.

- **New Cases Sizes, Nested Cartons in Bundles**: This program will develop new cases sizes for you by examining your bundle count range, and alternating every other carton in the bundle. So instead of having a bundle with one end larger than the other, your bundle size will be an even thickness. The program then takes these bundles and loads them into case configurations in a row/column pattern based on the maximum size you have allowed for your case. Then it palletizes your cases for you. The best solution will be the bundle count and case size that gets the most cartons on the pallet load.

- **New Cases Sizes, Nested Bundles in Cases**: This program will develop new cases sizes for you by examining your bundle count range, creating bundles of each count, and then alternating every other bundle in the case. So if your bundle has 2 different thicknesses, one end of the bundle will be larger than the other and all cartons will be facing the same direction. The program loads the bundles in the case, alternating each bundle, in a row/column pattern based on the maximum size you have allowed for your case. Then it palletizes your cases for you. The best solution will be the bundle count and case size that gets the most cartons on the pallet load.

- **Fixed Case Sizes, Nested Cartons in Bundles (All Patterns)**: This program uses the Casefill procedure of filling cases in a current database, using all the pattern types available. It still creates bundles of alternated cartons, but then arranges those bundles in Column, Interlock, Trilock, Spiral, Diagonal and Expanded Spiral patterns within existing cases to see if there is a case that will work. The program palletizes the cases that are acceptable solutions.

- **Fixed Case Sizes, Nested Bundles in Cases (Row/Column)**: This program uses the Casefill procedure of filling cases in a current database, but uses only Row/Column bundle arrangements. It creates bundles of alternated cartons, and then arranges those bundles in existing cases in the Row/Column pattern. The program palletizes the cases that are acceptable solutions.

- **Fixed Cases Sizes, Nested Bundles in Cases (Row/Column)**: This program uses the Casefill procedure of filling cases in a current database, but uses only Row/Column bundle arrangements. It creates bundles of cartons, all facing the same direction in a bundle, and then arranges those bundles in existing cases in the Row/Column pattern. The program palletizes the cases that are acceptable solutions.

Provided in this chapter will be a tutorial for the New Case Sizes, Nested Bundles in Cases and also the Fixed Case Sizes, Nested Bundles in Cases (Row/Column). The other programs are similar in nature and only the calculation of the bundle size will vary.

New Case Sizes

The first analysis we are going to run is going to help us find a new case size for our cartons. We want the program to build bundles of 20-25 cartons and then alternate every other bundle within the case.
From the FCA Group, select the FCA module you want to run, the case type you want to use and then turn pallets and trucks both on. Click on Go to launch the program.

Or you can launch the program from the Programs menu.

The screen will load with default settings and look like the following.
For our flat carton dimensions, we will enter the dimensions of the unit flat – not as it would be when erect. Length will always be the longer of Length and Width. Enter 10.25 for the Length and 6.875 for the Width.

For the Thickness fields, if your carton is symmetrical, enter the same thickness for both fields. If your carton is asymmetrical, enter the thickness of one end in the first field and the other end in the second field. When calculating, the program will alternate the bundles to minimize space required. So for example, if you have thicknesses of 3" and 5", the total thickness for 2 bundles on each end would be 8": 3" from the first bundle and 5" from the second. Enter .10 for Thickness 1 and .25 for Thickness 2.

Fluff factor is added in after bundle size is determined and is expressed as a total percentage. Enter 3%.

Enter the weight of 1 flat carton in the Weight field. You can right-click on this field for an ounce to decimal conversion.

Select 2 ¾ ounces from the list. A weight of .1719 will appear in the field.

Bundle Counts can be entered as a range or a specific count. You must enter at least 1 for the minimum bundle count. Enter 20 for the minimum and 25 for the maximum.
Enter the dimension vertical as you would like the cartons loaded into the case. The default above shows the cartons being loaded on their folded edge into the case. The normal dimension will be **Width** and that is what we will select for this analysis.

Your input screen should look like this.

For your Case tab, you can use specific counts for your boxes as shown below, or enter a minimum and maximum quantity per box. Either way, the program will calculate quantities in your bundle count groups.

We will use individual counts, so right-on your screen, and select SP Count Type and then 8X Single Counts.

The following screen opens. The Case tab is the same for all the Arrange and Design Group programs, including Folding Carton Arrange. For more information, please review the Arrange Group chapter of this documentation.
We will allow for our cartons to stack 2-high in the case if the case size is more efficient, but we want them protected. So from the Select Partition Type list, select Divides Height as a partition type.

Select 125 E Flute from the Caliper list for this partition.

Enter 200 in the first Case Count block, 240 in the second and 300 in the third.

Finally, in the Enter Max Case Weight field, enter 75. Your screen should look like the following.

Click on the Case Settings button in the center of the screen.

Change your maximum case dimensions to 30 x 24 x 16.

We will not need slack because we have allowed for fluff.
Click **OK** to close this screen.

Click on the pallet tab labeled **48x40**.

Change your maximum height to **52**. Your screen should look like this.

Click on the tab labeled **53Footer**.

Change your maximum load weight to **55000**. Your screen should look like this.
Click on the Product Name/Product Code button and enter identifying formation for your analysis.

Click on Save/Calc and enter a file name. Your results will calculate and will be displayed in Multi-Viewer Graphics.

The program has calculated 13 solutions for you with 2 different bundle counts and various case counts. The first one showing is the solution where you will get the most cartons per load. The new case sizes allow for your bundles to be alternated and also allow for fluff in the case.
You can scroll to different case sizes using the left and right arrows in the tool bar, and then different pallet patterns for that case using the up and down arrows in the tool bar. Here is solution number 2, with the second pallet pattern option.

The case count for the case size and the pallet pattern both get the same 5400 per load. However this case uses bundles of 25 arranged with the width vertical in the length of the case, and the other uses bundles of 20 with the length vertical in the length of the case. Solution number 2 is probably a better solution to prevent product damage.

All the same graphic and reporting options are available in this program as in the rest of CAPE PACK.

**Fixed Case Sizes**

The second option we will look at is for Fixed Case Sizes, with the same alternated bundle pattern. Click on the **Programs** menu, **Folding Carton Arrange (FCA)**, **Fixed Case Sizes, Nested Bundles in Cases (Row/Column)**.

The following screen will appear.
This option calculates bundles in the same way as the New option, but for case sizing it uses the Casefill database of your existing cases and trays. You can review this database under the **Database** menu, **Database Utility**.

The FCA tab info is the same as for the New Cases program except for the Min Slack in ID button.
Click on the button and you will see this data entry screen where you can enter required slack in any dimension of the case.

Instead of the Case tab for creating new cases, we have the Fill Restrictions tab. This tab is for defining how you want the program to evaluate the cases in your database when filling them with your bundles of cartons.

We will use the same case counts as the New program and the same Maximum Weight.

Select the dimension vertical to the pallet you want to use. We will use Height, which is flaps up on the case and is general the loading default for cartons. Your tab should look like this.
Our pallet and truck tabs will also remain the same as the New program.
Click on Save/Calc and if you are asked for a database, select one to use.

Enter a file name and calculate your solutions.

The Multi-Viewer Graphics will appear with your solutions.

The program displays the case in your database that achieves the most primary packages per load. Unlike the Casefill program, the Folding Carton program automatically calculates a pallet load for you with that case.

Your solution report will list only those cases in your database that achieve your goals.
New Features in Folding Carton Arrange

Case Cube Utilization

One of the new features added to this program is the ability to see the cube utilization of the case on your quick report as shown below.

Because this program uses a database of existing case sizes and styles, it is important to know how efficiently those cases are being used. In this case the first solution is 63.1% cube efficient. Here is the second solution.
Compare the two results. The first solution is 63.1% cube efficient. The second solution has increased the carton bundle by 5 units, however, the cube efficiency has decreased to 58.1%.
KDF Group – Knocked Down Flat Cartons

Introduction

KDF stands for Knocked Down Flat. It refers to a flat-glued corrugated case. That is, a corrugated flatblank that has been folded and glued. These programs are provided for designers and estimators, in corrugated companies, to establish the best number of flat-glued cases (KDF's) per bundle, the optimum number of bundles onto a pallet or bale, and the maximum number of pallets into a truck.

There are four KDF programs:

- **Flatblank** to bundles of the KDF's on a pallet. You enter the size of the flatblank (corrugated sheet) and select a formula. The program automatically converts the flatblank to a KDF. You enter the min/max number of KDF's per bundle and the program creates the bundle size. You choose a pallet and truck type and the program does the rest.

- **Made-up Case** to bundles of the KDF's on a pallet. You enter the size of the Made-up Case (an erected corrugated case) and select a formula. The program automatically converts the Made-up Case dimensions back to a KDF. You enter the min/max number of KDF's per bundle and the program creates the bundle size. You choose a pallet and truck type and the program does the rest.

- **Bale FlatBlank** is the same basic program as Flatblank but it loads the KDFs into bales and then directly into trucks rather than using pallets.

- **Bale Made-up Case** is the same basic program as Made-up Case but it loads the KDFs into bales and then directly into trucks rather than using pallets.

Starting the KDF Programs

On the Programs menu select KDF and the type of package you want to work with (i.e. Flatblank or Made-up Case.)
Or you can setup your Front Menu in CAPE PACK to always show the KDF Group wherever you choose to have it appear.

Selecting this option from the Front Menu replaces the bottom section of the screen with a KDF section.

Whichever way you choose to start the KDF program you will arrive at the first input screen with your Default Settings already filled out.
These settings are previously loaded data input figures that have been saved as your Default Settings. So, in our analysis we can simply change the figures, to suit our product information, and then save our data to a new file name. That way the Default Settings will remain unchanged and our new filename, containing all the data we use for this analysis, will be saved for future reference.

### Modifying Formulas

By clicking on the **Add/Edit Formula** button on the first input screen. Here is the screen in the Flatblank program.

The formula is the length of the Flatblank multiplied by a number (usually less than 1), the width multiplied by a number (normally 1) and the height multiplied by the number of material thicknesses in the final KDF/Flat-Glued Case (normally 2 or 3).

Here is the screen in the **Made-up Case** program.
This formula creates the length of the KDF/Flat-Glued case by adding the length of the Made-up case plus allowances to the width of the case plus allowances. The width of the KDF is generated from a combination of the height of the case plus allowances added to the width of the case plus any allowances. The height of the KDF is created by multiplying the material thickness of the corrugated material by the number of material thicknesses in the final KDF (usually 2 or 3).

The number of fields in the formulas is fixed. But you can vary content according to the case style, the material specification and the allowances you need to consider for each case/material type. And, you can add as many formulas as you need.

Editing Formulas
Select the formula you want to change, in the list, and click on the **Edit** button. Make your changes and click on **Update**.

Adding Formulas
Select the formula you want to change, in the list, and click on the **Add** button. Make your changes and click on **Update**.

Running a Flatblank Analysis
In this analysis we will start with a specified size for a flatblank, select a formula and specify the min/max number of KDF's per bundle. We will choose a 48x40 GMA pallet and a 40 foot truck. We will then let the program determine the best number of KDF's per bundle, per pallet and per truck.

Using the methods described earlier, launch the KDF Flatblank program. You will see the first Input screen with the Default Settings already filled out.
Click on the **Input Settings** button or use the right mouse click feature to activate your Input Settings.

Here you have several additional options for your analysis:

- **Bulge Allowed** (e.g. bundle spreads under compression on the pallet)
- **Add. Bundle Weight Allowed** (if you want to add extra weight for straps etc)
- **Alternate Layers**
- **Height Factor Allowed** (if you need to use a fluff factor, or compress or expand the height of the bundle). You can add the Height Factor as either a fixed quantity (i.e., 1") or a percentage.

We will not be using any of these features in our first analysis.

On the right side of the screen we need to choose the appropriate settings for our problem. We are putting our bundles on to a single pallet size and then we want to load those pallets into a truck. So make sure the settings are as follows:
• Select 1 x Pallet.
• Select Objects onto Pallet into Truck.
• Under Units of Measure, select in/lb.

Click on OK at the bottom of the screen and you will returned to the first input screen.

You have to change the size and weight of the flatblank, pick a material thickness, select an appropriate formula, choose a min/max number per bundle and the program updates everything for you.

Starting at the top of the screen, change the Flat Length to 57.25, and the Flat Width to 22.25.

From the Flat Thickness list, select 200 C Flute 42-26-42.

Change the Flat Weight to .625. This the weight of 1 flat carton.

Click on the Select Formula list box and select Glue joint = 1".
Notice how the KDF dimensions and Bundle dimensions have been updated to reflect your input.

Now change the Bundle Counts. Make your Minimum 25 and your Maximum 50.

Make sure Height is selected for Bundle Dimension Vertical On Pallet.

See how the picture of the bundle and how the height and weight of the bundle also changes as you increase/decrease the number of KDF's per bundle.

Adding Straps to the Bundle

Click on the Add Straps button at the bottom of the screen.

In the Vertical Strapping section, enter 1 for the number of straps Across the Length of the bundle.

Enter 1 for the number of straps Across the Width of the bundle.

Enter 5 for the Width of the straps This figure is expressed as percentage of the bundle size so 5 should be sufficient.

In the Horizontal Strapping section, leave the strapping Across Height set to 0.
Now click on **OK** and you will be returned to the input screen. The picture of the bundle now shows yellow straps on it: Your screen should look like the following.

**Pallet Information for Flatblanks**

Click on the tab heading with the name **48x40** and you will see the following screen.
If you want to change to a different pallet, click on the Select Pallet Base Style list and select the pallet you prefer. Or you can use the Pallet Base Style Directory button or the Pallet Thumbnails button for your selection.

We will not be considering overhang for this load, however quite often overhang is permitted on loads of flat glued cases. This is because of the construction of the load, very little damage will usually result if the load has overhang.

Change the Max. Height to 50, and the Max. Weight to 2000. Your screen should look like this.

Truck Information for Flatblanks

Click on the tab marked 53footer. We will not be changing the truck style for this analysis.

Enter a Max. Weight of 80000. Your screen should look like this.
Saving Flatblank Data

Next we need to save our input data and calculate solutions. We have changed those settings and now we need to save our data to a filename we can recognize.

If you want to save the current input data to become your new Default Settings, click on the File menu and then Save My Default Settings.

To save your data and calculate solutions, choose Save As Input Data & Calculate from the File menu, or click on the Save/Calc. button at the bottom of the screen.

Enter a filename of your choice, in the Save As dialog box, and click on Save. The next thing you will see is the Multi-Viewer Graphics screen with Solution #1 displayed.

You can see the full pallet load in the top left hand corner, a single pallet layer in the bottom left hand corner, a bundle (with the straps on it) in the middle and a single flatblank in the bottom right hand corner.
Reviewing Solution Statistics

You can review the different solutions with their pallet patterns by clicking on the Solution Report button on the right side of the screen.

By using the arrows on this screen you can scroll to different solutions, which represent different bundle counts. Each solution will have between 1 and 6 different pallet patterns to choose from.

There is also a report that displays all the available solution statistical information. Click on the Solution Report button at the bottom of this screen.

The best solution shown has 276 flatblanks per load in bundles of 46. However, we would prefer a bundle amount divisible by 5 so solution number 4 is better suited to our needs. Double click on solution 4 to see those graphics.
Formatting the Load

All of the normal Pallet Group formatting applies to KDF loads as well. You can add corner posts, layer pads, layer trays, straps and top caps to your load.

Click on the **Set-up Buttons** button to activate the formatting controls.

Click on the **Format Load** button in the top right hand corner of the screen and a pop-up window appears.

Add whatever formatting to you want to the load and click on **OK** to save your changes to the Multi-Viewer Graphics.

Loading the Truck

Select the **Truck** menu, and **Show My Truck**. You will see the following screen.
From the **File** menu, choose **Save Current Load and Exit** to exit the Truck Analysis Solution Report.

You can change the diagrams to suit your needs by using the **Format Panel** button or the right-click options.

**Printing Reports**

First you will need to make sure that the report settings are correct.

To check your report settings, go to the **File** menu and select **Page Setup**.
Select **User Text** and type in an appropriate message.

Click on **OK**.

Go back to the **File** menu and select **Print Preview**.
Check that everything is okay and then click on the **Print** button at the top of the screen.

You can also print your report by using the **Print** function under the **File** menu.

### Running a Made-up Case Analysis

Running an analysis for a Made-up Case is similar to the previous Flatblank analysis. The only difference is that you are starting from an erected case size (not a flatblank). Therefore, you need to input the length, width and height of the case, the material weight for the case and you need to choose an appropriate formula. This will then convert the erected case to a KDF (flat-glued case). You enter the min/max number of KDF’s you want in the bundle, add straps (if necessary) and the program will do the rest.

Open the **Made-up Case** program from the **KDF Group** on the **Programs** menu.

The program opens to the first input screen with the **Default Settings** displayed.
Simply enter a new figure for the length, width, and height. Select a material thickness from the drop-down list and enter the weight of your erected corrugated case.

Let’s change our figures to:

Length = 13.75 inches

Width = 8.625 inches

Height = 11.5 inches

Material = 200 Doublewall (.3125)

Weight = 1.25 lb:

Now click on the Select Formula drop-down list and select Allowance = .200.

Make sure that the bundle counts are 20 minimum and 30 maximum. Your screen should look like this.
Pallet Information for Made-Up Cases

Click on the pallet tab and select 48x40 from the drop-down list.

Enter 55 for the Max. Height and 2000 for the Max. Weight. Your screen will look like the following.

![Pallet Information](image1)

Truck Information for Made-Up Cases

Click on the Truck tab and select 40hicube from the drop-down list.

Enter 80000 for the Max. Weight. Your screen should look like the following.

![Truck Information](image2)

Saving Made-Up Case Data

Next we need to save our input data and calculate solutions. We have changed those settings and now we need to save our data to a filename we can recognize.
If you want to save the current input data to become your new Default Settings, click on the File menu and then Save My Default Settings.

To save your data and calculate solutions, choose Save Input Data & Calculate from the File menu, or click on the Save/Calc. button at the bottom of the screen.

Enter a filename of your choice, in the Save As dialog box, and click on Save. The next thing you will see is the graphics screen with Solution # 1 displayed.

You can see the full pallet load in the top left hand corner, a single pallet layer in the bottom left hand corner, a bundle in the middle and a single flatblank in the bottom right hand corner.

You have all the same formatting options as the KDF Flatblank program described earlier.

Running a Bale Analysis

Running an analysis using Bales is basically the same as with pallets. The difference is that you enter the maximum bale size rather than choosing a pallet size from the list. Bales for flatblanks and for made-up cases are run the same way. We will demonstrate with Made-up Cases.

Open the Bales Made-up Case program from the KDF Group on the Programs menu.

The program opens to the first input screen with the Default Settings displayed.
Simply enter a new figure for the length, width, and height. Select a material thickness from the drop-down list and enter the weight of your erected corrugated case.

Let's use the same analysis as the normal Made-up Cases. Enter the following.

Length = 13.75 inches
Width = 8.625 inches
Height = 11.5 inches
Material = 200 Doublewall (.3125)
Weight = 1.25 lb:

Now click on the Select Formula drop-down list and select Allowance = .200.

Make sure that the bundle counts are 20 minimum and 30 maximum. Your screen should look like this.
Bale Information

Click on the Bale 1 tab. **Bale Analysis** has already been selected from the *Select Pallet Base Style* list.

Enter 52 for the bale *Length* and 48 for the bale *Width*.

Enter 50 for the *Max. Height* and 2000 for the *Max. Weight*. Your screen will look like the following.

![Bale Dimensions](image)

**Truck Information for Bales**

Click on the Truck tab and select **53footer** from the drop down list.

Enter 80000 for the *Max. Weight*. Your screen should look like the following.

![Truck Dimensions](image)
Saving Bale Data

Next we need to save our input data and calculate solutions. We have changed those settings and now we need to save our data to a filename we can recognize.

If you want to save the current input data to become your new Default Settings, click on the File menu and then Save My Default Settings.

To save your data and calculate solutions, choose Save Input Data & Calculate from the File menu, or click on the Save/Calc. button at the bottom of the screen.

Enter a filename of your choice, in the Save As dialog box, and click on Save. The next thing you will see is the graphics screen with Solution # 1 displayed.

The program calculates the bale size, then loads them directly into the truck. Your best solution will be the bundle size that best fills the container.
Display Pallet

Introduction

Display Pallet is designed to help you determine the best way to load multiple cases or trays onto a pallet. You can use standard cases, or any case or tray that you have designed in the Make a new Shape feature. You can also fill these packages with inner packs that can be bottles, bags or boxes.

You have two different loading patterns that you can use: Columns or Layers. Columns are useful when you need a load of different items that is shoppable. The layer method is useful when you need to send mixed loads, but you need to be able to stack them for shipping. In this tutorial we will enter the data for a column stacked load and then recalculate the same data using the layer method.

In addition, you have two different methods of loading.

Single Palletization is for building a single pallet display with as many of the packages in the load as possible. Order Fulfillment is for building loads to ship all the products requested in the load, regardless of how many pallets are required for the shipment.

In some situations, you might want to edit or modify a particular load, change the position of some of the cases or even add or delete certain items. For these purposes we have provided a series of load editors. There may be times when you
might want to build a load with special requirements that fall outside the normal “column” or “layer” calculations. Or you might want to build a load manually from scratch. To do this you can use one of the Display Pallet load editors.

Note: For further information on how to use this feature, please refer to the “Exploring the Pattern Editors” chapter of this user guide.

The Problem

Let’s imagine that we are a food manufacturer and a local supermarket has just faxed an order for 2 different beverages, as well as 3 different types of snack foods. They want to have a pallet that they can place directly onto the floor of their supermarket.

Considerations

Based on previous experience, you know:

- you must use a standard pallet base size, a US GMA 48x40 inches.
- fork-lift trucks can lift a maximum of 2000 pounds.
- you must use a 40-foot truck that has a 45,000 weight limit.
- you know the dimensions and weights of the packages as well as the arrangement of items inside the package.
- each product can only be loaded with the height dimension of the case vertical to the pallet.
- the customer does not allow any overhang on the pallet.
- you know the number of each product required for the customer’s order.
- you know the customer wants the products stacked in columns on the pallet to make it more “shoppable”.

After reading through the Exploring CAPE PACK chapter, you establish that you will need the Display Pallet program.

You can start the Display Pallet program from the Programs menu.
Or if you have your screen setup for Display Pallet, you can select the type of load you want, and whether or not you want trucks and then click on **Go**.

Display Pallet appears with your Default Settings already loaded.
Data Input

Before you start anything, you need to understand that you can either import the product details (case/tray sizes, weights, names, etc) from a Display Pallet database or you can enter the same details manually.

For example, you can start by importing the product details or entering them manually. Then deal with changing the Input Settings, entering a Product Name/Code, checking/specifying the pallet restrictions and, if necessary the truck/container information. Finally, choose the Calc. Settings you need. Then save your input data and get the answers. By always following the same procedure, the process will be faster and more efficient.

The first thing that you need to do is setup the parameters for you analysis. You do this through Input Settings.

Click on the Input Settings button near the bottom of the screen. Or you can use the Input menu and then choose Input Settings. The following screen appears.

Make sure the following items are marked: Packages Per Load, Objects onto Pallet into Truck, and in/lb. If you mark Show Package Descriptions on this screen, you must enter a description for every product in your load.

Click on OK.

You can also use the right-click options for these settings. Right click your mouse outside of the “spreadsheet” area to reveal the popup menu.

Next we’ll give the analysis a name. Click on the Product Name/Product Code button and a dialog box appears.
Enter **Supermarket Order** in the *Product Name* field.

Enter **2013-0001** in the *Product Code* field. Your screen should now look like this.

Now click on **OK**.

Now that you have defined the problem, you need to establish what type of load you want to build. Click on the **Calc. Settings** button. The following screen will appear with a variety of calculation options for your load.

**Optimization Type**

This is where you decide on the type, or purpose, of your load. You have 2 options, both of which can be in either a layer or column configuration.
Single Pallet Optimization

Single Pallet Optimization will provide you with a variety of loads that all get some (or maybe all) of the products on the pallet. These loads are often used for Club Store Displays.

Order Fulfillment

This type of optimization is designed to transport product from point A to point B. The program will load all the items in your load list and use as many pallets as are required.

Algorithm Type/Parameters

These options let you decide more specifically what type of load you want and which algorithm or editor to use.

Column Algorithm

Will build loads with only columns of boxes. The program will not allow mixed columns of product unless Allow Mixed Columns is marked.

Layer Algorithm

The program will build loads with layers of boxes, with the largest layer on the bottom of the load. When you select the Layer Algorithm, you will have access to 4 additional Layer Algorithm Restrictions at the bottom of the screen.

- Do Not Allow Mixed Top. This option will not allow the program to allow mixed top layers. When this is marked, the program will allow all layers to be mixed except the top layer.
- Do Not Allow Mixed Layers. This option will not allow any mixed layers in the load.
- Spread to Biggest Layer. The program will spread the upper level layers to the full footprint of the lowest layer on the load.
- Maximum Spread. The program will spread the bottom layer to the full size of the load including any overhang allowed.
Editors

There are three editors available to you for building your own loads from scratch. You can find more information about the editors in the *Exploring the Pattern Editors* chapter.

- Column Editor. Allows you to build loads with columns of boxes.
- Layer Editor. Allows you to build loads with layers of boxes.
- Mixed Load Editor. Allows you to build loads with some layers and some columns. This is hybrid type editor.

Packaging Loading Rules

These rules are established so that you can further enhance and define your loads based on specific restrictions.

No Loading Restrictions

The program builds the loads the best way it can with the algorithm selected.

Limit Column Height

This option enables you to limit the number of packages in a column. Use the **Max in Column** field on the Edit Package Screen to define the maximum height of the column for each box type. This option is not available for the Layer Algorithm.
Load Priority

This option prevents heavy objects from being placed on lighter objects. Specify your loading priority in **Load Priority** field on the Edit Package screen. The lower the number, the lower in the load the box will be placed. The higher the number, the higher the box can be placed in the load.

Make sure that **Column Algorithm** is checked.

Make sure **No Loading Restrictions** is marked. Your screen should look like this.

Click on **OK**. You are ready to start entering your data.

Packages Tab

Make sure you are on the tab labeled **Packages**. This is the tab that we will use to enter the items in our list.
Our default settings have a few cases already input and we will only be using the first one. Let’s delete the other three cases.

Click on package number 2 in the list and then on the Delete button. You will be prompted to verify the delete.

Click on Yes.

Repeat this process for each of the last two cases in the list.

Package 1 – Bagged Chips in a Case

Select box number 1 in the list and then click on Edit Package. The package details will appear.
The size of this case is correct, but there are other items we need to change. Tab to the Package Name field.

Type in Chips. Tab to the Weight field.

Enter 6 pounds for the weight of the box.

Tab to the Desired Min field. The Supermarket manager has requested 5-8 boxes of these chips. Enter 5 in this field.

Tab to the Absolute Max field and enter 8 here.

Make sure under Dimension Vertical that only Height is marked.

Your screen should look like this.

You will noticed that the Max. in Column and the Load Priority fields are grayed out. This is because we have not chosen to use a load restriction. To confirm this, you can click on the Calc Settings button to review your settings.
There are two additional options for stacking these packages. Must Not be Stacked on Base and Stacked Together. We will not be using these options for this case.

Click on the Fill Wizard button so we can enter our chip bag arrangement. The Fill Wizard window will open.

From the Pack Type list, select the Chipbag.csf shape.

Select Bag from the Pack Name list.

Select Divides Length from the Divider/Partition List and enter .1 for the Material Thickness.

In the Arrangement in Secondary Pack section, enter 2 in the length (L), 4 in the width (W) and 1 in the height (H) fields.

Make sure the Dim. Vert. in SP is Height.

Last, we will color our bags. Click on the Color menu, and Change Package Color.
Select a color and click on OK to update your bag’s appearance. Your screen should look like the following.

Click on Close to close the Fill Wizard, and then OK to return to the Packages tab. Your package list will be updated with your Chips package.

Package 2 – Boxed Crackers in a Case

Click on Add Package to enter the next item. The Add Package window will appear.

Select RSC Box from the Package Type list.

Enter Crackers in the Package Name field.

Enter dimensions as follows in the appropriate fields.

- Length: 12.5
- Width: 9.875
- Height: 13.75
- Weight: 13

Enter 10 in both the Min and Max fields.

Make sure only Height is marked for the Dimension Vertical.

Click on the color button and choose a color for your box that differs from the first package you entered.

Click on the Fill Wizard button and tab to Arrangement in Secondary Pack. Since this package is a carton, the defaults work fine.

In the Arrangement in Secondary Pack section, enter 5 in the length (L), 4 in the width (W) and 1 in the height (H) fields. Your screen should look like the following.
Click on **Close** to close the **Fill Wizard**, and then **OK** to return to the **Packages** tab.

**Package 3 – Candy Pouches in a Case**

For the next two packages, we will use the database and import some packages to save us time.

Click on **Import from Database**. The following screen appears.

Select **displaypallet.mdb** and then click on **Open**.

Click on the **Import** column next to packages number 1 and 3, and then click on **Import**.
Click on package number 3, and then on Edit Package. The Edit Package screen will open with package number 3.

Type in Candy and tab to the Label field.

Change the box color.

Enter 3 and tab to the Weight field.

Enter 15 pounds for the weight of the box.

Tab to the Desired Min field. Enter 8 for both the Min and Max quantities.

Change the default dimension vertical to Height only.

Select a color different from the first two packages. Your screen should look like this.

Click on the Fill Wizard button so we can enter our product arrangement.
From the Pack Type list, select the `bites.csf` shape.

Enter Candy for your Pack Name, and then tab to the Arrangement in Secondary Pack section.

Enter 3 in the length (L), 4 in the width (W) and 1 in the height (H) fields.

Click on the Color menu, and Change Package Color.

Select a color and click on OK to update your bag’s appearance. Your screen should look like the following.

![Image of Fill Wizard interface]

Click on Close to close the Fill Wizard and then the right arrow next to the package number area (3 of 4), to move to the next package.

Package 4 – Bottles of Lemonade

Type in 16 oz. and tab to the Label field.

Change your Package Color.

Enter 4 and tab to the Weight field.

Enter 12 pounds for the weight of the box.

Tab to the Desired Min field. Enter 6 for the Min and 8 for the Max quantities.

Change the default dimension vertical to Height only. Your screen should look like this.
Click on the **Fill Wizard** button so we can enter our product arrangement.

From the *Pack Type* list, select the **20ounce.csf** shape.

Enter **16 oz.** for your *Pack Name*, and then tab to the *Arrangement in Secondary Pack* section.

Enter 4 in the length (L), 3 in the width (W) and 1 in the height (H) fields.

Click on **Close** to close the **Fill Wizard** and then click on **OK** to return to the Packages tab.

**Package 5 – Cans of Coffee**

The last package is a tray that contains cans of coffee. Click on **Add Package** to add this package to the list.

Select **Tray** from the *Package Type* list, and type in **Coffee** for the *Package Name*.

Enter in 5 for the Label and tab to the dimension fields.
Enter the tray dimensions as follows:

Length = 12”

Width = 8”

Height = 8”

Weight = 13 lb.

Tab to the Tray Wall Height field and enter 4 for the height of the wall.

Tab to the Desired Min field. Enter 6 for the Min and 10 for the Max quantities.

Select a color different from the other packages

Change the default dimension vertical to Height only. Your screen should look like this.

Click on the Fill Wizard button so we can enter our product arrangement.

From the Pack Type list, select the cylinder shape.

Enter 3 lb. for your Pack Name, and then tab to the Arrangement in Secondary Pack section.

Select a 2-way Divider/Partition type and enter .1 for the material thickness.

Enter 3 in the length (L), 2 in the width (W) and 1 in the height (H) fields.
Click on Close to close the Fill Wizard and then OK to return to the Packages tab. Your Packages tab should now look like the following.

Pallet Information

Click on the Pallet tab which should be labeled 48x40.
This screen is similar to the Pallet Restrictions tab used in the Pallet, Arrange and Design programs. The two main differences are:

- The introduction of the **Center of Gravity** fields which can be activated through the **Input Settings** button. If you do not choose to enter this information, the defaults will remain in effect. You can change the default by activating the fields, entering your new data and then deactivating the fields. Finally, save as your Default Settings.

- The fact that Display Pallet only builds Column or Layer patterns.

Click on the down arrow next to **Pallet Base Style**.

For this example we will use a standard GMA pallet. From the list select **48x40 US GMA 4-Way Pallet**. Notice how the Pallet Dimensions are automatically entered for you.

Press the **Tab** key and the cursor will move to the **Maximum Overhang** fields. Leave these at **0** for this problem.

Move to the **Max Height** field under the **Maximum Load** section. Enter **50** in this field.

Hit the **Tab** key and enter **2000** for the **Max Weight** field.

Hit the **Tab** key and enter **500**. Check that your window looks like this.
Click on the tab labeled 53footer which is our default truck style.

In the Truck Style field choose 40 ft. long – High Cube. Notice how many parts of the Truck Internal Dimension field are automatically filled in with the values for your truck style.

In the Max. Weight field, enter 45000.

Make sure that Simple and Complex Loading Patterns are marked. Your screen should now look like the following.
Now that you have entered all of the information about the case, the pallet and the truck you want to see the results.

**Saving Data**

Click on the **Save/Calc.** button on any of the input screens. The Save As dialog box appears.

Make sure you have the Private folder showing in the **Save In** field. Type **Supermart** in the **File name** box.

Click on **Save**. The program automatically begins calculating solutions and assembling the diagrams for your problem.

When the calculations are finished you will see a new window, Multi-Viewer Graphics, showing solution number 1.

The program has calculated two solutions. It now displays the graphics for the first solution in the list. You have many of the same options in Display Pallet as you do in the single product programs.
Click on **Set-up Buttons**. This will display all the controls you need for setting up and creating your diagrams. Notice how the button now shows the **Quick Report**. This is used for displaying the solution information. You can toggle between the **Quick Report** and the **Set-up Buttons** just by clicking on this button. Click on **Quick Report** to bring back the solution information.

### Evaluating Results

You will be shown the corner view of the pallet, along with the side views and 2 top views. You can easily review the numbers in the upper right-hand corner. The Load Cubic Efficiency is shown as 76.2%, and the number of packages per load is 44. You can click on the **Solution Details** button to see the list of the items in the load.

![Solution Details]

Here you can see that the maximum number of boxes for this load was 44, and this load contains 44. If you want to review other solutions to see if there is a better load, you do this through the **Solution Report**.

### Comparing Statistics

Click on the **Solution Report** button.

![Solution Report]

The solutions are listed in descending order of cubic efficiency. Double click on any one of these solutions to review the graphics.

### Reviewing Graphics for Other Solutions

Although the results of solution number 1 appear perfectly satisfactory, you want to view other solutions.
Click on the right arrow button (→) on the menu icon bar. This brings up the next solution in the list.

Click on the left arrow button (←). This brings up the previous solution in the list.

Click on the **Jump to a Solution arrow** button. Enter a particular solution number, and click on **OK**. That solution number appears.

If a particular arrow button is gray you are at the first or last solution in the list. Click on the opposite button or the **Jump to a Solution** button to switch solutions.

---

**The Best Solution**

After analyzing the statistics and graphics you decide you like solution #1 best. It contains all of the packages we needed and has a very shoppable pallet pattern.

---

**Formatting the Pallet Load**

In order to achieve some level of stability this load requires a top cap and corner posts. CAPE PACK will be able to display all this for you. We will not be adding formatting to this load, but the following section explains the process.

---

**Adding a Top Cap**

Make sure you have highlighted the panel with the **Pallet Load** and then click on the **Set-up Buttons** button.

Next click on the **Format Load** button.

Click on the button labeled **Top Cap**. New fields appear in the bottom half of the screen.

Select the **200 lb B flute** material from your list and the information for Weight Thickness and Height will be filled in automatically for you. You can overwrite any of this information as needed.

You can set your own defaults for these values and for Layer Pads/trays and Corner Post from the **Tools** menu at the top of the screen.

Click on the button labeled **Accept Values**. A top cap will be drawn on top of the load.

---

Notice in the spreadsheet how the height and weight in the Product Dimensions have changed from the original calculations.
Adding Corner Posts

Click on the button labeled **Corner Post**. New fields appear at the bottom of the screen.

Again select the **200 lb B-flute** from the list to fill in the required information.

Click on the button labeled **Accept Values**. Four corner posts will be drawn at the corners of the pallet extending out over the cases by the amount you entered in the *Width* field. You will see the following screen.

Click on **OK** to accept all your changes and the Multi-Viewer Graphics will return with the updated diagrams and dimensions.

Loading the Truck

From the **Truck** menu, choose **Show my Truck**, or from the **Tools** menu, choose **Truck Analysis**.
You will then see a Truck Analysis Solution Report.

From this window you can evaluate different truck solutions. In our analysis, you like solution number 1.

Click on the File menu and select Save Current Load and Exit.

Your truck diagram will be placed in the last active panel in the Multi-Viewer Graphics. We had the Pallet Load panel (panel 1) highlighted, so the truck appears in the top left corner of the Multi-Viewer screen.
Sharing Data

The first thing you must decide on is the layout and set-up of the screen report and printout, i.e., the type and quantity of diagrams you want to show. You know that the production floor workers like to see the corner and side views of the pallet load. It is not necessary to see the contents of the secondary package, so you do not want to show this on the report. However, you also want to show the truck. Thus, you need to set up the report to show three diagrams.

Setting up the Screen

Click on the button labeled **Format Screen.**

![Format Screen](image)

Click on the button labeled 3. The Multi-Viewer returns with 3 diagrams.

![Multi-Viewer](image)

All we need to change is the view of the Pallet load in panel 2.

Click on panel number two, and change the **Diagram Type** to 48x40.
Next quick on the Rotation button and select 180 degrees. Your finished diagrams should look like the following.

Now that you have the Multi-Viewer Graphics configured with the layout and types of diagrams you want, you can manipulate the pallet load and the screen settings to show how it will look when it is ready for shipment.

Graphics Options

The following options are available for further enhancement of your on screen diagrams.

Showing Content of Cases

In addition to the standard graphic pictures of the pallet and truck loads, you can also choose to show the contents of your cases. Right click on any of the boxes displayed in separate panels of the screen and select Show Content from the list.

A cutaway of your case will be displayed in this panel and every panel that shows a view of that case.
This procedure can be completed as needed to show contents of additional cases.

Showing Labels

To use the labels you entered as identifiers in your graphics, click on Set-up Buttons, then the Control Panel button. Some new controls will be revealed.

Click on Show Label to turn on this feature.

Showing Outlined Boxes

To use the labels you entered as identifiers in your graphics, click on Set-up Buttons, then the Control Panel button. Some new controls will be revealed.

Click on Show Outline to activate this feature.

Showing All Four Sides of the Load

You have the ability to show each individual side of the load in a separate panel to. Click on the View menu, All Side Views, and then Show All Side Views.
Your screen will appear like the one below. Each side will be labeled. The labels are fixed in location and verbiage and cannot be modified.

Build-Up View

The Build-Up View show four separate views of the pallet, one per panel. The first view is 25% of the load, the second is 50%, the third is 75% and the last is the full load. Each view is labeled and the labels are fixed and cannot be moved or modified.

To access this view, click on View, Build-up View and then Show Build-up Views.
Your screen will appear like the following.

To reverse this, click on **View**, **Build-up View**, and then **Restore Views**.

**Page Setup**

Many of the Page Setup features are the same as the main program groups. Here is the Page Setup screen.
Using this option and the other tabbed screens you can set up margin sizes, the date (on/off), whether you want the top specification, user text, if you want to use a logo on the printout and the quality and color of printing. There is also a feature called Border Adjustment that will turn off borders around the text tables of the report.

Printing the Graphical Report

Now that you have formatted the screen to meet your specific requirements, you can print a report.

From the File menu, choose Print Preview. A window will come up showing you how the printout will look.

Use the scroll bars to scroll around the entire page, or use the Zoom controls.

If everything looks okay, click on the Print button.

Exporting CAPE Reports

You can use the Edit menu to take the diagram or a full CAPE report to the Windows Clipboard. Or you can use the Export menu to export graphics files or text/numerical information. You can also Export your CAPE PACK Reports directly to Adobe PDF format using this menu.
Emailing Results

Make sure you have the pallet load highlighted.

Select the e-mail menu option and click on email Full Report, and then select either the JPEG or PDF option.

![Email Full Report](image)

This will automatically export the report or diagram as the chosen file type and open your email program. You will see that an email has been opened and that the JPEG file has already been attached. All you have to do is enter the name of the recipient, add or change any text and send the email!

Calculating Loads with Layers

Let's see what our example will look like if we use layers rather than columns.

Click on the Back button to return to data entry.

Let's change our product quantities a bit. Click on package number 1 and then Edit Package.

![Edit Package](image)

Change the Absolute Max quantity to 15.

Now go to package number 2 and do the same thing.

Repeat this process for each of the 5 boxes and then click on OK. You should see the 15 in the Max column for each of the packages on your Product tab.
Click on the **Calc. Settings** button.

Select **Layer Algorithm**. Your screen should look like the following.

Now click on the **File** menu and **Save As Input Data & Calculate**.

Enter a new name and click on **OK**. Your layer load will appear after calculations have completed.
Let’s take a look at load number 2.

This is a nice stable load with even layers so we will choose this one. Here is the load in Truck Analysis.
Database Import

In addition to using your databases to update your load files, you can also use your open analyses to import records into your databases. The following tutorial will walk you through this process. This process works with CLF files as well as the older CL2 files.

On the Display Pallet data input screen, click on File, Open Input Data.

Open the last file you created, Supermart.clf.

Now let’s create a new database and import these three records.

Click on the Database menu and then Create New Package Database.
Name your database **Tutorial**.

Click on **Save** and your empty database will appear.

Next click on the **File** menu and then **Import Package(s) from Analysis**.
A screen will appear listing the items in the load. Select each item by clicking in the Import column for that item.

Click on **Import** to add the items to your database.
Close the database by clicking on **Close**.
Exploring the Pattern Editors

Introduction

With an almost infinite number of possible case sizes and the many different pallet pattern styles available within the CAPE PACK palletizing calculations, there are literally hundreds of ways of arranging cases onto a pallet layer.

The palletizing algorithms have been designed to find the maximum number of cases per layer. However, you may decide that the positioning of the cases or the nature of the pattern interlock is not the most appropriate or stable for your production or handling system. This is particularly true when the "case length to case width ratio" is 2:1 and numerous pairs of cases can be turned 90° to provide many different pattern styles.

To overcome this particular problem and other potential pattern layout problems, CAPE PACK is supplied with powerful 3D Pattern Editors – Layer Editor for the single product programs and Load Editors for Display Pallet.

Layer Editor

The Layer Editor provides a simple, yet very realistic, way for you to move, rotate and reposition cases within a single pattern layout to suit your exact needs. You can also add or delete layers from a pallet load.

Alternatively, you may wish to use the Layer Editor to edit the layout of the cases to produce different layers with the same number of cases per layer.

Either way, the Editor allows you to modify a pattern layer quickly and then construct your full pallet load.

Once a pattern has been edited it can be reviewed in an on-line mode in the Multi-Viewer Graphics. The pattern can then be saved and recalled at a future date.

You cannot edit layers in the Layer Editor if you have chosen either None or No Package as your package type.

Editing Layers

Select Layer Editor from the Edit menu in Multi-Viewer Graphics.

The Layer Editor consists of a top-view Pattern Editor on the right hand side of the screen and the ability to view the pallet load in a 3-D Viewer on the left-hand side.

You can select the Editor window by clicking on the little circle marked Edit.
The Editor window displays a top-view of your selected pattern. This window is used for editing and manipulating the cases within the layer pattern.

The Viewer window is used to look at the layer pattern in the load you are editing. Thus, you can see the changes you make to the layer pattern as they happen simply by choosing Edit or View. You can also use the Viewer window to examine your edited pattern in a variety of different formats.

If you select Edit, the screen changes to the editing mode with just a single layer in the viewing box.

The Layer Editor Window always displays a single layer, top-view of the pallet pattern. If you need to create an alternate layer that is not a normal alternated or flipped layer, you can create a second layer pattern.

**Viewer Toolbar**

In addition to the standard pull down menus, the Layer Editor provides a convenient set of buttons for accessing the most commonly used Viewer Window options. Here is a description of the Viewer Toolbar functions.
0°  Sets the viewing orientation to 0°
90°  Sets the viewing orientation to 90°
180° Sets the viewing orientation to 180°
270° Sets the viewing orientation to 270°

1  Shows side 1 of the load
2  Shows side 2 of the load
3  Shows side 3 of the load
4  Shows side 4 of the load

New  Allows an existing pattern to be used to create an entirely new pattern
Copy  Duplicates a pattern, creating an additional layer
Up    Moves a selected layer up in the pallet load
Down  Moves a selected layer down in the pallet load
Delete Deletes the highlighted layer in the list box
Flip  Allows the pattern to be flipped in the length, width or both directions

Selecting Cases
The Layer Editor uses a Windows technique for manipulating objects on the screen. This allows you to treat a case as if it were a real object. You can pick it up, rotate it or slide it around. There is also the ability to move several cases together (a “block of cases”) as if they were a single case.

However, the Editor options which manipulate cases affect only the selected item in the load. A selected item is indicated with a large X drawn on top of it.

Selecting a Single Case
To select a single case move the mouse cursor over the case you want and click on the left mouse button.
Selecting a Block of Cases

A “block of cases” is a group of cases stacked together in the same orientation. This method provides a very effective and efficient way to perform editing functions on more than one case at the same time. This feature eliminates the need to do things repetitively.

Press and hold down the **Shift** key, place the cursor over the first case you want to select and press and hold the left mouse button.

Now drag the mouse pointer to the last box to be included. The dotted line you are drawing is called the Selection Rectangle.

Release both the mouse buttons and the **Shift** key. The block becomes selected.
Having selected a block of cases, you can now use any of the available Editor functions. An X drawn through them indicates the cases included in the block. This technique is sometimes referred to as “elastic banding”. Only those cases that are near to one another and are in the same orientation can be selected into a block.

### Moving Cases

Moving a case or block of cases is a simple process. After you have selected a case or block of cases, click and hold down the left mouse button and move the pointer to the position where you want the case/block of cases to be placed.

Select the case or block of cases.

While pressing down the left mouse button, drag the box to the required position.
Release the mouse button to stop the movement of the case or block of cases.

**Lifting Cases**

This lifting technique is similar to moving a single case but requires you to press and hold both mouse buttons at the same time and then drag to the new location.

Select the case with the left mouse button, now hold down both the left and right mouse buttons together.

Drag the case to the required position.
Now release both mouse buttons to drop the case into the required position.

You cannot lift a case if another case is above it. However, you can slide the case or block of cases from side to side if there is sufficient room available.

---

### Rotating Cases

The Editor provides the ability to rotate individual cases.

Select a case, using your mouse.
Press the **right or left arrow keys** on your keyboard to rotate the selected case in the direction you require.

If there is not enough room to rotate the case where it is located, the program will lift it up over the cases near it and turn it.

### Creating New Layer Patterns

The Layer Editor allows you to create as many layer patterns as you like with a different layout to that of the first layer pattern. This option allows you to create unique alternate layers that will make up your final pallet load.

Most users will not need a unique second pattern since they simply want all their layer patterns to be the same layout as their first pattern, just flipped in a particular fashion.

If you do want your alternate layers to have a different pattern layout you will need to create a new layer pattern before you exit the Editor.

Once you have completed editing and creating your first pattern, click on the **View** selector, and then the **New** button. The following box appears.
You can select a new layer pattern from the list provided (P001, P002, etc.) by selecting the “Use PXXX” feature.

Or you can create your own new layer based on one of the patterns in the list. Click on the layer of your choice and then the Create button.
Either way, once you choose, the control returns to the Editor. As you create new layers, you will notice that your pallet load grows. If you do not want to expand the height of your pallet, simply use the Delete button to delete the unwanted layers.

Select **Edit** to change the pattern of your choice.

When you have completed editing your second, third, fourth (or however many different layers you want), you can select the View mode to review your load or move layers up/down.
When finished, select **Close** from the **File** menu. The following screen will appear.

Click **Yes** to save your changes, **No** to exit without saving or **Cancel** to return to the Editor. If you select **Yes**, you will be returned to Multi-Viewer Graphics and you will see the pallet load with your edited layers.

**Adding Cases**

Just highlight one case by clicking on it.
Then hold down the **CTRL** key and click on the case again. This will automatically add one case on top of the highlighted case.

Now move the new case to the chosen location.
Expanding Overhang

Click on the **Options** menu and then **Reset Overhang**.

The following screen appears.

Enter in the total amount of overhang you want in the length and width and click on **OK**. The pattern will reappear with a border around the layer that represents the new boundaries of the load.

The program will retain the last overhang amount entered as the default.
Make whatever changes you need and then exit the Layer Editor. The load will automatically center when you exit back to Multi-Viewer Graphics.

If you don’t want the load to center, click on the Options menu and Do not center pattern on Exit.

Deleting Cases
Just highlight a case and hit the Delete key on your keyboard. The case will be removed.

Deleting Layers from your Load
Click on the View field and you will see the full pallet load.
Highlight a layer and click on the **Delete** button.

The pallet now has one less layer.

**Copying Layers**

To copy a layer, click on the layer in the list you want to copy and click on the **Copy** button.

The Editor will make a duplicate of that layer.

**Moving Layers up or down in the load.**

To move a layer up, click on the **Up** button. The layer will move up 1 level for each click on that button.
To move a layer down, repeat this process using the **Down** button.

---

**Display Pallet Load Editor**

The Display Pallet Load Editors are powerful program utilities that allow you to create and edit different loads. These special Editors allow for adding or deleting packages, building or moving individual or blocks of boxes on the pallet and generally creating a load as if you were physically placing the boxes onto the pallet.

The Editors use simple drag-and-drop techniques to give natural control over the placement of the boxes within the load. A number of additional features are available for you to quickly and easily customize your pallet load. Once you have finished editing/building your load, the results can be printed or saved.

You can choose the Display Pallet editors in two ways:

- You can start with an empty pallet and build your own load. Choose to start with an editor via the **Calc. Settings** button. If you choose this option, the program will not calculate any loads for you automatically. It will take you directly to the selected editor option when you select to calculate the load.
• You can calculate your loads, go to the on-screen graphics and use the editors to customize or modify the layout of the case/trays in your pallet load.

Calculation Settings Button

• To access the Editor from the **Calc. Settings** button and use it to totally design your load, click on the **Calc. Settings** button.

The following screen appears.

Click on the Column Editor, Layer Editor or Mixed Load Editor selector. Then click on OK.
Choose one of the calculate options from the **File** menu. You will be presented with an empty pallet ready to start building.

To access the Editor from Multi-Viewer Graphics after Display Pallet has calculated solutions for you, select the load you wish to edit.

Click on the **Edit** menu, then **Load Editor**.

The Load Editor window will open.

For simplicity in this chapter, the word “boxes” will be used to describe boxes, cases and trays of products.
Editor and Viewer Windows

Notice the Load Editor has two open windows.

- The Viewer window is used to look at the load being edited from a variety of angles, with or without the labels, control faces or box types.

- The Editor window is used for manipulating, adding or deleting boxes. Boxes cannot be selected in the Viewer window. It is for viewing only.

Viewer Toolbar

In addition to the standard menus, the editor provides a convenient toolbar for accessing Viewer window functions. The toolbar resides on the left side of the Viewer window. The following table provides a summary of these functions.

| 0° | Sets the orientation to 0 degrees corner. |
| 90° | Sets the orientation to 90 degrees corner |
| 180° | Sets the orientation to 180 degrees corner |
| 270° | Sets the orientation to 270 degrees corner |
| 1 | Shows side one of the load |
| 2 | Shows side two of the load |
| 3 | Shows side three of the load |
| 4 | Shows side four of the load |
|   | Toggles between color and outline modes |
|   | Turns the labels on and off |
|   | Turns the control faces on and off |
|   | Turns the types on and off |

Editing Loads

The editor supports a Windows technique for manipulating objects called “drag-and-drop.” This technique treats a box on your screen like a real object. The object can be picked up, stacked, slid around, duplicated or even deleted. Other features supported in the editor include:

- The ability to manipulate blocks of boxes as a single box.

- The option to automatically create a full stack of boxes from a single box.

- The ability to rotate a box or block.

- A range of useful editing and viewing techniques.

A block of boxes is defined as a group of boxes in the same orientation and which are stacked together. A block can be created by using the selection rectangle procedure described in this section.
Selecting a Box

Each of the functions in the Editor, which allow manipulation of a box or block of boxes, will affect the selected item in the load. Just select a box (case or tray) or block and then perform the desired function on it.

Click on the box using the left mouse button. The selection status of an item is illustrated by the following pictures:

![Unselected item](image1)
![Selected item](image2)

Selecting a Block of Boxes

Sometimes a function, such as Move or Copy, will need to be performed on a group of boxes simultaneously. Multiple box selection is easily accomplished by using the “Selection Rectangle” feature.

In the Column Editor, blocks can be selected which extend in three dimensions. For example, the number of boxes that make up a block could be one box wide, three boxes long and four boxes deep, for a total of 12 boxes selected (1 x 3 x 4). Since loads made up of layers consist of separate layers of boxes (cases/trays), blocks cannot be selected with more than a depth of one box in the Layer Editor.

Press and hold down the Shift key.

Click and hold the left mouse button on the first box in the block and drag the mouse pointer diagonally to the last box to be included. The mouse pointer becomes a cross-hair indicator. A dashed rectangle should be drawn over the boxes as the mouse is moved.

Release the mouse button and the Shift key. The Editor will automatically select the largest block possible within the given rectangle. The boxes that were included in the block will now be shown with a diagonal selection mark (or cross).

The editor will select the largest block possible. All the boxes to be defined as a block must be of exactly the same type and orientation. In order to define a block, all the boxes must be touching or stacked together as a group.

To determine how many layers deep the selection covers, refer to the list box in the upper-left corner of the Editor Window. Remember that blocks can be selected with a depth greater than one only in the Column Load Editor.

The list box above indicates that 8 layers are selected in the block. Simply selecting a different number from this list box can change the number of layers selected in the block. For example, if (2) is selected from the list box, the block automatically becomes only two layers deep.

Once a block has been selected, the usual editing functions are available.
Placing a New Box onto a Pallet

Make the Editor window active by clicking in it.

From the View menu, choose Select Box.

From the resulting small window, click on the type of box and orientation desired.

Copying a Box or Block

Making a copy of a box or block is very easy. The procedure is similar to that for moving an object, except that the Ctrl (Control) key must be held and kept down before selecting the box or block.

Identify the box or block to be copied, then press and hold down the Ctrl key, and click on the box or block.

Release the Ctrl key and the left mouse button. The new box or block will appear on top of the original box or block.

Moving a Box or Block

Moving a box or block is a natural extension of selecting the object.

Once the block has been selected, click and drag the block to the new location.

When the block is in position, release the mouse button.

Lifting a Box or Block

The process of lifting a box or block is similar to moving the object. However, instead of clicking and dragging with the left mouse button, use both mouse buttons at the same time to lift the object.

Click on the box or block to be lifted with both mouse buttons.
Drag the block to the new location and release both mouse buttons.

A box or block cannot be lifted if there is another box or block above it.

Creating Gaps within a Block

To create evenly spaced gaps within a block of boxes:

Select the block to be gapped.

Move the mouse pointer to the edge of the selection. It will turn into a **double-headed arrow**.

When the arrow is double-pointed, hold the left mouse button and drag the mouse outwards.

When the left mouse button is released, the boxes will be spread out with even gaps between the boxes.

Function Keys in the Load Editors

The options listed above give the power to create and modify pallet loads to meet defined specifications. The Editor, however, provides a number of function keys that make the creation of loads even easier. Here is a description of those function keys.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Up</td>
<td>Creates a stack of the maximum allowed height from the selected box (case/tray).</td>
</tr>
<tr>
<td>Page Down</td>
<td>Reduces a selected block to a single box in height.</td>
</tr>
<tr>
<td>Left Arrow (←)</td>
<td>Rotates the selected object 90° in a counter clockwise direction. There must be space available for the box in its new orientation.</td>
</tr>
<tr>
<td>Right Arrow (→)</td>
<td>Rotates the selected object 90° in a clockwise direction. There must be space available for the box in its new orientation.</td>
</tr>
<tr>
<td>Up Arrow (↑)</td>
<td>Adds one box to the selected block if space is available.</td>
</tr>
<tr>
<td>Down Arrow (↓)</td>
<td>Removes one box from the selected block (down to one).</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected box or block from the load.</td>
</tr>
<tr>
<td>Shift</td>
<td>Used with the mouse to select the block within the selection rectangle.</td>
</tr>
<tr>
<td>Ctrl (Control)</td>
<td>Used with the mouse to copy a box or block.</td>
</tr>
</tbody>
</table>

Fine Tuning Movements

To fine tune any movements of boxes or blocks:

Select a box or block.

Press and hold the **Alt** key, then use the four arrow keys to move the selected box or block.

The selected object will jump to the next adjacent box or intersection of boxes. This method makes it easy to ensure that the object is lined up precisely with the other boxes already on the pallet.

Up and Down Buttons

The up and down arrow buttons pictured below have different functions depending upon which Editor is being used.
UP Arrow

- In the Layer Editor, this button will make the next higher layer active.
- In the Column Editor, this button will build all stacks in the load to the maximum height allowed according to your specified maximum load height.

DOWN Arrow

- In the Layer Editor, this button will make the next lower layer active.
- In the Column Editor, this button will reduce all stacks in the load to a single box high in each column.

Load Restrictions Violations

When saving a load, the Editor automatically checks the load for conformity to the restrictions and specifications defined for the current problem. If the load violates any of the problem restrictions, a window detailing the violations will appear. This feature stops you from creating unrealistic loads that do not abide by your specified loading requirements, i.e. maximum weight and height restrictions.

The violations listed are of two types:

- Blue violations are warnings that the load you have created differs from your original specifications or restrictions. The edited load can still be saved.
- Red violations are far more severe; a load cannot be saved which contains any red violations.

At any time during the creation of a pallet load, you can check the load for conformity by selecting View Restrictions from the View menu and looking at the information provided.

Layer Editor Dialog Box

Since loads made up of layers often require different characteristics from column or mixed loads, the Layer Editor dialog box is only accessible from the Layout menu when you are in the Layer Load Editor.

Select the Layout menu, then Layer to display the following window.

This feature offers a variety of functions that can help you modify and arrange layers within the load. Here is a list of the button functions available.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new layer and makes it the active layer.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected layer and makes it the active layer.</td>
</tr>
<tr>
<td>Up</td>
<td>Moves the selected layer up one position on the pallet.</td>
</tr>
</tbody>
</table>
### Menu Options

Many additional editing functions are available from the toolbar menus at the top of the window. These are described below.

<table>
<thead>
<tr>
<th>File Menu</th>
<th>Print</th>
<th>Allows the setting of printing options and printing of the load displayed in the Viewer and Editor windows.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Print Preview</td>
<td>Displays a scaled version of the Viewer window as it will appear on the final printed output.</td>
</tr>
<tr>
<td></td>
<td>Print Setup</td>
<td>Allows the selection of printer configuration options available for your printer driver.</td>
</tr>
<tr>
<td></td>
<td>Save and Update</td>
<td>Saves the load currently being edited using the same filename that load had (prior to entering the Editor). This method saves your changes over the original load.</td>
</tr>
<tr>
<td></td>
<td>Save as New Load</td>
<td>Saves the current load being edited using a different filename from the one loaded into the Editor. This method does not change the original load information.</td>
</tr>
<tr>
<td></td>
<td>Close</td>
<td>Quits the Load Editor and returns to Display Pallet.</td>
</tr>
<tr>
<td>Layout Menu</td>
<td>Clear All Boxes</td>
<td>Deletes all of the boxes on the pallet. You cannot get the boxes back once they have been deleted unless you leave the Editor.</td>
</tr>
<tr>
<td></td>
<td>Layer</td>
<td>Shows the Layer Editor dialog box for manipulating layer loads.</td>
</tr>
<tr>
<td></td>
<td>Columns to Min</td>
<td>Reduces all columns in the load to a single box in height.</td>
</tr>
<tr>
<td></td>
<td>Columns to Max</td>
<td>Builds all columns in the load to their maximum height.</td>
</tr>
<tr>
<td></td>
<td>Center Load</td>
<td>Allows you to center the load, as edited, between sides 1 and 3 of the pallet, sides 2 and 4 of the pallet, or both.</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
<td>Moves the active layer or column as far as possible to either the left, right, top or bottom sides of the pallet.</td>
</tr>
<tr>
<td>View Menu</td>
<td>Select Box</td>
<td>Displays a window containing the box types (cases, cans/bottles/cartons in trays etc.) that were defined for the current problem. Select a box for placing in the load.</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td>Turns the status bar at the bottom of the Editor on or off.</td>
</tr>
<tr>
<td></td>
<td>View Restrictions</td>
<td>Checks the current load for violations of the load restrictions and specifications you defined for the current problem.</td>
</tr>
<tr>
<td></td>
<td>Statistics</td>
<td>Displays a spreadsheet of statistical information about the load.</td>
</tr>
<tr>
<td></td>
<td>Auto Update</td>
<td>Turns the automatic update status of the Viewer window on or off.</td>
</tr>
<tr>
<td>Window Menu</td>
<td>Cascade</td>
<td>Arranges the open windows in a cascade fashion.</td>
</tr>
<tr>
<td></td>
<td>Tile</td>
<td>Arranges the open windows in a tiled fashion. This is the default mode.</td>
</tr>
<tr>
<td></td>
<td>Editor</td>
<td>Makes the Editor window active for manipulating boxes.</td>
</tr>
<tr>
<td></td>
<td>Viewer</td>
<td>Makes the Viewer Window active for showing different angles of the edited load.</td>
</tr>
<tr>
<td>Help Menu</td>
<td>Contents</td>
<td>Opens the Display Pallet Load Editor on-line Help system.</td>
</tr>
<tr>
<td></td>
<td>About Load Editor</td>
<td>Displays information about the current Editor.</td>
</tr>
<tr>
<td>File Menu</td>
<td>Print</td>
<td>Allows the setting of printing options and printing of the load displayed in the Viewer and Editor windows.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Displays a scaled version of the Viewer window as it will appear on the final printed output.</td>
<td></td>
</tr>
</tbody>
</table>
Casefill Group – Case Consolidation

Introduction

Casefill is a type of case consolidation program. Imagine that you have 20 or 50 different cases sitting on the floor and a colleague gave you a carton and said, “How many of these can you fit into each case and how many will we get on a pallet?”

That’s what Casefill is for. It lets you look at how to use your existing secondary package (case/tray) sizes for packing and distributing any size primary package.

Even the largest companies will be looking to maintain relatively few standard case sizes, which could ultimately hold the majority of their products. Typically the 80/20 rule (80% of revenue generated by 20% of the product range) governs which case sizes are likely to be retained. These cases, in addition to the industry standard modular case sizes, will probably form your initial database entries, but each company will have different needs.

This approach can produce both financial and logistical benefits. These benefits include reduced inventory of cases and longer runs for the case supplier, resulting in a better unit price. In addition, less pallets have to be handled and stored. This sort of increase in overall efficiency reaches a very significant level when you incorporate the use of modular case sizes designed to fit onto standard pallets (e.g., 16 x 12 inches cases on a 48 x 40 inch pallet).

The methodology behind Casefill is that you create a database of existing secondary package/case sizes by entering or importing the appropriate dimensions into CAPE PACK. This, in turn, creates the information base of individual secondary package/case and pallet records. It then becomes the reference point for the analyses using the other CAPE PACK programs to consider a range of quantities of a fixed primary package.

To simplify descriptions and the terms used in the remainder of the Casefill section, secondary packages will be referred to as cases.

Because the three Casefill programs are similar, this chapter will refer to the Casefill – Cartons/Bags/Ovals - Fixed program (meaning fixed size rectangular or square shapes).

From the Casefill Group section of the Front Menu, choose Carton from the Type of Pack drop down list and click on Go. Or you can use the Programs menu to select the group and module you want to use.
The first data input screen will appear with your Default Settings loaded.

![Image of data input screen]

All of the normal CAPE PACK menu options are available here. You can build your own list of Material Thicknesses and Pack Names, Change Package Color, Change to Original Colors, Set Custom Colors or Add 3D Graphics.

### Casefill Databases

To understand how Casefill works you must be aware of the database from which it draws the case and pallet information. You will need to build your own database, or any number of different databases. For more information on the Casefill Database features, please refer to the *CAPE PACK Databases* chapter of this user guide.

For getting started in Casefill we have provided a small database. You can use this one to run the tutorials in this chapter.

### The Problem

To run Casefill, you must first open a database. Once you have opened the appropriate database you can begin to enter the data for your analysis.

### Input Settings

Click on the **Input** menu **Input Settings** option to establish the parameters for your analysis.

Or you can use the **Input Settings** button, or the right click options. The following screen appears.
You have the following options.

- **Bulge Allowed:** If you turn this on, then three additional fields appear on the input screen for you add a bulge factor to the *Length*, *Width* and *Height* of the primary pack. You can also allow Bulge by percentages.

- **Additional Weight:** This field adds an additional weight field to your screen for items that are not included in net weight but need to be included in gross weight. This could represent the weight of a informational insert or perhaps a promotional item.

- **Slack Allowed:** The total amount of extra space to be allowed, in each dimension. Minimum slack reduces the effective inside case dimensions used in the Casefill calculations. If you click on this option the screen will add three extra fields.

- **Case Count Type:** Here you can select a Min/Max for the Fill Restrictions screen, or you can specify 8 individual case counts. You can also select to fill to the maximum cube of the case.

- **Units of Measure:** You can choose between using either Metric or English.

- You will also have a recessed option if you are using the Cylinder program of Casefill.

For this tutorial, make sure your **Input Settings** screen looks like the following.
Product Name and Code

Choose either the **Input Product Name/Product Code** button on the **Input Settings** screen, or the one at the bottom of your data input tabs. A window appears.

![Input Product Name/Code](image)

Enter your **Date of Analysis**, **Product Name** and **Product Code** and click on **OK**. You are now ready to start your data entry.

Primary Package Information

The first data input screen has many of the same features and menus as the Pallet, Arrange and Design programs.

![Primary Package Information](image)

**Select Pack Type**: Select the type of primary package from the list box available. We are using an **ECO Seal** carton.

**Select Pack Name**: Select a name from the list box or enter your own package name. We are using the name **Carton**.

**Number per Pack**: Enter the value 1 if you are dealing with individual products. This numeric field also allows you to work with a bundle package of individual items together. For example, if 10 items are bundled and assembled with other bundles, you can enter 10 in the field and then enter the dimensions of the bundle on the Primary Package tab. This will let the program tell you how many individual items are packed per case and per pallet.

We are working with a single carton so this input should be set to 1.
**Enter Pack (OD) (Length, Width, Height):** Enter the outside dimensions of the primary pack. We are using dimensions of 3.5” length, 3” width and 4” height.

**Set Pack Dim vertical:** Specify which orientations of the bundle or package you can allow vertical relative to the case. We are allowing both the **Width** and **Height** vertical.

For **Slack** we will enter .125” in both the **length** and **width** of the case. No slack is needed in the height dimension.

**Gross Weight:** This is for entering the total weight of the product and the primary package. Enter **0.15** pounds.

**Net Weight:** For the weight of the product excluding any weight of the packaging materials. Enter **0.1** pounds. Your completed screen should look like this.

For **Additional Weight**, enter .01 for an information insert.

### Fill Restrictions

Click on the Fill Restrictions tab.
Maximum Case Weight: The maximum weight allowed for a single case, including all the primary packages inside the case plus the weight of the case itself. Enter 50 pounds.

Select Pattern Types to Use: Casefill actually builds pallet patterns inside the respective case sizes within the database. The valid styles of primary package arrangement are:

- **Simple** corresponds to the Column and Interlock palletizing styles.
- **Medium** corresponds to Trilock and Diagonal.
- **Complex** corresponds to Spiral and Expanded Spiral.

Thus, when you calculate the number of items per box, a number of different patterns can be considered. We will use all of the pattern types. So click them all to turn them **On**.

Enter Min/Max Case Count: This field is for the minimum and maximum number of units or bundles that can be placed inside a single case. We can allow a minimum of 10 and a maximum of 100 items per case. You can also choose to specify 8 individual case counts on the Input Options screen.

Min Fill Efficiency: This number is based on the total volume of the filled case.

Total Records in Database: In this area, you have three choices.

- All Records will use all the cases in the active database for the analysis.
- 10 x Records allows you to choose 10 specific record/case numbers to use for your analysis.
- Record Block allows you to choose a block of record numbers to use (i.e. record 9 through record 18).

Enter Palletizing Details: Here you have two choices. You can either select **All** of the pallet sizes, or you can specify one footprint that you want to consider. A value in this field ensures that only records in the database with matching pallet length and width footprints are considered in the analysis. If you wish to use all pallet sizes, then click on the **All** option.

Allow Multi-Dimensional Solutions: Casefill can consider more complex options such as two or more primary package dimensions vertical in the case. Turn this option on.
Allow Maximizer Solutions: Casefill can use the Maximizer program to arrange different columns of product to use empty space in the carton.

We cannot use this option and the Multi-Dimensional Solutions option in the same analysis. Turn this option off. Your completed screen should look like this.

Saving Data

Either click on the Save/Calc button on the Carton tab, or select the File menu and choose the Save As Input Data and Calculate option.

You may be asked to select the Casefill database that you wish to use.
Select from the list and click on **Open**.

When the Save As dialog box appears, enter a file name and click on **OK**.

If you have not previously opened a database, you will first be prompted to select a database to use.

The calculation process will begin. You will be presented with a screen to select dimensions vertical.

Click **OK** on this screen and your solution will appear.
Reviewing Graphic Solutions

When the calculations have been completed, the Multi-Viewer Graphics screen will appear.

This shows a three-dimensional view of the case and its contents, a top view, side views and the primary package itself.

Reviewing Statistics

Click on the Solution Report button.
The solution with the maximum number of packages per load (Total Count) will be highlighted for you.

The Solution Report shows the cases from the database and their associated statistics. If you allowed Multi-Dimensional solutions in your input, every other line of data (excluding case name field) represents the Multi-Dimensional variation for the case immediately above. If this option was disabled, these lines would not be on the report. If the Multi-Dimensional Solution finds a result that falls outside the minimum-maximum primary range, the line will show zeroes for case count, etc.

The name under Case Name is the case name of the record in the database. The case length, width and height dimensions are Inside Dimensions as they appear in that record in the database.

The Pat Type field (Pattern Type) corresponds to the C,I,T,S,D, and X filling patterns.

The #Per Case shows the number of unit packages per case (falling within the min- max range specified).

The Cube Eff. figure (Cube Efficiency of the contents in the case) indicates the utilization of the total case capacity.

The Total Count column shows primary package calculations based upon the number of cases per pallet entry in the database. This is applied as a straight multiplier to show total units per load. The Total Count value is based on Cases per Load x Unit Packages per Case x No. of items per Unit Pack.

The Load Weight (exclusive of pallet) column shows the weight of each case multiplied by the number of cases per pallet. The number of cases per pallet is taken from the record in the database.

The DV field identifies the primary package Dimension Vertical for this solution (i.e., L for Length, W for Width or H for Height).

Expanded Solution Report

At the Solution Report, click on the Options menu.

Now click on the Expand option. This report shows all the patterns available, within the case, for your selected solution.

To bring up a multi-dimensional analysis diagram, go to the Normal Solution Report.

Go to Solution number 12 and double-click on the solution with pattern type MD.

The MDA Loading Order screen will appear.
The message on this screen is self-explanatory and is suggesting that the layers with different dimensions vertical should be stacked in order of area efficiency. If you want to change the order of the layers just reset the length, width or height in the order you require.

We will accept the default setting for now. Click on OK.

To change the order in which the layers have been built, repeat this process. You must use Upper Case letters in these boxes.

Formatting Diagrams for your Report

The normal Format Screen, Format Panel, Format Load, Format Object and menu options are all available.

Some of the items in the Diagram Types and Diagram Views have been disabled, as they are not applicable to Casefill.

Print, Print Preview and any Custom Documents can be accessed from the File menu. The other menus are the same as for the Pallet, Arrange and Design programs.
Palletizing in Casefill

We have added the ability for you to calculate pallet loads for Casefill to replace the old imported pallet load.

After calculating, click on the Tools menu to access this feature.

The standard CAPE PACK palletization screen appears with all the normal palletizing options.

Make your changes as required and click on the Calculate button.

Options to palletize your case appear on the screen.
Select the load you wish and then close this screen to update Multi-Viewer Graphics. All normal viewing and load formatting options are available.

Using Other Shapes in Casefill
You can use any appropriate shape created in the Make a New Shape feature. Here is an example with oval bottles.

Casefill for Cylinders
This option operates in a very similar fashion to the standard Casefill for cartons shapes described above. The essential differences are:

- You are dealing with cylindrical objects instead of rectangular boxes.
- The primary package dimensions are specified as top and bottom diameters and a height instead of length, width and height.
- You can allow both row/column and nested arrangements within the cases.
- You can allow partial top layers within the case if the case weight limit will not allow full layers.
- You can specify spacing between each cylindrical object to simulate dividers or another form of product separator.

In all other respects this option program operates in the same way. The input and output screens for a Cylinder/Bottle Casefill analysis are shown next.
Primary Package Input

![Image of Primary Package Input]

Fill Restrictions Input

![Image of Fill Restrictions Input]
Multi-Viewer Graphics Screen

Recessed Cylinders

You must enter a bottom diameter that is different from your top diameter and you must enter a recess factor. The recess factor is the amount that the top cylinder recesses into the one directly beneath it in the stack.

Here are your results.
Varying Carton Size in Casefill

This option operates in an almost identical way to the Fixed Casefill options described above. There are, however, three major differences:

- The primary package can be allowed to vary in size.
- You can only work with one database record at a time.
- You cannot select Multi-Dimensional loading or Pallet Maximizer as an option.

Here are the input and output screens for a variable analysis using the data in our original example. The only differences are that we will allow the primary package to vary +/- .5 inches in all three dimensions and we will only be using record #1.

Primary Package Input
Casefill Hints and Tips

Casefill is a program used to calculate the most efficient loading of a primary package into a range of existing cases. These can fall into one of three categories:

- A routine which establishes good internal case cubic efficiency, but does not consider the way such cases are palletized.
- As above, but with pre-established pallet loading information not specific to the product, but related to the case size.
- As in the first point above, but which individually palletizes each case with product specific parameters.

The first option is all very well, except that a case, which provides a very high internal cubic efficiency, may not palletize as efficiently on a specific pallet as a less efficient case.

Obviously the third option is the most comprehensive and should supply good comparative results in a single Solution Report. However, the negative aspect of this option is that all analyses will require far greater calculation time.

In fact, the Casefill program operates on the basis of the second option, as a compromise between flexibility and performance. The critical factor in the usefulness of this option is the relative product weight. Let's assume that a palletizing solution is calculated with a nominal case weight of 1 lb. and achieves 50 per load in space utilization alone.

Casefill uses this case from the database in the course of its calculations, and gets 25 primary packages of 1 lb. each in the internal arrangement. With the case material weight added, let us say the case gross weight becomes 26 lb. which, multiplied by the 50 cases per load, gives a pallet load weight of 1300 lb., excluding the pallet itself.

If the maximum load weight is 1200 lb., it is clear that although you can place this quantity of product in the physical space, the weight of the load has become the critical factor.

Thus, the logic employed by the Casefill program is perfectly satisfactory as long as you 'cube out' before you 'weight out'. In these circumstances you should revert to the Pallet Group to recalculate the relative efficiencies of the well-filled cases, as indicated by the first option in the list.
The premise behind the case database is to provide the dimensional data for the running of analyses. It is not designed to be for general use as a 'packaging database'. The reference point for entries is simply the record number.

The maximum number of records which can be held in the database is 2500, although it is desirable to keep the working database as compact as possible to maintain operating performance.

**Data Restrictions**

- The Casefill Group uses the *Minimum Number of Primary Packs per Secondary Pack* field value to exclude cases from the database in preliminary volume calculations. That is, if the minimum number of objects or primary packages is too large to fit within a secondary package or case defined in the database, that secondary package will be excluded from the calculations.

- The Casefill Group may find over the maximum number if it can complete a pattern by adding 1 or 2 more objects or if it can find a higher cube efficiency.

- The product **cannot** exceed the internal height of a case.

- The product **can** exceed the internal height of a tray.

**Object Tips**

- The *Number per Pack* field lets you enter the number of items within the object dimensions you are defining. If there were 6 cans in a shrink-wrapped package, you would enter 6 here. This number is multiplied to calculate the exact number of packs/items per case and pallet load.

- If you want to vary weight or volume, you must click on the *Vary Volume/weight* option on the Input menu on the Primary Package input tab to get the settings.

- If you choose to vary only one dimension, you must vary the volume.

- If you want to vary the volume of the primary package, you must specify in percent form the amount to vary. This field can be used when you need to do a "25% more free promotion" of a particular product, or if you are just looking to vary volume, to create new sizes.

- If the weight is to increase as the volume increases, check the *Vary Weight* box. This will also work if the volume decreases. If you want the weight to remain constant as the volume changes, do not select this box.

- The primary package will not change in size if you do not enter a variance amount on the Primary Package input tab.

- If you choose not to vary the volume of the product one dimensional increment must be set to zero. This ensures a constant volume of the primary package because the third dimension will be calculated in accordance with the other two dimensions.

**Fill Tips**

- If you want the program to find Multi-Dimensional or Maximizer solutions make sure you have specified more than one dimension vertical.

- Make sure your maximum case weight allows for the maximum number of primary packages to fit in the case based on the primary package weight.
Adding Graphics With 3D Imaging

Introduction

The 3D Imaging Program allows you to transfer scanned images or artwork files onto the surface of the packaging components in CAPE PACK programs. This provides a very high level of "visual reality" and brings your packaging to life!

You can work with boxes, cases, trays, cans, bottles, bags, cones, trapezoids, ovals, gable-ended packages and many more.

The idea behind the 3D Imaging Program is to transfer scanned images or artwork files to the surfaces of the packaging components that are already available within CAPE PACK or are created using the Make a new Shape feature. The combination is remarkable!

To start the program:

From the Multi-Viewer Graphics screens: In this mode you can work with the current file and objects. You can create or add graphics.

From the input screens: In this mode you can only add graphics to the current file.

Regardless of where you start the program, to create a 3D Imaging file (*.3DI), you must run a CAPE PACK analysis and save the resulting CAPE Load File. This provides the file structure necessary for a 3D Imaging file to recognize the shapes and types of packaging components used in a particular analysis. Once created, 3D Imaging files can be used with different load files.

Graphic File Types

Image files (source files) that contain “flat” graphics can come from a wide variety of programs and different sources. They can also be saved in many different file formats. They can be artwork files that have been converted to another format or they can be scanned images that have been saved to a file format.

The following table lists some of the file formats (256 color) that can be imported into the 3D Imaging Program.

<table>
<thead>
<tr>
<th>File Format</th>
<th>File Extensions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows &amp;OS/2 Bitmap</td>
<td>BMP</td>
<td>Windows independent Bitmap</td>
</tr>
<tr>
<td>CALS Raster</td>
<td>CAL</td>
<td>A 1-bit standard set by the US government</td>
</tr>
<tr>
<td>LEAD</td>
<td>CMP</td>
<td>LEAD Technologies' own compressed format</td>
</tr>
<tr>
<td>Postscript Raster</td>
<td>EPS</td>
<td>Encapsulated PostScript</td>
</tr>
<tr>
<td>GEM Image</td>
<td>IMG</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>-----</td>
<td>---</td>
</tr>
<tr>
<td>JPEG</td>
<td>JPG</td>
<td>JEF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>JTF</td>
</tr>
<tr>
<td>MacPaint</td>
<td>MAC</td>
<td></td>
</tr>
<tr>
<td>Microsoft Paint</td>
<td>MSP</td>
<td></td>
</tr>
<tr>
<td>PhotoCD</td>
<td>PCD</td>
<td></td>
</tr>
<tr>
<td>Macintosh Pict</td>
<td>PCT</td>
<td></td>
</tr>
<tr>
<td>PC Paintbrush</td>
<td>PCX</td>
<td></td>
</tr>
<tr>
<td>SUN Raster</td>
<td>RAS</td>
<td></td>
</tr>
<tr>
<td>Truevision</td>
<td>TGA</td>
<td></td>
</tr>
<tr>
<td>Tagged Image File</td>
<td>TIF</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphic</td>
<td>WPG</td>
<td></td>
</tr>
</tbody>
</table>

Includes SPEG File interchange Format and Tagged Interchange Format which are industry standards.

**Image Sizes**

It is important to understand that the size of the image being used must relate to the size of the object onto which you are going to place the image.

Imagine if you scanned a postage stamp and tried to put it onto a panel of a case measuring 16 x 12 inches. The image would have to be stretched so much that the result would be distorted and very grainy and you would probably find it unacceptable.

Here is an example of a small CAPE logo put onto the side of a case as label.

Here is the same size logo use on the entire side panel of the case.
As you can see, the logo is now distorted and will appear very grainy. For best results, make sure the image is the right size for the package you want to use.

**Types of 3D Imaging Wizards**

There are two types of 3D Imaging Wizards.

The new Quick Wizard lets you quickly and easily design graphics for cases. In this wizard, you will be able to apply graphics to the entire side of cases, trays and cartons only.

Standard Wizard allows you to create more customized graphic imaging files for any type of packaging in CAPE PACK. This wizard allows you to use the masking and transparency features as well as design labels for bottles.

Once created, the 3DI files will be added to the list of graphics and can be added to any package of the same basic shape.

**Quick Wizard**

Here is an example of creating a 3DI file for a case using the Quick Wizard.

First select the **Add Graphics** menu, and then click on **Quick Wizard**.

The following screen Quick Wizard appears.
The screen shows you a 3D view of the case at 0 degrees and scroll buttons to change the view. Beneath that picture are pictures depicting sides A through F of the case with labels to indicate where they are positioned on the case. This screen has very limited controls.

**Select face(s) to add image**: this drop down list lets you select the face or side of the case that you want the image to appear on.

**Open New Image**: allows you to browse to find the graphic file you want to use.

**Add Image**: places the graphics file on the panel(s) you selected from the drop down box.

**Save and Exit** prompts you for a name to save your new 3DI file and exits you back to Multi-Viewer Graphics.

Let's add an image to **Face A**.

Select **Face A** from the drop down list.

Click on **Open New Image** and select a graphic to use.
Click on **Add Image**. Your image is added to the top of the case.

Complete this process with as many sides of the case as you wish, and then click on **Save and Exit**. You will be prompted for a file name. Enter a name and click on save.
When you return to Multi-Viewer Graphics, your new 3DI file has been applied to the case.

You will also find it in the drop down list under Add Graphics, Add Graphics.
Standard Wizard

Here is an example of creating a 3DI file for a case.

First select the **Add Graphics** menu, and then click on **Standard Wizard**.

The Choose a package screen will appear.

This screen allows you to select which package type you want to work with. In our example, we have only a case or a truck to choose from. Click on **Case** and then on **OK**. You will then see the following screen.
You will see the case in the top left corner panel. Now select 3DI from the menu bar and Click on New as we are creating a new graphic file.

A Save As dialog box appears. Enter a file name (TEST) and click on Save.

You will see a line drawing of your case in the top left corner and the flat-blank of the case in the bottom left of the screen. Creating a 3DI file for a case means putting an image on one or more of the panels and then creating the 3D shape.

To begin we must locate the images we have for the surfaces of this case. We have provided some bitmaps for you in the Tutor folder. These bitmaps are called Capea25.bmp, Capeb25.BMP ............ Capef25.BMP. The letter a, b, c, d, e, and f after the name CAPE, represents each of the six panels of the case.

Select the 3DI menu and then select Panel Names. The following diagram appears to show you which panel is which. All you have to do is match the Capea25.BMP to the panel A, and so on.
Select the **Image** menu and then select **Open**. A File Open dialog box appears.

Select the **Images** folder and scroll down/across the contents of the **Faces** folder, and then find the file **Capea25.bmp**. Double-click on this file and the following screen will appear.

Now click on panel **A** (the panel marked A in the lower left corner of the screen).
You will see that all the panels except panel A are grayed out. This identifies where the image will be placed. Now select the camera on the tool bar. It will display a message saying Snapshot.

Click on the camera.

The image for panel A appears on the flat-blank and on the top of the 3D case. Now repeat this procedure for panel B.

Click on panel B. Then select the Image menu, and Open.

Select the Images directory, faces and click on Capeb25.BMP. Click on the Open button.
Click on the camera.

Now repeat this procedure for panels C, D, E and F. Your completed case should look like this.

Double-click on the white area around the flat-blank. All the “gray” panels on your screen become brighter.
To see your case in greater detail, click on the View menu and then select Maximize Package.

All we have to do now is save the case with the images on each panel. Select the 3DI menu and then choose Save.

Remember, we already selected a file name when we entered the program. So now the file has been saved as TEST.3DI. This file can now be used with a case or rectangular object in Pallet, Arrange, Design or Casefill programs.

To leave the program, select the File menu and then choose Exit.

In some circumstances you will be prompted to save the 3DI file with your CLF file. If you select Yes, this will attach the files together. If you select No, the 3DI file will be saved to the specified folder without being attached to the CLF.

Using 3D Image Files

Having created our TEST.3DI file, let's use it in a Arrange Group analysis.
Launch the Arrange Group for Cartons program and calculate a solution.

Click on the picture of the case.

Now select the **Add Graphics** menu and then choose **Add 3D Graphics**.

You will see this screen. Select the **Test.3DI** file that you saved.

Click on **OK**.
Labeling Bottles

Create a bottle in the Make a New Shape feature, run an Arrange (Cylinders) analysis using that bottle.

Go to the Multi-Viewer and then select **Create Graphics** from the **Add Graphics** menu.

Highlight **Bottle** in the list.

Click on **OK** and the 3D Imaging program will open.

Now select **New** from the **3DI** menu.

The Save As dialog box appears. Give your image a file name (NewBott.3DI) and click on **Save**.

Now select the **3DI** menu and choose **Default Fill Color**.

Select a color and click on **OK**.

Be careful when selecting your Default Fill Color. Make sure that **Color** you select and the **Solid** color are compatible. Some dark colors can become a solid black and some light colors can become a solid white.

Now select the **Image** menu and then **Open**.

Select the folder and image you want to use. We are using the CAPE1.BMP from the PACK99 folder. The image will appear in the right hand box of the screen.
Click on the flat bottle in the bottom left panel, and the small circles (top and bottom of the bottle) change to a darker color.

Now select the **Image** menu and choose **Mask**.
The right screen panel will turn gray and a white outline of the bottle will appear around your image.

You can resize the white bottle by grabbing the corners or you can move it by clicking on the bottle and dragging it. You cannot move the image. However, you can resize it with the zoom drop-down box.

Resize the image to **50%** and then reposition the bottle panel as shown.

Now click on the camera to Snapshot the image to the bottle.
Now let's add a blue cap to the bottle. To add a cap or neck label we need to avoid moving or affecting the body label already on the bottle.

Select the **Image** menu and choose **Transparency**.

We need to locate a blue image to be used for the cap. Choose the **Image** menu and select **Open**.

Now select **Blue.BMP** from the Tutor folder and click on **Open**.

The new image appears with the bottle shape behind it. Resize the bottle so that the image fits into the neck of the bottle. Resize the image if necessary.

Once you are satisfied with the location of the neck label click on the camera to Snapshot the label to the bottle.
Now do the same for the top of the cap.

Double-click in the white area of the flat black panel to lighten the pictures.

Select **Save** from the **3DI** menu.

Select **Exit** from the **File** menu.

Your 3D Image can then be used in the CAPE PACK programs on any cylindrical object.

In Multi-Viewer Graphics, select the **Add Graphics** menu and then **Add 3D Graphics**. Select your NewBott 3dimage file and apply it to the bottle.

**Menu Options**

The menu options of the 3D Imaging program provide a vehicle for you to easily switch between the different features and settings, as well as to perform different tasks. The following table describes the options found on the menus.
<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Open</td>
<td>Display a File Open dialog box allowing you to open a CLF.</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Saves the current CLF with any associated 3DI files.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Saves the existing CLF with a new name.</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td>Generates a standard 3D Imaging Report showing the 3D image of the current</td>
</tr>
<tr>
<td></td>
<td></td>
<td>package from all 10 alternate view angles, and a diagram of the Image Wrap</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from the current 3DI file.</td>
</tr>
<tr>
<td></td>
<td>Print Preview</td>
<td>Displays a screen image of the standard 3D Imaging Report.</td>
</tr>
<tr>
<td></td>
<td>Print Setup</td>
<td>Allows you to change your printer settings.</td>
</tr>
<tr>
<td></td>
<td>List of Previous CLFs</td>
<td>Listing of the last four CLFs opened in the program. Clicking on any of</td>
</tr>
<tr>
<td></td>
<td></td>
<td>these files will open it for your use.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Exits the 3D Imaging program.</td>
</tr>
<tr>
<td>Edit</td>
<td>Undo</td>
<td>Allows you to back up one step and undo selected operations. This feature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>is not yet available in version 1.0 of the 3D Imaging Program.</td>
</tr>
<tr>
<td>View</td>
<td>Standard</td>
<td>Shows the program main screen with the package window, ImageWrap window and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the source image window.</td>
</tr>
<tr>
<td></td>
<td>Maximize Package</td>
<td>Shows an enlarged version of the package.</td>
</tr>
<tr>
<td></td>
<td>Maximize 3DI</td>
<td>Shows an enlarged version of the ImageWrap Window.</td>
</tr>
<tr>
<td></td>
<td>Maximize Image</td>
<td>Shows an enlarged version of the source image Window.</td>
</tr>
<tr>
<td></td>
<td>Summary Information</td>
<td>Provides information about the file names, folders, sizes for the current</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CLF, 3DI file and source image file.</td>
</tr>
<tr>
<td></td>
<td>Toolbar</td>
<td>Turns the toolbar on or off.</td>
</tr>
<tr>
<td></td>
<td>Status Bar</td>
<td>Turns the status bar on or off.</td>
</tr>
<tr>
<td>Package</td>
<td>Choose</td>
<td>Allows you to select an available package from the CLF.</td>
</tr>
<tr>
<td></td>
<td>0° Corner</td>
<td>A view of the package as if the viewer was above, in front and to the left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of it.</td>
</tr>
<tr>
<td></td>
<td>90°</td>
<td>A view of the package as if the viewer was above, in front and to the left</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of it.</td>
</tr>
<tr>
<td></td>
<td>180°</td>
<td>A view of the package as if the viewer was above, behind and to the right</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of it.</td>
</tr>
<tr>
<td></td>
<td>270°</td>
<td>A view of the package as if the viewer was above, in front and to the right</td>
</tr>
<tr>
<td></td>
<td></td>
<td>of it.</td>
</tr>
<tr>
<td></td>
<td>Side 1</td>
<td>A view from the front of side 1 of the package.</td>
</tr>
<tr>
<td></td>
<td>Side 2</td>
<td>A view from the front of side 2 of the package.</td>
</tr>
<tr>
<td></td>
<td>Side 3</td>
<td>A view from the front of side 3 of the package.</td>
</tr>
<tr>
<td></td>
<td>Side 4</td>
<td>A view from the front of side 4 of the package.</td>
</tr>
<tr>
<td></td>
<td>Top</td>
<td>A top-down view of the package.</td>
</tr>
<tr>
<td></td>
<td>Bottom</td>
<td>A bottom up view from the package.</td>
</tr>
<tr>
<td>3DI</td>
<td>New</td>
<td>Creates a new 3DI file.</td>
</tr>
<tr>
<td></td>
<td>Open</td>
<td>Opens existing 3DI file.</td>
</tr>
<tr>
<td></td>
<td>Save</td>
<td>Saves the current 3DI file to the Images folder of your program.</td>
</tr>
<tr>
<td></td>
<td>Save As</td>
<td>Saves the 3DI file to the 3DI folder with a new filename.</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td>Clears all the images from the active 3DI ImageWrap.</td>
</tr>
<tr>
<td></td>
<td>Remove</td>
<td>Removes the association between the active 3DI file and the active package.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>It does not modify or change the last saved version of the 3DI file.</td>
</tr>
<tr>
<td></td>
<td>Load Bitmap Series</td>
<td>Automatically loads a series of Bitmap images that have been saved for all</td>
</tr>
<tr>
<td></td>
<td></td>
<td>panels of the 3DI ImageWrap.</td>
</tr>
<tr>
<td></td>
<td>Panel Names</td>
<td>Panel names are used to identify each panel in the ImageWrap. When they are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>tuned on, they show up as “letter labels” in all panels that do not have an</td>
</tr>
<tr>
<td></td>
<td></td>
<td>image assigned.</td>
</tr>
<tr>
<td></td>
<td>Edit Inside Panels</td>
<td>Allows you to assign images to the inside panels of a package. The inside</td>
</tr>
<tr>
<td></td>
<td></td>
<td>panels of a package are automatically set to default fill color.</td>
</tr>
</tbody>
</table>
Using Image Files

There are three basic methods of importing a source image into the 3D Imaging Program. Once imported, some or all of that image can be applied to one or more of the ImageWrap panels of the package.

Use an existing Graphics File

Use the **Open** option on the **Image** menu to open an existing graphics file that you want to include on your package.

Use a Screen Capture Program

Use a standard graphics program such as Paintbrush, Corel Draw, Quark Express, etc., to display the image on your screen. Then you can use a screen capture utility such as Paint Shop Pro or Hijack to capture the portion of screen that contains the desired source image. Save the result in one of the acceptable graphics formats (Bitmap, PCX or TIF). Once saved, you can import the graphics into the 3D Imaging Program.

Use a Scanner

Use a standard scanning device connected to your PC to capture a source image directly into the 3D Imaging program. This procedure requires that:

- You have a printed page with the desired source image.
You have an actual printed flat-blank with your package’s artwork.

You can place one or more sides of the package directly on the scanner to capture the desired source image.

Use the **Acquire** option on the **Image** menu to start the scanning process. Your scanner has a dialog box that you can use to control the scanning process. Refer to the user’s manual of your scanner for specified instructions on the required options and settings needed.

### Size and Resolution of Graphics Files

Graphics files come in all sizes and in a wide variety of resolutions. These characteristics are determined at the time they are created. They can be high resolution, have large color depths, and be quite large.

If you have worked with the graphics in other applications, you know that it takes a very fast PC or a long processing time for every editing or printing operation you may want to perform using graphics. There are many millions of calculations and read/writes to be accomplished when working with very large graphics files.

However, CAPE PACK is only designed to handle a reasonable representation of the 3D Image. In addition, the packages are usually depicted as small objects in the context of a bigger package, pallet load, truck, etc. Thus, a 3DI file does not need to maintain the high resolution and color depth frequently found in original packaging artwork images. The 3D Imaging Program will automatically reduce the color depth to 256 colors and will sometimes reduce the resolution of the image to a more manageable size.

This compromise is needed in order to reduce the processing time. If the original color depth and resolution were maintained, the processing time would quickly exceed your patience in moving from one analysis step to the next.

Remember, the purpose of the 3D Imaging program is to provide realistic shapes of packages and their associated images. It is not intended to provide artwork quality or detail and it is not intended to be a high-end CAD program. It is meant to provide good, useable images in a realistic time frame on a standard Windows PC.

### 3DI ImageWrap Panel - Masking Techniques

The portion of the source image contained inside of the mask is transferred to the current ImageWrap panel during the snapshot operation.

Notice that the mask has been moved from its original position centered on the source image. Sometimes it is also necessary to resize the mask.
Moving the Mask

When your mouse cursor is inside the mask, it turns into a 4-pointed arrow.

Click your left mouse button and drag the mask to any point in the source image window. When you release the mouse button, the mask will be in its new position.

If you drag the mask off the screen or outside of the image window, the mask may disappear. To get it back, simply select the panel of your choice in the 3DI ImageWrap window and click on the mask button on the toolbar.

Resizing the Mask

When your mouse cursor is on the corner of the mask, it turns into a 2-pointed arrow.

Click on your left mouse button and drag the mouse in one of the directions of the arrow. This will make the mask either larger or smaller depending on which direction you moved. When you release the mouse button, the mask will be resized as specified.

The diagram below shows the results of moving and re-sizing the mask. Notice that the portion of the source image contained inside of the mask is transferred to the current ImageWrap panel.
Remember that when the mask is not turned on, the entire contents of the source image is warped to fit the current panel.

### Composite Images

Sometimes it is necessary to combine several source images onto one ImageWrap panel. Examples of situations where this may be necessary include:

- Two different labels that need to be placed on the side of a bottle.
- Two different source images representing the two flaps on the top panel of a box.
- Adding a company logo to a panel that already has an image on it.
- Adding a texture image first that covers the entire panel, such as corrugated texture, and then adding a smaller label image in the center of the panel.

Here is a label image that needs to be split in two and reversed before applying to a can.

![Label Image Split and Reversed](image)

To reverse the front and back images first use **Clear** option on the **3DI** menu to clear the contents of the 3DI file and the ImageWrap panels, but retain the package and the source image.
Select the side panel and position the left portion of the mask over the back portion of the image and click on the Snapshot button. You will then see the following results.

Notice that only the back portion of the image was transferred to the panel.

Select **Transparency** from the **Image** menu. This needs to be done so that the next time we Snapshot an image to the right side of the ImageWrap panel, the image that we have already copied will not be overwritten with the default fill color.

Finally, select the side panel once again, but this time, position the right portion of the mask over the Front portion of the image and click on the **Snapshot** button.
This example is meant to show you the basic method of placing multiple images onto one ImageWrap panel. Although we took both of our images from the same source image, it would have been possible to use portions of images from several different sources.
CAFE PACK Databases

Introduction

CAFE PACK includes a variety of databases for use with the various programs. For the most part, the database structures are the same, most are Access-based, and they have similar functions. However, their purposes are different. Here are the databases available to you within the programs of CAPE PACK.

<table>
<thead>
<tr>
<th>Database Name</th>
<th>Used in:</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Package (SP) Database</td>
<td>Pallet Group</td>
<td>Database of existing case sizes that are used for more than one analysis. Can also be used to import case sizes from an external source, such as Excel, to eliminate data entry.</td>
</tr>
<tr>
<td>Primary Package (PP) Database</td>
<td>Arrange/Design Group</td>
<td>Database of existing carton sizes that are used for more than one analysis. Can also be used to import carton sizes from an external source, such as Excel, to eliminate data entry.</td>
</tr>
<tr>
<td>Bundle Database</td>
<td>Arrange/Design Group</td>
<td>A database of bundle configurations that are commonly used to group primary packages together. Can be created with or without bundle packaging.</td>
</tr>
<tr>
<td>Casefill Database</td>
<td>Casefill</td>
<td>Database of existing case sizes that are used in Casefill to evaluate package fit for new products or products with new sizes. This is a case consolidation database.</td>
</tr>
<tr>
<td>Display Pallet Database</td>
<td>Display Pallet</td>
<td>Database of existing case sizes and weights that is used in Display Pallet to reduce data entry requirements. You create a database of all your existing products including outside dimensions and weights and then select from the database to build your loads.</td>
</tr>
<tr>
<td>Packaging Information Database</td>
<td>PID</td>
<td>A database that includes all complete analysis information for the single product modules. This database can be created and then shared with non-CAPE users so that they can open and view your files.</td>
</tr>
</tbody>
</table>

Package Databases

CAFE PACK includes 3 databases to assist you in accurate data entry. They include the Secondary Package Database in the Pallet Group, and the Primary Package and Bundle databases in the Arrange/Design Groups. These databases were created to allow you to import your packages from an external source through the use of our CDI text file, and then have the information available for use in the program groups. The Secondary Package database is only available for cases or trays (rectangular objects). The Primary Package database is only available for cartons. The Bundle Database can be used in any of the Arrange or Design Group programs.

All of the databases are Access based, and all of them are locked. They can only be edited from within CAPE PACK. They are accessed via the Database menu once you start the program group. Here are the menu options for the Secondary Package (SP) Database.

And here is an example of the Primary Package (PP) Database in the Arrange Group.
Secondary Package Database

The SP Database is used to store the sizes of all your cases and trays that you have in your database. Once created, you can import your case size from the database and then simply calculate your results. This is especially helpful if you have a large number of products that use the same case size. You have the option to create a new database or open and modify an existing database.

Create New Database

Launch CAPE PACK and the Pallet Group for cases.

Select the Databases menu and choose Create a new SP Database. A dialog box opens.

Enter a Name and Description in the appropriate fields and click on Create & Set as Current. The database will be created with no records.

To view the database being used, select SP Database Utility from the Databases menu. The following screen appears.
Here you can add case information (records), view the information for each record or modify an existing record.

### SP Database Fields

The following fields are part of your SP Database record.

**Number:** One up number that remains with the case in the order that it was entered into the database.

**Name:** A 15-character description of the case

**Type:** Select the type of Secondary Pack to be used

**Units:** Sets program to Metric or English units

**Length OD:** Outside package length dimension

**Width OD:** Outside package width dimension

**Height OD:** Outside package height dimension

**Length ID:** Inside package length dimension

**Width ID:** Inside package width dimension

**Height ID:** Inside package height dimension

**Tray Wall Height:** Sets the height of the walls for the tray style you select. In a tray, your product **height can exceed** the tray wall height.

**Net Weight:** Weight of the contents of the case or tray.

**Gross Weight:** Weight of the case or tray including the contents. The gross weight must be equal to or greater than the Net Weight of the case.

**Material Thickness:** The thickness of the corrugated material used to construct the secondary package.

**No. Material Thicknesses:** The number of material thicknesses in each dimension of the secondary package.
Navigating the Database

The **Database Utility** program has 2 options for navigation: buttons and menus. Below is an explanation of both.

**Buttons**

- **Close:** Accepts your changes and returns you to the Pallet Group input screens.
- **Add:** Adds a new case and palletizing record to the database.
- **Edit:** Allows you to change the record number highlighted in the spreadsheet.
- **Delete:** Removes the current record from the database.
- **Select All:** Highlights all records in the spreadsheet.

**Menu Options**

**SP Database File Menu**

The **File** menu has a number of features for managing your database.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Database</td>
<td>Creates a new SP Database</td>
</tr>
<tr>
<td>Open Database</td>
<td>Lets you open a different existing SP Database.</td>
</tr>
<tr>
<td>Export SP to Analysis</td>
<td>Allows you to use the highlighted record in your current Pallet Group Analysis.</td>
</tr>
<tr>
<td>Import SP from Analysis</td>
<td>Imports the current SP case as a record in your current database.</td>
</tr>
<tr>
<td>Export Entire Database as ASCII File</td>
<td>Allows you to export either the highlighted record or the entire database as an ASCII file.</td>
</tr>
<tr>
<td>Import .cdi from Database</td>
<td>Allows you to import a CDI file as a new database or into the existing database.</td>
</tr>
<tr>
<td>Import SP from CLF into Database</td>
<td>Allows you to import a secondary package from a saved clf into the current database.</td>
</tr>
<tr>
<td>Import Case size to Database</td>
<td>Imports from the older Case Size Database to the current SP database.</td>
</tr>
<tr>
<td>Purge Duplicates</td>
<td>Allows you to eliminate duplicate records in the database.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the database.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Standard Windows Print Preview feature.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Standard Windows Print Setup feature.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the program and returns you to the input data tabs.</td>
</tr>
</tbody>
</table>

**SP Database Options Menu**

The **Options** menu assists you in using your database with features such as sort and search.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort By</td>
<td>You can sort your records by Secondary Pack Size, Type, Name, or Package Number.</td>
</tr>
<tr>
<td>Search</td>
<td>Search feature that allows you to quickly locate packages meeting your criteria. You can search by any of the data fields and use up to 3 of those fields in your search.</td>
</tr>
<tr>
<td>Show All Records</td>
<td>Clears the search list and returns you back to the full spreadsheet.</td>
</tr>
<tr>
<td>Select All</td>
<td>Highlights all the records in your database.</td>
</tr>
<tr>
<td>Unselect All</td>
<td>Removes highlighting from all records in your database.</td>
</tr>
</tbody>
</table>
Maintaining Databases

The Database Utility allows you to modify your existing cases, add new cases or delete cases from your database. The following will demonstrate each of these options.

Adding Cases to a Database

Click on the **Add** button under the spreadsheet area. The following screen appears.

![Add Secondary Pack](image)

Select a **Package Type** and then using the **Tab** key to move through the data fields, enter all the information for your new case or tray.

![Add Secondary Pack](image)

When all the data has been entered, click **OK** to add the record to the database.
Importing Cases from the Current Analysis

To save your current case as a record in your database, you have two options.

From the Pallet Group data entry area, click on the Databases menu and Export Current SP to SP Database.

Or from the Database Utility, click on File, Import SP from Analysis. The record will appear in your database.

Deleting Cases from a Database

Highlight the case in the list that you want to remove and click on the Delete button. Once a case is deleted, it cannot be recovered.

Editing Cases in a Database

Highlight the case in the list that you want to change and click on the Edit button. The following screen appears.
Make your changes and click on **OK** to update the database.

**Searching for Cases in a Database**

Click on the **Options** menu and then **Search**.

**Sorting Database Records**

To sort the records in your database, click on the **Options** menu, then **Sort by**, and finally choose a field to sort by. The database sorts in ascending order.

**Exporting Database Information**

You may have a need for a listing of the cases in your SP Database with all of the specifications for use in another application. This database, when customized for your operation, is an excellent source of information for cases used in your organization. CAPE PACK provides a feature to export all the records in your database in ASCII (TXT) format.

Select the **File** menu and choose **Export Entire Database as ASCII File…** and then choose either the **Entire Database** or **Current Recordset**. A Save As dialog will appear.

The default path for your export will be your Private path and the default name will be your [database name].CDI. You may change either of these if you wish.

Click on **Save** and your database will be exported in a “flat” ASCII file format with a .cdi extension. You may open this file with Windows Notepad or any similar program.

Each database record will contain its own details, as follows:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[General]</td>
<td>Section Heading</td>
<td>[General]</td>
</tr>
<tr>
<td>Field 1</td>
<td>Number of Pages</td>
<td>2</td>
</tr>
<tr>
<td>Type</td>
<td>Database type</td>
<td>4</td>
</tr>
<tr>
<td>[Package #1]</td>
<td>Section Heading</td>
<td>[Package #1]</td>
</tr>
<tr>
<td>Field #1</td>
<td>Package Name</td>
<td>Case</td>
</tr>
<tr>
<td>Field #4</td>
<td>Case type:*</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1 =Regular Slotted Container (RSC)</td>
<td>1</td>
</tr>
</tbody>
</table>
Purging Duplicate Records from your Database

Click on the **File** menu and **Purge Duplicates**.

Check the records you want to delete in the far right column.

Then click on **Delete** to remove the records. You will be prompted to confirm.

Click on **Yes** to delete the records. The screen returns to your spreadsheet with the records deleted.

Importing Databases

You can import data into a new or existing SP Database with the use of the .CDI ASCII file. You could export from one database and then import into another using this feature.

Click on **File. Import from External Source, As a new Database**. A file open box appears to allow you to select the cdi file that you want to use.

Click on the file you want to import and then on the **Open** button. The Create New Secondary Pack Database screen appears.
Enter a name and description and then **Create Database**. A query will ask if you want to open the new database.

Click on **Yes** and your new database is imported and opened for your use.

### Primary Package Database

The PP Database is used to store the sizes of all your cartons and other rectangular shaped primary packages that you have in your database. Once created, you can import your package size from the database and then simply calculate your results. Most of the options available for this database are the same as for the SP Database. We will highlight the differences here.

You have the option to create a new database or open and modify an existing database.

### Create New Database

Launch CAPE PACK and the Arrange Group for cartons/bags/ovals.

Select the **Databases** menu and choose **Create a new PP Database**. A dialog box opens.

Enter a **Name** and **Description** in the appropriate fields and click on **Create & Set as Current**. The database will be created with no records.
To view the database being used select **PP Database Utility** from the **Databases** menu. The following screen appears.

Here you can add case information (records), view the information for each record or modify an existing record.

**PP Database Fields**

The following fields are part of your PP Database record.

- **Number:** One up number that remains with the package in the order that it was entered into the database.
- **Name:** A 15-character description of the package
- **Type:** Select the type of Primary Pack to be used
- **Units:** Sets program to Metric or English units
- **Length OD:** Outside package length dimension
- **Width OD:** Outside package width dimensions
- **Height OD:** Outside package height dimension
- **Length ID:** Inside package length dimension
- **Width ID:** Inside package width dimension
**Height ID:** Inside package height dimension

**Net Weight:** Weight of the contents of the package.

**Gross Weight:** Weight of the packaging including the contents. The gross weight must be equal to or greater than the Net Weight of the package.

**Material Thickness:** The thickness of the corrugated material used to construct the primary package.

**Material Weight:** The weight of the material in pounds per 1000 square feet of board.

**Glue Flap** The width of the Glue Flap of the carton.

**No. Material Thicknesses:** The number of material thicknesses in each dimension of the primary package.

### Maintaining Databases

The Database Utility allows you to modify your existing packages, add new packages or delete packages from your database. The following will demonstrate each of these options.

### Adding Packages to a Database

Click on the **Add** button under the spreadsheet area. The following screen appears.

Select a **Package Type** and then using the **Tab** key to move through the data fields, enter all the information for your new package.
When all the data has been entered, click **OK** to add the record to the database.

Exporting Database Information

You may have a need for a listing of the cases in your PP Database with all of the specifications for use in another application. This database, when customized for your operation, is an excellent source of information for packages used in your organization. CAPE PACK provides a feature to export all the records in your database in ASCII (TXT) format.

Select the **File** menu and choose **Export Entire Database as ASCII File...** and then choose either the **Entire Database** or **Current Recordset**. A Save As dialog will appear.

The default path for your export will be your Private path and the default name will be your [database name].CDI. You may change either of these if you wish.

Click on **Save** and your database will be exported in a “flat” ASCII file format with a .cdi extension. You may open this file with Windows Notepad or any similar program.

Each database record will contain its own details, as follows:
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[General]</td>
<td>Section Heading</td>
<td></td>
</tr>
<tr>
<td>Field 1</td>
<td>Number of Pages</td>
<td>2</td>
</tr>
<tr>
<td>Type</td>
<td>Database type</td>
<td>2</td>
</tr>
<tr>
<td>[Package #1]</td>
<td>Section Heading</td>
<td></td>
</tr>
<tr>
<td>Field #1</td>
<td>Package Name</td>
<td>Carton</td>
</tr>
<tr>
<td>Field #4</td>
<td>Pack type:*</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1=Full Overlap Seal End (Seal End)</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>2=Part Overlap ECO Seal (ECO Seal)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3=Cover Tray (Cover Tray)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4=Tray (Tray)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5=Double Wall Tray (DW Tray)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6=Standard Reverse Tuck (REV Tuck)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7=Straight Tuck (STR Tuck)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8=Tuck Top/Auto Bottom (Auto Bottom)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9=Tapered Wall/Shadow * (TAP SHAD)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10=Hollow Wall/Shadow Box (HOL Shadow)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>11=Surface Area (Surface)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1xyz=Custom-1000 series</td>
<td></td>
</tr>
<tr>
<td>Field #6</td>
<td>Outside Length</td>
<td>6.0000</td>
</tr>
<tr>
<td>Field #7</td>
<td>Outside Width</td>
<td>5.0000</td>
</tr>
<tr>
<td>Field #8</td>
<td>Outside Height</td>
<td>8.0000</td>
</tr>
<tr>
<td>Field #14</td>
<td>Units. 0=Metric, 1=Imperial</td>
<td>1</td>
</tr>
<tr>
<td>Field #15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field #16</td>
<td>Inside Length</td>
<td>5.5000</td>
</tr>
<tr>
<td>Field #17</td>
<td>Inside Width</td>
<td>4.5000</td>
</tr>
<tr>
<td>Field #18</td>
<td>Inside Height</td>
<td>7.000</td>
</tr>
<tr>
<td>Field #19</td>
<td>Gross Weight</td>
<td>1.0000</td>
</tr>
<tr>
<td>Field #20</td>
<td>Net Weight</td>
<td>0.8500</td>
</tr>
<tr>
<td>Field #22</td>
<td>Material thickness, Length</td>
<td>2</td>
</tr>
<tr>
<td>Field #23</td>
<td>Material thickness, Width</td>
<td>2</td>
</tr>
<tr>
<td>Field #24</td>
<td>Material thickness, Height</td>
<td>4</td>
</tr>
<tr>
<td>Field #25</td>
<td>Material thickness (caliper)</td>
<td>.0895</td>
</tr>
<tr>
<td>Field #26</td>
<td>Material weight (lb/msf)</td>
<td>80.000</td>
</tr>
<tr>
<td>Field #27</td>
<td>Glue Flap</td>
<td>1.0000</td>
</tr>
<tr>
<td>Field #28</td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

**Bundle Database**

The Bundle database is used to store all the standard bundle configurations used by your company. Once created, you can import your bundle setup from the database, and then return to data input. This is especially helpful if you have a large number of products that use the same bundle arrangement. You have the option to create a new database or open and modify an existing database.

**Create New Database**

Launch CAPE PACK and the Arrange Group for any package type you wish.

Select the **Bundle** menu and **Define/Review Bundle Input**. The Bundle Wizard opens.
Select the **Database** menu and choose **Create New Bundle database**. A dialog box opens.

Enter a **Name** and **Description** in the appropriate fields and click on **Create & Set as Current**. The database will be created with no records.

Next we need to add a bundle to the database. Select **Add Current Bundle Input to Bundle Database** from the **Database** menu.
To view the contents of the database, select the **Database** menu and then **View/Edit Bundle Database**. The following screen appears.

To edit your record for Bundle 1, highlight it and click on the **Edit** button. The following screen appears.

Here you can change whatever information you want and then save the changes. Let's make some changes to this record.

First select a Bundle Package type of **Tray**.

Next change the Bundle name to **Tray**.

Add a 2-way divider.
Select the **125 E Flute** material for both the tray and the partition.

Let's change the bundle to a 6-pack. Your screen should look like the following.

![Image of Bundle Database Fields](image)

Last, select the **Colors** menu and change the Bundle Package color to yellow.

![Image of Colors](image)

Click on **Save Changes**.

**Bundle Database Fields**

The following fields are part of your Bundle database record.

**Name:** A 15-character description of the bundle

**Length OD:** Outside package length dimension

**Width OD:** Outside package width dimension
**Height OD:** Outside package height dimension

**Units:** Metric or inches.

**Qty:** Number of total primary packages in the bundle.

**Qty in X:** Number of primary packages in the Length of the bundle.

**Qty in Y:** Number of primary packages in the Width of the bundle.

**Qty in Z:** Number of primary packages in the Height of the bundle.

**Other Bundle Definition Data**

**Bundle Package Type:** Type of package used for the bundle if any.

**Divider/Partition:** Type of divider used for the bundle.

**Tray Wall Height:** Sets the height of the walls for the tray style you select. In a tray, your product **height can exceed** the tray wall height.

**Package Thickness:** Thickness of the corrugated material used for the bundle package.

**LB/MSF:** Basis weight of the corrugated material used to make the bundle package.

**Divider Thickness:** Thickness of the corrugated material used for the divider.

**Colors:** Colors of the divider and/or bundle package.

**Graphics:** 3D imaging files associated with the bundle package.

So essentially, the Bundle Database is comprised of all the fields and options that are in the Bundle Wizard.

**Maintaining Databases**

Database menu allows you to modify your existing bundles, add new bundles or delete bundles from your database. The following will demonstrate each of these options.

**Adding Bundles to a Database**

Set up your bundle the way you want it in the Bundle Wizard as shown in the example below.
To add the bundle to your database, select the Database menu and then Add Current Bundle Input to Bundle Database. The bundle will be added to the current database.

Deleting Bundles from a Database

To delete a bundle from your database that you no longer use, click on Database, Delete from Bundle Database. The following screen will appear.
In the **Delete** column, click on the bundle(s) you want to delete, then click on the **Delete** button.

**Editing Bundles in a Database**

Highlight the bundle in the list that you want to change and click on the **Edit** button.

Make your changes and click on **Save Changes** to update the database.

**Using your Bundle Database**

To use the bundles in your database, you simply select them from the list.

Click on the **Database** menu and then **Import from Bundle Database**. The following screen appears.

Click the **Import** column for whichever bundles you wish to use (no more than 8 per analysis), and then click on the **Import** button. Your bundles will appear in your list on the Bundle Wizard screen.
Working with a Casefill Database

To understand how Casefill works you must be aware of the database from which it draws the case and pallet information. You will need to build your own database, or any number of different databases. However, for getting started in Casefill we have provided a small database.

Select the **Database** menu and choose **Open Database**. A dialog box opens.

Select the **casefill.mdb** and then click on **Open**. Behind the input screen the database will be open. The database name will appear in the title bar of your window.

To view the database being used select **Database Utility** from the **Database** menu. Or you can click on the Database Utility toolbar button. The following screen appears.

Here you can view the information for each record or you can modify an existing database.
Navigating the Casefill Database

Casefill uses a locked Access database which gives you great flexibility. In addition to the spreadsheet and control buttons, you have a wide variety of menu options.

Database Fields

**Number:** One up number that remains constant regardless of sort order.

**Case Name:** A 15-character description of the case

**Pack Type:** Select the type of Secondary Pack to be used

**Rec:** One up number that remains with the case when sorted.

**Length ID:** Inside package length dimension

**Width ID:** Inside package width dimension

**Height ID:** Inside package height dimension

**Tray Wall:** Sets the height of the walls for the tray style you select. In a tray, your product can exceed this height restriction.

**Units:** Sets program to Metric or English units

**Length OD:** Outside package length dimension

**Width OD:** Outside package width dimensions

**Height OD:** Outside package height dimension

**Volume:** A package volume figure calculated by the program

**Material Weight:** Weight of packaging material

**Cases per Load:** How many cases or shippers there are on the pallet load

**Pallet Length:** The length dimension of the Pallet Base Style used

**Pallet Width:** The width dimension of the Pallet Base Style used

**Pallet Height:** The height of the Pallet Base Style used

Buttons

**Close:** Accepts your changes and returns you to the Casefill input screens.

**Delete:** Removes the current record from the database

**Edit:** Allows you to change the record number highlighted in the spreadsheet

**Add:** Adds a new case and palletizing record to the database

**Select All:** Highlights all records in the spreadsheet
Menu Options

Casefill Database File Menu

The **File** menu has a number of features for managing your database.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Database as .cfi</td>
<td>This feature allows you to export the information in your Casefill database for use in other programs. You have the option to export either the Entire Database or just the Current Recordset.</td>
</tr>
<tr>
<td>Export Current Record to Case Size Database</td>
<td>This feature allows you to export the case size information to the Case Size Database for use in the Pallet Group program.</td>
</tr>
<tr>
<td>Import Database</td>
<td>This feature allows you to import a database from another data source such as Access or Excel.</td>
</tr>
<tr>
<td>Purge Duplicates</td>
<td>Eliminates duplicate records from the database.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the database.</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Standard Windows Print Preview feature.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Standard Windows Print Setup feature.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the program and returns you to the Casefill input data tabs.</td>
</tr>
</tbody>
</table>

Casefill Database Options Menu

The **Options** menu assists you in using your database with features such as sort and search.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort By</td>
<td>You can sort your records by Case Size, Case Type, Case Name, or Record Number.</td>
</tr>
<tr>
<td>Find a Case/Tray</td>
<td>Search feature that allows you to quickly locate packages meeting your criteria. You can search by any of the datafields and use up to 3 of those fields in your search.</td>
</tr>
<tr>
<td>Show All Records</td>
<td>Clears the search list and returns you back to the full spreadsheet.</td>
</tr>
<tr>
<td>Select All</td>
<td>Highlights all the records in your database.</td>
</tr>
<tr>
<td>Unselect All</td>
<td>Removes highlighting from all records in your database.</td>
</tr>
</tbody>
</table>

Creating and Maintaining Databases

The Casefill Group can help you consolidate the number of secondary package sizes your company uses. In order to do this CAPE PACK requires you to specify information regarding the case sizes existing within your warehouse. The program can scan this information and report which existing case size will best suit the needs of the primary package (product) you are trying to load.

Depending on the nature of your business, you can set up many different databases containing certain case sizes, or set up one database containing all case sizes. It is at your discretion as to how you set up your databases.

CAPE PACK includes a default database. So you can either add your case sizes to the existing database or create your own.

Creating a New Database

With Casefill started, choose **Create New Database** from the **Database** menu. A Create New Database dialog box will appear.

Enter a filename in the **File name** field. Click on **Save**. Your new empty database appears.

Adding Cases to a Database

Adding records is a simple task.
Click on the **Add** button under the spreadsheet area. The following screen appears.

![Screenshot of the CAPE PACK interface](image)

Using the **Tab** key to move through the data fields, enter all the information for your new case or tray. The **Volume** will calculate for you automatically. If you choose a tray style, an additional field will appear for **Tray Wall Height**.

![Screenshot of the CAPE PACK interface](image)

When all the data has been entered, click **OK** to add the record to the database.
Deleting Cases from a Database

Highlight the case in the list that you want to remove and click on the **Delete** button. Once a case is deleted, it cannot be recovered.

Editing Cases in a Database

Highlight the case in the list that you want to change and click on the **Edit** button. The following screen appears.

Make your changes and click on **OK** to update the database.

Searching for Cases in a Database

Click on the **Options** menu and then **Find a Case/Tray**. The following dialog box appears.
Select a field to search by, and operator from the drop down list and then enter a value. You may use up to three criteria for your search. See the example below.

Sorting Database Records

To sort the records in your database, click on the Options menu, then Sort by, and finally choose a field to sort by. The database sorts in ascending order.

Exporting Database Information

You may have a need for a listing of the cases in your Casefill database with all of the specifications for use in another application. This database, when customized for your operation, is an excellent source of information for cases used in your organization. CAPE PACK provides a feature to export all the records in your database in ASCII (TXT) format.

Select the File menu and choose Export Database as .cfi and then choose either the Entire Database or Current Recordset. A Save As dialog will appear.

The default path for your export will be your Private path and the default name will be your [database name].cfi. You may change either of these if you wish.

Click on Save and your database will be exported in a “flat” ASCII file format with a .cfi extension. You may open this file with Windows Notepad or any similar program.

Each database record will contain its own details, as follows:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Record Number]</td>
<td>[Record Number]</td>
<td>[Case 1]</td>
</tr>
<tr>
<td>Field #1</td>
<td>Case Name</td>
<td>Tray</td>
</tr>
<tr>
<td>Field #2</td>
<td>Volume</td>
<td>1340.4</td>
</tr>
<tr>
<td>Field #3</td>
<td>Inside Length</td>
<td>14.2500</td>
</tr>
<tr>
<td>Field #4</td>
<td>Inside Width</td>
<td>8.7500</td>
</tr>
</tbody>
</table>
Purging Duplicate Records from your Database

Click on the File menu and Purge Duplicates. The following screen appears listing all the duplicates.

Check the records you want to delete in the far right column.

Then click on Delete to remove the records. You will be prompted to confirm.

Click on Yes to delete the records. The screen returns to your spreadsheet with the records deleted.
Importing Databases

You can import data into a new or existing Casefill database with the use of the .cfi ASCII file. You could export from one database and then import into another using this feature.

Click on **File, Import Database, As a new Database**. A file open box appears to allow you to select the .cfi file that you want to use.

Click on the file you want to import and then on the **Open** button. The Import .cfi to new Database screen appears.

Enter a file name and click on the **Save** button. You will be prompted.

Click on **Yes** and your new database is imported and opened for your use.

Creating Databases from an Excel Spreadsheet

Included in your program is a utility that allows you to create a Casefill database from an Excel spreadsheet. You can populate the spreadsheet provided and then use the included macro to create a new database for your Casefill program.

From the Front Menu in CAPE PACK, click on the **File** menu and **Open MS Excel Examples**.
A list of the Examples folder content appears.

Select `transferMyCasesTrays2Casefill.xls` and click on Open. The spread sheet will open.

From the tabs at the bottom, select the tab for the units of measure you prefer. Then populate the spreadsheet columns with your data for your cases. Don't forget to change the **No. of Cases/Trays** and the **Casefill Database** name fields at the top of the spreadsheet.
When you are finished, click on the **Click here to Transfer Cases/Trays to Casefill Database**.

The macro will run and CAPE PACK will open, Casefill will open, a new database will be created for you to your specifications and it will open in Database Utility for you to review.

You can use this spreadsheet process to create as many databases as you wish.

**Display Pallet Databases**

Display Pallet uses databases to store product information. You can build as many databases as you wish and cross-use them with different analyses. There are four options for your Databases: three from the **Database** menu and the **Import from Database** button which is used to pull cases from the database into your current analysis.

**Create New Package Database**

This feature is used to create a new database for use in Display Pallet.

Click on the **Create New Package Database** option on the **Database** menu. The following screen appears.

Enter a name for your database and click on **Save**. The database will open for you to add packages.
Navigating the database

Use the Package Database Utility option on the Database menu to open and edit or review your databases. You can change, add or delete packages.

Buttons

Close: Closes the database and returns to the main Display Pallet window.

Add: Adds a record to the database.

Edit: Allows you edit a record currently in the database.

Delete: Deletes the highlighted record(s) from the database.

Select All: Allows you to highlight all the records showing.
Menu Options

Display Pallet Database File menu

Create New Package Database Allows you to create a new database.

Open Package Database Allows you to open a different database.

Export Package(s) to Analysis Includes the selected packages in the current open analysis.

Import Package(s) from Analysis Allows you to import packages in the current analysis to be included in the database.

Export Entire Database as ASCII File Exports your database in ASCII format with a *.CDI extension.

Import .cdi from Database Allows you to import database records from a CDI file and either save it as a new database, or to the existing open database.

Import SP from clf into database Allows you to import database records from a clf file into the current database.

Purge Duplicates Allows you to identify and eliminate duplicate database records.

Print Prints the database.

Print Preview Previews your document prior to printing.

Print Setup Lets you setup your printer specifications.

Close Closes the database utility function.

Display Pallet Database Options menu

Sort By Allows you sort your database according to Package Size, Package Type, Package Name or Record Number.

Search Allows you to search your database based on your selected criteria. You can choose up to 3 different parameters with which to search.

Show All Records Recovers the entire database after your search.

Select All Selects all the records showing in the database.

UnSelect All UnSelects all the records showing in the database.

Adding Packages to the Database

Click on the Add button to enter in data for a new package. The following screen appears.
Select your **Package Type** and **Name** from the lists provided.

Enter a **Label** and select a **Color**.

Enter in your package dimensions, and quantity allows if desired.

Click on **OK** to enter the package into the database.

### Creating Databases from an Excel Spreadsheet

Included in your program is a utility that allows you to create a Casefill database from an Excel spreadsheet. You can populate the spreadsheet provided and then use the included macro to create a new database for your Casefill program.

From the Front Menu in CAPE PACK, click on the **File** menu and **Open MS Excel Examples**.

A list of the Examples folder content appears.
Select **transferMyPackages.xls** and click on **Open**. The spreadsheet will open.

From the tabs at the bottom, select the tab for the units of measure you prefer. Then populate the spreadsheet columns with your data for your cases. Don't forget to change the **No. of Products** and the **Package Database Name** fields at the top of the spreadsheet.

When you are finished, click on the **Transfer My Packages to Display Pallet**.

The macro will run and CAPE PACK will open, Display Pallet will open, a new database will be created for you to your specifications and it will open in Database Utility for you to review.
You can use this spreadsheet process to create as many databases as you wish.

Packaging Information Database

The principle of CAPE PACK is that you run an analysis, get to the graphics, customize your solution and then print or export the results. And, if required, you can save the graphics for future recall from the View/Open Saved Solutions options on the File menu at the Front Menu.

Packaging Information Database, referred to as PID, goes one step further and allows you to export the on-screen graphics and numerical data, for each solution, to a standard database format.

It is an extremely powerful and flexible tool in today’s environment of storing and sharing packaging related information.

Exporting the results of your work to PID means you can now manage and maintain your solution information in an easily accessible format. You can search on previous results or specific criteria, or you can even use an existing database record as the input for a new analysis!

You can search on wide range of criteria, avoid duplication of effort, delete unwanted files and make individual or overall assessments of the solution information you have saved. And you can share both the numerical and graphical results with colleagues, customers or your suppliers – even if they don’t have a CAPE program. If they have a copy of the CAPE PACK, simply send them a copy of your database and they can access it through the PID Setup program.

You can access PID from the PID menu at the Front Menu.

Or, from the input screens in the Pallet, Arrange, Design and Casefill Groups.

When you first enter PID, you will see the following screen.
Here you can choose which program group you want to use or search or select **All** to search every solution in the database. We will choose the Pallet Group.

You can **Search Across All Groups** under the **Options** menu on both the database and Search screens.

Highlight the circle next to **Pallet Group Solutions** and then click on **Open**.

Here you will see a listing of all the Pallet Group solutions in your database. The information that is available for each solution includes the following. Scroll across the screen to view all the data.

- Package Shape (e.g. Cylinder, Rect/Oval, Trapezoid etc)
- Secondary Pack length, width and height dimensions
- Number of Secondary Packs per Load
- Number of layers per pallet
- Product dimensions on pallet (Length, width and height)
- Area efficiency (%)
- Name of pallet style used
- Number of pallets per truck
- Name of truck style used
- Units of measure (mm/kg or in/lbs)

**Select Group Functions**

The initial screen of the PID feature gives you several options. You can either select a group and open the database, or you can use the other features available as follows.
**PID Setup**

**PID Setup** is used to select which database you want to use, add more databases, save a current database to another name or move a database to a different directory. Click on **PID Setup** to access this feature.

**Update PID**

Using this option will ensure that all your information is saved to the “current” database if you move the database or try to send it to someone without using the features in PID Setup. Whenever you merge or modify your PID database, it is a good idea to update.

**PID Setup**

Click on the **PID Setup** button. A message appears telling you that your database is being loaded, and then you see the following screen.

![PID Setup Screen](image)

This screen allows you to manipulate and manage your databases. You have the following features.

**Buttons**

- **Close**  Returns you to the Select Group screen with your changes.
- **Add PID**  Lets you add an existing database to the list. It can then be set as the “default” if required. This button is not for creating new databases.
- **Save As**  Allows you to save a database to another name. This is a very useful feature if you want to maintain a master copy of a database and have a working copy.
- **Set As Current PID**  Just highlight the database you want to use and click on this button. This action then sets the chosen database to be the “default” database to be used.
- **Merge PID’s**  Allows you to combine two or more databases to form one single database.

**PID Setup File Menu**

| New | Allows you to create a new PID database with a name of your choice. All new databases will contain four records – one for Pallet Group, Arrange Group, Design Group and Casefill Group. These records are necessary as “place holders” for the database structure. |

---
Copy PID to… Allows you to locate a copy of a selected PID database to another directory (i.e. send it to your “attach” directory when you want to email a copy of a database to a colleague/customer).

Change Path Lets you change the default path the program will store newly created databases. CAPE PACK will also copy the current database to this path.

Delete PID Lets you delete a PID database from your list.

Close Returns you to the selector screen.

Exporting Information to a PID Database

Simply select the Databases menu in Multi-Viewer Graphics and then Packaging Information Database (PID), Export Current Solution to PID(cap.csf).

The current solution will be exported to the current PID, in the above case, cap.czf. You can also use the other menu options to access PID Setup and update your current PID.

PID Menu Options

File Menu

Change Group This option allows you to switch between the PID records for the Pallet, Arrange, Design and Casefill Groups.

Import Solutions Allows you to import the appropriate data from a previously saved solution file. This option applies mainly to users of previous versions of CAPE PACK who have already saved the solutions in Multi-Viewer Graphics.

PID will not import CLF files where there are no saved graphics/solutions. You must save your Solution in MVG for it to be successfully added to your database.

To import a previously saved solution file, select Import Solution(s) from the File menu. The following screen appears where you can highlight the file or group of files.
If you try to import file that has not been “saved” correctly, you will see the Failed Imports message on the right side of the screen.

Click on Close and your imported file(s) will be added to the list in the appropriate PID section (Pallet Group in our example).

| Save Current Solution As CLF | Allows you to save the “current solution” to another filename as a CLF file. This can then be used to open an analysis in the appropriate program group. |
| Print | Prints the database in columnar form. |
| Print Preview | Standard Windows Print Preview feature. |
| Close | This option closes PID and returns you to the Front Menu or the input screens depending on where you launched PID. |

Options Menu

Search

There are two options: Search Current Group and Search Across All Groups. Searching the Current Group allows you to search on a wide range of dimensional criteria, names and number per case, per pallet and truck, type of pallet and truck and even area efficiency. Search Across all Groups allows you to search across the Pallet, Arrange, Design and Casefill Group solutions on only those criteria that are common to solutions within all the groups.

You can set the Search Key/Fields to:

- Secondary Pack (OD and ID) length, width and height
- Product Name
- Units of measure (mm/kg or in/lbs)
- Secondary Packs per layer
- Secondary Packs per load
- Secondary Packs per Slave Pallet
- Load dimensions for the pallet (length, width and height)
- Pallet Load with Slave Pallets on (length, width and height)
- Number per truck
- Name of pallet Base Style used
- Solution reference
- Product Code
- Primary Packs per Secondary Pack (Arrange and Design solutions)
- Layers per pallet
- Secondary Packs per truck
- Product dimensions on the pallet (length, width and height)
- Slave Pallet load dimensions (length, width and height)
- Loaded truck dimensions (length, width and height)
- Name of pallet Base Style used

You can set the search parameter Operators to:

- < less than
- > greater than
- = equal to
- “between” means a range to search within
The first field on the Search screen is a single search facility that lets you search just on Product Name or Product Code. You do not have to enter the full name as a search is carried out on partial words.

For example, do I have a case size greater than 12” in length, and 8” in width that has been palletized on a standard GMA pallet?

Click on **Go** to see if there are any matching records.

You can search on just a single criteria, or you can search on several different criteria. However, the more search criteria you use the more it will narrow the range of potential solutions.
View Solution (Information)  The information about each solution record can be viewed as a **Summary** of all solutions.

---

Or, to view as an **Individual** record, simply select the solution record you want to view and click on **Individual**.

---

This screen contains all of the information available for your chosen record.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sort Order</strong></td>
<td>This allows you to choose whether or not you want your data sorted in ascending or descending order. This selection remains the default until you change it. Once selected, to sort your data just click on the heading of the column you want to sort by. For example, if you want to sort by case name, click on the field labeled SP Name and the records will be sorted in that order.</td>
</tr>
<tr>
<td><strong>Delete Selected Solution(s)</strong></td>
<td>Allows you to delete individual or groups of records.</td>
</tr>
<tr>
<td><strong>Recover Deleted Solutions</strong></td>
<td>A back-up facility to recover any records you may accidentally delete. You can only recover these &quot;deleted solutions&quot; while you are in the current use of PID. If you close the PID program, you will lose the ability to recover these records.</td>
</tr>
</tbody>
</table>
View Current Solution (Graphics)  
This option allows you to see the Multi-Viewer Graphics, exactly as they were when you exported the information to PID.

Highlight the solution record you want to see the graphics for and select **View Current Solution (Graphics)**. You will then see the graphics for that record.

![Graphics View](image)

To return to the numerical information screens, in PID, simply select the **File** menu and click on **Close**.

<table>
<thead>
<tr>
<th>Launch as New Analysis</th>
<th>Allows you to use a selected solution record as the input for a new Pallet Group analysis. When you select this option the program will automatically open the appropriate Pallet Group module (in our case Rectangle/Oval) and fill in all of the data input fields for you.</th>
</tr>
</thead>
</table>

**Arrange and Design Group Solutions**

Basically, the records for Arrange and Design will contain more individual pieces of information because these programs involve the primary package size and the number of items per bundle/case.

Here is the information in view for **Arrange** solutions in PID. The essential differences are:

- The primary pack length, width and height.
- The number of primary packs per load.

When you execute the **Search** option you can set one of the criteria to be the number of primary packs in a secondary pack, the number of primary packs per bundle, etc.

Here are the extra search criteria available for the Arrange and Design solutions/records.

- Primary Pack Length (OD)
- Primary Pack Height (OD)
- Bundle Length (OD)
- Bundle Height
- Primary Pack Width (OD)
- Primary Packs per Bundle
- Bundle Width
- Bundles per Secondary Pack
Exporting Casefill Solutions to PID

Casefill works on finding the best “fit” for a single primary pack into a range of different case sizes. Thus, the information stored here is slightly different to the Pallet, Arrange and Design record.

The full range of information is as follows.

- Secondary Pack Length, Width and Height (ID)
- Primary Pack Length, Width and Height (OD)
- Number of Primary Packs per Secondary Pack
- Secondary Pack Length, Width and Height (OD)
- Number of Primary Packs per Load
- Area Efficiency (%)
- Cube Efficiency (%)

Exporting Information from the PID Database

We have added a batch Export of solutions from the PID. Simply highlight the solutions you want to export and then select the option from the File menu while in your Packaging Information Database.

The Export Solution screen appears for you to include a file name for your text file.

When you have exported, you will have a CSV file with text (shown in the Excel window below) as well as a JPG file depicting the CAPE PACK report for each of the records you selected (shown in the Explorer window below).
Corrugated Compression Strength

Introduction

The Strength Program allows you to evaluate the effects of a number of loading parameters and environmental conditions on the predicted individual case compression strength and on the resulting stacking height of a pallet load.

This program and the McKee formula relate to a standard Regular Slotted Container (top loading) case style. To run the Metric version of this program, you must install the European English version of the software.

The Case Compression Strength program uses the North American version of the universally accepted McKee Formula for calculating initial case compression strength. As input to the calculations, the McKee formula requires the combined board Edge Crush Test (ECT), Caliper (CAL) and Case Perimeter (PER) information.

The McKee formula is expressed as

\[
\text{Compression Strength} = 5.874 \times \text{ECT} \times \text{CAL}^{0.508} \times \text{PER}^{0.492}
\]

(For more information on the McKee formula, please refer to the August 1963 issue of Paperboard Packaging, Compression Strength Formula for Corrugated Boxes by R. C. McKee, J. W. Gander, and J. R. Wachuta published by The Institute of Paper Chemistry, Appleton, Wisconsin, USA. Also reprinted in Chapter 11, Compression Strength Formula for Corrugated Board, Performance and Evaluation of Shipping Containers, George C. Maltenfort, copyright 1989.


Accessing the Strength Program

Strength can be accessed from two different places.

From the Programs menu on the Front Menu screen, under Other Programs.

Or from the Tools menu in Multi-Viewer Graphics after you have calculated solutions in either the Pallet, Arrange or Design group programs.
Or you can click on the Strength icon on any of the appropriate toolbars.

The difference between the two analysis options is that running Strength from the Front Menu or data input area gives you the ability to evaluate compression strength for a single case or a user defined palletized load. If you run Strength from the Tools menu in Multi-Viewer Graphics, you are restricted to using one of the pallet patterns taken from one of the calculated solutions.

Navigating the Strength Program

Like all parts of CAPE PACK, the Strength program features menu options, buttons and right-clicks that allow you to accomplish the tasks you need. The following is a brief overview.

File Menu

The following are the File menu options on the main Strength window.

Reset to Environment

This will reload your environmental database to the last saved version of your Local data (str.cap).

Reset to Default Environment

This will reload your environmental database to the last saved version of your Default data (strength.stf).
Save Local Environmental Changes

This will save the currently active environmental database as the Local data (str.cap).

Update Default Environment

This will save the currently active environmental database as the Default data (strength.stf).

Close

Exits the Strength Program.

Options Menu

The following are the Options menu items on the main Strength window.

![Options Menu]

Work with Case

Allows you to evaluate the strength of a single case, rather than a palletized load. Dynamic Strength will not be active if this option is chosen.

Work with Pallet

Allows you to evaluate the strength of a palletized load.

Results in Metric

Displays your results converted to metric units of measure.

Results in In/lb

Displays your results in imperial units of measure.

Select New Configurations

Allows you to review strength for different solutions.

Analyze this Configuration

Calculates the strength of the input data showing on the screen.
Show Environmental Data
Takes you to the Environmental database tabs.

Show Partition Types
Shows you a picture of the Strength divider types. Press any key to close this screen.

Show Formulas
Takes you to the Environmental database tabs, with the Formulas tab active.

Right-Click Options
In the main Strength window, if you right click on any of the Solution Parameters fields, the program will take you to the Environmental database tabs.

If you right-click on the Partition Type field, the picture of the Strength divider types will appear. Press any key to close this screen.

Understanding the Strength Program
The following section describes the North American version of the CAPE PACK Strength program.

The edge crush values and calipers provided within the board grade combination databases are provided for demonstration purposes only. You should create your own board grade information to use within the program.

In this program, you have access to five databases which provide direct input for the McKee formula calculations. Together these databases make up the Environmental Data.

These databases are:

- The Single Wall Materials Database
- The Double Wall Materials Database
• The Storage Environment Database
• The Case Configuration Database
• Material Factors Database

To access these databases from the input screen Options menu, select Show Environmental Data.

The Single Wall and Double Wall features let you build databases of Single Wall and Double Wall board grade combinations along with their respective descriptions, flute types, caliper and edge crush values.

The Storage Environment and Case Configuration Databases contain each of the environmental and case design parameters that can be used to affect the final compression strength value. For each individual parameter you can change the multiplication factor so that the final calculated compression strength matches, as closely as possible, your own distribution environment.

Once you have constructed the databases for your own board grade combinations, environmental factors and case design factors, you can run the Case Compression Analysis with all the relevant information incorporated within the McKee formula.

The McKee formula will calculate the initial case compression strength. The program will then multiply this value by the factors you have specified for the load parameters and environmental conditions. This methodology is designed to accurately predict the case compression strength at the end of your specified time period using the appropriate palletizing information and safety factor.

Updating your data

If any of the data is changed in your Strength program including environmental data, printing options or Solution Parameters, you will be prompted to save this data when you exit the program.

Material Factors Database

The Material Factors Database contains all of the Liner, Medium, take up and efficiency factors that are used to calculate the combined board edge crush value, from either the ring crush or STFI formulas. For each liner and medium, you can enter a ring crush and/or STFI value and caliper. For take up factors, you can enter any flute type with the corresponding take up factor. For efficiency factors you can enter any value for boards up to 200-pound burst and another for any board over 200 pound burst.

Before you can enter new Single or Double Wall board grades, you must make sure that their Liners and Mediums are in the Material Factors database.
Once entered, these factors are run through the formula on the formulae tab screen and the resulting edge crush value is entered in the appropriate field in the Single Wall or Double Wall database.

Data Input Fields

The following data fields are included in the Material Factors Database.

<table>
<thead>
<tr>
<th>Liner Materials</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Matl (Material)</td>
<td>Enter the basis weight (lbs/msf) of the liner material to be used in a finished board in either the Single Wall or Double Wall database.</td>
<td></td>
</tr>
<tr>
<td>RC (Ring Crush)</td>
<td>Enter the Ring Crush value for the liner.</td>
<td></td>
</tr>
<tr>
<td>STFI (STFI)</td>
<td>Enter the STFI value for the liner.</td>
<td></td>
</tr>
<tr>
<td>CAL (Caliper)</td>
<td>Enter the caliper of the liner.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Medium Materials</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Matl (Material)</td>
<td>Enter the basis weight (lbs/msf) of the medium material to be used in a finished board in either the Single Wall or Double Wall database.</td>
<td></td>
</tr>
<tr>
<td>RC (Ring Crush)</td>
<td>Enter the Ring Crush value for the medium.</td>
<td></td>
</tr>
<tr>
<td>STFI (STFI)</td>
<td>Enter the STFI value for the medium.</td>
<td></td>
</tr>
<tr>
<td>CAL (Caliper)</td>
<td>Enter the caliper of the medium.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Take Up Factors</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Flutes</td>
<td>Enter the flute type.</td>
<td></td>
</tr>
<tr>
<td>Factor</td>
<td>Enter the take up factor for the flute.</td>
<td></td>
</tr>
<tr>
<td>Caliper</td>
<td>Enter the caliper of the flute.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Efficiency Factors</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>The Efficiency Factors are used to convert the ring crush test value to linear inches. Enter the factor to be used in the conversion to edge crush formula for boards up to 200 lbs. burst and over 200 lbs. burst.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Modifying Material Factor Information

To modify a liner or medium, double click on the row. Or you can click on the row and then the **Edit...** button.

The material information will appear in a new window for you to edit.

![New Liner Material](image)

Make your changes to existing entries and click on **OK**.

When you edit the Ring Crush or STFI values of existing materials and click on **Save**, the Edge Crush of any boards in your database that use these materials will automatically be updated.

To add materials to the list, click on the appropriate **New...** button.

Enter the appropriate values and click on **OK**. Your list will automatically be updated.

Single Wall and Double Wall Materials Databases

The Single Wall and Double Wall Materials Databases will store up to 200 Single Wall and 100 Double Wall combinations along with their respective Description, Flute, Edge Crush and Caliper values.

When calculating initial case compression results, the Edge Crush and Caliper values from the database are used as direct input into the McKee formula. This value is then multiplied by any of the Storage Environment and Case Configuration factors you have selected:
Data Fields

The following fields are included in the Single Wall and Double Wall Materials Databases.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>The Mullen Burst Test value for the board grade. The database combinations are ranked by this value.</td>
</tr>
<tr>
<td>Liner/Medium/Liner</td>
<td>The Basis Weight of the paper used for each liner and the medium.</td>
</tr>
<tr>
<td>Description</td>
<td>A description identifying each board grade (up to 35 characters may be used).</td>
</tr>
<tr>
<td>Flute</td>
<td>Enter A, B, C or E to identify the flute type of each particular board.</td>
</tr>
<tr>
<td>Edge Crush</td>
<td>Enter the known (or estimated) Edge Crush value for each board combination which will be used as input into the McKee formula and run through the Compression calculations. The program allows for three different types of Edge Crush values: Ring Crush, STFI and Custom. The Ring Crush and STFI values are derived from their respective testing procedures. Both tests involve the testing of individual samples of paper, but differ slightly in sample size and testing method. When the results from these tests are entered into their respective Edge Crush formulas, the resulting values are used to predict the finished combined board compression strength. The Custom value is normally obtained from testing a sample of the board.</td>
</tr>
<tr>
<td>Ring Crush (RC)</td>
<td>Automatically calculated from Ring Crush values in the Material Factor Database.</td>
</tr>
<tr>
<td>STFI (STFI)</td>
<td>Automatically calculated from STFI values in the Material Factor Database.</td>
</tr>
<tr>
<td>Custom (Cstm)</td>
<td>Manually entered by the user.</td>
</tr>
<tr>
<td>Caliper</td>
<td>The caliper (thickness) of the board grade, in inches. This value goes directly into the McKee formula for compression calculations.</td>
</tr>
<tr>
<td>Use</td>
<td>This field gives you the ability to activate/deactivate board grades in your list. By clicking on this column you can toggle between Y (use the board) and N (don't use the board). Once changed and your solution data is saved, this data will remain as adjusted until you change it again (i.e., the board stays on until you go back into the database and turn it off).</td>
</tr>
</tbody>
</table>

Changing Board Information

To modify a field, double-click on the row with that board, or click on the row and then on the Edit Board button.
Change any information you want in the fields provided and click on **OK**.

### Adding Board Grades

To add a board, click on the **New Board** button.

Type in all the information for the board and click on **OK**.

### Deleting Board Grades

To delete a board from the database, select the row by clicking anywhere on the row. Click on the **Delete Board** button.

To save your changes to the database, click on the **File** menu and then **Close**.

In the main Strength screen, click on the **File** menu and then **Save Local Environmental Data** or **Save Default Environmental Data**.

---

The Strength program gives you the option of saving two different sets of data. The local environment data will be saved to your Tutor folder as STR.XXX, where the XXX represents your login ID. If you are not asked to Login to CAPE PACK, the file will be called STR.CAP. The local environment is the “working” copy of your Strength database. When you exit the Strength program, you are prompted to save to this file.

The default environment serves as a back-up to your Strength database. This way, should your database ever become corrupted, you can use the default to rebuild your local environment. The default environment is maintained in a file called Strength.stf in the Tutor folder. If you want to update this environment, **you must select File, Save Default Environmental Data**.

---

### Deactivating Boards in the Database without Deleting Them

To deactivate a board, click on the **Options** menu and **Select Boards to Use**.
The following box will appear.

Highlight the boards you want to deactivate and click on **Yes**. You can use the standard Windows Control and Shift key functions to highlight blocks of boards.

To reactivate the board, highlight them and click on **No**.

**Case Configuration Factors Database**

The Case Configuration factors Database contains all of the case design factors along with their respective values which are used when factoring (multiplying by) the initial calculated compression value. For example, after the strength of a case is computed, that result may be increased or decreased based on how much printing is on the carton, which partition is being used or even what type of case you use. By taking these factors into consideration, the software gives a more “real world” result.
Once you have set the factors within the database to match the type of container you are evaluating, you can predict the required compression strength for a variety of different corrugated box styles and manufacturing methods.

Data input fields

The following data fields are included in the Case Configuration Factors Database.

<table>
<thead>
<tr>
<th>Case Proportions</th>
<th>A value used to reflect how your box would perform in relation to the panel dimensions. This also works in conjunction with Case Orientation if a tall narrow case is placed on its end.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Types</td>
<td>A value for different corrugated case styles.</td>
</tr>
<tr>
<td>Divider/Partition Type</td>
<td>A value for the additional compression strength added to the case as a percentage of the case compression strength. See the Pack Types and Divider Styles chapter for further information.</td>
</tr>
<tr>
<td>Amount/Type of Printing</td>
<td>A value for different amounts of printing.</td>
</tr>
<tr>
<td>Fluting</td>
<td>A value for the direction of fluting.</td>
</tr>
<tr>
<td>Length/Width Ratio</td>
<td>A value used to reflect how your corrugated case would perform in relation to one panel length to another. This also works in conjunction with Dimension Vertical if a tall, narrow case is placed on its end.</td>
</tr>
</tbody>
</table>

Modifying Case Configuration Factors

For each of the individual factors, click on the field and enter a value. Your value is automatically saved. This value will be used in the final multiplication of initial compression strength to obtain the final predicted compression strength.

Click on any tab to move to another section.

Storage Environment Database

The Storage Environment Database contains all of the environmental factors used in the predicted compression calculations and the respective values that are to be used when factoring (multiplying by) the initial calculated compression value. For example, if you choose a humidity of 90% and the respective factor value is .50, the initially calculated compression strength will be multiplied by .50 (or reduced by 50%) prior to displaying the predicted compression strength.
Once you select a series of environmental factors that will affect the estimated compression strength of the case, the program will use the corresponding numbered value for each of the environmental factors in the compression strength calculations.

Once you have set the factors within your database to match the theoretical conditions to which your corrugated cases will be subjected, it can be used within the initial calculations to replicate your own distribution environment. This will allow you to fine tune your corrugated requirements. Thus, you can ensure that you are only purchasing the strength of corrugated cases that you actually need.

**Data input fields**

The following data fields are included in the Storage Environment Database.

<table>
<thead>
<tr>
<th>Data Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Relative Humidity</td>
<td>A factor for each Relative Humidity range listed.</td>
</tr>
<tr>
<td>Days of Storage</td>
<td>A value for each range of days listed.</td>
</tr>
<tr>
<td>Case Orientation</td>
<td>A value for whichever panel of the corrugated case will be placed flat on the pallet.</td>
</tr>
<tr>
<td>Pallet Surface</td>
<td>A factor reflecting use of a gapped or solid surface on which the corrugated case will be placed.</td>
</tr>
<tr>
<td>Stacked/Interlocked</td>
<td>A factor to be used depending on whether or not you choose to rotate/alternate layers in the load. This especially impacts the second layer of cases from the bottom of the load.</td>
</tr>
<tr>
<td>Overhang</td>
<td>A value for each range of overhang listed. This is calculated for the maximum overhang on any one of the four pallet sides.</td>
</tr>
</tbody>
</table>

**Modifying Storage Environment Factors**

For each of the individual factors, click on the field and enter a value. Your value is automatically saved. This value will be used in the final multiplication of initial compression strength to obtain the final predicted compression strength.

Click on any tab to move to another section.

**Using a Custom Formula**

You can substitute your own data into the McKee Formula thereby creating your own custom formula.

Click on the **Options** menu and then choose **Show Formulas**.
From the screen that follows, click on the **Edit** button in the Custom Formula section.

The following Custom Formula Entry screen appears.
Adjust the various fields to suit your own formula and click on Save. Your new formula will appear in the **Custom** section.

## Determining the Strength of a Single Case

To run the single case Strength Analysis option, click on **Programs, Other Programs, Strength** at the Front Menu screen.

The Single Case Compression Strength Analysis is used to simulate in-lab test conditions for a single case using the case depth vertical on a flat pallet.

You will notice that under the **Options** menu, **Work with Case** is checked. This is the default. You can switch to a pallet load analysis by clicking on **Work with Pallet**.

Enter the **Product Name**, **Product Code**, case dimensions, dimension vertical and the **Solution Parameters**. Once all necessary data is entered, the **Solve** button will activate.

Click on **Solve** to calculate compression strength solution information.

Choose the appropriate **Display/Print** options and click on the Single Wall or Double Wall tabs.
Determining the Strength of a Palletized Case

The Palletized Case analysis is used to simulate a user-defined pallet loading situation where you input the case dimensions. This is useful for calculating compression strength and safe pallet load stacking heights for a particular pallet load configuration without having to run a palletizing analysis or if you only have limited palletizing information. It can also be used to plan ‘what if’ situations for potential pallet configurations when exact dimensions may not be known.

To run a Strength analysis on a palletized case, select **Strength** from the **Programs** menu, **Other Programs** at the Front Menu screen. The following screen will appear.

Click on the **Options** menu and **Work with Pallet**. The screen changes.

Enter your **Product Name** and **Product Code**.

Enter your case dimensions and weight.

Enter your **Pallet Dimensions** and weight. This information refers to the pallet itself, not the load.
Enter any overhang.

Enter the number of cases on a single layer of the load and the number of layers on the pallet.

Last, enter your Solution Parameters.

**Data Fields**

The following data fields are included in the Solution Parameters window:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td>The maximum humidity your product will be subjected to through its shipping cycle (0-100%). Bear in mind that once humidity adversely affects corrugated, lowering the humidity will not repair the damage incurred under loading.</td>
</tr>
<tr>
<td>Days in Storage</td>
<td>The length of time the corrugated will be subjected to the specified conditions (0-999). As an alternative, this can also be used to find the proper board grade needed to survive a given number of days in storage.</td>
</tr>
<tr>
<td>Additional Internal Support</td>
<td>Enter (in lb.) the amount of additional support your product adds to the calculated corrugated case compression strength (0-9999). With this value at 0, only the strength of the case is calculated. Any other value will add the entered value to the calculated compression strength prior to displaying the final value on the Solution Report. If you do not know this value and cannot estimate a value, use a straight percentage of the case total. It is entirely possible that if you have a rigid or solid product this value could be more than the actual case compression strength value.</td>
</tr>
<tr>
<td>Pallet Stack Height</td>
<td>The number of pallets stacked one on top of another, for compression calculations.</td>
</tr>
<tr>
<td>Partition Type</td>
<td>From the list of available partition types (which all add support to the case) choose the type that most closely represents the one you use. If there is not an exact match, choose a style that uses a bigger or smaller factor, or change any factor to meet your own needs. The partition type factor, in the Case Configuration Database, is the percentage of the individual initial case compression strength added to the initial value prior to displaying the final calculated value on the Solution Report.</td>
</tr>
<tr>
<td>Partition Material</td>
<td>If the partition is made up of a material different than that of the case, select the material that most closely matches your partition material.</td>
</tr>
<tr>
<td>Case Type</td>
<td>Choose the case type that most closely matches your case type.</td>
</tr>
<tr>
<td>Amount of Printing</td>
<td>Choose the amount of printing that most closely matches your case.</td>
</tr>
<tr>
<td>Interlock of Load Layers</td>
<td>Click on this box if you are alternating the pattern arrangement for layers (or if at least the second layer from the bottom of the load).</td>
</tr>
<tr>
<td>Horizontal Fluting</td>
<td>Check this box if your case is made with horizontal fluting.</td>
</tr>
<tr>
<td>Gapped or Solid Pallet</td>
<td>If there are any gaps in the pallet surface, click on this field. You can then fine-tune the Gapped Input Factor in the Environmental Factors Database to reflect the amount of gap in your pallet surface relative to the panel lengths of the case you are evaluating.</td>
</tr>
<tr>
<td>Solution Mode</td>
<td>Specify the method of calculating the Edge Crush for the boards in the Single Wall and Double Wall databases.</td>
</tr>
</tbody>
</table>

Your completed screen should look something like the following.
Click on the **Solve** button to view the Parameters tab.

Keep in mind you are setting the parameters for a complete palletized load.

Click on the Single Wall or Double Wall tabs to see calculated strengths of the different boards in those databases. You will notice that Dynamic Strength is now filled in. This represents the Strength of your palletized load with the factors for humidity, days in storage, etc. included.
Determining Strength for a CAPE PACK Solution

The program can calculate the strength of a load designed in Pallet Group for cases, the Arrange Group, or the Design Group. The program cannot reliably calculate the strength of a mixed load or of a load that uses trays rather than cases.

Start the Strength program by clicking on **Strength** on the **Tools** menu in Multi-Viewer Graphics after calculating solutions for Pallet, Arrange or Design.

You will be presented with the following screen.
Click on the solution number to highlight the row(s) you want to evaluate and then click on Continue.

Bear in mind that when running a Pallet Analysis, each solution number represents the same size case dimensions (OD). In the Arrange or Design Analysis, each solution number represents a different size case dimension (OD).

The Case Compression Strength input screen will be displayed.

All of the Case, Pallet and Load information has been entered for you.

Enter your Solution Parameters information.

**Data Fields**

The following data fields are included in the Solution Parameters window.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Humidity</td>
<td>The maximum humidity your product will be subjected to through its shipping cycle (0-100%). Bear in mind that once humidity adversely affects corrugated, lowering the humidity will not repair the damage incurred under loading.</td>
</tr>
<tr>
<td>Days in Storage</td>
<td>The length of time the corrugated will be subjected to the specified conditions (0-999). As an alternative, this can also be used to find the proper board grade needed to survive a given number of days in storage.</td>
</tr>
<tr>
<td>Additional Internal Support</td>
<td>Enter (in lb.) the amount of additional support your product adds to the calculated corrugated case compression strength (0-9999). With this value at 0, only the strength of the case is calculated. Any other value will add the entered value to the calculated compression strength prior to displaying the final value on the Solution Report. If you do not know this value and cannot estimate a value, use a straight percentage of the case total. It is entirely possible that if you have a rigid or solid product this value could be more than the actual case compression strength value.</td>
</tr>
<tr>
<td>Pallet Stack Height</td>
<td>The number of pallets stacked one on top of another, for compression calculations.</td>
</tr>
<tr>
<td>Partition Type</td>
<td>From the list of available partition types (which all add support to the case) choose the type that most closely represents the one you use. If there is not an exact match, choose a style that uses a bigger or smaller factor, or change any factor to meet your own needs. The partition type factor, in the Case Configuration Database, is the percentage of the individual initial case compression strength added to the initial value prior to displaying the final calculated value on the Solution Report.</td>
</tr>
<tr>
<td>Partition Material</td>
<td>If the partition is made up of a material different than that of the case, select the material that most closely matches your partition material.</td>
</tr>
<tr>
<td>Case Type</td>
<td>Choose the case type that most closely matches your case.</td>
</tr>
<tr>
<td>Amount of Printing</td>
<td>Choose the amount of printing that most closely matches your case.</td>
</tr>
</tbody>
</table>
Interlock of Load Layers  Click on this box if you are alternating the pattern arrangement for layers (or if at least the second layer from the bottom of the load).

Horizontal Fluting  Check this box if your case is made with horizontal fluting.

Gapped or Solid Pallet  If there are any gaps in the pallet surface, click on this field. You can then fine-tune the Gapped Input Factor in the Environmental Factors Database to reflect the amount of gap in your pallet surface relative to the panel lengths of the case you are evaluating.

Solution Mode  Specify the method of calculating the Edge Crush for the boards in the Single Wall and Double Wall databases.

To calculate solutions, click on the Solve button and you will be taken to the Parameters Screen.

Reviewing the Results

If you do not agree with the values shown or would like to investigate another set of circumstances, you can either change these inputs or modify the appropriate factors. Regardless of which compression analysis program option you run, the calculated compression strengths for each board grade selected from the database will be displayed on these tabs.
Click on the Single Wall tab and the Solution Report will display all the board grades in the database along with their respective compression strengths.

You can scroll through the table by using the arrows on the right-hand side of the screen.

**Solution Report Information**

The new information calculated from your input data is as follows.

<table>
<thead>
<tr>
<th>Safety Factor</th>
<th>This column added only if a Safety Factor has been selected on the Parameters tab.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty Strength</td>
<td>The case compression strength (lbs.) calculated as if the case were brand new or in a laboratory test environment at optimum conditions. It is derived from the McKee formula value multiplied by factors for flute direction, case position, case proportions and case type.</td>
</tr>
<tr>
<td>Static Strength</td>
<td>The empty case strength plus the printing and divider/partition factors.</td>
</tr>
<tr>
<td>Dynamic Strength</td>
<td>Compression Strength of the case remaining at the number of days you specified on the Solution Parameters input tab. This value is derived by taking the static value and multiplying it by each factor selected (e.g., humidity, days of storage, overhang, dimension vertical, pallet surface type, interlocked layers and additional internal support). It does take into account the number of pallet loads high specified. That parameter is used for sorting successful from unsuccessful materials.</td>
</tr>
<tr>
<td>Loads High</td>
<td>This figure represents the number of loads high you can stack this case under the environmental conditions you requested. It is determined using the Dynamic Strength of the case.</td>
</tr>
</tbody>
</table>

**Printing Results**

The **Print** buttons on the tabs will print all or part of your information as follows.

- Parameters tab **Print** button: Prints all solution information for the analysis including the Parameters tab, the Single Wall and Double Wall solutions.
- Single Wall **Print** button: Prints the Parameters and Single Wall tabs only.
- Double Wall **Print** button: Prints the Parameters and Double Wall tabs only.

You can also select specific boards to print if you do not wish to print all of the data.
Click on the *Print Selected* field at the bottom of the screen next to the **Print** button, and then click on the **Print** button. The following box appears.

![Print selected single test materials](image)

Highlight the boards you want to print and click on **Yes**, or highlight the boards you don’t want to print and click on **No**.

Click on **OK** to print your report.

When you click on **Close**, the program will prompt you about saving your data for your graphical solution report.

![Multi-Viewer Graphics Strength report options](image)

If you want to save the data for inclusion in your normal CAPE PACK report from the MultiViewer Graphics screen, mark that option. Then you can select if you want to print all boards or only the ones you selected. If you simply chose to print successful materials, that will be considered “selected” boards by the program.

If you choose to Print Selected boards, the following screen will appear when you click on Close.
Your CAPE PACK graphical solution report will include the Strength data on additional pages.

Establishing Safety Factors

After you have clicked on the Solve button on the Solution Parameters data input screen, you will see the Parameters output tab.

On the screen you will choose what factors will be used to display the board grades which successfully meet your chosen requirements. Your Display/Print options are:

<table>
<thead>
<tr>
<th>Display/Print Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Materials</td>
<td>Will display the solution for all the materials in the Single Wall and Double Wall databases.</td>
</tr>
<tr>
<td>Successful Materials</td>
<td>Will display only those solutions in which the dynamic strength will support the projected weight.</td>
</tr>
<tr>
<td>+/- Compression Strength &gt;</td>
<td>Lets you set a percentage that will be applied to the weight on the bottom case figure to search for solutions whose Dynamic Strength falls within that range. Be aware that the percentage relates to the weight of an individual case.</td>
</tr>
<tr>
<td>Materials with Safety Factor &gt;</td>
<td>In the corrugated industry, and any theory related to the estimated compression strength of corrugated containers, the term safety factor means different things to different people who estimate it and calculate it</td>
</tr>
</tbody>
</table>
In theory, the safety factor is an estimation that, based on the various conditions the container will be subjected to, including its design, tells the designer how much stronger to design a container than the actual weight on the bottom container in a load. Usually, the more severe the shipping and distribution environment, the higher the safety factor you would want. For instance, if you want a container to be four times stronger than the greatest weight it will have to support, this means the initial compression strength of the container should be four times the most weight it will ever have to support. You would enter a safety factor of four. Keep in mind, everyone has a different idea of what their safety factor should be, but a rule of thumb in the corrugated industry is between 3 and 5. This means for a corrugated container, it should be designed to be 3 to 5 times stronger upon initial testing that the greatest load it will have to support.

In the compression strength program, you can select the safety factor you want to use, and only those board combinations which meet or exceed the chosen safety factor will be displayed. For example, if your pallet loads will never be stacked more than two loads high, the greatest weight on the bottom container will never exceed the weight of the two pallet loads. If you ask for a safety factor of four, the calculations will only provide you with those board grade combinations in the database that meet or exceed four times the weight on the bottom container of the bottom pallet load.

Enter the Safety Factor you wish to use along with the Empty, Static or Dynamic Strength. Only those solutions that meet or exceed the specified Safety Factor will be added to the report.

Order Solutions

Choose the way you want the Single Wall and Double Wall databases ranked, either by Burst Test, Flute Type or Compression Strength.

Load Data

Displays the chosen number of pallets high and corresponding weight on the bottom case. This weight is the starting point for the calculation of the safety factors chosen.

On the Task Bar in the lower right-hand corner of the screen you will see the method of calculating the edge crush (i.e. ring crush), the units of measure, and the method of calculating the initial compression strength.

Exporting Solution Data

You can either copy your data to the clipboard and paste it into another application, such as Excel, or you can export the data to a text (TXT) file.

All data for this configuration will be exported/copied to the clipboard. You cannot export just a single board grade.

To exit the solution, click on Close.

To exit Strength, select the File menu and then choose Close, or use the Close button.
Opening Saved Graphics Files

Introduction

Open Saved Solutions is a feature that has been provided to let you view saved graphics files at a later date/time. It can also be used in a network environment, to let your colleagues see the results of your work with CAPE PACK.

The idea is that you run an analysis, choose a solution, manipulate the graphics and then save that graphics solution. Then, instead of having to rerun the analysis, you can use the conveniently located Open Viewer: Open Saved Solutions function under the File menu on the Front Menu screen.

You have these two choices when opening saved solutions for either the normal CAPE PACK single product solutions or the Display Pallet (Club-store) solutions.

- **Solution Dialog:** Shows only those CLF files with saved graphical solutions.

- **Standard Dialog:** Shows all files in a standard Windows Open box.
If you have a large number of clf files in your private folder, it is recommended that you use the Standard Dialog method. The program response time will be much quicker this way.

**Saving Graphics**

Here is your screen in the Multi-Viewer Graphics.

From the **File** menu, select **Save Solution** to save your graphic solutions with your input data to the same file name, or **Save Solution As** to use a different file name.

**Opening your Saved Graphics file**

Go to the Front Menu and select the **File** menu. Choose **Open Viewer/Open Saved Solutions, cape pack, Solution dialog**. The program will display all the files in your Private path that have saved solutions.
Each file is identified by the name, the program module used to create it, the units of measure, the secondary package dimensions and the product name and code. Highlight the file you want to open and click on the Select button. Your file will be opened in the Multi-Viewer.

Points to remember about Saved Solutions

It is important to remember that you are saving the graphics for a single solution. If you rerun the data input, you will lose the saved graphics.

If you have saved the graphics for a particular solution and then try to re-run the analysis you will see a warning message when you select Save Input Data. In this situation you should choose the Save As option and give your saved graphics file another name. This will retain your original file with its saved graphics.
Data Import and Export

Introduction

CAPE PACK has extensive and versatile import and export capabilities which make interfacing with other systems and programs an easy process. You can import your data from your existing files or systems with the use of our CIF file and a simple command line. We have provided examples of this process in the form of Excel and Access documents.

In addition, you can export ASCII text of your load results as well as standard graphics forms of your diagrams. These industry-standard file types can be used in virtually all systems that are used in the market place today.

Automating Your Input Data

The CAPE Interface Files have been provided to allow users to import any or all of the data input required to automatically fill out the input fields for an individual CAPE PACK program module (i.e. Pallet - Bags).

These CIF files are updated on a regular bases as and when new features are added to the CAPE PACK programs. To make sure you have the latest files, please check with CAPE Systems.

This approach avoids the user having to manually enter data that may already be available in existing databases or other proprietary programs. See below.
Once the data has been imported, via a macro, it is the responsibility of the user to check/validate the data before executing the Save or Save As commands, within CAPE PACK.

The CAPE Interface Files (CIF), supplied with your CAPE PACK program, are in a Windows .INI format and they are located in the Tutor Path of CAPE PACK. However, you can create as many CIF files as you need and locate them in a directory of your choice.

Remember, in the command line instruction, you must identify the name of your CIF file and where it is located.

There is a CIF for each of the following program modules in the CAPE PACK Tutor directory.

**Pallet Group**

- Rectangle/Oval (PAL1.CIF)
- Cylinder/Bottle (PAL2.CIF)
You can create as many CIF files as you need and you are not restricted to using the filenames listed above. Any file name can be used. Just remember to include the name and location of your CIF file in your command line instruction.
Running CAPE PACK using CIF Files

To operate the CIF file format you will need to create a macro that extracts the relevant data (for any or all fields within the required CIF) from another program or application. The macro must also place the appropriate information in the correct field for each piece of data input that might be available from the other program/application.

Any input data not available from another program/application can be entered manually by the user once the command line instruction has been activated and the fields on the CAPE PACK input screens have been populated.

Use of Command Line Instructions

Once the CIF has been populated with the required input data, you will need to issue a command line instruction to run the appropriate CIF and start the CAPE PACK program.

This action will initiate the appropriate program module, bypass the normal CAPE PACK Licensing and Front Menu screens, and load the selected program module with the appropriate data input fields already populated.

Here is an example of the command line instruction to run a Pallet Group - Rectangle/Square (PAL1.CIF).

"C:\Program Files(x86)\cape213\Cmenu32.exe" /CIF C:\Program Files(x86)\cape213\Tutor\Pal1.cif

Once the CIF file is created you use the command line instruction to begin the process. You will not see the normal CAPE License screen or the Front Menu. All you will see is the "Loading xxx Module” screen, followed by the first input screen (for your selected module) with your data already loaded.

Opening CIF Files for Data Input

We have added the option for you to open your previously created or saved CIF (CAPE Interface File) from the Front Menu in CAPE PACK, simply select it from the file menu and it will open the program group and the input data from the CIF as well.
Your program will open with the data preloaded.

And if you have the CIF designed to calculate, the program will automatically take you to Multi-Viewer Graphics.
Saving CIF Files

In the **Program Settings** under the **File** menu, choose **More Settings**.

The following screen appears.

Click on **Activate CIF** to activate this feature.
CIF Files Structure

Here is a separate listing and detailed description of the file structures for all of the CIF files for each of the program modules.

The File Extension CIF
The File Type Windows INI

File Format for Pallet - Rectangle/Oval

[General] - Section Name
Field #1 = 1 (Pallet - Rectangle/Oval)
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #5 = Inside or Outside Dimensions (1=Inside Dimensions, 2=Outside Dimensions)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #41 = User Text free flow line 1
Field #42 = User Text free flow line 2
Field #43 = User Text free flow line 3
Field #44 = User Text free flow line 4
Field #45 = User Text free flow line 5
Field #46 = User Text free flow line 6
Field #47 = User Field 1
Field #48 = User Field 2
Field #49 = User Field 3
Field #50 = User Field 4

Secondary Pack Data
[Secondary Pack] - Section Name
Field #1 = Outside Length Dimension
Field #2 = Outside Width Dimension
Field #3 = Outside Height Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Pack Type
  1 = RSC (2,2,4)
  2 = FOL (2,2,6)
  3 = CSSC (2,2,4)
  4 = SURFACE (2,2,2)
  5 = SLEEVE (2,2,0)
  6 = TRAY (4,2,1)
  7 = END (2,2,4)
  8 = Custom (Specify Mat. Thicknesses in Field #15 - 17)
  9 = None
 10 = No Package
 11 = Shrink Wrap
1000 = Custom Shape Name (Enter shape name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height  
Field #18 = Material thickness  
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)  
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)  
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)  
Field #37 = Length Bulge Allowance  
Field #38 = Width Bulge Allowance  
Field #39 = Height Bulge Allowance  
Field #59 = Tray Wall height  
Field #64 = Inside Length Dimension  
Field #65 = Inside Width Dimension  
Field #66 = Inside Height Dimension  

Pallet Restrictions Data  

**[Pallet Restrictions#1] - Section Name**  
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)  
Field #2 = Maximum Height  
Field #3 = Maximum Weight  
Field #4 = Maximum Length Overhang  
Field #5 = Maximum Width Overhang  
Field #6 = Minimum Load Length  
Field #7 = Minimum Load Width  
Field #8 = Minimum Area Efficiency  
Field #9 = No Pattern Gaps (1=Yes, 0=No)  
Field #10 = Clamp in Length (1=Yes, 0=No)  
Field #11 = Clamp in Width (1=Yes, 0=No)  
Field #12 = Maximum offset  
Field #13 = Minimum Contact (Percentage - %)  
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)  
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)  
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)  
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)  
Field #27 = Pallet Length  
Field #28 = Pallet Width  

**[Pallet Restrictions#2] - Section Name**  
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)  
Field #2 = Maximum Height  
Field #3 = Maximum Weight  
Field #4 = Maximum Length Overhang  
Field #5 = Maximum Width Overhang  
Field #6 = Minimum Load Length  
Field #7 = Minimum Load Width  
Field #8 = Minimum Area Efficiency  
Field #9 = No Pattern Gaps (1=Yes, 0=No)  
Field #10 = Clamp in Length (1=Yes, 0=No)  
Field #11 = Clamp in Width (1=Yes, 0=No)  
Field #12 = Maximum offset  
Field #13 = Minimum Contact (Percentage - %)  
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)  
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)  
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

**[Pallet Restrictions#3] - Section Name**
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Percentage - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)

**[Master Base] - Section Name**
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data

**[Truck Restrictions] - Section Name**
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. If Inside Dimensions (Field #5 in the General Section) for the Secondary Pack are selected then Fields 15-18 will need to be completed.
4. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required. Also, Field #3 and Field #4 in the Truck Restriction section are replaced by Field #5 and Field #6 respectively, also, Field #7 will now be relevant since this Field only works with Cylinders. The
reason for this is since cylinders will be palletized into Trucks the patterns applied change from the CAPE six standard
patterns to Row / Columns or Nested.

File Format for Pallet - Bag

[General] - Section Name
Field #1 = 3 (Pallet – Bag)
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47 = User Field 1
Field #48 = User Field 2
Field #49 = User Field 3
Field #50 = User Field 4

Secondary Pack Data
[Secondary Pack] - Section Name
Field #1 = Length Outside Dimension
Field #2 = Width Outside Dimension
Field #3 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Pack Type
1 = Default
1000 = Custom Shape Name (Enter shape name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance

Pallet Restrictions Data
[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify
Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width
Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required. Also, Field #3 and Field #4 in the Truck Restriction section are replaced by Field #5 and Field #6 respectively, also, Field #7 will now be relevant since this Field only works with Cylinders. The reason for this is since cylinders will be palletized into Trucks the patterns applied change from the CAPE six standard patterns to Row / Columns or Nested.

File Format for Pallet - Cylinder/Bottle

[General] - Section Name
Field #1 = 2 (Pallet Cylinder/Bottle)
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #6 = Recessed Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #21 = Allow vary cylinder size (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Secondary Pack Data

[Secondary Pack] - Section Name
Field #3 = Height Outside Dimension
Field #4 = Top Outside Diameter
Field #5 = Bottom Outside Diameter
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Pack Type
1 = Default
1000 = Custom Shape Name (Enter shape name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #34 = Allow On Side Orientation on Pallet (1=Yes, 0=No)
Field #35 = Allow Upright Orientation on Pallet (1=Yes, 0=No)
Field #36 = Recess Factor
Field #50 = Diameter Dimensional Variance (+)
Field #51 = Height Dimensional Variance (+)
Field #52 = Diameter Dimensional Variance (-)
Field #53 = Height Dimensional Variance (-)
Field #54 = Diameter Dimensional Increment
Field #55 = Height Dimensional Increment
Field #56 = Vary Volume By (Percentage - %)
Field #57 = Vary Weight with Volume (1=Yes, 0=No)

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #20 = Row / Column Pattern Allowed on Pallet (1=Yes, 0=No)
Field #21 = Nested Pattern Allowed on Pallet (1=Yes, 0=No)
Field #22 = Hybrid Pattern Allowed on Pallet (1=Yes, 0=No)
Field #23 = Space Between
Field #24 = Partial Top Layer Permitted (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width
Field #29 = Pallet Height
Field #30 = Pallet Weight

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #20 = Row/Column Pattern Allowed on Pallet (1=Yes, 0=No)
Field #21 = Nested Pattern Allowed on Pallet (1=Yes, 0=No)
Field #22 = Hybrid Pattern Allowed on Pallet (1=Yes, 0=No)
Field #23 = Space Between
Field #24 = Partial Top Layer Permitted (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width
[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #20 = Row / Column Pattern Allowed on Pallet (1=Yes, 0=No)
Field #21 = Nested Pattern Allowed on Pallet (1=Yes, 0=No)
Field #22 = Hybrid Pattern Allowed on Pallet (1=Yes, 0=No)
Field #23 = Space Between
Field #24 = Partial Top Layer Permitted (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)
[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0 =No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #5 = Row / Column Loading Pattern Applied (1=Yes, 0=No)
Field #6 = Nested Loading Pattern Applied (1=Yes, 0=No)
Field #7 = Space Between
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required. Also, Field #3 and Field #4 in the Truck Restriction section are replaced by Field #5 and Field #6 respectively, also, Field #7 will now be relevant since this Field only works with Cylinders. The reason for this is since cylinders will be palletized into Trucks the patterns applied change from the CAPE six standard patterns to Row / Columns or Nested.

File Format for Pallet - Trapezoid
[General] - Section Name
Field #1 = 4 (Pallet – Trapezoid)
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #6 = Recessed Allowed (1=Yes, 0=No)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47 = User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Secondary Pack Data
[Secondary Pack] - Section Name
Field #3 = Height Outside Dimension
Field #6 = Top Length Outside Dimension
Field #7 = Bottom Length Outside Dimension
Field #8 = Top Width Outside Dimension
Field #9 = Bottom Width Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Pack Type (1 = Default)
Field #14 = Pack Name (Maximum 15 characters)
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #36 = Recess Factor
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance

Pallet Restrictions Data
[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Percentage - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width at Fields #27 and 28)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17=Maximum Truck Load Height
Notes: 1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required. Also, Field #3 and Field #4 in the Truck Restriction section are replaced by Field #5 and Field #6 respectively, also, Field #7 will now be relevant since this Field only works with Cylinders. The reason for this is since cylinders will be palletized into Trucks the patterns applied change from the CAPE six standard patterns to Row / Columns or Nested.

File Format for Arrange - Box/Bag/Bottle
[General] - Section Name
Field #1= 5 (Arrange - Box/Bag/Bottle)
Field #3= Product Name (Max. 50 Characters)
Field #4= Product Code (Max. 25 Characters)
Field #5= Inside or Outside Dimensions (1= Inside Dimensions, 2=Outside Dimensions)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Object onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #13 = Product Allowed (1=Yes, 0=No)
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Product Data
[Product] - Section Name
Field #1 = Product Name
Field #2 = Pack Type (1000 = Custom Shape Name)
Field #3 = Shape Name

Primary Pack Data
### Primary Pack - Section Name
Field #1 = Length Outside Dimension
Field #2 = Width Outside Dimension
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Net Weight
Field #23 = Allow Length Vertical in Secondary Pack (1=Yes, 0=No)
Field #24 = Allow Width Vertical in Secondary Pack (1=Yes, 0=No)
Field #25 = Allow Height Vertical in Secondary Pack (1=Yes, 0=No)
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type
1 = Seal End (3,2,6)
2 = Eco Seal (3,2,4)
3 = Cover Tray (6,3,2)
4 = Tray (4,2,1)
5 = DW Tray (8,4,1)
6 = REV Tuck (3,2,4)
7 = STR Tuck (3,2,4)
8 = Auto Bottom (3,2,5)
9 = TAP SHAD (2,2,2)
10 = HOL Shadow (2,3,4)
11 = Surface (2,2,2)
12 = Custom (Specify Mat. Thicknesses in Field Numbers 42-44) 1000 = Custom Shape Name (Enter shape name in Field #33)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #42 = Number of thicknesses in Length
Field #43 = Number of thicknesses in Width
Field #44 = Number of thicknesses in Height
Field #45 = Material thickness
Field #46 = Material Weight
Field #47 = Glue Flap Width
Field #52 = Length Inside Dimension
Field #53 = Width Inside Dimension
Field #54 = Height Inside Dimension

### Secondary Pack Data
#### Secondary Pack - Section Name
Field #12 = Pack Type
1 = RSC (2,2,4)
2 = FOL (2,2,6)
3 = CSSC (2,2,4)
4 = SURFACE (2,2,2)
5 = SLEEVE (2,2,0)
6 = TRAY (4,2,1)
7 = END (2,2,4)
8 = Custom (Specify Mat. Thicknesses in Field #15 - #17)
9 = None
10 = No Package
11 = Shrink Wrap
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18 = Material thickness
Field #19 = Material Weight
Field #20 = Glue Flap Width
Field #21 = Primary Pack Count per Secondary Pack #1
Field #22 = Primary Pack Count per Secondary Pack #2
Field #23 = Primary Pack Count per Secondary Pack #3
Field #24 = Primary Pack Count per Secondary Pack #4
Field #25 = Primary Pack Count per Secondary Pack #5
Field #26 = Primary Pack Count per Secondary Pack #6
Field #27 = Primary Pack Count per Secondary Pack #7
Field #28 = Primary Pack Count per Secondary Pack #8
Field #29 = Minimum Count per Secondary Pack
Field #30 = Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Length Outside Dimension
Field #45 = Minimum Width Outside Dimension
Field #46 = Minimum Height Outside Dimension
Field #47 = Maximum Length Outside Dimension
Field #48 = Maximum Width Outside Dimension
Field #49 = Maximum Height Outside Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) - Only applies if you are working in (in/lb) Units.
Field #59 = Tray Wall height
Field #60 = Divider / Partition
0 = None
1 = 1-Way
2 = 2-Way
3 = 3-Way
4 = Sleeve
5 = H-Pad
6 = S-Strip
7 = 8-Strip
8 = Divides Length
9 = Divides Width
10 = Divides Height
11 = Divide Rows
12 = Divide Columns
13 = Z-Strip
14 = Surface
1000 = Custom Divider / Partition
Field #61 = Divider / Partition thickness
Field #62 = Divider / Partition material weight
Field #63 = Divider / Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)  
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)  
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)  
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)  
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)  
Field #27 = Pallet Length  
Field #28 = Pallet Width  

Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style  
Field #2 = Maximum Length Overhang  
Field #3 = Maximum Width Overhang

Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style  
Field #2 = Maximum Weight  
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)  
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)  
Field #8 = Truck Length  
Field #9 = Truck Width  
Field #10 = Truck Height  
Field #11 = Truck Tare Weight  
Field #12 = Hybrid pattern applied (0=No, 1=Yes)  
Field #13 = Trilock pattern applied (0=No, 1=Yes)  
Field #14 = Diagonal pattern applied (0=No, 1=Yes)  
Field #15 = Spiral pattern applied (0=No, 1=Yes)  
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)  
Field #17=Maximum Truck Load Height  

Notes:
1. No Fields are available to select 3D Images.  
2. A maximum of 4 decimal places can be used.  
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.

File Format for Arrange - Cylinder / Bottle

[General] - Section Name
Field #1 = 6 (Arrange Cylinder / Bottle)  
Field #3 = Product Name (Max. 50 Characters)  
Field #4 = Product Code (Max. 25 Characters)  
Field #6 = Recessed Allowed (1=Yes, 0=No)  
Field #7 = Bulge Allowed (1=Yes, 0=No)  
Field #9 = Palletizing Type (1=Object onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)  
Field #10 = Units of Measure (0=mm/kg, 1=In/lb)  
Field #12 = Problem Date  
Field #19 = Number of Pallets (Range=1 to 3)  
Field #20 = Show Flap Indicator (1=Yes, 0=No)  
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)  
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)  
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)  
Field #41= User Text free flow line 1  
Field #42= User Text free flow line 2  
Field #43= User Text free flow line 3  
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data

[Primary Pack] - Section Name
Field #3 = Top Outside Diameter
Field #4 = Bottom Outside Diameter
Field #9 = Outside Height
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #26 = Allow On Side Orientation in Secondary Pack (1=Yes, 0=No)
Field #27 = Allow upright Orientation in Secondary Pack (1=Yes, 0=No)
Field #28 = Recess Factor
Field #32 = Pack Type
1 = Default
1000 = Custom Shape (Write Shape Name to Field #33)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #41 = Allow nested pattern (1=Yes, 0=No)

Secondary Pack Data

[Secondary Pack] - Section Name
Field #12 = Pack Type
1 = RSC (2,2,4)
2 = FOL (2,2,6)
3 = CSSC (2,2,4)
4 = SURFACE (2,2,2)
5 = SLEEVE (2,2,0)
6 = TRAY (4,2,1)
7 = END (2,2,4)
8 = Custom (Specify Mat. Thicknesses in Field numbers 15 - 17)
9 = None
10 = No Package
11 = Shrink Wrap
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18 = Material thickness
Field #19 = Material Weight
Field #20 = Glue Flap Width
Field #21 = Primary Pack Count per Secondary Pack #1
Field #22 = Primary Pack Count per Secondary Pack #2
Field #23 = Primary Pack Count per Secondary Pack #3
Field #24 = Primary Pack Count per Secondary Pack #4
Field #25 = Primary Pack Count per Secondary Pack #5
Field #26 = Primary Pack Count per Secondary Pack #6
Field #27 = Primary Pack Count per Secondary Pack #7
Field #28 = Primary Pack Count per Secondary Pack #8
Field #29 = Minimum Count per Secondary Pack
Field #30 = Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Outside Length Dimension
Field #45 = Minimum Outside Width Dimension
Field #46 = Minimum Outside Height Dimension
Field #47 = Maximum Outside Length Dimension
Field #48 = Maximum Outside Width Dimension
Field #49 = Maximum Outside Height Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) – [Valid only for in/lb units]
Field #59 = Tray Wall height
Field #60 = Divider / Partition
0 = None
1 = 1-Way
2 = 2-Way
3 = 3-Way
4 = Sleeve
5 = H-Pad
6 = S-Strip
7 = 8-Strip
8 = Divides Length
9 = Divides Width
10 = Divides Height
11 = Divide Rows
12 = Divide Columns
13 = Z-Strip
14 = Surface
1000 = Custom Divider / Partition
Field #61 = Divider / Partition thickness
Field #62 = Divider / Partition material weight
Field #63 = Divider / Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum Offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum Offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang
Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17= Maximum Truck Load Height
Notes: 1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required. Also,

File Format for Arrange - Trapezoid

[General] - Section Name
Field #1 = 7 (Arrange – Trapezoid)
Field #3 = Product Name (Max. 50 Characters)
Field #4 = Product Code (Max. 25 Characters)
Field #6 = Recessed Allowed (1=Yes, 0=No)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Object onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data

[Primary Pack] - Section Name
Field #5= Top Outside Length
Field #6 = Bottom Outside Length
Field #7 = Top Outside Width
Field #8 = Bottom Outside Width
Field #9 = Outside Height
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #23 = Allow Length Vertical in Secondary Pack (1=Yes, 0=No)
Field #24 = Allow Width Vertical in Secondary Pack (1=Yes, 0=No)
Field #25 = Allow Height Vertical in Secondary Pack (1=Yes, 0=No)
Field #28 = Recess Factor
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type, 1 = Default
Field #34 = Pack Name (Maximum 15 characters)

Secondary Pack Data
[Secondary Pack] - Section Name
Field #12 = Pack Type
1 = RSC (2,2,4)
2 = FOL (2,2,6)
3 = CSSC (2,2,4)
4 = SURFACE (2,2,2)
5 = SLEEVE (2,2,0)
6 = TRAY (4,2,1)
7 = END (2,2,4)
8 = Custom (Specify Mat. Thicknesses in Field numbers 15 - 17)
9 = None
10 = No Package
11 = Shrink Wrap 1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18 = Material thickness
Field #19 = Material Weight
Field #20 = Glue Flap Width
Field #21 = Primary Pack Count per Secondary Pack #1
Field #22 = Primary Pack Count per Secondary Pack #2
Field #23 = Primary Pack Count per Secondary Pack #3
Field #24 = Primary Pack Count per Secondary Pack #4
Field #25 = Primary Pack Count per Secondary Pack #5
Field #26 = Primary Pack Count per Secondary Pack #6
Field #27 = Primary Pack Count per Secondary Pack #7
Field #28 = Primary Pack Count per Secondary Pack #8
Field #29 = Minimum Count per Secondary Pack
Field #30 = Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Outside Length Dimension
Field #45 = Minimum Outside Width Dimension
Field #46 = Minimum Outside Height Dimension
Field #47 = Maximum Outside Length Dimension
Field #48 = Maximum Outside Width Dimension
Field #49 = Maximum Outside Height Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) – [Valid only for in/lb units]
Field #59 = Tray Wall height
Field #60 = Divider / Partition
  0 = None
  1 = 1-Way
  2 = 2-Way
  3 = 3-Way
  4 = Sleeve
  5 = H-Pad
  6 = S-Strip
  7 = 8-Strip
  8 = Divides Length
  9 = Divides Width
  10 = Divides Height
  11 = Divide Rows
  12 = Divide Columns
  13 = Z-Strip
  14 = Surface
  1000 = Custom Divider / Partition
Field #61 = Divider / Partition thickness
Field #62 = Divider / Partition material weight
Field #63 = Divider / Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

**[Pallet Restrictions#3] - Section Name**
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)
**[Master Base] - Section Name**
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
**[Truck Restrictions] - Section Name**
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height
Notes: 1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.

File Format for Design - Box / Bag / Bottle

[General] - Section Name
Field #1 = 8 (Design - Box / Bag / Bottle)
Field #3=Product Name (max. 50 characters)
Field #4=Product Code (max. 25 characters)
Field #5= Inside or Outside Dimensions (1=Inside Dimensions, 2=Outside Dimensions)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #13 = Product Allowed (1=Yes, 0=No)
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Product Data
[Product] - Section Name
Field #1= Product Name
Field #2 = Pack Type (1000 = Custom Shape Name)
Field #3 = Shape Name

Primary Pack Data
[Primary Pack] - Section Name
Field #1 = Length Outside Dimension
Field #2 = Width Outside Dimension
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Length Dimensional Variance (+)
Field #13 = Width Dimensional Variance (+)
Field #14 = Height Dimensional Variance (+)
Field #15 = Length Dimensional Variance (-)
Field #16 = Width Dimensional Variance (-)
Field #17 = Height Dimensional Variance (-)
Field #18 = Length Dimensional Increment
Field #19 = Width Dimensional Increment
Field #20 = Height Dimensional Increment
Field #21 = Vary Volume By (Percentages - %)
Field #22 = Vary Weight with Volume (1=Yes, 0=No)
Field #23 = Allow Length Vertical in Secondary Pack (1=Yes, 0=No)
Field #24 = Allow Width Vertical in Secondary Pack (1=Yes, 0=No)
Field #25 = Allow Height Vertical in Secondary Pack (1=Yes, 0=No)
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type
1 = Seal End (3,2,6)
2 = Eco Seal (3,2,4)
3 = Cover Tray (6,3,2)
4 = Tray (4,2,1)
5 = DW Tray (8,4,1)
6 = REV Tuck (3,2,4)
7 = STR Tuck (3,2,4)
8 = Auto Bottom (3,2,5)
9 = TAP SHAD (2,2,2)
10 = HOL Shadow (2,3,4)
11 = Surface (2,2,2)
12 = Custom (Specify Mat. Thicknesses in Field Numbers 42-44)
1000 = Custom Shape Name (Enter shape name in Field #33)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #42 = Number of thicknesses in Length
Field #43 = Number of thicknesses in Width
Field #44 = Number of thicknesses in Height
Field #45 = Material thickness
Field #46 = Material Weight
Field #47 = Glue Flap Width
Field #52 = Length Inside Dimension
Field #53 = Width Inside Dimension
Field #54 = Height Inside Dimension

Secondary Pack Data

[Secondary Pack] - Section Name
Field #12 = Pack Type
1 = RSC (2,2,4)
2 = FOL (2,2,6)
3 = CSSC (2,2,4)
4 = SURFACE (2,2,2)
5 = SLEEVE (2,2,0)
6 = TRAY (4,2,1)
7 = END (2,2,4)
8 = Custom (Specify Mat. Thicknesses in Field numbers 15 - 17)
9 = None
10 = No Package
11 = Shrink Wrap
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18 = Material thickness
Field #19 = Material Weight
Field #20 = Glue Flap Width
Field #21 = Primary Pack Count per Secondary Pack #1
Field #22 = Primary Pack Count per Secondary Pack #2
Field #23 = Primary Pack Count per Secondary Pack #3
Field #24 = Primary Pack Count per Secondary Pack #4
Field #25 = Primary Pack Count per Secondary Pack #5
Field #26 = Primary Pack Count per Secondary Pack #6
Field #27 = Primary Pack Count per Secondary Pack #7
Field #28 = Primary Pack Count per Secondary Pack #8
Field #29 = Minimum Count per Secondary Pack
Field #30 = Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Length Outside Dimension
Field #45 = Minimum Width Outside Dimension
Field #46 = Minimum Height Outside Dimension
Field #47 = Maximum Length Outside Dimension
Field #48 = Maximum Width Outside Dimension
Field #49 = Maximum Height Outside Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) – [Valid only in in/lb units]
Field #59 = Tray Wall height
Field #60 = Divider / Partition
0 = None
1 = 1-Way
2 = 2-Way
3 = 3-Way
4 = Sleeve
5 = H-Pad
6 = S-Strip
7 = 8-Strip
8 = Divides Length
9 = Divides Width
10 = Divides Height
11 = Divide Rows
12 = Divide Columns
13 = Z-Strip
14 = Surface
1000 = Custom Divider / Partition
Field #61 = Divider / Partition thickness
Field #62 = Divider / Partition material weight
Field #63 = Divider / Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #20 = Pallet Length
Field #21 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #20 = Pallet Length
Field #21 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)
[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17=Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.

File Format for Design - Cylinder/Bottle
[General] - Section Name
Field #1 = 9 (Design - Cylinder/Bottle)
Field #3 = Product Name (Max. 50 characters)
Field #4 = Product Code (Max. 25 characters)
Field #6 = Recessed Allowed (1=Yes, 0=No)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data

[Primary Pack] - Section Name

Field #3 = Top Outside Diameter
Field #4 = Bottom Outside Diameter
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #14 = Height Dimensional Variance (+)
Field #17 = Height Dimensional Variance (-)
Field #20 = Height Dimensional Increment
Field #21= Vary Volume By (Percentage - %)
Field #22 = Vary Weight with Volume (1=Yes, 0=No)
Field #26 = Allow On Side Orientation in Secondary Pack (1=Yes, 0=No)
Field #27 = Allow upright Orientation in Secondary Pack (1=Yes, 0=No)
Field #28 = Recess Factor
Field #32 = Pack Type
  1 = Default
  1000 = Custom Shape (Write Shape Name to Field #33)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #41 = Allow nested pattern (1=Yes, 0=No)
Field #48 = Diameter Dimensional Variance (+)
Field #49 = Diameter Dimensional Variance (-)
Field #50 = Diameter Dimensional Increment

Secondary Pack Data

[Secondary Pack] - Section Name

Field #12 = Pack Type
  1 = RSC (2,2,4)
  2 = FOL (2,2,6)
  3 = CSSC (2,2,4)
  4 = SURFACE (2,2,2)
  5 = SLEEVE (2,2,0)
  6 = TRAY (4,2,1)
  7 = END (2,2,4)
  8 = Custom (Specify Mat. Thicknesses in Field #15 - 17)
  9 = None
  10 = No Package
  11 = Shrink Wrap
  1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18= Material thickness
Field #19= Material Weight
Field #20= Glue Flap Width
Field #21= Primary Pack Count per Secondary Pack #1
Field #22= Primary Pack Count per Secondary Pack #2
Field #23= Primary Pack Count per Secondary Pack #3
Field #24= Primary Pack Count per Secondary Pack #4
Field #25= Primary Pack Count per Secondary Pack #5
Field #26= Primary Pack Count per Secondary Pack #6
Field #27= Primary Pack Count per Secondary Pack #7
Field #28= Primary Pack Count per Secondary Pack #8
Field #29= Minimum Count per Secondary Pack
Field #30= Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Length Outside Dimension
Field #45 = Minimum Width Outside Dimension
Field #46 = Minimum Height Outside Dimension
Field #47 = Maximum Length Outside Dimension
Field #48 = Maximum Width Outside Dimension
Field #49 = Maximum Height Outside Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) – [Valid only in in/lb units]
Field #59 = Tray Wall height
Field #60 = Divider / Partition
0 = None
1 = 1-Way
2 = 2-Way
3 = 3-Way
4 = Sleeve
5 = H-Pad
6 = S-Strip
7 = 8-Strip
8 = Divides Length
9 = Divides Width
10 = Divides Height
11 = Divide Rows
12 = Divide Columns
13 = Z-Strip
14 = Surface
1000 = Custom Divider / Partition
Field #61 = Divider / Partition thickness
Field #62 = Divider / Partition material weight
Field #63 = Divider / Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) * .pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) * .pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #5 = Truck Length
Field #6 = Truck Width
Field #7 = Truck Height
Field #10 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes: 1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.

File Format for Design - Trapezoid

[General] - Section Name
Field #1 = 10 (Design – Trapezoid)
Field #3 = Product Name (Max. 50 characters)
Field #4 = Product Code (Max. 25 characters)
Field #6 = Recessed Allowed (1=Yes, 0=No)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #9 = Palletizing Type (1=Objects onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of Measure (0=mm/kg, 1=ln/lb)
Field #12 = Problem Date
Field #19 = Number of Pallets (Range=1 to 3)
Field #20 = Show Flap Indicator (1=Yes, 0=No)
Field #22 = Secondary Pack Count Type (1=8 Single Counts, 2=Min./Max. Count)
Field #23 = Allow Secondary Pack Minimum Outside Dimensions (1=Yes, 0=No)
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data
[Primary Pack] - Section Name
Field #5 = Top Length Outside Dimension
Field #6 = Bottom Length Outside Dimension
Field #7 = Top Width Outside Dimension
Field #8 = Bottom Width Outside Dimension
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Length Dimensional Variance (+)
Field #13 = Width Dimensional Variance (+)
Field #14 = Height Dimensional Variance (+)
Field #15 = Length Dimensional Variance (-)
Field #16 = Width Dimensional Variance (-)
Field #17 = Height Dimensional Variance (-)
Field #18 = Length Dimensional Increment
Field #19 = Width Dimensional Increment
Field #20 = Height Dimensional Increment
Field #21 = Vary Volume By (Percentage - %)
Field #22 = Vary Weight with Volume (1=Yes, 0=No)
Field #23 = Allow Length Vertical in Secondary Pack (1=Yes, 0=No)
Field #24 = Allow Width Vertical in Secondary Pack (1=Yes, 0=No)
Field #25 = Allow Height Vertical in Secondary Pack (1=Yes, 0=No)
Field #28 = Recess Factor
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type (1 = Default)
Field #34 = Pack Name (Maximum 15 characters)

Secondary Pack Data
[Secondary Pack] - Section Name
Field #12 = Pack Type
1 = RSC (2,2,4)
2 = FOL (2,2,6)
3 = CSSC (2,2,4)
4 = SURFACE (2,2,2)
5 = SLEEVE (2,2,0)
6 = TRAY (4,2,1)
7 = END (2,2,4)
8 = Custom (Specify Mat. Thicknesses in Field #15 - 17)
9 = None
10 = No Package
11 = Shrink Wrap
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #13 = Shape Name
Field #14 = Pack Name (Maximum 15 characters)
Field #15 = Number of thicknesses in Length
Field #16 = Number of thicknesses in Width
Field #17 = Number of thicknesses in Height
Field #18= Material thickness
Field #19= Material Weight
Field #20= Glue Flap Width
Field #21= Primary Pack Count per Secondary Pack #1
Field #22= Primary Pack Count per Secondary Pack #2
Field #23= Primary Pack Count per Secondary Pack #3
Field #24= Primary Pack Count per Secondary Pack #4
Field #25= Primary Pack Count per Secondary Pack #5
Field #26= Primary Pack Count per Secondary Pack #6
Field #27 = Primary Pack Count per Secondary Pack #7
Field #28 = Primary Pack Count per Secondary Pack #8
Field #29 = Minimum Count per Secondary Pack
Field #30 = Maximum Count per Secondary Pack
Field #31 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #32 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #33 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #37 = Length Bulge Allowance
Field #38 = Width Bulge Allowance
Field #39 = Height Bulge Allowance
Field #40 = Slack Length Allowance
Field #41 = Slack Width Allowance
Field #42 = Slack Height Allowance
Field #43 = Maximum Weight
Field #44 = Minimum Outside Length Dimension
Field #45 = Minimum Outside Width Dimension
Field #46 = Minimum Outside Height Dimension
Field #47 = Maximum Outside Length Dimension
Field #48 = Maximum Outside Width Dimension
Field #49 = Maximum Outside Height Dimension
Field #58 = Round to the nearest 1/16" (1=Yes, 0=No) – [Valid only in/lb units]
Field #59 = Tray Wall height
Field #60 = Divider / Partition
  0 = None
  1 = 1-Way
  2 = 2-Way
  3 = 3-Way
  4 = Sleeve
  5 = H-Pad
  6 = S-Strip
  7 = 8-Strip
  8 = Divides Length
  9 = Divides Width
 10 = Divides Height
 11 = Divide Rows
 12 = Divide Columns
 13 = Z-Strip
 14 = Surface
1000 = Custom Divider / Partition
Field #61 = Divider/Partition thickness
Field #62 = Divider/Partition material weight
Field #63 = Divider/Partition Glue flap width

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width
Master Pallet Base Data (Optional)

[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes: 1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required

File Format for Casefill - Box/Bag/Bottle(Fixed)

[General] - Section Name
Field #1 = 11 (Casefill - Box/Bag/Bottle(Fixed))
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #25=Primary Pack Count Type (1=8 Single Counts, 0=Min/Max Count)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data

[Primary Pack] - Section Name
Field #1 = Length Outside Dimension
Field #2 = Width Outside Dimension
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #23 = Allow Length Vertical in Secondary Pack (1=Yes, 0=No)
Field #24 = Allow Width Vertical in Secondary Pack (1=Yes, 0=No)
Field #25 = Allow Height Vertical in Secondary Pack (1=Yes, 0=No)
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type
1 = Seal End (3,2,6)
2 = Eco Seal (3,2,4)
3 = Cover Tray (6,3,2)
4 = Tray (4,2,1)
5 = DW Tray (8,4,1)
6 = REV Tuck (3,2,4)
7 = STR Tuck (3,2,4)
8 = Auto Bottom (3,2,5)
9 = TAP SHAD (2,2,2)
10 = HOL Shadow (2,3,4)
11 = Surface (2,2,2)
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #35 = Minimum Slack (ID) in Length
Field #36 = Minimum Slack (ID) in Width
Field #37 = Minimum Slack (ID) in Height
Field #38 = Number of UnitPack Per Primary Pack

Casefill Data

[Casefill] - Section Name
Field #1 = Maximum Case Weight
Field #2 = Database record #1 to Use
Field #3 = Database record #2 to Use
Field #4 = Database record #3 to Use
Field #5 = Database record #4 to Use
Field #6 = Database record #5 to Use
Field #7 = Database record #6 to Use
Field #8 = Database record #7 to Use
Field #9 = Database record #8 to Use
Field #10 = Database record #9 to Use
Field #11 = Database record #10 to Use
Field #12 = Pallet footprint Length
Field #13 = Pallet footprint Width
Field #14 = Simple Loading Patterns to use for filling Secondary Pack (1=Yes, 0=No)
Field #15 = Medium Loading Patterns to use for filling Secondary Pack (1=Yes, 0=No)
Field #16 = Complex Loading Patterns to use for filling Secondary Pack (1=Yes, 0=No)
Field #17 = Vacant
Field #18 = Multi-Dimensional Solutions Allowed (1=Yes, 0=No)
Field #23 = Casefill Database to Use (Filename must include full path)
Field #24 = All Records flag (1=Yes, 0=No)
Field #25 = Primary Pack Count per Secondary Pack #1
Field #26 = Primary Pack Count per Secondary Pack #2
Field #27 = Primary Pack Count per Secondary Pack #3
Field #28 = Primary Pack Count per Secondary Pack #4
Field #29 = Primary Pack Count per Secondary Pack #5
Field #30 = Primary Pack Count per Secondary Pack #6
Field #31 = Primary Pack Count per Secondary Pack #7
Field #32 = Primary Pack Count per Secondary Pack #8
Field #33 = Minimum PP per SP count
Field #34 = Maximum PP per SP count
Field #35 = Pallet Size flag (0=all, 1=Select)
File Format for Casefill - Cylinder/Bottle(Fixed)

[General] - Section Name
Field #1 = 12 (Casefill - Cylinder/Bottle(Fixed))
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #24 = Allow Slack in Secondary Pack, (1=Yes, 0=No)
Field #25 = Primary Pack Count Type (1=8 Single Counts, 0=Min/Max Count)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data
[Primary Pack] - Section Name
Field #3 = Outside Diameter
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #26 = Allow On Side Orientation in Secondary Pack (1=Yes, 0=No)
Field #27 = Allow Upright Orientation in Secondary Pack (1=Yes, 0=No)
Field #32 = Pack Type
  1 = Default
1000 = Custom Shape Name (Enter Shape Name in Field #13)
Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #35 = Minimum Slack (ID) in Length
Field #36 = Minimum Slack (ID) in Width
Field #37 = Minimum Slack (ID) in Height
Field #38 = Number of UnitPack Per Primary Pack

Casefill Data
[Casefill] - Section Name
Field #1 = Maximum Case Weight
Field #2 = Database record #1 to Use
Field #3 = Database record #2 to Use
Field #4 = Database record #3 to Use
Field #5 = Database record #4 to Use
Field #6 = Database record #5 to Use
Field #7 = Database record #6 to Use
Field #8 = Database record #7 to Use
Field #9 = Database record #8 to Use
Field #10 = Database record #9 to Use
Field #11 = Database record #10 to Use
Field #12 = Pallet footprint Length
Field #13 = Pallet footprint Width
Field #19 = Row/Column Pattern Allowed in Secondary Pack (1=Yes, 0=No)
Field #20 = Nested Pattern Allowed in Secondary Pack (1=Yes, 0=No)
Field #21 = Partial Top Layer Permitted (1=Yes, 0=No)
Field #23 = Casefill Database to Use (Filename must include full path)
Field #24 = All Records flag (1=Yes, 0=No)
Field #25 = Primary Pack Count per Secondary Pack #1
Field #26 = Primary Pack Count per Secondary Pack #2
Field #27 = Primary Pack Count per Secondary Pack #3
Field #28 = Primary Pack Count per Secondary Pack #4
Field #29 = Primary Pack Count per Secondary Pack #5
Field #30 = Primary Pack Count per Secondary Pack #6
Field #31 = Primary Pack Count per Secondary Pack #7
Field #32 = Primary Pack Count per Secondary Pack #8
Field #33 = Minimum PP per SP count
Field #34 = Maximum PP per SP count
Field #35 = Pallet Size flag (0=all, 1=Select)

File Format for Casefill - Box/Bag/Bottle(Variable)

[General] - Section Name
Field #1 = 13 (Casefill - Box/Bag/Bottle(Variable))
Field #3 = Product Name (Maximum 50 characters)
Field #4 = Product Code (Maximum 25 characters)
Field #7 = Bulge Allowed (1=Yes, 0=No)
Field #10 = Units of Measure (0=mm/kg, 1=in/lb)
Field #12 = Problem Date
Field #24 = Allow Slack in Secondary Pack. (1=Yes, 0=No)
Field #25=Primary Pack Count Type (1=8 Single Counts, 0=Min/Max Count)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47= User Field 1
Field #48= User Field 2
Field #49= User Field 3
Field #50= User Field 4

Primary Pack Data

[Primary Pack] - Section Name
Field #1 = Length Outside Dimension
Field #2 = Width Outside Dimension
Field #9 = Height Outside Dimension
Field #10 = Gross Weight
Field #11 = Nett Weight
Field #12 = Length Dimensional Variance (+)
Field #13 = Width Dimensional Variance (+)
Field #14 = Height Dimensional Variance (+)
Field #15 = Length Dimensional Variance (-)
Field #16 = Width Dimensional Variance (-)
Field #17 = Height Dimensional Variance (-)
Field #18 = Length Dimensional Increment
Field #19 = Width Dimensional Increment
Field #20 = Height Dimensional Increment
Field #21= Vary Volume By (Percentage - %)
Field #29 = Length Bulge Allowance
Field #30 = Width Bulge Allowance
Field #31 = Height Bulge Allowance
Field #32 = Pack Type
1 = Seal End (3,2,6)
2 = Eco Seal (3,2,4)
3 = Cover Tray (6,3,2)
4 = Tray (4,2,1)
5 = DW Tray (8,4,1)
6 = REV Tuck (3,2,4)
7 = STR Tuck (3,2,4)
8 = Auto Bottom (3,2,5)
9 = TAP SHAD (2,2,2)
10 = HOL Shadow (2,3,4)
11 = Surface (2,2,2)
1000 = Custom Shape Name (Enter Shape Name in Field #13)

Field #33 = Shape Name
Field #34 = Pack Name (Maximum 15 characters)
Field #35 = Minimum Slack (ID) in Length
Field #36 = Minimum Slack (ID) in Width
Field #37 = Minimum Slack (ID) in Height
Field #38 = Number of UnitPack Per Primary Pack
Field #51 = Dimension Vertical in Case (1= Length, 2=Width, 3=Height.)

Casefill Data
[Casefill] - Section Name
Field #1 = Maximum Case Weight
Field #2 = Database record #1 to Use
Field #12 = Pallet footprint Length
Field #13 = Pallet footprint Width
Field #14 = Simple Loading Patterns to use for filling Secondary Pack (1=Yes, 0=No)
Field #15 = Medium Loading Patterns to use for filling Secondary Pack (1=Yes,0=No)
Field #16 = Complex Loading Patterns to use for filling Secondary Pack(1=Yes,0=No)
Field #23 = Casefill Database to Use (Filename must include full path)
Field #25 = Primary Pack Count per Secondary Pack # 1
Field #26 = Primary Pack Count per Secondary Pack # 2
Field #27 = Primary Pack Count per Secondary Pack # 3
Field #28 = Primary Pack Count per Secondary Pack # 4
Field #29 = Primary Pack Count per Secondary Pack # 5
Field #30 = Primary Pack Count per Secondary Pack # 6
Field #31 = Primary Pack Count per Secondary Pack # 7
Field #32 = Primary Pack Count per Secondary Pack # 8
Field #33 = Minimum PP per SP count
Field #34 = Maximum PP per SP count
Field #35 = Pallet Size flag (0=all, 1=Select)

File Format for KDF-Flatblank
[General] - Section Name
Field #1 = 19 KDF/Flatblank
Field #3 = Product name (Max. 50 Characters)
Field #4 = Product code (Max. 25 Characters)
Field #7 = Bulge allowed (1=Yes, 0=No)
Field #9 = Palletizing type (1=Object onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of measure (0=mm/kg, 1=in/lb)
Field #12 = Problem date
Field #19 = Number of pallets (Range=1 to 3)
Field #26= Automatic mode (1=Run to MVG, 2=Normal)
Field #41= User Text free flow line 1
Field #42= User Text free flow line 2
Field #43= User Text free flow line 3
Field #44= User Text free flow line 4
Field #45= User Text free flow line 5
Field #46= User Text free flow line 6
Field #47 = User Field 1
Field #48 = User Field 2
Field #49 = User Field 3
Field #50 = User Field 4

Primary Pack Data

[Primary Pack] - Section Name
Field #1 = Flatblank length
Field #2 = Flatblank width
Field #9 = Flatblank height
Field #10 = Flatblank weight
Field #11 = Add. bundle weight
Field #34 = Flatblank name
Field #45 = Flat thickness
Field #56 = Height factor (1 – 100 %)

Secondary Pack Data

[Secondary Pack] - Section Name
Field #14 = Pack name (Maximum 15 characters)
Field #29 = Min. Flat count per bundle
Field #30 = Max. Flat count per bundle
Field #31 = Allow length vertical on pallet (1=Yes, 0=No)
Field #32 = Allow width vertical on pallet (1=Yes, 0=No)
Field #33 = Allow height vertical on pallet (1=Yes, 0=No)
Field #37 = Bundle length bulge allowance
Field #38 = bundle width bulge allowance
Fields #68 = Formula number
Field #69 = Number of straps across length
Field #70 = Number of straps across width
Field #71 = Width of straps (1-100 %)
Field #72 = KDF length
Field #73 = KDF width
Field #74 = KDF height

Pallet Restrictions Data

[Pallet Restrictions] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width
[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#3] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)
[Master Base] - Section Name
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.

File Format for KDF-Made-up Case

[General] - Section Name
Field #1 = 20 (KDF/Made-up Case)
Field #3 = Product name (Max. 50 Characters)
Field #4 = Product code (Max. 25 Characters)
Field #7 = Bulge allowed (1=Yes, 0=No)
Field #9 = Palletizing type (1=Object onto Pallet, 2=Objects onto Pallet into Truck, 3=Objects into Truck)
Field #10 = Units of measure (0=mm/kg, 1=in/lb)
Field #12 = Problem date
Field #19 = Number of pallets (Range=1 to 3)
Field #26 = Automatic mode (1=Run to MVG, 2=Normal)
Field #41 = User Text free flow line 1
Field #42 = User Text free flow line 2
Field #43 = User Text free flow line 3
Field #44 = User Text free flow line 4
Field #45 = User Text free flow line 5
Field #46 = User Text free flow line 6
Field #47 = User Field 1
Field #48 = User Field 2
Field #49 = User Field 3
Field #50 = User Field 4

Primary Pack Data
[Primary Pack] - Section Name
Field #1 = Made-up Case length
Field #2 = Made-up Case width
Field #9 = Made-up Case height
Field #10 = Made-up Case weight
Field #11 = Add. Bundle weight
Field #45 = Made-up Case thickness
Field #56 = Height factor (1 – 100 %)
Field #34 = Made-up Case name

Secondary Pack Data
[Secondary Pack] - Section Name
Field #14 = pack name (Maximum 15 characters)
Field #29 = Min. Made-up Case count per bundle
Field #30 = Max. Made-up Case count per bundle
Field #31 = Allow length vertical on pallet (1=Yes, 0=No)
Field #32 = Allow width vertical on pallet (1=Yes, 0=No)
Field #33 = Allow height vertical on pallet (1=Yes, 0=No)
Field #37 = Bundle length bulge allowance
Field #38 = Bundle width bulge allowance
Field #68 = Formula number
Field #69 = Number of straps across length
Field #70 = Number of straps across width
Field #71 = Width of straps (1-100 (%))
Field #72 = KDF length
Field #73 = KDF width
Field #74 = KDF height

Pallet Restrictions Data

[Pallet Restrictions#1] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

[Pallet Restrictions#2] - Section Name
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

**Pallet Restrictions#3 - Section Name**
Field #1 = Pallet Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style 0 = No Pallet (Specify Length, Width and Height at Fields # 27 - 29)
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Length Overhang
Field #6 = Minimum Load Length
Field #7 = Minimum Load Width
Field #8 = Minimum Area Efficiency
Field #9 = No Pattern Gaps (1=Yes, 0=No)
Field #10 = Clamp in Length (1=Yes, 0=No)
Field #11 = Clamp in Width (1=Yes, 0=No)
Field #12 = Maximum offset
Field #13 = Minimum Contact (Integer - %)
Field #14 = Column Pallet Pattern Allowed (1=Yes, 0=No)
Field #15 = Interlock Pallet Pattern Allowed (1=Yes, 0=No)
Field #16 = Trilock Pallet Pattern Allowed (1=Yes, 0=No)
Field #17 = Diagonal Pallet Pattern Allowed (1=Yes, 0=No)
Field #18 = Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #19 = Expanded Spiral Pallet Pattern Allowed (1=Yes, 0=No)
Field #27 = Pallet Length
Field #28 = Pallet Width

Master Pallet Base Data (Optional)
**[Master Base] - Section Name**
Field #1 = Master Base Style (e.g. ukstd.pa4) *.pa4 = Valid name for a named Pallet Base Style
Field #2 = Maximum Length Overhang
Field #3 = Maximum Width Overhang

Truck Restrictions Data
**[Truck Restrictions] - Section Name**
Field #1 = Truck Base Style (e.g. 40stan.pa4) *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #12 = Hybrid pattern applied (0=No, 1=Yes)
Field #13 = Trilock pattern applied (0=No, 1=Yes)
Field #14 = Diagonal pattern applied (0=No, 1=Yes)
Field #15 = Spiral pattern applied (0=No, 1=Yes)
Field #16 = Expanded Spiral pattern applied (0=No, 1=Yes)
Field #17 = Maximum Truck Load Height

Notes:
1. No Fields are available to select 3D Images.
2. A maximum of 4 decimal places can be used.
3. When Field #9=1 in the General Section then No Truck Restriction data is required. When Field #9=2 in the General Section then both Pallet and Truck Restriction data are required. When Field #9=3 in the General Section then No Pallet Restriction data is required.
File Format for Display Pallet

[General] - Section Name
Field #1 = Module program you want to run.
0 = Normal Run, that is, Bypass CAPE Standard License screen but go straight to the CAPE Front Menu.
15 = Display Pallet
Field #3 = Product Name (Maximum 50 characters).
Field #4 = Product Code (Maximum 25 characters).
Field #5 = Box Description Allowed
Field #6 = Palletising Type (1=Pallet, 2=Pallet and Truck)
Field #7 = Units of Measure (0=Metric, 1=English)
Field #8 = Problem Date
Field #9 = Total Number of Secondary Packs in Display Pallet
Field #18 = Pallet Maker (Alvery) export path.
Field #26 = Run Mode (1=Use Wizard, 2=Use my default settings)

Secondary Pack Data for Display Pallet
[Secondary Pack#x] - Where “#x” is the secondary pack number
Field #1 = Box Name. Max. of 12 characters.
Field #2 = Label (Max. of 2 characters)
Field #3 = Box Type. To select a box type, assign the number that corresponds to the box type of your choice. See list below. If you choose box type 4 or 5 as stated below, get shape name from Field #4.
1 = Standard Box
2 = RSC Box
3 = End Loader box
4 = Display Case
5 = Variable Tray
Field #4 = Shape name (CSF name).
Field #5 = Tray wall height
Field #8 = Color. To select a color, assign the number that corresponds to the color of your choice. See list below)
1 = Red
2 = Green
3 = Blue
4 = Cyan
5 = Pink
6 = Yellow
7 = Brown
8 = Magenta
9 = Dark Cyan
10 = Dark Blue
11 = Dark Green
12 = Dark Red
Field #9 = Length Dimension
Field #10 = Width Dimension
Field #11 = Height Dimension
Field #12 = Weight
Field #13 = Box Description. Max. of 25 Characters.
Field #14 = Absolute maximum
Field #15 = Desired Minimum
Field #35 = Allow Length Vertical on Pallet (1=Yes, 0=No)
Field #36 = Allow Width Vertical on Pallet (1=Yes, 0=No)
Field #37 = Allow Height Vertical on Pallet (1=Yes, 0=No)
Field #38 = Quantity Allowed (Order Fulfilment ONLY)
Field #39 = Max. in Column
Field #40 = Load Priority
Field #41 = Must not be stacked on Base; (0=No, 1=Yes)
Field #42 = Stacked together; (0=No, 1=Yes).
Display Pallet Build Data

[Display Pallet Build] - Section Name
Field #1 = Algorithm to use. Select from the list below, a number that corresponds to the algorithm of your choice, then assign to Field #1.
1 = Column Algorithm
2 = Column Editor
3 = Layer Algorithm
4 = Layer Editor
5 = Mixed Load Editor
Field #2 = Time limit for each strategy (in seconds)
Field #8 = Do not allow mixed top (0=No, 1=Yes)
Field #9 = Do not allow mixed layers (0=No, 1=Yes)
Field #10 = Spread to biggest layer (0=No, 1=Yes)
Field #11 = Maximum spread (0=No, 1=Yes)
Field #12 = Type of Optimization
0 = Single Pallet method (Default)
1 = Order Fulfilment
Field #13 = Package Loading rules
0 = No Loading Restrictions (Default)
1 = Limit Column Height
2 = Load Priority
Field #14 = Allow Mixed Columns
0 = Do not Allow Mixed Columns (Default)
1 = Allow Mixed Columns

Pallet Restrictions Data

[Pallet Restrictions] - Section Name
Field #1 = Pallet Base Style (e.g. UKSTD.PA4)
*.pa4 = Valid name for a named Pallet Base Style
0 = No Pallet. Specify Length and Width in Fields 27 and 28.
Field #2 = Maximum Height
Field #3 = Maximum Weight
Field #4 = Maximum Length Overhang
Field #5 = Maximum Width Overhang
Field #27 = Pallet Length
Field #28 = Pallet Width
Field #29 = Pallet Height
Field #30 = Pallet Weight
Field #31 = Acceptable center of gravity cylinder height
Field #32 = Acceptable center of gravity cylinder radius
Field #33 = Maximum Boxes

Truck Restrictions Data

[Truck Restrictions] - Section Name
Field #1 = Truck Base Style (e.g. 40stan.pa4). *.pa4 = Valid name for a named Truck Base Style
Field #2 = Maximum Weight
Field #3 = Simple Loading Pattern Applied (1=Yes, 0=No)
Field #4 = Complex Loading Pattern Applied (1=Yes, 0=No)
Field #8 = Truck Length
Field #9 = Truck Width
Field #10 = Truck Height
Field #11 = Truck Tare Weight
Field #17 = Maximum Truck Load Height

Export Features

CAPE PACK allows you to export numerical data, graphics images and standard CAPE reports for use in other program applications.
These capabilities mean you can maintain or create your own printouts/reports and pass information to the other program applications that you use within your department or company.

Here is the Export Settings screen.

![Export Settings Screen](image)

This screen is very similar to the Page Setup screen for printing. The essential differences are:

**Export Width and Height:** Allows you to set the size of the image you want to export.

**Decimal Places:** Allows you to specify the number of decimal places for the information you are exporting.

**Export Options**

There are a variety of export types available.

**Export Information Only**

Refers to numerical and text information. These are provided in the form of a “flat ASCII” file.

**Export CAPE Diagram**

Refers to diagrams or images that can be exported in a variety of graphics file formats.
Export CAPE Report

Refers to Standard CAPE reports (diagrams and numerical header information) or full CAPE Reports plus an ASCII file. These reports can be exported in a variety of graphics file formats.

Export to Databases

Allows you to export your solution information to a Casefill database for use in the Casefill programs, your case information to either the Display Pallet or Secondary Pack databases, and your primary pack information to your Primary Pack Database.

Robot

Allows you to export information in the CAPE Robotics File format for use by automatic palletizers.

CAD Programs

Allows you to export information for use in several CAD programs.

SAP

Allows you to export information for use in SAP as either XML, ASCII or comma-separated value data.

Export Information Only

Here are the options.

Pallet Load

This option is designed to work with a new program to be launched later in the year.

ASCII Solution Information

You can export the ASCII Solution Data (the text and numerical information from your analysis) in the form of a text (.TXT) file. You can then write a macro to extract any or all of the information to another program application.

Because you can calculate on up to three pallets, at the same time, you will be prompted to select either Pallet 1, 2 or 3 depending on the number of pallets you selected at the input stage.
Here are the details of the information contained within the individual fields for an exported text file.

**Solution Data Text File - Boxes**

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Product Name</td>
</tr>
<tr>
<td>Line 2</td>
<td>Product Code</td>
</tr>
<tr>
<td>Line 3</td>
<td>Solution Reference</td>
</tr>
<tr>
<td>Line 4</td>
<td>File Name</td>
</tr>
<tr>
<td>Line 5</td>
<td>Analysis Creation Date</td>
</tr>
<tr>
<td>Line 6</td>
<td>Primary Pack Name (PP Name)</td>
</tr>
<tr>
<td>Line 7</td>
<td>Secondary Pack Name (SP Name)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Pallet Name</td>
</tr>
<tr>
<td>Line 9</td>
<td>Units of Measure (0=Metric;1=English)</td>
</tr>
<tr>
<td>Line 10</td>
<td>Pack Type (Primary Pack)</td>
</tr>
<tr>
<td>Line 11</td>
<td>Pack Type (Secondary Pack)</td>
</tr>
<tr>
<td>Line 12</td>
<td>Number of Primary Packs per Secondary Pack</td>
</tr>
<tr>
<td>Line 13</td>
<td>Number of Primary Packs in Length of Secondary Pack</td>
</tr>
<tr>
<td>Line 14</td>
<td>Number of Primary Packs in Secondary Pack Width</td>
</tr>
<tr>
<td>Line 15</td>
<td>Number of Primary Packs in Secondary Pack Height</td>
</tr>
<tr>
<td>Line 16</td>
<td>Primary Pack Dimension in Secondary Pack Length</td>
</tr>
<tr>
<td>Line 17</td>
<td>Primary Pack Dimension in Secondary Pack Width</td>
</tr>
<tr>
<td>Line 18</td>
<td>Primary Pack Dimension In Secondary pack Height</td>
</tr>
<tr>
<td>Line 19</td>
<td>Number of Secondary Packs per Layer</td>
</tr>
<tr>
<td>Line 20</td>
<td>Number of Layers per Load</td>
</tr>
<tr>
<td>Line 21</td>
<td>Number of Secondary Packs per Load</td>
</tr>
<tr>
<td>Line 22</td>
<td>Primary Pack Length (Inside Dimension)</td>
</tr>
<tr>
<td>Line 23</td>
<td>Primary Pack Width (Inside Dimension)</td>
</tr>
<tr>
<td>Line 24</td>
<td>Primary Pack Height (Inside Dimension)</td>
</tr>
<tr>
<td>Line 25</td>
<td>Primary Pack Length (Outside Dimension)</td>
</tr>
<tr>
<td>Line 26</td>
<td>Primary Pack Width (Outside Dimension)</td>
</tr>
<tr>
<td>Line 27</td>
<td>Primary Pack Height (Outside Dimension)</td>
</tr>
<tr>
<td>Line 28</td>
<td>Primary Pack Net Weight</td>
</tr>
<tr>
<td>Line 29</td>
<td>Primary Pack Gross Weight</td>
</tr>
<tr>
<td>Line 30</td>
<td>Primary Pack Material Thickness</td>
</tr>
<tr>
<td>Line 31</td>
<td>Primary Pack Material Weight</td>
</tr>
<tr>
<td>Line 32</td>
<td>Secondary Pack Length (Inside Dimension)</td>
</tr>
<tr>
<td>Line 33</td>
<td>Secondary Pack Width (Inside Dimension)</td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>34</td>
<td>Secondary Pack Height (Inside Dimension)</td>
</tr>
<tr>
<td>35</td>
<td>Secondary Pack Length (Outside Dimension)</td>
</tr>
<tr>
<td>36</td>
<td>Secondary Pack Width (Outside Dimension)</td>
</tr>
<tr>
<td>37</td>
<td>Secondary Pack Height (Outside Dimension)</td>
</tr>
<tr>
<td>38</td>
<td>Secondary Pack Net Weight</td>
</tr>
<tr>
<td>39</td>
<td>Secondary Pack Gross Weight</td>
</tr>
<tr>
<td>40</td>
<td>Secondary Pack Material Thickness</td>
</tr>
<tr>
<td>41</td>
<td>Secondary Pack Material Weight</td>
</tr>
<tr>
<td>42</td>
<td>Pallet Load Area Efficiency</td>
</tr>
<tr>
<td>43</td>
<td>Pallet Load Cube Efficiency</td>
</tr>
<tr>
<td>44</td>
<td>Pallet Length</td>
</tr>
<tr>
<td>45</td>
<td>Pallet Width</td>
</tr>
<tr>
<td>46</td>
<td>Pallet Height</td>
</tr>
<tr>
<td>47</td>
<td>Pallet Weight</td>
</tr>
<tr>
<td>48</td>
<td>Product Length</td>
</tr>
<tr>
<td>49</td>
<td>Product Width</td>
</tr>
<tr>
<td>50</td>
<td>Product Height</td>
</tr>
<tr>
<td>51</td>
<td>Product Net Weight</td>
</tr>
<tr>
<td>52</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>53</td>
<td>Load Length</td>
</tr>
<tr>
<td>54</td>
<td>Load Width</td>
</tr>
<tr>
<td>55</td>
<td>Load Height</td>
</tr>
<tr>
<td></td>
<td>If Analysis Contains Bundles</td>
</tr>
<tr>
<td>56</td>
<td>Bundles per Secondary Pack</td>
</tr>
<tr>
<td>57</td>
<td>Bundles Per Pallet Load</td>
</tr>
<tr>
<td>58</td>
<td>Primary Packs per Bundle</td>
</tr>
<tr>
<td>59</td>
<td>Primary Packs per Pallet Load</td>
</tr>
<tr>
<td>60</td>
<td>Bundle Length (Outside dimension)</td>
</tr>
<tr>
<td>61</td>
<td>Bundle Width (Outside Dimension)</td>
</tr>
<tr>
<td>62</td>
<td>Bundle Height (Outside Dimension)</td>
</tr>
<tr>
<td>63</td>
<td>Bundle Net Weight</td>
</tr>
<tr>
<td>64</td>
<td>Bundle Gross Weight</td>
</tr>
<tr>
<td>65</td>
<td>Bundle Name</td>
</tr>
<tr>
<td></td>
<td>If Analysis does not contain Bundles</td>
</tr>
<tr>
<td>56</td>
<td>Blank Line</td>
</tr>
<tr>
<td>57</td>
<td>Blank Line</td>
</tr>
<tr>
<td>58</td>
<td>Blank Line</td>
</tr>
<tr>
<td>59</td>
<td>Primary Packs per Pallet Load</td>
</tr>
<tr>
<td>60</td>
<td>Blank Line</td>
</tr>
<tr>
<td>61</td>
<td>Blank Line</td>
</tr>
<tr>
<td>62</td>
<td>Blank Line</td>
</tr>
<tr>
<td>63</td>
<td>Blank Line</td>
</tr>
<tr>
<td>64</td>
<td>Blank Line</td>
</tr>
<tr>
<td>65</td>
<td>Blank Line</td>
</tr>
<tr>
<td>66</td>
<td>User Text Line 1</td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>67</td>
<td>User Text Line 2</td>
</tr>
<tr>
<td>68</td>
<td>User Text Line 3</td>
</tr>
<tr>
<td>69</td>
<td>User Text Line 4</td>
</tr>
<tr>
<td>70</td>
<td>User Text Line 5</td>
</tr>
<tr>
<td>71</td>
<td>User Text Line 6</td>
</tr>
<tr>
<td>72</td>
<td>User Field 1</td>
</tr>
<tr>
<td>73</td>
<td>User Field 2</td>
</tr>
<tr>
<td>74</td>
<td>User Field 3</td>
</tr>
<tr>
<td>75</td>
<td>User Field 4</td>
</tr>
<tr>
<td>76</td>
<td>Truck Length</td>
</tr>
<tr>
<td>77</td>
<td>Truck Width</td>
</tr>
<tr>
<td>78</td>
<td>Truck Height</td>
</tr>
<tr>
<td>79</td>
<td>Truck Gross Weight</td>
</tr>
<tr>
<td>80</td>
<td>Truck Net Weight</td>
</tr>
<tr>
<td>81</td>
<td>Pallet Loads per Truck</td>
</tr>
<tr>
<td>82</td>
<td>Secondary Packs per Truck</td>
</tr>
<tr>
<td>83</td>
<td>Truck Name</td>
</tr>
<tr>
<td>84</td>
<td>Secondary Pack per Multi-Dimensional Load</td>
</tr>
<tr>
<td>85</td>
<td>Secondary Pack Blank Area</td>
</tr>
<tr>
<td>86</td>
<td>Divider Type</td>
</tr>
<tr>
<td>87</td>
<td>Number of Dividers in Length</td>
</tr>
<tr>
<td>88</td>
<td>Number of Dividers in Width</td>
</tr>
<tr>
<td>89</td>
<td>Number of Dividers in Height</td>
</tr>
<tr>
<td>90</td>
<td>Divider Blank Area</td>
</tr>
<tr>
<td>91</td>
<td>Layer pads per Load</td>
</tr>
<tr>
<td>92</td>
<td>Secondary Packs per Maximizer Load</td>
</tr>
<tr>
<td>93</td>
<td>PP Additional Weight</td>
</tr>
<tr>
<td>94</td>
<td>SP Additional Weight</td>
</tr>
<tr>
<td>95</td>
<td>PP/Truck</td>
</tr>
<tr>
<td>96</td>
<td>Per layer quantities after editing (with Layer Editor)</td>
</tr>
<tr>
<td>97</td>
<td>SP dimension vertical on Pallet (Length = 1, Width = 2 and Height = 3)</td>
</tr>
<tr>
<td>98</td>
<td>Product Net Weight</td>
</tr>
<tr>
<td>99</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>100</td>
<td>Truck Product Length</td>
</tr>
<tr>
<td>101</td>
<td>Truck Product Width</td>
</tr>
<tr>
<td>102</td>
<td>Truck Product Height</td>
</tr>
<tr>
<td>103</td>
<td>Truck Product Net Weight</td>
</tr>
<tr>
<td>104</td>
<td>Truck Product Gross Weight</td>
</tr>
<tr>
<td>105</td>
<td>Pallet Load Accessories Weight</td>
</tr>
<tr>
<td>106</td>
<td>Secondary Pack Material Saved</td>
</tr>
<tr>
<td>107</td>
<td>Layers per Truck Load</td>
</tr>
<tr>
<td>108</td>
<td>Truck Load Solution Reference</td>
</tr>
<tr>
<td>109</td>
<td>Secondary Pack Area Efficiency</td>
</tr>
<tr>
<td>110</td>
<td>Secondary Pack Slack ID Length</td>
</tr>
<tr>
<td>111</td>
<td>Secondary Pack Slack ID Width</td>
</tr>
<tr>
<td>Line</td>
<td>Information</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>112</td>
<td>Secondary Pack Slack ID Height</td>
</tr>
<tr>
<td>113</td>
<td>Truck Cube Used</td>
</tr>
<tr>
<td>114</td>
<td>Truck Area Efficiency</td>
</tr>
<tr>
<td>115</td>
<td>Multidimensional Load length</td>
</tr>
<tr>
<td>116</td>
<td>Multidimensional Load Width</td>
</tr>
<tr>
<td>117</td>
<td>Multidimensional Load Height</td>
</tr>
<tr>
<td>118</td>
<td>Multidimensional Load Net Weight</td>
</tr>
<tr>
<td>119</td>
<td>Multidimensional Load Gross Weight</td>
</tr>
<tr>
<td>120</td>
<td>Multidimensional Load Product Length</td>
</tr>
<tr>
<td>121</td>
<td>Multidimensional Load Product Width</td>
</tr>
<tr>
<td>122</td>
<td>Multidimensional Load Product Net Weight</td>
</tr>
<tr>
<td>123</td>
<td>Multidimensional Load Product Gross Weight [line123]</td>
</tr>
<tr>
<td>124</td>
<td>Multidimensional Load Area Efficiency</td>
</tr>
<tr>
<td>125</td>
<td>Multidimensional Load Cube Efficiency</td>
</tr>
<tr>
<td>126</td>
<td>Maximizer Load Length</td>
</tr>
<tr>
<td>127</td>
<td>Maximizer Load Width</td>
</tr>
<tr>
<td>128</td>
<td>Maximizer Load Height</td>
</tr>
<tr>
<td>129</td>
<td>Maximizer Load Net Weight</td>
</tr>
<tr>
<td>130</td>
<td>Maximizer Load Gross Weight</td>
</tr>
<tr>
<td>131</td>
<td>Maximizer Load Area Efficiency</td>
</tr>
<tr>
<td>132</td>
<td>Maximizer Load Cube Efficiency</td>
</tr>
<tr>
<td>133</td>
<td>Maximizer Product Gross Weight</td>
</tr>
<tr>
<td>134</td>
<td>Maximizer Product Net Weight</td>
</tr>
<tr>
<td>135</td>
<td>Maximizer Load Gross Weight</td>
</tr>
<tr>
<td>136</td>
<td>Maximizer Load Area Efficiency</td>
</tr>
<tr>
<td>137</td>
<td>Maximizer Load Cube Efficiency</td>
</tr>
<tr>
<td>138</td>
<td>Secondary Pack Tray Wall Height</td>
</tr>
</tbody>
</table>

**Solution Data Text File - Cylinders**

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Product Name</td>
</tr>
<tr>
<td>Line 2</td>
<td>Product Code</td>
</tr>
<tr>
<td>Line 3</td>
<td>Solution Reference</td>
</tr>
<tr>
<td>Line 4</td>
<td>File Name</td>
</tr>
<tr>
<td>Line 5</td>
<td>File Date</td>
</tr>
<tr>
<td>Line 6</td>
<td>Primary Pack Name (PP Name)</td>
</tr>
<tr>
<td>Line 7</td>
<td>Secondary Pack Name (SP Name)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Pallet Name</td>
</tr>
<tr>
<td>Line 9</td>
<td>Units of Measure (0=Metric;1=English)</td>
</tr>
<tr>
<td>Line 10</td>
<td>Pack Type (Primary Pack)</td>
</tr>
<tr>
<td>Line 11</td>
<td>Pack Type (Secondary Pack)</td>
</tr>
<tr>
<td>Line 12</td>
<td>Number of Primary Packs per Secondary Pack</td>
</tr>
<tr>
<td>Line 13</td>
<td>Number of Primary Packs in Length of Secondary Pack</td>
</tr>
<tr>
<td>Line 14</td>
<td>Number of Primary Packs in Secondary Pack Width</td>
</tr>
<tr>
<td>Line 15</td>
<td>Number of Primary Packs in Secondary Pack Height</td>
</tr>
</tbody>
</table>

Version 2.13
<p>| Line 16 | Primary Pack Dimension in Secondary Pack Length |
| Line 17 | Primary Pack Dimension in Secondary Pack Width |
| Line 18 | Primary Pack Dimension in Secondary Pack Height |
| Line 19 | Number of Secondary Packs per Layer |
| Line 20 | Number Layers per Pallet Load |
| Line 21 | Number of Secondary Packs per Pallet Load |
| Line 22 | Primary Pack Diameter Top (Inside Dimension) |
| Line 23 | Primary Pack Diameter Bottom (Inside Dimension) |
| Line 24 | Primary Pack Height (Inside Dimension) |
| Line 25 | Primary Pack Diameter Top (Outside Dimension) |
| Line 26 | Primary Pack Diameter Bottom (Outside Dimension) |
| Line 27 | Primary Pack Height (Outside Dimension) |
| Line 28 | Primary Pack Net Weight |
| Line 29 | Primary Pack Gross Weight |
| Line 30 | Primary Pack Material Thickness |
| Line 31 | Primary Pack Material Weight |
| Line 32 | Secondary Pack Length (Inside Dimension) |
| Line 33 | Secondary Pack Width (Inside Dimension) |
| Line 34 | Secondary Pack Height (Inside Dimension) |
| Line 35 | Secondary Pack Length (Outside Dimension) |
| Line 36 | Secondary Pack Width (Outside Dimension) |
| Line 37 | Secondary Pack Height (Outside Dimension) |
| Line 38 | Secondary Pack Net Weight |
| Line 39 | Secondary Pack Gross Weight |
| Line 40 | Secondary Pack Material Thickness |
| Line 41 | Secondary Pack Material Weight |
| Line 42 | Pallet Load Area Efficiency |
| Line 43 | Pallet Load Cube Efficiency |
| Line 44 | Pallet Length |
| Line 45 | Pallet Width |
| Line 46 | Pallet Height |
| Line 47 | Pallet Weight |
| Line 48 | Product Length |
| Line 49 | Product Width |
| Line 50 | Product Height |
| Line 51 | Product Net Weight |
| Line 52 | Product Gross Weight |
| Line 53 | Load Length |
| Line 54 | Load Width |
| Line 55 | Load Height |
| If Analysis Contains Bundles |
| Line 56 | Bundles per Secondary Pack |
| Line 57 | Bundles Per Pallet Load |
| Line 58 | Primary Packs per Bundle |
| Line 59 | Primary Packs per Pallet Load |</p>
<table>
<thead>
<tr>
<th>Line</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>60</td>
<td>Bundle Length (Outside dimension)</td>
</tr>
<tr>
<td>61</td>
<td>Bundle Width (Outside Dimension)</td>
</tr>
<tr>
<td>62</td>
<td>Bundle Height (Outside Dimension)</td>
</tr>
<tr>
<td>63</td>
<td>Bundle Net Weight</td>
</tr>
<tr>
<td>64</td>
<td>Bundle Gross Weight</td>
</tr>
<tr>
<td>65</td>
<td>Bundle Name</td>
</tr>
<tr>
<td>56</td>
<td>Blank Line</td>
</tr>
<tr>
<td>57</td>
<td>Blank Line</td>
</tr>
<tr>
<td>58</td>
<td>Blank Line</td>
</tr>
<tr>
<td>59</td>
<td>Primary Packs per Pallet Load</td>
</tr>
<tr>
<td>60</td>
<td>Blank Line</td>
</tr>
<tr>
<td>61</td>
<td>Blank Line</td>
</tr>
<tr>
<td>62</td>
<td>Blank Line</td>
</tr>
<tr>
<td>63</td>
<td>Blank Line</td>
</tr>
<tr>
<td>64</td>
<td>Blank Line</td>
</tr>
<tr>
<td>65</td>
<td>Blank Line</td>
</tr>
<tr>
<td>66</td>
<td>User Text Line 1</td>
</tr>
<tr>
<td>67</td>
<td>User Text Line 2</td>
</tr>
<tr>
<td>68</td>
<td>User Text Line 3</td>
</tr>
<tr>
<td>69</td>
<td>User Text Line 4</td>
</tr>
<tr>
<td>70</td>
<td>User Text Line 5</td>
</tr>
<tr>
<td>71</td>
<td>User Text Line 6</td>
</tr>
<tr>
<td>72</td>
<td>User Field 1</td>
</tr>
<tr>
<td>73</td>
<td>User Field 2</td>
</tr>
<tr>
<td>74</td>
<td>User Field 3</td>
</tr>
<tr>
<td>75</td>
<td>User Field 4</td>
</tr>
<tr>
<td>76</td>
<td>Truck Length</td>
</tr>
<tr>
<td>77</td>
<td>Truck Width</td>
</tr>
<tr>
<td>78</td>
<td>Truck Height</td>
</tr>
<tr>
<td>79</td>
<td>Truck Gross Weight</td>
</tr>
<tr>
<td>80</td>
<td>Truck Net Weight</td>
</tr>
<tr>
<td>81</td>
<td>Pallet Loads per Truck</td>
</tr>
<tr>
<td>82</td>
<td>Secondary Packs per Truck</td>
</tr>
<tr>
<td>83</td>
<td>Truck Name</td>
</tr>
<tr>
<td>84</td>
<td>Secondary Pack per Multi-Dimensional Load</td>
</tr>
<tr>
<td>85</td>
<td>Secondary Pack Blank Area</td>
</tr>
<tr>
<td>86</td>
<td>Divider Type</td>
</tr>
<tr>
<td>87</td>
<td>Number of Dividers in Length</td>
</tr>
<tr>
<td>88</td>
<td>Number of Dividers in Width</td>
</tr>
<tr>
<td>89</td>
<td>Number of Dividers in Height</td>
</tr>
<tr>
<td>90</td>
<td>Divider Blank Area</td>
</tr>
<tr>
<td>91</td>
<td>Layer pads per Load</td>
</tr>
<tr>
<td>92</td>
<td>Secondary Packs per Maximizer Load</td>
</tr>
<tr>
<td>93</td>
<td>PP Additional Weight</td>
</tr>
<tr>
<td>Line 94</td>
<td>SP Additional Weight</td>
</tr>
<tr>
<td>Line 95</td>
<td>PP/Truck</td>
</tr>
<tr>
<td>Line 96</td>
<td>Per layer quantities after editing (with Layer Editor)</td>
</tr>
<tr>
<td>Line 97</td>
<td>SP dimension vertical on Pallet (Length = 1, Width = 2 and Height = 3)</td>
</tr>
<tr>
<td>Line 98</td>
<td>Product Net Weight</td>
</tr>
<tr>
<td>Line 99</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>Line 100</td>
<td>Truck Product Length</td>
</tr>
<tr>
<td>Line 101</td>
<td>Truck Product Width</td>
</tr>
<tr>
<td>Line 102</td>
<td>Truck Product Height</td>
</tr>
<tr>
<td>Line 103</td>
<td>Truck Product Net Weight</td>
</tr>
<tr>
<td>Line 104</td>
<td>Truck Product Gross Weight</td>
</tr>
<tr>
<td>Line 105</td>
<td>Pallet Load Accessories Weight</td>
</tr>
<tr>
<td>Line 106</td>
<td>Secondary Pack Material Saved</td>
</tr>
<tr>
<td>Line 107</td>
<td>Layers per Truck Load</td>
</tr>
<tr>
<td>Line 108</td>
<td>Truck Load Solution Reference</td>
</tr>
<tr>
<td>Line 109</td>
<td>Secondary Pack Area Efficiency</td>
</tr>
<tr>
<td>Line 110</td>
<td>Secondary Pack Slack ID Length</td>
</tr>
<tr>
<td>Line 111</td>
<td>Secondary Pack Slack ID Width</td>
</tr>
<tr>
<td>Line 112</td>
<td>Secondary Pack Slack ID Height</td>
</tr>
<tr>
<td>Line 113</td>
<td>Truck Cube Used</td>
</tr>
<tr>
<td>Line 114</td>
<td>Truck Area Efficiency</td>
</tr>
<tr>
<td>Line 115</td>
<td>Multidimensional Load length</td>
</tr>
<tr>
<td>Line 116</td>
<td>Multidimensional Load Width</td>
</tr>
<tr>
<td>Line 117</td>
<td>Multidimensional Load Height</td>
</tr>
<tr>
<td>Line 118</td>
<td>Multidimensional Load Net Weight</td>
</tr>
<tr>
<td>Line 119</td>
<td>Multidimensional Load Gross Weight</td>
</tr>
<tr>
<td>Line 120</td>
<td>Multidimensional Load Product Length</td>
</tr>
<tr>
<td>Line 121</td>
<td>Multidimensional Load Product Width</td>
</tr>
<tr>
<td>Line 122</td>
<td>Multidimensional Load Product Height</td>
</tr>
<tr>
<td>Line 123</td>
<td>Multidimensional Load Product Net Weight</td>
</tr>
<tr>
<td>Line 124</td>
<td>Multidimensional Load Product Gross Weight [line123]</td>
</tr>
<tr>
<td>Line 125</td>
<td>Multidimensional Load Area Efficiency</td>
</tr>
<tr>
<td>Line 126</td>
<td>Multidimensional Load Cube Efficiency</td>
</tr>
<tr>
<td>Line 127</td>
<td>Maximizer Load Length</td>
</tr>
<tr>
<td>Line 128</td>
<td>Maximizer Load Width</td>
</tr>
<tr>
<td>Line 129</td>
<td>Maximizer Load Height</td>
</tr>
<tr>
<td>Line 130</td>
<td>Maximizer Load Length</td>
</tr>
<tr>
<td>Line 131</td>
<td>Maximizer Load Width</td>
</tr>
<tr>
<td>Line 132</td>
<td>Maximizer Load Height</td>
</tr>
<tr>
<td>Line 133</td>
<td>Maximizer Product Gross Weight</td>
</tr>
<tr>
<td>Line 134</td>
<td>Maximizer Load Net Weight</td>
</tr>
<tr>
<td>Line 135</td>
<td>Maximizer Load Gross Weight</td>
</tr>
<tr>
<td>Line 136</td>
<td>Maximizer Load Area Efficiency</td>
</tr>
<tr>
<td>Line 137</td>
<td>Maximizer Load Cube Efficiency</td>
</tr>
<tr>
<td>Line 138</td>
<td>Secondary Pack Tray Wall Height</td>
</tr>
</tbody>
</table>
**Solution Data Text File - Trapezoids**

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Product Name</td>
</tr>
<tr>
<td>Line 2</td>
<td>Product Code</td>
</tr>
<tr>
<td>Line 3</td>
<td>Solution Reference</td>
</tr>
<tr>
<td>Line 4</td>
<td>File Name</td>
</tr>
<tr>
<td>Line 5</td>
<td>File Date</td>
</tr>
<tr>
<td>Line 6</td>
<td>Primary Pack Name (PP Name)</td>
</tr>
<tr>
<td>Line 7</td>
<td>Secondary Pack Name (SP Name)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Pallet Name</td>
</tr>
<tr>
<td>Line 9</td>
<td>Units of Measure (0=Metric; 1=English)</td>
</tr>
<tr>
<td>Line 10</td>
<td>Pack Type (Primary Pack)</td>
</tr>
<tr>
<td>Line 11</td>
<td>Pack Type (Secondary Pack)</td>
</tr>
<tr>
<td>Line 12</td>
<td>Number of Primary Packs per Secondary Pack</td>
</tr>
<tr>
<td>Line 13</td>
<td>Number of Primary Packs in Length of Secondary Pack</td>
</tr>
<tr>
<td>Line 14</td>
<td>Number of Primary Packs in Secondary Pack Width</td>
</tr>
<tr>
<td>Line 15</td>
<td>Number of Primary Packs in Secondary Pack Height</td>
</tr>
<tr>
<td>Line 16</td>
<td>Primary Pack Dimension in Secondary Pack Length</td>
</tr>
<tr>
<td>Line 17</td>
<td>Primary Pack Dimension in Secondary Pack Width</td>
</tr>
<tr>
<td>Line 18</td>
<td>Primary Pack Dimension In Secondary Pack Height</td>
</tr>
<tr>
<td>Line 19</td>
<td>Number of Secondary Packs per Layer</td>
</tr>
<tr>
<td>Line 20</td>
<td>Number Layers per Pallet Load</td>
</tr>
<tr>
<td>Line 21</td>
<td>Number of Secondary Packs per Pallet Load</td>
</tr>
<tr>
<td>Line 22</td>
<td>Primary Pack Length Top (Inside Dimension)</td>
</tr>
<tr>
<td>Line 23</td>
<td>Primary Pack Width Top (Inside Dimension)</td>
</tr>
<tr>
<td>Line 24</td>
<td>Primary Pack Height (Inside Dimension)</td>
</tr>
<tr>
<td>Line 25</td>
<td>Primary Pack Length Top (Outside Dimension)</td>
</tr>
<tr>
<td>Line 26</td>
<td>Primary Pack Width Top (Outside Dimension)</td>
</tr>
<tr>
<td>Line 27</td>
<td>Primary Pack Height (Outside Dimension)</td>
</tr>
<tr>
<td>Line 28</td>
<td>Primary Pack Net Weight</td>
</tr>
<tr>
<td>Line 29</td>
<td>Primary Pack Gross Weight</td>
</tr>
<tr>
<td>Line 30</td>
<td>Primary Pack Material Thickness</td>
</tr>
<tr>
<td>Line 31</td>
<td>Primary Pack Material Weight</td>
</tr>
<tr>
<td>Line 32</td>
<td>Secondary Pack Length (Inside Dimension)</td>
</tr>
<tr>
<td>Line 33</td>
<td>Secondary Pack Width (Inside Dimension)</td>
</tr>
<tr>
<td>Line 34</td>
<td>Secondary Pack Height (Inside Dimension)</td>
</tr>
<tr>
<td>Line 35</td>
<td>Secondary Pack Length (Outside Dimension)</td>
</tr>
<tr>
<td>Line 36</td>
<td>Secondary Pack Width (Outside Dimension)</td>
</tr>
<tr>
<td>Line 37</td>
<td>Secondary Pack Height (Outside Dimension)</td>
</tr>
<tr>
<td>Line 38</td>
<td>Secondary Pack Net Weight</td>
</tr>
<tr>
<td>Line 39</td>
<td>Secondary Pack Gross Weight</td>
</tr>
<tr>
<td>Line 40</td>
<td>Secondary Pack Material Thickness</td>
</tr>
<tr>
<td>Line 41</td>
<td>Secondary Pack Material Weight</td>
</tr>
<tr>
<td>Line 42</td>
<td>Pallet Load Area Efficiency</td>
</tr>
<tr>
<td>Line</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>43</td>
<td>Pallet Load Cube Efficiency</td>
</tr>
<tr>
<td>44</td>
<td>Pallet Length</td>
</tr>
<tr>
<td>45</td>
<td>Pallet Width</td>
</tr>
<tr>
<td>46</td>
<td>Pallet Height</td>
</tr>
<tr>
<td>47</td>
<td>Pallet Weight</td>
</tr>
<tr>
<td>48</td>
<td>Product Length</td>
</tr>
<tr>
<td>49</td>
<td>Product Width</td>
</tr>
<tr>
<td>50</td>
<td>Product Height</td>
</tr>
<tr>
<td>51</td>
<td>Product Net Weight</td>
</tr>
<tr>
<td>52</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>53</td>
<td>Load Length</td>
</tr>
<tr>
<td>54</td>
<td>Load Width</td>
</tr>
<tr>
<td>55</td>
<td>Load Height</td>
</tr>
<tr>
<td>56</td>
<td>Bundles per Secondary Pack</td>
</tr>
<tr>
<td>57</td>
<td>Bundles Per Pallet Load</td>
</tr>
<tr>
<td>58</td>
<td>Primary Packs per Bundle</td>
</tr>
<tr>
<td>59</td>
<td>Primary Packs per Pallet Load</td>
</tr>
<tr>
<td>60</td>
<td>Bundle Length (Outside dimension)</td>
</tr>
<tr>
<td>61</td>
<td>Bundle Width (Outside Dimension)</td>
</tr>
<tr>
<td>62</td>
<td>Bundle Height (Outside Dimension)</td>
</tr>
<tr>
<td>63</td>
<td>Bundle Net Weight</td>
</tr>
<tr>
<td>64</td>
<td>Bundle Gross Weight</td>
</tr>
<tr>
<td>65</td>
<td>Bundle Name</td>
</tr>
<tr>
<td>56</td>
<td>Blank Line</td>
</tr>
<tr>
<td>57</td>
<td>Blank Line</td>
</tr>
<tr>
<td>58</td>
<td>Blank Line</td>
</tr>
<tr>
<td>59</td>
<td>Primary Packs per Pallet Load</td>
</tr>
<tr>
<td>60</td>
<td>Blank Line</td>
</tr>
<tr>
<td>61</td>
<td>Blank Line</td>
</tr>
<tr>
<td>62</td>
<td>Blank Line</td>
</tr>
<tr>
<td>63</td>
<td>Blank Line</td>
</tr>
<tr>
<td>64</td>
<td>Blank Line</td>
</tr>
<tr>
<td>65</td>
<td>Blank Line</td>
</tr>
<tr>
<td>66</td>
<td>User Text Line 1</td>
</tr>
<tr>
<td>67</td>
<td>User Text Line 2</td>
</tr>
<tr>
<td>68</td>
<td>User Text Line 3</td>
</tr>
<tr>
<td>69</td>
<td>User Text Line 4</td>
</tr>
<tr>
<td>70</td>
<td>User Text Line 5</td>
</tr>
<tr>
<td>71</td>
<td>User Text Line 6</td>
</tr>
<tr>
<td>72</td>
<td>User Field 1</td>
</tr>
<tr>
<td>73</td>
<td>User Field 2</td>
</tr>
<tr>
<td>74</td>
<td>User Field 3</td>
</tr>
<tr>
<td>75</td>
<td>User Field 4</td>
</tr>
<tr>
<td>Line 76</td>
<td>Truck Length</td>
</tr>
<tr>
<td>Line 77</td>
<td>Truck Width</td>
</tr>
<tr>
<td>Line 78</td>
<td>Truck Height</td>
</tr>
<tr>
<td>Line 79</td>
<td>Truck Gross Weight</td>
</tr>
<tr>
<td>Line 80</td>
<td>Truck Net Weight</td>
</tr>
<tr>
<td>Line 81</td>
<td>Pallet Loads per Truck</td>
</tr>
<tr>
<td>Line 82</td>
<td>Secondary Packs per Truck</td>
</tr>
<tr>
<td>Line 83</td>
<td>Truck Name</td>
</tr>
<tr>
<td>Line 84</td>
<td>Secondary Pack per Multi-Dimensional Load</td>
</tr>
<tr>
<td>Line 85</td>
<td>Secondary Pack Blank Area</td>
</tr>
<tr>
<td>Line 86</td>
<td>Divider Type</td>
</tr>
<tr>
<td>Line 87</td>
<td>Number of Dividers in Length</td>
</tr>
<tr>
<td>Line 88</td>
<td>Number of Dividers in Width</td>
</tr>
<tr>
<td>Line 89</td>
<td>Number of Dividers in Height</td>
</tr>
<tr>
<td>Line 90</td>
<td>Divider Blank Area</td>
</tr>
<tr>
<td>Line 91</td>
<td>Layer pads per Load</td>
</tr>
<tr>
<td>Line 92</td>
<td>Secondary Packs per Maximizer Load</td>
</tr>
<tr>
<td>Line 93</td>
<td>PP Additional Weight</td>
</tr>
<tr>
<td>Line 94</td>
<td>SP Additional Weight</td>
</tr>
<tr>
<td>Line 95</td>
<td>PP/Truck</td>
</tr>
<tr>
<td>Line 96</td>
<td>Per layer quantities after editing (with Layer Editor)</td>
</tr>
<tr>
<td>Line 97</td>
<td>SP dimension vertical on Pallet (Length = 1, Width = 2 and Height = 3)</td>
</tr>
<tr>
<td>Line 98</td>
<td>Product Net Weight</td>
</tr>
<tr>
<td>Line 99</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>Line 100</td>
<td>Truck Product Length</td>
</tr>
<tr>
<td>Line 101</td>
<td>Truck Product Width</td>
</tr>
<tr>
<td>Line 102</td>
<td>Truck Product Height</td>
</tr>
<tr>
<td>Line 103</td>
<td>Truck Product Net Weight</td>
</tr>
<tr>
<td>Line 104</td>
<td>Truck Product Gross Weight</td>
</tr>
<tr>
<td>Line 105</td>
<td>Pallet Load Accessories Weight</td>
</tr>
<tr>
<td>Line 106</td>
<td>Secondary Pack Material Saved</td>
</tr>
<tr>
<td>Line 107</td>
<td>Layers per Truck Load</td>
</tr>
<tr>
<td>Line 108</td>
<td>Truck Load Solution Reference</td>
</tr>
<tr>
<td>Line 109</td>
<td>Secondary Pack Area Efficiency</td>
</tr>
<tr>
<td>Line 110</td>
<td>Secondary Pack Slack ID Length</td>
</tr>
<tr>
<td>Line 111</td>
<td>Secondary Pack Slack ID Width</td>
</tr>
<tr>
<td>Line 112</td>
<td>Secondary Pack Slack ID Height</td>
</tr>
<tr>
<td>Line 113</td>
<td>Truck Cube Used</td>
</tr>
<tr>
<td>Line 114</td>
<td>Truck Area Efficiency</td>
</tr>
<tr>
<td>Line 115</td>
<td>Multidimensional Load length</td>
</tr>
<tr>
<td>Line 116</td>
<td>Multidimensional Load Width</td>
</tr>
<tr>
<td>Line 117</td>
<td>Multidimensional Load Height</td>
</tr>
<tr>
<td>Line 118</td>
<td>Multidimensional Load Net Weight</td>
</tr>
<tr>
<td>Line 119</td>
<td>Multidimensional Load Gross Weight</td>
</tr>
<tr>
<td>Line 120</td>
<td>Multidimensional Load Product Length</td>
</tr>
</tbody>
</table>
Line 121  Multidimensional Load Product Width
Line 122  Multidimensional Load Product Height
Line 123  Multidimensional Load Product Net Weight
Line 124  Multidimensional Load Product Gross Weight [line123]
Line 125  Multidimensional Load Area Efficiency
Line 126  Multidimensional Load Cube Efficiency
Line 127  Maximizer Load Length
Line 128  Maximizer Load Width
Line 129  Maximizer Load Height
Line 130  Maximizer Load Length
Line 131  Maximizer Load Width
Line 132  Maximizer Load Height
Line 133  Maximizer Product Gross Weight
Line 134  Maximizer Load Net Weight
Line 135  Maximizer Load Gross Weight
Line 136  Maximizer Load Area Efficiency
Line 137  Maximizer Load Cube Efficiency
Line 138  Secondary Pack Tray Wall Height

Solution Data Text File – Display Pallet

<table>
<thead>
<tr>
<th>Line Number</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>Product Name</td>
</tr>
<tr>
<td>Line 2</td>
<td>Product Code</td>
</tr>
<tr>
<td>Line 3</td>
<td>Solution Reference</td>
</tr>
<tr>
<td>Line 4</td>
<td>File Name</td>
</tr>
<tr>
<td>Line 5</td>
<td>File Date</td>
</tr>
<tr>
<td>Line 6</td>
<td>Pallet Name</td>
</tr>
<tr>
<td>Line 7</td>
<td>Units of Measure (0=Metric;1=English)</td>
</tr>
<tr>
<td>Line 8</td>
<td>Packages per Load</td>
</tr>
<tr>
<td>Line 9</td>
<td>Pallet Load Cubit Efficiency</td>
</tr>
<tr>
<td>Line 10</td>
<td>Pallet Length</td>
</tr>
<tr>
<td>Line 11</td>
<td>Pallet Width</td>
</tr>
<tr>
<td>Line 12</td>
<td>Pallet Height</td>
</tr>
<tr>
<td>Line 13</td>
<td>Pallet Weight</td>
</tr>
<tr>
<td>Line 14</td>
<td>Product Length</td>
</tr>
<tr>
<td>Line 15</td>
<td>Product Width</td>
</tr>
<tr>
<td>Line 16</td>
<td>Product Height</td>
</tr>
<tr>
<td>Line 17</td>
<td>Product Gross Weight</td>
</tr>
<tr>
<td>Line 18</td>
<td>Load Length</td>
</tr>
<tr>
<td>Line 19</td>
<td>Load Width</td>
</tr>
<tr>
<td>Line 20</td>
<td>Load Height</td>
</tr>
<tr>
<td>Line 21</td>
<td>Load Net Weight</td>
</tr>
<tr>
<td>Line 22</td>
<td>Load Gross Weight</td>
</tr>
<tr>
<td>Line 23</td>
<td>Pallet Loads per Truck</td>
</tr>
<tr>
<td>Line 24</td>
<td>Packages per Truck</td>
</tr>
<tr>
<td>Line 25</td>
<td>Truck Name</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Line 26</td>
<td>Truck Length</td>
</tr>
<tr>
<td>Line 27</td>
<td>Truck Width</td>
</tr>
<tr>
<td>Line 28</td>
<td>Truck Height</td>
</tr>
<tr>
<td>Line 29</td>
<td>Truck Product Length</td>
</tr>
<tr>
<td>Line 30</td>
<td>Truck Product Width</td>
</tr>
<tr>
<td>Line 31</td>
<td>Truck Product Height</td>
</tr>
<tr>
<td>Line 32</td>
<td>Truck Load Gross Weight</td>
</tr>
<tr>
<td>Line 33</td>
<td>Truck Load Net Weight</td>
</tr>
<tr>
<td>Line 34</td>
<td>Truck Product Net Weight</td>
</tr>
<tr>
<td>Line 35</td>
<td>Truck Product Gross Weight</td>
</tr>
<tr>
<td>Line 36</td>
<td>Number of Package Types per Load</td>
</tr>
</tbody>
</table>

The following lines are repeated for each different package on the load, but are numbered sequentially.

<table>
<thead>
<tr>
<th>Line 37</th>
<th>Package Name (#1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 38</td>
<td>Package Length (#1)</td>
</tr>
<tr>
<td>Line 39</td>
<td>Package Width (#1)</td>
</tr>
<tr>
<td>Line 40</td>
<td>Package Height (#1)</td>
</tr>
<tr>
<td>Line 41</td>
<td>Package Weight (#1)</td>
</tr>
<tr>
<td>Line 42</td>
<td>Primary Packs Per Package (#1)</td>
</tr>
<tr>
<td>Line 43</td>
<td>Number of this Package Type per Load (#1)</td>
</tr>
<tr>
<td>Line 44</td>
<td>Package Type (#1)</td>
</tr>
<tr>
<td>Line 45</td>
<td>Package RGB Component (#1)</td>
</tr>
<tr>
<td>Line 46</td>
<td>Package Label (#1)</td>
</tr>
</tbody>
</table>

**XML**

You can export the same data as in the ASCII Solution Data (the text and numerical information from your analysis) in XML format. You can then write a macro to extract any or all of the information to another program application.

**Comma-Separated Values**

You can export the same data as in the ASCII Solution Data (the text and numerical information from your analysis) in CSV format. You can then write a macro to extract any or all of the information to another program application.

**Exporting CAPE Diagrams**

There are several ways you can export diagrams to other software applications.
Diagram Only

Here you export the on-screens diagrams in a wide range of graphics file formats.

Click on **PCX** or any of the other file formats.

Diagram and ASCII

This option not only exports the diagram as in **Diagram Only**, but also sends the ASCII file solution information to the directory of your choice.

Single Diagrams and ASCII

This feature allows you to save each diagram on the screen as a separate file. Thus, a screen with four diagrams would save out four individual bitmap files. The ASCII file for a single pallet load will be just one file.

If you have more than one pallet load on the screen then the diagrams will be exported as normal, but a separate ASCII file will be exported for each pallet load.

The file extension for the individual diagrams is `name.BM1` through `name.BM4`. You can instruct another program application to read this file or you can rename the file `name.BMP`.

The file extension for the ASCII file(s) is `name.TX1` through `name.TX3`. Again, you can instruct your program application to read this file extension or you can rename it.

CAPE’s Web Page (Html format)

This format is an ideal attachment to an email. You can export either the Diagram Only or the full CAPE Report:

Simply click on the **CAPE’s Web Page (html format)** option and a Save As dialog box appears.
Enter a filename and the target directory. The HTML style file, in a JPEG format, will be saved to that directory.

Create a .PDF Diagram

This option lets you create a PDF file of only your CAPE PACK diagrams rather than the full report.

Sending Email Attachments

Using your normal email program, write your email and then attach the CAPE JPEG file to your email. It’s that simple!

This is a very easy way to communicate the results of a CAPE analysis with anyone, anywhere in the world.

Please also refer to the email menu where you automatically attach the CAPE Report or Diagrams to an email.

Exporting CAPE Reports

Here are the options.

Report Only

This works in a similar fashion to the previously explained Diagram Only option, except that here you are exporting the entire CAPE Report. You can use the Export settings to customize the report and set the exact size you want.
CAPE Report and ASCII

This option not only exports the report as in Report Only, it also sends the ASCII solution file information to a directory of your choice.

Web Page (Html format)

This option exports the CAPE PACK report to a graphics HTML file. All settings for the normal exported report apply to this format.

Create a PDF Report

This option lets you create a PDF of your exported CAPE PACK report.

Other Export Options

Using the Clipboard

The information sent from the Multi-Viewer to the Clipboard is in a graphical format, even if it contains some text. This means that you cannot manipulate or edit the text once it has been pasted into another Windows application.

If you want to manipulate the solution information (text), you should use the Copy command in the Solution Report screen.

The solution shown in the Multi-Viewer Graphics is the solution which is sent to the Clipboard.

Choose Copy CAPE Report from the Edit menu.

To send a copy of just the diagrams to the Windows Clipboard, choose Copy Diagram from the Edit menu.

You can import the information on the Clipboard into any other application using the Paste command under the Edit menu.

Exporting Graphics from Print Preview

Using the Export button you can export a graphics file to a directory/destination of your choice.
Exporting Information from the Solution Report

The data from the Solution Report and Alternate Solution Report can be copied to the Clipboard for use in another Windows application. You can also export the information to a comma separated value (csv) format. Use the Edit menu to accomplish this task.

Exporting Information for a Palletizing Robot

You can do this through the Export menu Robot option.
Robotic Interface

This option creates a “flat ASCII file” containing the entire pallet load information and the XYZ coordinates of the cases. This data can then be transferred, via an external interface, to the PLC of the robotic palletizer.

Select this option and you will be prompted with the following screen.

Provide a file name and path and the program will save the CAPE Robotic Interface file and send it to your chosen directory. The file extension is .CRF.

CAPE Robotic Interface File Format

[LoadHeader]
spPDNAME       * Load FileName
SolRef               * Solution Reference

[LoadInfo]
iLDBNUM  * Number of Pallet Base style used
iLDTNUM  * Number of SP per Load
sLDTIME  * Create Date and Time
fLDM1    * Cube Efficiency
AreaEff  * Area Efficiency
fLDDIM1   * Product Length (Metric)
fLDDIM2   * Product Width (Metric)
fLDDIM3   * Product Height (Metric)
fLDLWGT   * Product Weight (Metric)
fLDDIM1E  * Product Length (English)
fLDDIM2E  * Product Width (English)
fLDDIM3E  * Product Height (English)
fLDLWGTE  * Product Weight (English)
LoadX      * Load Length
LoadY      * Load Width
LoadZ      * Load Height
LoadWgt    * Load Weight

[ProbDef]
sPDSDESC   * Product Code
sPDLDESC   * Product Name
sPDDATE    * Problem Date
sPDUNITS   * Units of Measure (0=Metric, 1=English)
iPDSCALE   * Scale Factor (25.4)
Utext1     * User Text Line 1
Utext2     * User Text Line 2
Utext3     * User Text Line 3
Utext4     * User Text Line 4
Utext5     * User Text Line 5
Utext6     * User Text Line 6
Ufield1    * User Fields Line 1
Ufield2    * User Fields Line 2
Ufield3    * User Fields Line 3
Ufield4    * User Fields Line 4

[PalRest]
sLBFILE    * Name of Pallet Base style
fLBLEN     * Pallet Length (Metric)
fLBWID     * Pallet Width (Metric)
fLBHGTT    * Pallet Height (Metric)
fLBWGTT    * Pallet Weight (Metric)
fLBMAXLH   * Maximum Load Height
fLBMAXLW   * Maximum Load Weight
fLBLENE    * Pallet Length (English)
fLBWIDE    * Pallet Width (English)
fLBHGTE    * Pallet Height (English)
fLBWGTE    * Pallet Weight (English)

[SPInfo]
SPName     * Secondary Pack Name
SPPOLength  * Secondary Pack Outside Length
SPPOWidth   * Secondary Pack Outside Width
SPPOHeight  * Secondary Pack Outside Height
SPIDLength  * Secondary Pack Inside Length
SPIDWidth   * Secondary Pack Inside Width
SPIDHeight  * Secondary Pack Inside Height
SPNWeight   * Secondary Pack Net Weight
SPGWeight   * Secondary Pack Gross Weight
SPMatThick  * Secondary Pack Material Thickness
SPMatWeight * Secondary Pack Material Weight

[SolutionInfo]
LayersPerLoad * Layer per Load
SPPerLoad    * Secondary Pack per Load
SPPerLayer   * Secondary Pack per Layer

[PalletLocation]
PalletLoc=xPos,yPos,zPos

[BoxLocations]
;\*LDK=SpNo, No current use, Orientation, x, y, z
Example: 1=1,0,6,0,0,0

[SPDLayerN]
Notes: Where N is the Layer Number, e.g. If Layer 1 then section name will be "[SPDLayer1]"

LayerLevel    * The bottom height of Layer
LayerTray/Pad  * Identifies if Layer Tray or Pad is present at Layer Level. (0=No, 1=Yes).
LayerTray/PadThickness * LayerTray/Pad Thickness, if Layer Tray or Pad is present.
TopCap        * Identifies if Top Cap is present at Layer Level. (0=No, 1=Yes).
TopCapThickness * Layer/Pad Thickness, if Layer Tray or Pad is present.
Dimension Vertical * Dimension vertical of Secondary Pack at Layer Level
Pos_z         * Middle Z position
SecondaryPackperLayer * Number of Secondary Packs per Layer
SPno.=Middle X, Middle Y, SP Turn (L/W). Example: 1=203,162, L

The above example denotes the first SP on layer Level has a mid X distance of 203 and a middle Y distance of 162
and going by the orientation of the SP whatever dimension falls in the Length is in the X-direction and whatever
dimension falls in the Width is in the Y-direction.

Here is an example of the CRF file generated by the Pallet Group - Rectangle/Square program:

[LoadHeader]
sPDNAME=3DIEXAM2
SolRef=1 1

[LoadInfo]
iLDBNUM=1
iLDNUM=40
iLDTime=29/04/97 19:02:12
fLDM1=100.0
AreaEff=100.0
fLDIM1=1200.0
fLDIM2=1000.0
fLDIM3=1500.0
fLDIM4=65.0
LoadX=1200.0
LoadY=1000.0
LoadZ=1650.0
LoadWgt=90

[ProbDef]
sPDSDESC=bill
sPDDESC=peter
sPDDATE=22/06/96
sPDSUNITs=0
sPDSCALE=1
UTEXT1=
UTEXT2=
UTEXT3=
UTEXT4=
UTEXT5=
UTEXT6=
UFIELD1=peter
UFIELD2=******** USER FIELD 2 ********
UFIELD3=*** USER FIELD 3 ***
UFIELD4=*** USER FIELD 4 ***

[PalRest]
sLBFILE=UKSTD
fLBMAXLH=1650
fLBMAXLW=9999
fLBLEN=1200.0
fLBWID=1000.0
fLBHGT=150.0
fLBWGT=25.0

[SPInfo]
SPName=CASETWO
SPODLength=400.0
SPODWidth=300.0
SPODHeight=375.0
SPIDLength=400.0
SPIDWidth=300.0
SPIDHeight=375.0
SPNWeight=0.0
SPGWeight=1.0
SPMatThick=3.0
SPMatWeight=0.0

[SolutionInfo]
LayersPerLoad=4
SPperLoad=40
SPperLayer=10

[PalletLocation]
PalletLoc=0,0,0

[BoxLocations]
1=1,0,1,0,0,150
2=1,0,1,400,0,150
3=1,0,1,800,0,150
4=1,0,1,0,300,150
5=1,0,1,400,300,150
6=1,0,1,800,300,150
7=1,0,4,0,600,150
8=1,0,4,300,600,150
9=1,0,4,600,600,150
10=1,0,4,900,600,150
11=1,0,1,0,0,525
12=1,0,1,400,0,525
13=1,0,1,800,0,525
14=1,0,1,0,300,525
15=1,0,1,400,300,525
16=1,0,1,800,300,525
17=1,0,4,0,600,525
18=1,0,4,300,600,525
19=1,0,4,600,600,525
20=1,0,4,900,600,525
21=1,0,1,0,0,900
22=1,0,1,400,0,900
23=1,0,1,800,0,900
24=1,0,1,0,300,900
25=1,0,1,400,300,900
26=1,0,1,800,300,900
27=1,0,4,0,600,900
28=1,0,4,300,600,900
29=1,0,4,600,600,900
30=1,0,4,900,600,900
31=1,0,1,0,0,1275
32=1,0,1,400,0,1275
33=1,0,1,800,0,1275
34=1,0,1,0,300,1275
35=1,0,1,400,300,1275
36=1,0,1,800,300,1275
37=1,0,4,0,600,1275
38=1,0,4,300,600,1275
39=1,0,4,600,600,1275
40=1,0,4,900,600,1275

[SPDLayer1]
LayerLevel=150
LayerTray/Pad=0
TopCap=0
Dimension Vertical=H
Pos_Z=337
SecondaryPackPerLayer=10
1=200,150,L
2=200,450,L
3=150,800,W
4=450,800,W
5=600,150,L
6=600,450,L
7=750,800,W
8=1000,150,L
9=1000,450,L
10=1050,800,W

[SPDLayer2]
LayerLevel=525
LayerTray/Pad=0
TopCap=0
Dimension Vertical=H
Pos_Z=712
SecondaryPackPerLayer=10
1=200,150,L
2=200,450,L
3=150,800,W
4=450,800,W
5=600,150,L
6=600,450,L
7=750,800,W
8=1000,150,L
9=1000,450,L
10=1050,800,W

[SPDLayer3]
LayerLevel=900
LayerTray/Pad=0
TopCap=0
Dimension Vertical=H
Pos_Z=1087
SecondaryPackPerLayer=10
1=200,150,L
2=200,450,L
3=150,800,W
4=450,800,W
5=600,150,L
6=600,450,L
7=750,800,W
8=1000,150,L
9=1000,450,L
10=1050,800,W

[SPDLayer4]
LayerLevel=1275
LayerTray/Pad=0
TopCap=0
Dimension Vertical=H
Pos_Z=1462
SecondaryPackPerLayer=10
1=200,150,L
2=200,450,L
3=150,800,W
4=450,800,W
5=600,150,L
6=600,450,L
7=750,800,W
8=1000,150,L
9=1000,450,L
10=1050,800,W

Orientation Guide for Robotic Interface (CRF)

<table>
<thead>
<tr>
<th>No.</th>
<th>Orientation</th>
<th>X-axis</th>
<th>Y-axis</th>
<th>Z-axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Length</td>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Width</td>
<td>Length</td>
<td>Height</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Length</td>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>Width</td>
<td>Length</td>
<td>Height</td>
</tr>
<tr>
<td>5</td>
<td>15</td>
<td>Length</td>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>6</td>
<td>16</td>
<td>Width</td>
<td>Height</td>
<td>Height</td>
</tr>
<tr>
<td>7</td>
<td>13</td>
<td>Length</td>
<td>Width</td>
<td>Height</td>
</tr>
<tr>
<td>8</td>
<td>14</td>
<td>Width</td>
<td>Length</td>
<td>Height</td>
</tr>
<tr>
<td>9</td>
<td>19</td>
<td>Length</td>
<td>Height</td>
<td>Width</td>
</tr>
<tr>
<td>10</td>
<td>20</td>
<td>Height</td>
<td>Length</td>
<td>Width</td>
</tr>
<tr>
<td>11</td>
<td>17</td>
<td>Length</td>
<td>Height</td>
<td>Width</td>
</tr>
<tr>
<td>12</td>
<td>18</td>
<td>Height</td>
<td>Length</td>
<td>Width</td>
</tr>
<tr>
<td>13</td>
<td>5</td>
<td>Length</td>
<td>Height</td>
<td>Width</td>
</tr>
<tr>
<td>14</td>
<td>6</td>
<td>Height</td>
<td>Length</td>
<td>Width</td>
</tr>
<tr>
<td>15</td>
<td>7</td>
<td>Length</td>
<td>Height</td>
<td>Width</td>
</tr>
<tr>
<td>16</td>
<td>8</td>
<td>Height</td>
<td>Length</td>
<td>Width</td>
</tr>
<tr>
<td>17</td>
<td>9</td>
<td>Height</td>
<td>Width</td>
<td>Length</td>
</tr>
<tr>
<td>18</td>
<td>10</td>
<td>Width</td>
<td>Height</td>
<td>Length</td>
</tr>
<tr>
<td>19</td>
<td>11</td>
<td>Height</td>
<td>Width</td>
<td>Length</td>
</tr>
<tr>
<td>20</td>
<td>12</td>
<td>Width</td>
<td>Height</td>
<td>Length</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>Height</td>
<td>Width</td>
<td>Length</td>
</tr>
</tbody>
</table>
Exporting Information use in CAD Programs

We currently have 3 separate interface options for CAD programs, with the Esko interfaces being the most complex.

<table>
<thead>
<tr>
<th>22</th>
<th>Width</th>
<th>22</th>
<th>Height</th>
<th>23</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>24</td>
<td>Width</td>
<td>23</td>
<td>Height</td>
<td>24</td>
<td>Length</td>
</tr>
</tbody>
</table>

Export to Esko

These options create several different file types that can be sent to ArtiosCAD and Artios WebCenter.

Send to ArtiosCAD

This option send dimensional data to ArtiosCAD and recreates flat drawings of standard box types in that program.

XML and JPEG Report

This option creates XML and JPEG files for inclusion in WebCenter.

CRF/VRML

This option creates a CRF/VRML for use in ArtiosCADs 3D graphics rendering programs.

Show XML

This option opens the XML data for the analysis.

Export Pallet Load (XML)

This option exports the pallet load information in XML format.

Export to KASEMAKE

This option creates a text file that can be read into KASEMAKE CAD programs for processing.

Export to ImpactCAD/WEBcnx

This option creates a text file that can be read into ImpactCAD/WEBcnx programs for processing.
Other Features of CAPE PACK

Data Input Features

Open Input Data

Allows you to select and open your previously saved data input files. CAPE PACK defaults to your Private folder when opening and saving files.

You can open either .clf files created in the Pallet, Arrange, Design, Casefill, KDF groups or the Display Pallet program. CAPE PACK will open the correct program with the file you choose.

Inside/Outside Dimensions

The CAPE PACK default is set for Outside Dimensions. If you wish to work with Inside Dimensions, click on the Enter ID’s option. When you return to the input screen there will be some additional fields. They are Material Thickness box and the Number of Material Thicknesses in the length, width and height of your object.
Show Flap Indicator

This option is available under the **Input Settings** feature on the **Input** menu.

It turns the flap indicators on so that they automatically appear on the Multi-Viewer Graphics screen. Here is an example.
Bulge Allowed

Bulge is a factor, which can be added to some object shapes to take account of ballooning or outward distortion of the sides of the object. If you select this option on the Input Settings feature of the Input menu, an extra set of fields for Bulge Allowance will appear, permitting a bulge factor to be added to the length, width and height of the object.

You have 3 options for bulge which are all available on the Input Settings screen.
• Regular Bulge including negative Bulge

Enter the positive or negative amount of bulge you wish to include in each dimension of the carton or case.

• Percentage of Bulge
Enter the percentage of bulge you want to include for each dimension, or you can use the scroll arrows to select this amount.

- Minimum or maximum Bulge

Fill in the minimum and maximum bulge allowed along with an incremental variant. Your screen will populate like this.
Additional Palletizing Input

If you wish to restrict the solutions displayed in CAPE PACK, you can specify a minimum load efficiency or the minimum load dimensions.

These specifications are optional and do not need to be entered. They are designed to eliminate less efficient solutions from the Solution Report and to deal with the parameters for Clamp Trucks.

To enter these types of restrictions click on Additional Palletizing Input on the Input menu. A dialog box will appear.

If you want the load generated to pack the boxes together so there is no space between them, mark the No Pattern Gaps field.

If you know you want the load to be at least so many inches by so many inches, enter those dimensions in the Length and Width fields of the Minimum Load Dimensions box. CAPE PACK will not report on any solutions that do not meet the dimensions you specify in this field.
If you know you want the load to have at least a certain area efficiency, enter the percentage in the *Min Area Efficiency* field.

The *Load Target* field is for you to enter a target load quantity. The program will still calculate all possible solutions, but the solution report will only show answers with the specific quantity you have entered.

If you are going to use clamp trucks in your warehouse to move pallet loads, specify the options in the *Clamp Requirements* section.

### Dimension Label Decimal Places

This option is provided if you need to work in the Primary Pack Input, Bundle Wizard, Multi-Viewer graphics screens and your reports/printouts in a specified number of decimal places.

English versions of the program default to **two** decimal places.

If you want to change the decimal places, select the *Dim Label Decimal Places* option from the *Input* menu. The following screen will appear.

[Image: Set Decimal Places]

Changing this setting does **not** change the number of decimal places on the input fields. These are fixed at four decimal places.

Type in the number of decimal places you require and click on **OK**.

### Glue Flap Allowed

Another option available on *Input Settings* in Arrange, this feature opens up a field on the Secondary Pack tab for you to enter the size of the Glue Flap to be used in the calculations of the case blank area.
Vary Volume/Weight

CAPE PACK has always given you the ability to modify your primary pack volume based on a percentage of change, or to keep that amount constant. We now offer you a third option to fix a specific volume.

To change your volume, click on the **Input** menu and **Vary Volume/Weight**.
The following screen will open.

Your three choices are:

Keep volume as it is now by setting your Vary Volume By setting at 0% as shown above.

Change your volume variance by entering a percentage of change.

Set your volume to a specific measurement as shown below.
Customizing the Pack Names List

When you are specifying an object you should give it a pack name. That way, when a report is generated, a label will appear to identify related information. You can manually type in a pack name in the Pack Name field on the input tab. Alternatively, you can build your own list of Pack Names and then choose one where required. CAPE PACK is supplied with a small list of generic names (e.g., Carton, Box, Case and Tray).

Adding a Pack Name

Select Pack Names from the Tools menu. A dialog box will appear.

Click on the Add button. A new row will become available at the bottom of the list. The Pack Name column will be highlighted by a double lined rectangle.
Type a name for the pack name you are defining. For example, **Drum**.

You can continue to follow these steps until all your pack names have been defined. If at a later date, you need to add another one, repeat the same steps.

When you are finished click on **OK**. All of your Pack Names will now be added to the pull down list. The list will be available throughout the CAPE PACK programs.
Deleting a Pack Name

Highlight the row of the Pack Name you wish to delete. Click on the **Delete** button. A message box will appear confirming that you really want to delete the pack name associated with the highlighted row.

Click on **OK**. The entry will now disappear from the list.

Temporarily Removing a Pack Name

If you find that you no longer use a particular pack name you can hide it from view on the Pack Name pull down list.

In the list, find the pack name you wish to hide. Click once on the red check mark associated with that pack name. The check mark will go away.

Click on **OK**. The pack name will no longer be on the pull down list.
Customizing the Material Thicknesses List

When you are specifying the inside dimensions of an object, you must specify the thickness of the material from which the object is made. CAPE PACK can then calculate an outside dimension for your object. On the input tab, you can manually type in the thickness of the material (board) in the Thickness field.

However, if you cannot remember the thickness of a particular board, you can choose it from the pull down list. CAPE PACK is provided with a small English units list as well as a small Metric units list. However, you can customize these lists by selecting Material Thicknesses from the Tools menu.

When you are working in metric units, the metric list will be available for customizing. When you are working in English units, the English units list will be available. The program will not convert these lists between English and metric units. Two separate databases need to be maintained.

Adding a Material Thickness

From the Tools menu, select Material Thicknesses. A dialog box will appear.

![Material Thicknesses dialog box]

Click on the Add button. A new row will become available at the bottom of the list. The Thickness Description column will be highlighted by a double lined rectangle.
Type a name for the material thickness you are defining. For example, **32 ECT, C-Flute**.

Move the mouse over and click on the **Material** column. Type the thickness of the board. For example, **.15** inches.

Now click on the **Material Weight** column and enter **80**. This represents the weight of 1000 square feet of board if you are using English units, or grams per meter of board if you are using Metric units.

When you have finished click on **OK**. Your descriptions and material specifications will now be added to the pull down list. This information will then be available in the Pallet, Arrange and Design Programs.

**Deleting a Material Thickness**

Highlight any column in the row of the material thickness you wish to delete. Click on the **Delete** button.

A message box will appear asking you to confirm that you really want to delete the material thickness associated with the highlighted row. Click on **OK** and the item will be deleted.

**Temporarily Removing a Material Thickness**

If you find that you no longer use a particular material thickness, you can hide it from view.

In the list, find the material thickness you wish to hide. Click once on the red check mark associated with that material thickness. The check mark will go away. The material thickness will not appear on the list.

**Change Pallet Weight**

This feature allows you to modify the weight of any pallet base style within CAPE PACK. You must be on one of the Pallet tabs to activate this feature.

Select **Change Pallet Weight** from the **Tools** menu.
Select the pallet you want to change.

Type in the new weight and click on **Save**. You will see the Save As dialog box. Enter the same name or a new name and the pallet base will be saved with the new weight.

### Change Pallet Color

CAPE PACK gives you the ability to change the color of your pallet and then save it as the original file or as a new file.

Click on the **Colors** menu and then select **Change Pallet Color**.

Select the pallet base style you want to work with. Then click on the **Color** button.

Select a color from the palette and click on **OK**.

Click on the **Save** button to save the pallet file. You may change the file name, or save over the original file if you wish.

### Right-Click Shortcuts

The following demonstrate the right-click shortcuts available in the groups indicated.
Pallet Group

The following options can be accessed by right-clicking on the data input tabs in the Pallet Group.

For Data Entry options, right click on the active tab.

To access the ounce to decimal conversion, right click on the weights field. This same option is available in the Arrange and Design groups.
There is also a new feature for converting weights entered in metric to pounds, or vice versa. So if you know that your product weights 3.2 kilos, but don’t know the pound equivalent, you can use this feature to convert it.

To deselect loading patterns on the Truck tab, right-click in the pattern selection box.

Multi-Viewer Graphics Features

Formatting your Graphics

If you are new to the Multi-Viewer, here are some tips for setting up your screen.

Select the solution you want to manipulate by using the Solution Report button or the arrow icons.

Using the Format Screen button, set the number of screen panels or diagrams you want to view and print.

Next, using the Format Panel option, set each panel to a particular type of diagram.

If you need to use the Layer Editor, use it at this point.

Use Format Load to alternate layers, add layer pads, etc.

Run your Truck Analysis.

Use the Format Objects option to open the case, shrink-wrap objects, etc.

Finally, use the Review function from the Format menu as a final quality check on your work.

You can now print, copy or export your diagrams.

Diagram Types and Views

After you have chosen the number of diagrams, you can choose which types of diagrams you want in each panel. You then choose which view of the diagram types you want to view and print.

There are many different diagram types depending on the options and type of program you ran. All the different diagram types are listed below. If you do not see one of the diagram types in your list, then you did not select the option at input. The following is a complete list of the diagram types with available views.

<table>
<thead>
<tr>
<th>Diagram Type</th>
<th>Diagram Views</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pallet Load (1, 2, or 3)</td>
<td>Corner View, Side Views, Single Steps, Break Load</td>
</tr>
</tbody>
</table>
### Inverting the contents of the Secondary Pack

This option inverts the contents of the secondary package.

Using the **Invert** function in the **Diagram View** list, the product can be turned upside down.

### Customizing Materials for Top Caps, Corner Posts and Layer Pads/Trays

In the **Format Load** feature you can add Tops Caps, Corner Posts, Layer Pads, Layer Trays and Top Boards. All these options require you to enter material weights, thicknesses and heights. Entering this data every time you use the program can be a laborious process. To make this easier, we have provided three **Material Databases**, under the **Tools** menu on the Format Load screen.

![Format Load](image)

These databases are very easy to complete. Here is an example for Tops Caps and Layer Trays.
To create your own specifications, simply click on Add and fill out the Description, Thickness, Height and Weight fields.

Click on OK and your entry will be saved in the database.

Formatting the Objects in the Load

The many features available for formatting objects (Format Object button) provide a very powerful and useful way to enhance your final diagram printouts. The features available depend on which object you are dealing with. For example, you can open the flaps on a case or show the contents of a case, but you cannot show the contents of a cylindrical object.

The controls for formatting objects look like this.

Show Wrap

This option provides the ability to shrink-wrap an object. Here is the pallet load when shrink-wrapped.
Right-click on the show wrap field to see more options for your wrap.

**Show Cutaway**

This removes or adds a cut away wrapping from bundle packs.

**Open Flaps**

This option opens or closes the flaps on a case and lifts the contents out of the case.
Show Contents

This removes three sides of the secondary pack to show the contents inside.

Zoom

This menu item lets you expand the diagram in a selected panel.
Default Graphics View

This option allows you to set up a default number of panels and diagram views that appear every time you run an analysis. Here is an example where we have set the screen for three panels with the pallet load, pallet layer and secondary pack as our default.

The next time we run an analysis with different input data the same screen with the same diagram layout appears.

Set Dimension Label to

This option lets you set the dimensions around the Pallet Load to either those of the **Product**, the actual **Load** dimensions or the **Product with Load Height**.
Right-Click Shortcuts

The following demonstrate the right-click shortcuts available for the diagrams indicated.

Pallet Load
Truck Load

Pallet + Layer
Secondary Package

Bundle
Calculation of Weights in CAPE PACK

The following table describes the methods used by the program for calculation of weights.

<table>
<thead>
<tr>
<th>Plan of View</th>
<th>Calculation Formula</th>
</tr>
</thead>
</table>
| **Primary Pack (PP) figures (ID)** | PP Net Weight = Input PP Net Weight  
PP Gross Weight = Input PP Net + Add Weight + PP material weight |
| **Primary Pack (PP) figures (OD)** | PP Net = Input PP Net Weight  
PP Gross = Input PP Net + Add Weight |
| **Bundle figures** | Bundle Net Weight = Gross Weight of PP x PP per bundle  
Bundle Gross Weight = Gross Weight of PP x PP per bundle + bundle material weights |
| **Secondary Pack (SP) figures (no bundles)** | SP Net Weight = PP Gross Weight x PP per SP  
SP Gross Weight = PP Gross Weight x PP per SP + SP material and divider weights |
| **Secondary Pack (SP) figures (with Bundles)** | SP Net Weight = Bundle Gross Weight x Bundles per SP  
SP Gross weight = Bundle Gross Weight x Bundles per SP + SP material and divider weights |
| **Pallet figures in Pallet, Arrange and Design** | Product Net Weight = SP Net Weight x SP per load  
Product Gross Weight = SP Gross Weight x SP per load  
Load Net Weight = SP Gross Weight x SP per load  
Load Gross Weight = SP Gross Weight x SP per load + pallet weight |
| **Truck figures** | Truck Net Weight = Gross Weight of Pallet x pallets per truck  
Truck Gross Weight = Truck Net Weight + weight of truck |
| **Product Weight in Arrange and Design (for Pack Report only)** | Product weight = PP Net Weight x PP per load |
| **Working from ID’s in Arrange and Design** | PP Gross Weight = PP Net + Add Weight + PP material weight |

Adding or Changing Print Languages for Reports

This feature allows you modify your printed verbiage for your reports, or create an entirely new language for use on reports. English, French, German, Spanish, Swedish and Italian languages are available.

In Multi-Viewer Graphics, click on the **File** menu and then **Print Language Options**.
The following screen appears.

Select the language that you want to use for printing from the Available Languages drop down list in the upper right corner. The lists of languages will change.
You will see the default of English in the left column, followed by the Chosen Language in the middle column, and the number of characters available in the last column.

**Changing Languages Lists**

To change any of the language items, simply click on the line you want to change and type over the phrase. Here is an example in English. We will change “Layer” to “Tier”.

After you have made all your changes click on **Save**. And then click on **Close** to exit the Print Language Option screen.

Here is Print Preview with our changes.
Creating a New Language for Printing

CAPE PACK is capable of storing the printed labels and text for up to ten languages. In addition to the six provided, you have the ability to create four additional languages. To create a new language, you simply define what each of the “labels” should say.

In the Print Language Options screen, click on the **Add/Remove Languages** button at the bottom.

The following will appear.
Add your new language (ours is Lingo) at the bottom of the list and click the Show column.

Click OK, then select your language from the list of available languages.

Type in the terms you want to use for your language. You must enter something for each line in the language.
After you have created your language, select it in Page Setup as your Print Language.

Here is your language being used in Print Preview.
<table>
<thead>
<tr>
<th>Cubes per Case</th>
<th>Cases / Tier</th>
<th>Cubes per Pallet</th>
<th>Tiers / Total</th>
<th>Cubes per Total</th>
<th>Case / Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>10</td>
<td>400</td>
<td>5</td>
<td>400</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>Width</td>
<td>Height</td>
<td>Smaller</td>
<td>Larger</td>
<td>Cubic Feet</td>
</tr>
<tr>
<td>10.000 in</td>
<td>12.000 in</td>
<td>5.000 in</td>
<td>10.000 lb</td>
<td>10.000 lb</td>
<td>1.31 cuft</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overall Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>46.000</td>
<td>40.000</td>
<td>55.000</td>
<td>500.000 lb</td>
<td>550.000 lb</td>
<td>61.67 cuft</td>
</tr>
<tr>
<td>Coverage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.000</td>
<td>0.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Sustainability Scorecard

Introduction

We feel that it is a very important part of the packaging evaluation process to be able to substantiate your arguments for potential change or new packaging ideas with hard economic facts. The Sustainability Scorecard program was designed as a tool to assist you in this task. Sustainability Scorecard is used to compare the financial consequences of one selected solution against a maximum of three others.

The **Sustainability Scorecard** option is only available from the **Tools** menu in the Pallet, Arrange and Design Groups.

![Sustainability Scorecard Menu](image)

The example we are describing is based on the results of running the Widget data file in the Pallet Group Tutorial. Our example also assumes that the secondary packages are corrugated cases.

From our analysis, we have established that the maximum number of cases that can be loaded with one dimension vertical is 42 (6 layers of 7 cases per layer with the case height dimension vertical in solution 1).

We will assume that the 42 cases achieved 7 more cases per load than an original pattern we used.

![Numerical Solution Report (Pallet #1)](image)

To check the economic feasibility of these alternatives, click on **Sustainability Scorecard** on the **Tools** menu. The following screen will appear.
You can evaluate up to four (4) alternatives during on analysis. We are going to enter 2.

To change the number of alternatives, click on the **Options** menu and **Input Settings**.

The following screen will appear.

Click on the Use field to activate the Alternative number, then select the solution number you want to use. In this case we will activate the first 2 alternatives and select solutions 1 and 11 respectively.

Now click on **OK** and you will see the following screen.
Input Data

For our example, the basic information relating to case size and number of case per pallet is already filled in for the 3 alternatives. The remaining data must now be entered manually.

Volume/Usage Data

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Annual Volume</strong></td>
<td>Enter the annual quantity of cases or whatever the secondary package was called. Type <strong>50000</strong>. Annual volume is a required data entry.</td>
</tr>
<tr>
<td><strong>Avg. Inventory</strong></td>
<td>Approximately how many cases do you hold in stock on a monthly basis? Let's assume we hold a minimum quantity of one month's supply in stock. Enter <strong>4000</strong>.</td>
</tr>
<tr>
<td><strong>Cases/Pallet</strong></td>
<td>The number of cases per pallet is entered automatically, taken from the Solution.</td>
</tr>
<tr>
<td><strong>Pallets/Load (Pallet)</strong></td>
<td>How many full pallets can we load onto our delivery truck? Let's say <strong>24</strong>. Click on the Options menu and Repeat (or control+R) to fill in this entry for all alternatives.</td>
</tr>
<tr>
<td><strong>Cases/Load (Dead stack)</strong></td>
<td>You have designated that full pallets are being loaded into the truck versus hand-loading or dead stacked (no pallets). You cannot enter both pallets/load and cases/load. Your screen should now look like this.</td>
</tr>
</tbody>
</table>
Click on the Input 2 tab to continue your data entry.

### Logistics Costs

<table>
<thead>
<tr>
<th>Cost Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handling (Cost/Pallet)</td>
<td>Enter 1.80 for the alternatives based on the assumption that the case has the same handling costs.</td>
</tr>
<tr>
<td>Storage (Cost/Pallet/Month)</td>
<td>Enter 4.50 as the cost to store one pallet per month.</td>
</tr>
<tr>
<td>Transfer (Cost/Load)</td>
<td>If there are transfer costs incurred from factory to storage, enter the amount per truck as 60 for each.</td>
</tr>
<tr>
<td>Transport (Cost/Load)</td>
<td>Enter 250 for the average cost of delivering one truck to a given destination.</td>
</tr>
</tbody>
</table>

### Material Costs

<table>
<thead>
<tr>
<th>Cost Category</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases (Cost/000)</td>
<td>In our example the case is the same size for all alternatives. Therefore a materials cost comparison would be of no value. If the case material cost were different we would need to enter a cost per thousand cases here.</td>
</tr>
<tr>
<td>Pallets (Cost/Pallet)</td>
<td>Pallets cost money, so enter the cost of one pallet for each alternative as 8.00.</td>
</tr>
<tr>
<td>Miscellaneous Costs</td>
<td>Three fields are provided to include any other costs that might apply from one alternative or another. The cost is expressed as a total annual cost (e.g., 2000 for new printing or machinery costs, etc.).</td>
</tr>
</tbody>
</table>

Input 2 of the Sustainability Scorecard should now look like this.
Reviewing Results

Click on the File menu and Calculate to get your results.

Page 1 of the output will appear, which serves to recap your volume information.
Here is Page 2 which is an analysis of the volume information.

Here is Page 3 which recaps the handling costs.
And finally, Page 4 which compares the two options.

Our report shows that by using Alternative 1 we could save nearly 20% of our costs over Alternative 2. Sustainability Scorecard is a very simple, yet powerful way of comparing the financial implications of packaging changes.
Printing Results

Simply click on File menu and then Print to obtain a formatted report.

Tips and Background Information

The following formulas are used to calculate the Sustainability Scorecard.

Handing & Transfer Cost = (Handling Cost * Total Pallets/Year) + (Transfer Cost * Total Loads/Year)

Pallet Program

Total Storage Cost = [Avg. Inventory/(# of Cases/Pallet)] * Storage Cost * 12

OR

Arrange/Design Programs

Total Storage Cost = [Avg. Inventory/(# of Cartons/Pallet)] * Storage Cost * 12
Total Transportation Costs = Transportation Cost * (Total Loads/Year)

Total Costs per Year = Total Materials Cost + Total Miscellaneous Costs + H & T Costs + Total Storage Costs + Total Transportation Costs

If you select Close from the File menu, exiting the Sustainability Scorecard completely, the information regarding the chosen alternatives and the annual volumes, etc., on the first input screen must be re-entered. It is assumed that these will change for each Sustainability Scorecard you execute. The cost information, however, will be saved from the last analysis run during the current work session.

Select Print to produce a two page printed copy of the full analysis.

Select Close from the File menu to exit Sustainability Scorecard and return to the graphics section of the program (Pallet, Arrange or Design).
Making New Shapes

Introduction

The Make a new Shape feature is a group of easy-to-use programs designed to create packaging and loading shapes for use in your CAPE PACK programs. These shapes include rectangular bottles, bags, oval bottles, gable-end cartons, round bottles, other cylindrical shapes, cases, trays, pallet blocks, pallet bins and trucks or shipping containers. These “component designs” can be used within the Pallet, Arrange, Design, Casefill, KDF and 3D Imaging programs. Once you have created your shape/package style you can apply color to part or all of the object and save it for later use. You can also add graphics to any of the shapes that you create with the Make a new Shape feature.

It is important to understand that this feature saves the relative proportions of the shape you design and save. Thus, you can use one shape and apply several different dimensions to that shape in the other CAPE PACK programs.

In the Make a new Shape feature, all measurements are in units. These can represent inches, millimeters, or any other units you want to use. It is helpful to use small whole increments when designing shapes rather than decimals. We recommend you use either millimeters or hundreds of inches (i.e., 5 inches would be entered as 500).

You can access this feature on either the Front Menu screen, or in the Pallet, Arrange, Design or Casefill groups. If you launch this feature from the Pallet, Arrange or Design groups, you will have the option to create new Pallet Blocks, Pallet bins or Trucks/Containers.

To make a shape, click on the Make a New Shape menu and select the shape you want to work with.

Or, you can select this option with the icon on the toolbar.

Either way you will be presented with a screen similar to the one below.

You have two choices. You can create a new file or open an existing file.

To create a new file, you simply fill in the Initial Parameters.
To open an existing file, click on **Cancel**. Then select **Open** from the **File** menu.

**Shape Files Storage**

The files are saved in separate folders within CAPE PACK.

When you select **Save As**, the appropriate folder for the shape you are working on will be opened. You cannot save the file to another folder. You can share your shape files with other users. However, they must place the shape in the respective folder of their program. For example, if you share a tray shape, it will be retrieved from your VariableTray folder and the recipient will need to place it in their VariableTray folder.

When you save the shape files they become available in the Pack Type lists in Pallet, Arrange, Design and Casefill programs as follows.

<table>
<thead>
<tr>
<th>Shape Type</th>
<th>Programs Where Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bags</td>
<td>Pallet Group – Bags, Arrange and Design Groups – Box/Bag/Bottle and Casefill – Box/Bag/Bottle (Fixed and Variable)</td>
</tr>
<tr>
<td>Blisters</td>
<td>Pallet Group – Rectangle/Oval, Arrange and Design Groups – Box/Bag/Bottle and Casefill – Box/Bag/Bottle (Fixed and Variable)</td>
</tr>
<tr>
<td>Cylindrical Shapes</td>
<td>Pallet Group - Cylinders, Arrange and Design Group –Cylinders and Casefill – Cylinders Fixed</td>
</tr>
<tr>
<td>Display Cases</td>
<td>Pallet Group – Rectangle/Oval, Arrange Group, Design Group, Folding Carton – Casefill</td>
</tr>
<tr>
<td>Gable-End Shapes</td>
<td>Pallet Group – Rectangle/Oval, Arrange and Design Groups – Box/Bag/Bottle and ...</td>
</tr>
</tbody>
</table>
Casefill Box/Bag/Bottle (Fixed and Variable)

<table>
<thead>
<tr>
<th>Oval Bottles</th>
<th>Pallet Group - Rectangle/Oval, Arrange and Design Groups – Box/Bag/Bottle and Casefill Box/bag/Bottle (Fixed and Variable)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangular/Square Bottles</td>
<td>Pallet Group – Rectangle/Oval, Arrange and Design Groups – Box/Bag/Bottle and Casefill Box/bag/Bottle (Fixed and Variable)</td>
</tr>
<tr>
<td>Pallet Blocks, Pallet Bins,</td>
<td>Pallet Group, Arrange and Design Groups and KDF Group</td>
</tr>
<tr>
<td>Pallet Crates</td>
<td></td>
</tr>
<tr>
<td>Pallet Base Styles</td>
<td>Pallet Group, Arrange and Design Groups and KDF Group</td>
</tr>
<tr>
<td>Truck/Container</td>
<td>Pallet Group, Arrange and Design Groups and KDF Group</td>
</tr>
</tbody>
</table>

We have included examples for you in this chapter that can act as tutorials to get you started. In addition, the program is supplied with a large variety of shapes that have been created using this feature. You can modify these shapes as you see fit, or simply create your own.

Remember, in the **Make a new Shape** feature, all measurements are in units. These can represent inches, millimeters, or any other units you want to use. It is helpful to use small whole increments when designing shapes rather than decimals. We recommend you use either millimeters or hundreds of inches (i.e., 5 inches would be entered as 500).

### Designing Cases

The **Make a new Case** lets you create a variety of “cut-away” or "display" case styles. You can represent many types of display packs, shipping trays and cases. Once you have created your case style, you can give it an overall color or you can select a color for each face within your case design.

Your program is provided with a variety of special case styles. These can be found under the Pack Type lists in the analysis programs. You can either modify these existing case styles or develop your own completely new designs.

Click on the **Make a new Shape** menu, and then on **Make a new Case**.

You will be presented with the following screen.

Enter the following numbers into the appropriate fields.

For the **Overall Initial Height** enter **1000** and press the **Tab** key.
For the *Overall Initial Length* enter **1200** and press the **Tab** key.

For the *Overall Initial Width* enter **1600** and press the **Tab** key.

Click on **OK**. You will then see the following screen.

You are presented with a case and one face (face B) on the left side of the screen. Face B is highlighted in the row of buttons marked A, B, C, D, E, and F.

The buttons marked A, B, C, D, E and F represent the six panels of the case and are labeled in accordance with the face/panel naming conventions of the 3D Imaging Program. Face A represents the top of the case and F represents the bottom. Thus, by maintaining this convention throughout CAPE PACK, you can transfer images to the appropriate panels of the case in exactly the same way as you would for other packaging components.

Notice how, on this screen, there are four sections marked on face B on the left side of the screen. And that there are two sets of fields across the bottom of the screen. One row of fields is for setting the *Bottom* and *Top Height* and other row is for setting the *Right* and *Left Width*.

When you work with this screen, think of the face you are working on as a two dimensional (flat) drawing and that the changes you make to each section are like opening or closing the vertical or horizontal blinds on a window. The lower the number entered, the wider the gap on the face.

The changes you make are then shown in both 2D on the left side of the screen and 3D on the right side of the screen.

Let’s remove all of face C. We need to reduce the numbers to zero in both the height and width settings. If you change the bottom height, the appropriate section will move up or down on the left side of the screen and the change will be immediately reflected in the three dimensional case on the right hand side. The same will happen when you change the top height.

Click on the button marked **C**.
The Bottom Height is set at 300 and the Top Height is also 300. Change the Bottom Height to 0 and press the Tab key.

Now change the Top Height to 0. Notice how the small inset diagram (2D) has changed.

Change the Left Width to 0 and press the Tab key.

You can see that half of face C has disappeared. Change the Right Width to 0.
Notice how all the sections on the left side of the screen and face C on the right side have also disappeared. The idea of the Case Wizard is that, as you adjust the height and width sections of a particular face, you see both the two-dimensional changes on the left side of the screen and the three-dimensional case being formed on the right.

To better demonstrate the changes, let’s color the box.

Click on the button marked **Overall Color**.

Pick a brown shade and click on **OK**.
Making the Opposite Face the Same

If you want the opposite face of the case to be the same, click on the **Match Face** button. This feature quickly duplicates your efforts to create two identical sides of the case.

Partial Top Flaps Cases

The Case Wizard offers a simple way to do this. Let’s make a case with partial flaps along the length of the top panel. We will start with the same case as the first example.

Let’s start with the top panel of face A. Click on the **A** button to activate the face.

Make the **Top** and **Bottom Heights** 50, and press the **Tab** key.

The three dimensional case has not changed. Now make the **Left Width** 0 and press the **Tab** key.

Notice how the left side of face A has been removed and that we have a 50 unit partial top flap along the length of the panel.

Now enter 0 for the **Right Width**.
Now we have face A with two 50 unit-wide top flaps, along the length of our case.

Number of Material Thicknesses

Use the Options menu and select No. of Material Thicknesses.

You will be presented with a screen like this.

Simply enter the number of material thicknesses for the Length, Width and Height and click on OK. These numbers will be saved with the case style and then be carried through to the Pallet, Arrange, Design and Casefill programs.

Saving Your Case

Once you have finished the design of your case style you can save the design in the following way.
Select the **File** menu, then **Save As**. The Save As dialog box appears.

Enter the name you wish to use, and click on **Save**.

The Case shape files are saved with the .CSF extension (representing **CAPE Shape File**) in their own folders and they will appear in the **Pack Type** list in the appropriate Pallet, Arrange, Design and Casefill programs.

To leave the **Make a new Case** screen, select **Close** from the **File** menu.

**Designing Trays**

The **Make a new Tray** feature lets you create a variety of tray styles. You can represent many types of display packs, shipping trays and crates. Once you have created your tray style you can give it an overall color or you can select a color for each face within your design.

A tray, within CAPE PACK is defined as being “a case without a top”. If you need to create a tray or special case style that has any part of a top panel, you should use the **Make a new Case** feature.

Your program is provided with a variety of tray styles. These can be found under the **Pack Type** lists in the analysis groups. You can either modify these existing tray styles or develop your own new designs.

Click on the **Make a new Shape** menu, and then on **Make a new Tray**.

You will be presented with the following screen.
Enter the following numbers into the appropriate fields.

For the *Overall Initial Height* enter 600 to represent 6” and press the Tab key.

For the *Overall Initial Length* enter 1200 to represent 12” and press the Tab key.

For the *Overall Initial Width* enter 900 to represent 9” and press the Tab key.

Click on OK and you will see the following screen.

You are presented with a tray (a case without a top) on the right side of the screen and one face (face B) on the left side of the screen. Face B is highlighted in the row of buttons marked B, C, D, and E.

The buttons marked B, C, D, and E represent the four side panels of the tray and are labeled in accordance with the face/panel naming conventions of the 3D Imaging Program. The other two faces, A and F, are normally used for the top and bottom panels of a case in the 3D Imaging Program. Thus, by maintaining this convention throughout CAPE PACK, you can transfer images to the appropriate panels of the tray in exactly the same way as you would for other packaging components.

Notice how there are five sections marked on face B on the left side of the screen, and that there are two rows of fields across the bottom of the screen. One row of fields is for setting the *Face Panel Heights* and other row is for setting the *Face Panel Widths*.
The idea of the Tray Wizard is that, as you adjust the height and width sections of a particular face, you see both the two-dimensional changes on the left side of the screen and the three-dimensional tray being formed on the right side.

Start with the **Face Panel Height** fields to adjust the height along the panel. Leave the first two fields at **600**, using the **Tab** key to move between fields. In the third field, type **400** and press the **Tab** key. Your screen should now look like this.

Type **400** in the next field and press the **Tab** key.

See how face B has changed.

**Making the Opposite Face the Same**

If you want the opposite face the same you can use the **Match Face** button. This feature duplicates your efforts to create two identical sides of the tray.

Click on the **Match Face** button and your screen should now look like this.
Now let’s change face C. Click on the button for face C.

Leave the first two Face Panel Height fields at 600.

Enter 300 for the next field and press the Tab key.

Enter 300 for the next field and press the Tab key. Your screen should now look like this.

Now click on Match Face.
Straightening the Sides of a “Cut-Out Panel”

Here is panel B with sloping sides.

Changing the sloping sides to straight sides is achieved by changing the numbers in the five *Face Panel Width* fields.

In the second field type 0 and press the **Tab** key.
Notice how the left hand side of the “cut-out” has become upright. Also notice how, as you change the numbers in the fields, the figures in the remaining fields adjust themselves. This is because the total number (all the fields added together) cannot exceed the size of the original width dimension you specified.

Now enter **0 in the fourth field** and press the **Tab** key. Your screen should look like this.

Click on the **Match Face** button and the opposite face becomes the same.
Coloring the Tray

Click on the button marked **Overall Color**. The Windows color palette is now available, as you will see in the following picture.

Choose a color and click on **OK**.

Coloring Tray Panels

Select the button for the face you want to change (B, C, D, or E), and then click on the **Face Color** button.

Here is an example where each face of a tray has been given a different color.
Number of Material Thicknesses

Click on the **Options** menu, and then **No. of Material Thicknesses**.

You will be presented with a screen like this.

Simply enter the number of Material Thicknesses for the **Length**, **Width** and **Height** and click on **OK**.

These numbers will be saved along with tray style. When you later select the style, in the Pallet, Arrange, Design and Casefill programs, the number of material thicknesses will appear automatically.

Saving the Tray

Once you have finished the design of your tray style you can save the design in the following way.

Select the **File** menu.
Select **Save As**. The Save As dialog box appears.

Enter the name you wish to use. For our example, we will use the name **newtray**. Click on **Save**.

To leave the **Make a new Tray** screen, select **Close** from the **File** menu.

---

### Designing Cylinders and Round Bottles

We are going to create a wine bottle.

Select **Make a new Cylinder/Bottle** from the **Make a new Shape** menu.

First, you need to enter the number of sections to be used. 12 is the maximum number of sections you can select. Enter **7**.

Then you need to enter an overall diameter and height. For the **Overall Initial Height** enter **1400** to represent 14 inches.

For the **Overall Initial Diameter** enter **350** to represent 3.5 inches. You can work with a figure up to twice the initial overall diameter.
Click on **OK** and you will see the following screen.

You are presented with a straight-sided cylinder. Now we have to create our bottle shape.

Notice how the *Height at Top of Section* is set in 200 unit increments. Thus, based on a height of 1400 units and 7 sections, the program has assumed 7 equal sections of 200 units. If you wish to change these settings you may. Just type in the appropriate number. Notice how the diameter is set to 350 for all sections, hence the straight-sided shape.

Change the very top of the cylinder to start creating the neck of our bottle. Click in the very top section diameter column, and type **100**. Use the arrow keys on your keyboard to move to the next lower section (6).

See how the top has changed. Now enter **100** for the next section down and move to section 5 diameter.
Now the top of our wine bottle is beginning to take shape. Enter 140 in the section 5 diameter field and then move to section 4.

Continuing in this manner, enter 200 for section 4 and 300 for section 3. Your screen should now look like this.

Now let’s color the bottle.

Click on the Overall button. The Windows color palette is now available, as you will see in the following picture.
Select a green shade and then OK.

Notice how the vertical bar in the Color column has changed to the green you selected. Click on this bar and your bottle will change to green.

Now let’s make the typical seal around the top of a wine bottle. We will color it yellow.

Click on the green button in the Color column for section 7. Select a yellow shade from the color palette and click on OK. You will see the green bottle with a yellow seal around the top section. Our bottle is nearly complete.
Let's simulate a bottle label. Click on the green button for Section 2. Choose white from the Palette and click on OK. Your screen should now look like this.

The 0, 90, 180, and 270 buttons allow you to rotate the object to these angles. The 1, 2, 3, and 4 buttons allow you to see any of the four sides of the object. The Top and Bot buttons allow you to view the top and bottom of the object.

To save your bottle shape click on the File menu and select Save As.

Enter the file name you want to use and click on OK.

You can open existing files, make changes and then save the changes to another file name. The CAPE shape files are saved with the .CSF extension in their own folders, and they will appear in the Pack Type list in the appropriate Pallet, Arrange, Design and Casefill programs.

To leave the Make a new Cylinder/Bottle screen, select Close from the File menu.

Designing Bags

Next we will create a potato chip bag.

Select Make a new Bag from the Make a new Shape menu.
You will see the Initial Parameters screen.

Enter 7 for the Number of sections. The maximum number is 12.

Enter 800 for the Height, 500 for the Length, 100 for the Width representing 8” x 5” x 1” respectively.

Click on OK and you will see the following screen.

While the shape on the screen may look a little unusual, it will quickly become the bag shape we want.

Click on the Length at Section 1 Bottom and change it to 500. Change the Width of Section 1 Bottom to 5.

Clicking on the appropriate fields, change the top length to 500 and the top width to 5. Your screen should now look like this.
Now make the same changes for sections 2 and 6.

Next change all the lengths to 500.

Now let's color the bag.
Click on the **Overall** button and select a color. Click on **OK**.

Click on the top button in the **Color** column and choose a color for the “seal”.

Do the same for the bottom seal.

![Image of Shape Parameters](image1.png)

Last, save your shape by clicking on **File** and **Save As**.

To leave the Make a new Bag screen, select **Close** from the **File** menu.

### Designing Gable-End Shapes

Select **Make a new Gable End Shape** from the **Make a new Shape** menu.

Enter the following Initial Parameter data.

* **Number of sections**: 7 (the maximum number is 12)
* **Overall Height**: 700
* **Overall Length**: 350
* **Overall Width**: 350
Click on **OK** and you will see the following screen.

Make Section 5 **350** in the width instead of 175. Your screen should look like this.

Save your shape by selecting **Save As** from the **File** menu.

To leave the **Make a new Gable End Shape** screen, select **Close** from the **File** menu.

---

**Designing Rectangular or Square Bottles**

There are essentially two styles of rectangular bottles.
Let's create an offset bottle shape.

Select **Make a new Rectangle Square Bottle** from the **Make a new Shape** menu.

Change the default settings to the following:

Number of sections **7**

Overall Height **800**

Overall Length **400**

Overall Width **200**

Click on **OK**.
To make this an offset bottle, we need to move either the neck or cap (or both). Towards the top of the screen you will see a block labeled *Offset Information*. Here you can move the neck or cap in either the length or width direction.

Let's make one side of the bottle into a straight side. Notice the number 1.0 in the *Increment* box. This indicates the amount the neck or cap will be offset each time you want to move it.

Click on the left arrow button marked *Along Length*, in the *Section 6 Offset* block. Each time you click the neck will move towards the left and it will eventually become a straight side. Here is the screen after 10 clicks, shown from the side.

Here is the screen after 25 clicks have occurred.
Now let's move the cap to the left-hand side of the top section. This time click on the left arrow marked **Along Length**, in the **Neck Offset** block. Click on this arrow until the cap has reached the end of the top section.

Save your bottle by clicking on the **File** menu and **Save As**.

To leave the **Make a new Rectangle Square Bottle** screen, select **Close** from the **File** menu.

---

**Designing Oval Bottles**

Oval bottles require information similar to rectangular bottles except that you do not enter a length and width, you enter a long diameter and a short diameter.

Select **Make a new Oval Shape** from the **Make a new Shape** menu.
Leave the default settings as they appear.

Number of sections 7

Overall Height 200

Overall Length 100

Overall Width 50

Click on OK.

When you create a thin bottle, the outline of the edge facing you may appear to be faded. This is because the edge is slightly rounded. Use the Overall color feature to improve the appearance.

Also note that when you are changing long and short diameters for the cap, you should change the short diameter first starting at the top section.
Let's make the cap taller. Go to section 6 of the *Height at Top of Section* column and change it to *160* move to the next field.

Change the *Short Diameter of Sec 1 Bottom* to *65* and press the **Tab** key.
Now click on the blue button for section 7 and change the color.

You can also create offset oval bottles.

The technique for changing the neck and section 6 offset is the same as rectangular bottles.

To leave the Make a new Oval Bottle screen, select Close from the File menu.

Designing Blister Pack Shapes

We have added a new Make a New Shape feature for Blister Packs as well. This shape can be used to simulate plastic blisters as well as card type packages with a hanging extension.

From the Make a New Shape menu, select Make a New Blister Pack. Enter your starting dimensions.
Click **OK** to see the default shape on the screen.

Then adjust the placement of the card back and also the blister (or bubble) part of the package. The Flatboard is the card that attaches to the back of the blister. The Bubble is the blister itself.

If offset will not be possible, you will see the following prompt when you save.
Save your shape and it will appear in your list of options in the Arrange and Design Groups.

**Designing Pallet Blocks**

You cannot create a true pallet base style, but you can build three-dimensional **Pallet Blocks** to represent any pallet base size.

On the input screens choose the **Make a new Shape** menu, and **Make a new Pallet Block**.

The following screen will appear.

Enter a **Description**, the required **Length**, **Width**, **Height** and **Weight** of the pallet base you want to build:
Click on **Save** and a **Save As** dialog box appears:

Enter a name (maximum of 8 characters) for the "special" pallet base style and then click on **OK**.

Your new pallet block will now appear in the list of **Pallet Base Styles**.

---

**Designing Trucks or Shipping Containers**

Making new truck or container sizes is very similar to making a Pallet Block.

Make sure you are on one of the input screens. Now choose the **Make a New Shape** menu and then select **Make a New Truck/Container**.
The following screen appears:

Enter a **Description**, the dimensions and weight.

Click on **OK**. You will then be asked to enter a name (maximum of 8 characters) and save your **Truck/Container Style**:

Your newly created truck will automatically appear in the list of **Truck Types**:

---

**Designing Pallet Bins**

Pallet bins are often used as a disposable pallet container. Corrugated and carton manufacturers use them to deliver folding cartons, corrugated flatblanks and bundles of flat-glued cases (KDF’s). Here is an example.
To create a Pallet Bin:

Go to the Make a new Shape menu on the Pallet, Arrange, Design or KDF input screens and select Make a new Pallet Bin.

The following screen will appear:
Enter the following information in the appropriate fields.

Description -- pallet bin

ID for the bin length -- 48

ID for the bin width -- 40

ID for the bin height -- 50

Bin Weight -- 35

Leg Width for the width of the wooden runners -- 6

Leg Height for the height of the wooden runners – 4.5

Leg Offset from edge for how far the runners are from the edge -- 6

Now click on the Save button.
Enter a filename for the bin. These file names cannot exceed 8 characters.

Your pallet bin has now been saved to the chosen file name. It is available to use from the Pallet Base Style list on the Pallet tab.

Designing Pallet Crates

Pallet crates are best described as a box that sits on a regular pallet base style. They have a variety of uses including bulk items, fresh produce and flat cartons.

To create a Pallet Crate:

Go to the Make a new Shape menu on the Pallet, Arrange, Design or KDF input screens and select Make a new Pallet Crate.

The following screen will appear:
Enter Pallet Crate as the description.

Select 48x40.pa4 from the pallet base style drop down list.

For the Crate length, enter 48.

For the Crate Width, enter 40.

For the Crate Height, enter 50.

For the Crate weight, enter 53.

Now click on the Save button.
Enter a file name for the crate. These file names cannot exceed 8 characters.

Your pallet crate has now been saved to the chosen file name. It is available to use from the Pallet Base Style list on the Pallet tab.

**Designing Pallet Displays**

Pallet Displays are a regular pallet base style that has a display case or tray secured to the top. This allows stores and discount clubs to use their pallet loads for customer shopping convenience, without having to unload the product from the pallet or case.

To create a Pallet Display:

Go to the **Make a new Shape** menu on the Pallet, Arrange, Design or KDF input screens and select **Make a new Pallet Display**.

The following screen will appear:
Enter **Pallet Display** as the description.

Select **48x40.pa4** from the pallet base style drop down list.

Select **TRAY2.CSF** as your Display Case.

For the Crate length, enter **48**.

For the Crate Width, enter **40**.

For the Crate Height, enter **50**.

For the Crate weight, enter **53**.

Now click on the **Save** button.
Enter a file name for the Display. These file names cannot exceed 8 characters.

Your pallet display has now been saved to the chosen file name. It is available to use from the Pallet Base Style list on the Pallet tab.
Making New Pallet Base Styles

Introduction

CAPE PACK allows you to create your own realistic pallets rather than requesting pallets from Customer Service, or using Pallet Blocks. Because this is a design tool, it is essential that you have accurate measurements for the pallet, and all the boards or blocks that make up this pallet style.

Each pallet is created in layers by selecting boards from a list and then placing them on the pallet in the desired location. Once the bottom layer is completed, you add a new layer and continue on until all of the pieces are placed. There are 2 basic pallet styles that you will want to consider when using this feature:

- Two-way entry pallets that are usually created with 3 layers of boards.
- Four-way entry pallets that are usually created with 4 layers of boards. In the case of four-way pallets, the stringers are split vertically to create 2 separate layers. The easiest way to see this is to open a 4-way pallet and look at the different layers of the pallet. The 48x40.pa4 file is an excellent example of this type of pallet.

You have 2 options with the pallet design feature:

- Create a new pallet base style. Use this if you have a brand new style, or if you need to change the sizes of individual boards in an existing pallet style.
- Modifying an existing pallet base style. Use this option if you are change the number of boards on an existing pallet, but the size of the boards is remaining constant.

We will discuss both options.

Designing New Pallets

You will need to have a fairly accurate picture, drawing or specification of the pallet that you want to build with dimensions of the boards and gaps.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Size</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Deck Boards</td>
<td>40&quot; x 5.5&quot; x .75&quot;</td>
<td>5: 3 on the bottom and 2 on top</td>
</tr>
<tr>
<td>B</td>
<td>Deck Boards</td>
<td>40&quot; x 3.5&quot; x .75&quot;</td>
<td>7: 2 on the bottom and 5 on top</td>
</tr>
<tr>
<td>C</td>
<td>Runners</td>
<td>48&quot; x 1.75&quot; x 2&quot;</td>
<td>3. This is the top half of the runner.</td>
</tr>
<tr>
<td>D</td>
<td>Runners</td>
<td>6&quot; x 1.75: x 1.5&quot;</td>
<td>6. These will be place on either end to help frame the &quot;notch.&quot;</td>
</tr>
<tr>
<td>E</td>
<td>Runners</td>
<td>16&quot; x 1.75&quot; x 1.5&quot;</td>
<td>3. These will be placed in the middle to complete the frame for the &quot;notch.&quot;</td>
</tr>
</tbody>
</table>

On the Front Menu or the input screens for any program that uses pallets, choose the Make a new Shape menu, and Make a new Pallet Base.

The following screen will appear.

Select New Pallet and click on OK. You will see the next screen.
For this example we will be making a 48x40x5" pallet that weighs 50 pounds. So we need to select in/lb for our units of measure rather than metric and then enter our overall pallet size.

Click **OK** and you will see the following screen.

You can now begin to enter your boards for the pallet. Start with the first board in the table above.

Click on the **Another** button to clear the screen and allow you to enter an additional board. Repeat this process until all boards are entered. Then click **OK** to open the Pallet Builder program. Your screen will look the following.
The next step is to create a layer so that we can start placing our boards. Click on the **New Layer** button.

A line item for this layer will appear in the layers list, and you will see the outline of the pallet layer in red on the top view. Click on the first board that you want to place which will be number 1 in your board list. Then click on the **Select Board** button.
The first board will appear on your layer. However, it is oriented in the wrong direction. Click on the board, which will mark it with a large X, then click on the **Switch Direction On** indicator.

The board turns to the correct orientation. Using this procedure, add boards in the following order:

- Board 2
- Board 1
- Board 2
- Board 1

Your screen will look like this.
Click and drag the last board added to the far right side of the pallet. Then we will move on to layer 2 and leave final editing of this layer until later.

Click on **New Layer** to add layer 2. This will be the layer where we create the notches for the four-way entry.
First add a board number 4.

Add two more of these boards. Then we will center them equally across the width of the pallet.

Drag the top board to the top left corner of the pallet.
Now hold down the Shift key and click and drag from the top board to the bottom. A large X will be placed over the three boards.

Click on the **Format** menu, **Spacing Along Width, Make Equal**.
Repeat this process spacing all the rest of the boards for this layer equally in both the length and width of the pallet. Your pallet should look like the following.

Next we need to fix the spacing on the bottom layer. Click back on layer one, and make the spacing equal along the length of the pallet.
Then move the two smaller boards towards the center until all three center boards are equally spaced under the center runner piece.

Next we will add a new layer for the other half of the stringers. Click on **New Layer**.

Add 3 of board number 3 and space them equally along the width of the pallet.
And finally, we need to add the last layer, with the top boards. This layer has 1 board one on each end and then 5 board twos, all equally spaced along the length of the pallet. Your final pallet should look like this.

Finally, add a description in the area above the pallet top view.
Save your pallet by clicking on the File menu and Save. Pallet must have an 8-character name and must be saved into the Tutor folder. The program will add the PA4 extension to your file.

Features of the Pallet Builder

There are several features that have been built into this new feature that make it more user friendly if you are going to be building a lot of your own pallet styles. All of the can be access from the menus.

File Menu
New Pallet

Use this option to create a brand new pallet base style.

Open Pallet

Use this option to open and modify an existing pallet base style. You can open the file via a standard dialog as shown next.

Or you can open with the new Thumbnail option.

View Menu

This menu gives you the option to view the pallet from different angles. Here are your options.
Format Menu

This menu gives you the ability to equally space the boards of your layer either along the length or width of the pallet. The program will equally space the objects that are highlighted. You can also remove the spacing using this feature.

Tools Menu

The Tools menu contains two options.

Board Table

This option gives you the ability to create a listing of boards that are commonly used to create pallets.

Click on add to Add a board to the table.
Enter in your dimensions and click on **OK** to place the board in the table.

Click on **Add to Board List** to use a particular board to your current pallet configuration.

**Thumbnails**

This option on the **Tools** menu activates a thumbnail listing of all the pallets in your program.

Click on any pallet you wish and then the **Open** button.

**Colors Menu**

This menu is used to change pallet color.
Changing Existing Pallet Base Styles

This feature should be used to change the board configuration on a pallet, but not to change the overall dimensions of a pallet (length, width or height). If you need to change the dimensions, creating a new pallet will be simpler than modifying an existing style.

Open a pallet by selecting the File menu and Open Pallet and one of the dialogs. We will modify the 44x44.pa4 pallet in this exercise.

Let’s change the number of top and bottom boards on this pallet.

Select layer number one from the layer list.
Delete the two boards on the right side of the pallet by clicking on each one and then Remove Board.
Now let's add an additional board 1, then but the boards 2 and 1 back where they were.

Now add back the two boards we deleted. The pallet will have a 5 board bottom.
Center the boards equally along the length by first moving the right-hand board to the far right.

Then equally space the boards using the **Tools** menu.
Now change the configuration of the top layer (layer 3) using the same steps until your pallet deck looks like this.

Finally, save the pallet as a new 8-character name. The program will add the PA4 extension to the file.